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PREFACE

PREFACE

PCschematic ELautomation is a CAD-program for documenting PLC, wiring and 
power control circuit diagrams, and can furthermore be used for any kind of electri-
cal installations. The program is developed by the Danish software house DpS 
CAD-center ApS.

In the same family of CAD programs you will find:

- PCschematic PowerDistribution for registration and survey of LV installations, 
for e.g. operations and maintenance.

- PCschematic Tele for registration and survey of tele installations, for e.g. docu-
mentation, maintenance and operations.

- PCschematic Electronics for documenting electronic circuits and for transfer-
ring data to PCB layouts

DpS CAD-center ApS also develops software for interfaces, as well as user-defined 
modules and applications, for the PCschematic programs.

Furthermore you can use PCschematic ELautomation — or any of the other pro-
grams mentioned — as a general CAD drawing tool. The program uses DpS CAD-
center’s own file formats, but supports the CAD file formats DWG and DXF.

Symbols and databases
All symbols in the program are created by DpS CAD-center ApS, with license from 
Danish Standard / IEC. Where no overall standard exists, the symbols have been 
created in co-operation with either trade organisations, component vendors or 
PCschematic users.

PCschematic includes a database program, for which many vendors have created 
special databases. These can be loaded directly into the program. The extra advan-
tage of these PCschematic databases, are that they, beyond the common database 
information — such as EAN number, description and prices —, contain electrical 
as well as mechanical symbols for the components. You also have the option to cre-
ate your own component databases.

When buying the program, you will get access to component databases from sev-
eral component vendors. These databases are created in Access format.

Furthermore, PCschematic ELautomation can use databases, which are supported 
by ODBC, MDAC (Microsoft Data Access Components — standard on Windows 
2000, Windows ME and later) and BDE (or the so-called native drivers). In praxis 

PCschematic ELautomation RUNS UNDER WINDOWS VISTA

PCschematic ELautomation IS "VISTA READY", AND FUNCTIONS COR-
RECTLY UNDER WINDOWS VISTA. QUITE A FEW CHANGES HAVE BEEN MADE 
TO ACCOMPLISH THIS. PLEASE NOTE THAT THE PROGRAM WILL BEHAVE 
SLIGHTLY DIFFERENT IN SOME SITUATIONS WHEN USING WINDOWS VISTA.
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this means that the program supports practically all database formats for Windows 
— for instance Oracle and Microsoft SQL Server.

Reducing Repetitive Strain Injuries
Along with the program comes the specially designed Mouse Chasing System for 
learning the program short-cut keys while working.

Hot-line and Update
Hot-line and updates are available, but the terms can differ from country to country. 
Please contact your local PCschematic agent for detailed information.

DpS CAD-center participates in a continuous dialog with the users of the program. 
The input from this dialog is the basis for the future development of the program.

OTHER MANUALS

For PCschematic ELautomation the following additional manuals exists:

— The PCschematic tutorial manual, which contains step by step introductions on 
how to create projects in PCschematic ELautomation.

— The Project Generator manual, which describes automatic generation of 
projects in PCschematic ELautomation.

— The PCschematic Tools manual, which describes how you can document sym-
bols in projects or libraries automatically, how to set up parameters for DWG/DXF 
import/export, how to use the PCschematic Translator program, for translating 
project texts, as well as how you automatically create graphical terminal plans, 
graphical cable plans and graphical connection plans.

— The PCschematic Database manual, which describes how to use the PCsche-
matic Database program for creating and maintaining your database for PCsche-
matic ELautomation.
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LICENSE AGREEMENT

Licenses rights
All PCschematic ELautomation versions can be copied to any number of PC’s 
with relation to the license owner. However, the number of concurrent users of 
PCschematic ELautomation may not exceed the number of purchased PCsche-
matic ELautomation licenses.

The license owner is not allowed to lease away the PCschematic ELautomation 
software, but may transfer all rights to any other person or company, if DpS CAD-
center ApS and the local dealer is informed.

The license key
Any attempt to bypass the use of the license key, by changing the license key or 
making changes in the PCschematic ELautomation software, is not allowed.

Defect license keys
Under special conditions, like removing the license key with power on your PC, 
static electricity or thunder, the license key can loose the license code. If this should 
happen, the license key must be send to DpS or your local dealer to be exchanged. 
Within the first 12 months this exchange is without costs for the license key holder. 
After 12 months the exchange will be made according to the actual price list.

Lost or stolen license key
If the license key is lost or stolen it is a matter for your insurance, and you must 
then buy a new PCschematic ELautomation license.

Responsibility
DpS CAD-center ApS and their distributors or dealers only guaranty that the 
PCschematic software in all essentials will function as described in the enclosed 
documentation. This guaranty will be active for a period of 12 months after receiv-
ing the software.

THIS CHAPTER CONTAINS THE LICENSE AGREEMENT FOR PCschematic 
ELautomation.

READ THIS CHAPTER BEFORE GOING ANY FURTHER.
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DpS CAD-center ApS and their distributors or dealers can not directly or indirectly 
be held responsible for any loss of data, profit or other kind of loss by the license 
holder, as a consequence of using PCschematic.

USING ANY OF THESE PROGRAMS EXCEPT AS PERMITTED BY THIS LICENSE 
AGREEMENT IS COPYRIGHT INFRINGEMENT UNDER THE LAWS OF YOUR COUN-
TRY. IF YOU COPY YOUR PCSCHEMATIC PROGRAM WITHOUT PERMISSION OF 
DPS CAD-CENTER APS, YOU ARE VIOLATING THE LAW. YOU MAY BE LIABLE 
TO DPS CAD-CENTER APS FOR DAMAGES, AND YOU MAY BE SUBJECT TO 
CRIMINAL PENALTIES.



This article gives you a survey of quite a few of 

the options in PCschematic ELautomation.

Due to the many program facilities, not all func-

tions are described here. If you miss some func-

tions, which are not described here, please check 

the table of contents or the index.

On www.pcschematic.com you can see product 

videos, which can give you a survey of various 

functions in the program.

OTHER SURVEY ARTICLES IN THE MANUAL

PLEASE ALSO SEE THE OTHER SURVEY ARTICLES, 
WHICH GIVES SURVEYS ON DIFFERENT SUBJECTS.
THESE ARTICLES ARE FIRST OF ALL INCLUDED 
FOR THE BENEFIT OF NEW USERS, AND CAN BE 
FOUND IN THE FOLLOWING SECTIONS:
- "BASIC DRAWING FACILITIES" ................ (P. 71)
- "PLC FUNCTIONS"................................. (P. 441)
- "WORKING WITH PROJECTS" ................. (P. 481)
- "LISTS" .................................................. (P. 521)

A
rticle about the program

http://www.dps.dk/english/Video/Product_videos.htm




At a first glimpse, PCschematic
ELautomation might look like any
other Windows CAD program. And if
you just want to draw a few diagrams,
you will learn that these are created
easily - but you probably would not
discover why the program totally
dominates the Danish market for
electrical documentation.
However, when you take a closer look
at the program, you might understand
the reason behind the success:

• An easy accessible program
• Comprehensive component vendor

databases with electrical symbols
• Automatically updated lists
• On-line update of all kinds of project

references
• A project oriented structure
• Intelligent handling of reference

designations
• Complete subdrawings containing

article data for all included symbols,
can be dragged directly into the
diagram pages

• A fast development of new functions
according to user requirements

All this is followed by a good and
reliable hot-line service.
The fact that the program also sup-
ports IEC/EN standards, the user-
defined import and export of PLC I/O
data, the router for automatic drawing
of connection lines, the functions for
automatic generation of projects, the
intelligent chapter facilities, the
networks solutions and the house
installation facilities, are only extra
advantages for the many program
users.

From single users to heavy
industry
The program is basically used any-
where you need to document electrical
automation and control units. Or - in
other words - anywhere you find an
industrial electrician.

The users are therefore major and
minor automation/installation compa-
nies, consultant engineers, electrical
power plants, as well as major and

project oriented covers the fact that
all parts of the documentation are
represented as pages in the same
document. Using the built-in page

State-of-the-art electrical
documentation

This article gives you a survey of the options in PCschematic ELautomation.

minor production companies of any
kind.
While the single user might be
attracted by how fast you can create
electrical documentation, larger
companies also focus on issues such
as the network facilities, the interfaces
for practically all major database
formats, the intelligent reference
designations and the fulfilling of IEC/
EN standards.

Survey of all project details
One of the things that makes the
program so easy to work with, is its
project oriented structure. The term

menu, or by clicking on the page or
chapter tabs on the screen, you can
navigate between the various project
pages.
Beyond the Control Circuit and Main
Circuit diagrams, you will here find
pages for mechanical layouts, compo-
nents- and parts lists, and any other
types of lists. Mechanical symbols
can be loaded, and graphical terminal,
cable and connection plans can be
generated automatically from the
electrical diagrams.
When you need to find components
in a project, you can search on all
types of texts in the project, or view a

The project oriented structure of PCschematic ELautomation holds all parts in
the electrical documentation in the same document. This is supported by
strong survey facilities, which gives you control of the project data. Projects
can be divided in chapters with individually updated lists and tables of
contents. New projects can be created based on project templates, and sub-
drawings containing article data can be dragged directly into the diagrams



list of all project symbols or texts,
specifying their position in the
project. Clicking on the symbol/text/
page automatically displays the object
you clicked on.
The design check function locates
drawing errors in the project.

On-line updated references
The project oriented structure is
solidly supported by the many on-line
updated references between the
symbols on all project pages.
When for instance you place a
contactor, a reference cross is auto-
matically placed near the symbol on a
user defined location. The reference
cross is automatically updated with
the current path numbers of the
locations of the other electrical
symbols for the component.
In stead of reference crosses, the
program can also create contact
mirrors automatically, which further-
more gives you a graphical survey of
which of the functions for the compo-
nent, that are not used.
All references in the project are
updated on-line each time symbols or
project pages are moved, inserted or
deleted.
You can also specify your own
references between symbols in the
project. Furthermore you can insert
the so-called signal symbols, specify-
ing that an electrical potential contin-
ues on other pages in the project.

Reference designations and
Wire numbers
When you place new symbols, they
can be assigned new symbol names
automatically.
Working with reference designations,
the program supports you in adding
the function and the location aspects
to the symbol name. This makes the
symbol name reflect that the symbol is
a part of, say, Pump3 and is placed in
Hall2.
You can also specify that all symbols
on a project page - and/or in an area
on the page - has a specific reference
designation. When a symbol on the
page has another reference designa-
tion, you specify this in the symbol
name.
Applying this facility, the program can
also create specific lists for each
pump, rack or assembly - you name it -
automatically.
If you change a reference designation,

the program gives you the option of
changing the pages and symbols
influenced by this automatically.
Automatic wire numbering and
potential numbering are also standard
functions. The names of the wire
numbers can easily be exported to a
wire numbering tool.
Connection lists are generated just as
easily.

Project and Page templates
When you frequently create projects
consisting of e.g. a front page, a table
of contents, as well as some types of
lists and diagram pages, you can
create a so-called project template
containing these pages. The next time
you start a project, you can start by
opening this project template, and
continue working from there.

Drag’n Draw
In connection with this, you can
create a library of subdrawings, which
can have article data attached to each
individual symbol in the subdrawing.
These subdrawings can be dragged
directly into the project pages, and
can be connected to the diagrams
automatically.
Some component vendors with
databases for PCschematic have also
created complete motorstarter circuits
with attached article data, which you
can drag directly into your diagram
pages.

Project information
On the drawing headers of your
project pages, you can include
various information about customer
data, who the constructor is, when the

You can create a library containing
different project templates, for differ-
ent types of projects or different
customers.
Alternatively, you can use the project
template, which is included in the
program package.
Accordingly, you can create a library
with page templates, for each indi-
vidual page type in the program.

page was created etc. This information
is entered in a dialog box, which
covers the entire project.
When you need to change this type
of information, you only change it in
this dialog box, and the information in
the drawing headers in the entire
project are updated automatically.
Correspondingly, you can enter
information for each individual page.

Among the many automatic functions, you find on-line updated references
between symbols, intelligent support of reference designations according to
EN 61346, automatic wire numbering, automatic naming of symbols, replace
symbol functions, automatic drawing of symbol connections (router), intelli-
gent renaming of symbol names in copied areas, design check functions and
automatic generation of projects



Supporting your company
profile
When you are creating electrical
documentation with PCschematic
ELautomation, you can use the pre-
defined drawing headers and lists in
the program.
You can also design your own
drawing headers and lists to give the
documentation your own unique
company profile. You can either adapt
the pre-defined drawing headers by

able.
Apart from technical information and
ordering data, these databases
contains electrical symbols for the
components, and mechanical symbols
for drawing mechanical assembly
layouts.
You can either use these databases
directly, or load them into your own
component database. This database
you can create and maintain using the
PCschematic Database program,

the parts- and components lists in the
project.
You can also enter the database by
clicking on a symbol in the pickmenu.
This makes the database display all
components containing an electrical
symbol of the type you clicked on.
When you click on a component in
the database, you automatically get a
pickmenu containing electrical
symbols for all of the functions in the
selected component. These symbols
can then be placed in your diagrams.
If you attach a programmable barcode
scanner to the system, you can also
get the electrical symbol of a compo-
nent directly into the cross hairs, by
scanning the barcode for the compo-
nent in the vendor catalog. Via the
component vendor database, compo-
nent data are attached to the symbol
in the project.

All Lists Updated Automatically
When you place a symbol in a
diagram using the database, the article
number of the component is automati-
cally attached to the symbol in the
project.
This enables the program to fetch
additional component information
from the database, and update all
project lists automatically. These lists
can be parts, components, cable,
terminal, connection and PLC lists.
Automatically updated tables of
contents - on either project or chapter
level - front pages and chapter front
pages also exists.
All of these lists are an integrated part
of the project, and will not have to be
created again, when you return to the
project at a later stage.
You can freely define your own lists,
for instance with your - or your
customers - logo on all pages in the
documentation.
Lists can also be exported as user-
defined text files, which can be
imported into other systems - for
instance as order files. Lists can also
be exported to Excel.
Using the reference system of the
program, you can refer to the position
of both the electrical and the mechani-
cal symbols in the project lists.
If you are drawing single-line dia-
grams, the program automatically
includes the correct amount of
components in the components- and
parts lists. Lists can also be filled out
according to the applied reference

adding your company logo, or you
can design the drawing headers from
scratch. Bitmap and JPEG images can
also be placed on project pages.
It is furthermore possible to attach a
logo to a project on a general level.
This logo can then for instance be
placed in drawing headers, and is
replaced automatically in all parts of the
project, if the applied logo is changed.

Component vendor databases
Furthermore, many  international
component vendors have created a
database for PCschematic.
When you draw your electrical
diagrams using these databases, you
have both electrical symbols for the
components and all necessary
ordering information directly avail-

which you receive along with the
documentation program.
To get a better survey of the many
components in the database, it is easy
to set up different filters, so that e.g.
only components from specified
vendors are displayed, or only
specified approved components are
displayed.

Fetching Symbols Directly from
the Database
While drawing diagrams, you can
fetch the symbols directly from a so-
called pickmenu, which is displayed
on the screen. Here you place the
symbols (and text, line and arc types)
you use the most.
These symbols can have attached
article data, which are transferred to

When you click on a component in the component vendor database, you
automatically get a menu containing the electrical symbols for the component.
By placing these symbols in the diagrams you also transfer information to the
diagrams which enables PCschematic to fill out order lists or files automati-
cally



designations. Lists can either contain
information for a specified chapter, or
for the whole project.

Pre-defined symbols
Beyond the component vendor
databases - in which you will find
thousands of symbols - more than a
thousand electrical symbols comes
along with the program. This supports
you in creating electrical diagrams
quickly with PCschematic ELautoma-
tion. Among others this includes a
comprehensive IEC/EN symbol library,
symbols for sensors, power failure,
PLCs, flowcharts, hydraulics and
pneumatics as well as the many other
symbol libraries mentioned later.
If you need extra symbols for your
documentation, you can easily design
these in the program.
Using the built-in documentation
facility, your symbol libraries are
documented automatically.

Supports IEC/EN standards
Coming from an EU country, the
program developers have strongly
emphasized supporting IEC/EN
standards in the documentation.
Therefore the symbol library follows
the IEC/EN 60617 standard, and the
program supports reference designa-
tions according to IEC/EN 61346.

When you copy an area, the naming
standards in the area is analysed, and
if the terminals in the area are named
according to IEC/EN 60204-1, 14.2.1
(Conductor and Cable runs), the
terminals in the copy will be renamed
according to this standard.
However, it is important to note, that
the structure of the program is so
open, that it can also support any
standard you might choose to create
or follow.

Translation facilities
Furthermore, the program includes a
translation facility, which supports
you in translating the texts in the
projects to other languages.
This function also supports you in
making sure that the texts in the
projects follows your company
standards for texts in projects. The
program also supports different
character sets, such as the Polish,
Baltic, Czech and Russian characters.
Besides, there are special characters
from the other European languages.

Interfaces for any Database
system
If you already are using another
database program for your component
data, you can almost certainly make
this database work with the PCsche-

matic program.
This is because PCschematic can use
databases which are supported by
ODBC, MDAC (Microsoft Data
Access Components - standard on
Windows 2000, Windows ME and
later) and BDE.
Among many others, this enables you
to use Oracle and Microsoft SQL
databases in PCschematic.
PCschematic uses the database
formats Access and dBase directly.

Networks
Larger companies already benefit from
the fact, that PCschematic ELautoma-
tion also runs on networks. The net-
installation itself is quite easy, be-
cause you do not have to place the
license key on the server itself. The
built-in security checks, prevents
program users from overwriting what
other users have been creating for the
same project on the net.
The administrator can also centrally
control the settings for the PCs in the
network, so that the users for instance
have access to the same pickmenus
and database settings.
If you are using a net license key, it is
possible to give licenses from this
license key to other PCs not having a
license key - for a specified period of
time.
The program itself is a stand alone
Windows program. This means that
you do not need anything but Win-
dows to run the program. Furthermore,
PCschematic ELautomation is open for
integration with application programs.
For export and import to and from
other file formats, you have the option
of specifying your own mapping
parameters.

Several projects simultaneously
In PCschematic ELautomation you can
work with several projects open at the
time, and copy freely between the
projects. When you copy diagrams or
parts of diagrams from one project to
another, the program automatically
updates all references according to
the new situation, and asks you
whether to rename the inserted
symbols automatically.
Entire pages can be copied from one
project to another using the drag and
drop functions.

PCschematic ELautomation can interface with plc i/o tools, wire numbering
tools, label systems, send files for component ordering systems, edit PLC data
via Excel, import and export the standard CAD formats DWG and DXF, and
update all types of lists automatically. Furthermore the program supports
practically any database format, so that it can work with the database format
used in your company



Automatic diagram drawing
Via Excel you can also let the program
merge different projects, and you can
furthermore let the program draw
diagram pages automatically based on
for instance an Excel file.

Many automatic PLC functions
In many ways PCschematic ELautoma-
tion is a pioneer within electrical
documentation. Because no IEC
standard existed on the area, the
program developers for instance
joined efforts with a board of PLC
vendors, and designed their own
standard for documentation of PLCs.
These symbols are included with the
program, and component vendor
databases using these symbols have
already been introduced.
Also, the program supports user-
defined PLC I/O import and export to
and from PLC programming tools.
In the program you will also find
several automatic functions, which
supports documenting PLC’s, such as
automatic addressing and readdress-
ing. The readdressing function makes
it possible to insert extra I/O cards in
PLC’s without breaking your neck.
Furthermore it is possible to edit the
PLC data in the program via Excel.
Because of the extensive use of PLC’s
and other I/O systems, the program
developers puts great emphasis on
designing lots of extra automatic PLC
functions in the versions to come.

House installation
Along with the program comes special
IEC/EN symbols for common house
installation, and intelligent house
installation, such as EIB. On each
drawing page in a project, you can
work in 255 different layers. On these
layers you can work in different
elevations, which supports house
installation documentation. The

program can also display the installa-
tions isometrically.
Cable lengths are calculated automati-
cally in the project parts lists.
Using the built-in unit drawing facility,
you can show the various electrical
components as detailed unit drawings.
Right-clicking on for instance an
electrical symbol for a plug-and-
socket outlet, you can then see
graphical drawing and a list of the
parts included in the outlet. When
you update the project lists, you can
specify whether you want this
detailed information included on the
lists or not. A number of ready made
unit drawings are available for the
program.
You will also find symbols for docu-
mentation of alarm systems, tele- and
data communication as well as
symbols for buildings.
You can design ground plans in the
program, or import these from a DWG
or a DXF file.
Projects can also be exported as DWG
or DXF files.

Intelligent import of AutoCAD
files
If you have an already existing
electrical documentation as AutoCAD
files, there is furthermore created a
special tool for converting these.
This tool makes it possible to convert
DWG/DXF files from other electrical
applications, so that blocks in the
DWG/DXF file are translated to
intelligent symbols in the created
PCscheamtic project. This causes
references between the symbols to be
created automatically. Furthermore,
the applied text-attributes are attached
to the symbols as e.g. symbolname,
symboltype and connection names in
the project.
It is this intelligent attaching of data
to the symbols, which makes auto-

matic updating of all types of lists
possible in the porgram.

More than 20 years of experi-
ence
The program developers on DpS
CAD-center has more than 20 years of
experience in developing programs for
the electronics- and the electrical
trade.
Previously, a DOS version existed, and
the experience from the DOS program
prepared the ground for the Windows
version.
When the Windows version was
designed, the developers decided to
start programming from scratch.
This put them in the unique situation,
that they could create a program, that
from the very start of, was open for all
the demands, they knew would come
many years ahead.
Because of this openness, the devel-
opers are now able to add new
functions to the program very quickly
and with great precision - and also to
be extremely responsive to user
requests.
This is probably also why the program
dominates the Danish market for
electrical documentation, and a reason
why you can find PCschematic
ELautomation in more than 25 differ-
ent countries.

State-of-the-art documentation
On the field of PLC’s and many other
issues, you will find that PCschematic
ELautomation is a state-of-the-art
program within electrical documenta-
tion.
And the rapid increase in new pro-
gram facilities, ensures us that the
program will continue to be so in the
future.





In this section you get a first impression of how 

to get started with the program.

To get the most of the manual, you should read 

this short section before going any further.

Survey
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QUICK SURVEY OF THE MANUAL

To make the program as easy accessible as possible, the user interface for PCsche-
matic ELautomation have been developed as close to the Windows version of the 
Microsoft® Office-package as possible.

If you are not familiar with Windows, you may read the brief introduction in the 
chapter “Windows” on page 35.

The manual itself is divided in sections. Below you can get a survey of the contents 
of these sections.

THE CONTENTS OF PART 1

THIS CHAPTER DESCRIBES

THIS CHAPTER DESCRIBES THE CONTENTS OF THIS MANUAL.

SECTION DESCRIPTION SUBJECTS

"GETTING 
STARTED"
(P. 27)

HOW TO INSTALL THE 
PROGRAM, SCREEN 
FUNCTIONS IN THE 
PROGRAM ETC.

- INSTALLING THE PROGRAM

- INTRODUCTION TO WINDOWS

- THE ONLINE MANUAL

- THE PROGRAM WORK AREA

- BASIC IMAGE FUNCTIONS

"BASIC DRAW-
ING FACILI-
TIES"
(P. 71)

DETAILED DESCRIP-
TION OF THE BASIC 
DRAWING FACILITIES.

- DRAWING DIAGRAMS / WORKING WITH LINES, 
SYMBOLS, TEXTS AND AREAS

- TRANSFERRING PROPERTIES BETWEEN OBJECTS

- ALIGNING AND TRIMMING FUNCTIONS

- AUTOMATIC LINE DRAWING / ROUTER

- MOUNTING CORRECT DRAWING

- TEXT LINKS

- FUNCTIONS ON COMPONENT LEVEL

- SUB DRAWINGS / DRAG’N DRAW

- RENAME SYMBOLS

"SURVEY AND 
REFERENCE 
DESIGNA-
TIONS"
(P. 307)

DESCRIPTION OF HOW 
TO FIND PAGES AND 
OBJECTS IN PROJECTS, 
PERFORM DESIGN 
CHECK AND PRINT.
DESCRIPTION OF HOW 
TO USE REFERENCE 
DESIGNATIONS.

- USING THE BUILD-IN EXPLORER

- USING THE OBJECT LISTER

- FIND AND REPLACE

- DESIGNCHECK

- PRINTING

- USING THE WINDOWS EXPLORER AS PROJECT/
SYMBOL MENU

- REFERENCE DESIGNATIONS

SUMMARY OF THE MANUAL, PART 1
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THE CONTENTS OF PART 2

"REFERENCES"
(P. 371)

DESCRIPTION OF HOW 
TO USE REFERENCES 
IN THE PROGRAM.

- AUTOMATICALLY UPDATED REFERENCES

- CONTACT MIRRORS

- REFERENCE CROSSES

- CURRENT PATH NUMBERS / REFERENCE SYSTEM

"WIRE NUM-
BERS"
(P. 393)

DESCRIPTION OF HOW 
TO USE WIRE NUM-
BERS.

- AUTOMATIC WIRE NUMBERING

- MANUAL PLACING OF WIRE NUMBERS

- WIRENUMBER FILES

SECTION DESCRIPTION SUBJECTS

"PLC FUNC-
TIONS"
(P. 441)

DESCRIPTION OF PLC 
FUNCTIONS.

- SURVEY OF PLC FUNCTIONS

- WORKING WITH PLC’S
- SIGNAL BUSES

- READING PLC I/O FILES

- PLC I/O ADDRESSING VIA MICROSOFT EXCEL

"ADDITIONAL 
DRAWING 
FACILITIES"
(P. 469)

DETAILED DESCRIP-
TION OF THE MORE 
DRAWING FACILITIES.

- WORKING IN DIFFERENT LAYERS AND ELEVA-
TIONS

- SCALING

- SINGLE LINE DIAGRAMS

- INSERTING IMAGES

"WORKING 
WITH 
PROJECTS"
(P. 481)

THINGS YOU NEED TO 
KNOW WHEN YOU ARE 
CREATING PROJECTS.

- ON PROJECTS

- WORKING WITH PAGES, PAGE TYPES AND PAGE 
FUNCTIONS

- PROJECT CHAPTERS

- PAGE AND PROJECT TEMPLATES

- TEMPLATE PROJECTS

- COPYING BETWEEN PROJECTS

- WORKING WITH MORE THAT ONE PROJECT OPEN

- STARTING ANOTHER PROJECT BY CLICKING

"LISTS"
(P. 521)

HOW TO INSERT 
DRAWING HEADERS/
LISTS.

- INSERTING DRAWING HEADER/LIST

- LIST SETTINGS

- COMPONENT GROUPING

- UNIT DRAWINGS

"DATABASES"
(P. 557)

HOW TO USE THE 
DATABASE IN YOUR 
PROJECTS.

- USING AND CHOOSING A DATABASE

- GRAPHICAL CREATION OF COMPONENTS IN THE 
DATABASE

- PROGRAMMABLE BARCODE SCANNERS

- DATABASE SETTINGS

- REFERENCES FROM MECHANICAL TO ELECTRICAL 
PAGES

- MECHANICAL SYMBOLS FROM THE DATABASE

SUMMARY OF THE MANUAL, PART 2

SECTION DESCRIPTION SUBJECTS

SUMMARY OF THE MANUAL, PART 1
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HOW TO GET STARTED

Start by installing the program, as described in “Installation” on page 29.

Here it is important to read the initial part of the chapter “On Drawing objects” on 
page 75, which deals with general working routines and how to work with selected 
objects.

If you are familiar with Windows, you can then proceed directly to the PCsche-
matic Tutorial. Here you get a practical introduction in how to create a project, and 
get ready to carry on with the detailed description of the program in “Basic Draw-
ing facilities” on page 71.

Later on, you may return to the remaining part of “Getting started” on page 27, and 
get a better idea of the construction of the program.

You should also read “On projects” on page 485, which gives you a summary of the 
possibilities when you are working with projects in PCschematic ELautomation.

"EXPORT / 
IMPORT"
(P. 623)

DESCRIPTION OF HOW 
TO IMPORT/EXPORT 
FILES.

- LIST FILES

- DWG AND DXF FILES

- INTEGRATION WITH MICROSOFT EXCEL

- INSERTING OBJECTS FROM OTHER PROGRAMS / 
OLE OBJECTS

- PLACING SYMBOLS VIA LISTS

- PCSCHEMATIC VIEWER

"CREATE SYM-
BOLS, LISTS 
AND 
PROJECTS"
(P. 657)

HOW TO ADAPT SYM-
BOLS, LISTS AND 
DATAFIELDS TO MEET 
YOUR SPECIFIC NEEDS, 
AND HOW TO CREATE 
PROJECTS THAT CAN 
BE USED AS TEM-
PLATES FOR OTHER 
PROJECTS.

- CREATING STANDARD PROJECTS AND TEMPLATES

- SPECIFYING WHICH DATAFIELDS CAN BE USED IN 
PROJECTS

- DESIGNING SYMBOLS

- DESIGNING SIGNAL SYMBOLS

- DESIGNING DRAWING HEADERS/LISTS

- DESIGNING UNIT DRAWINGS

"UPDATING, 
MODULES AND 
LICENSES". (P. 
757)

INFORMATION ABOUT 
NETWORK SECURITY 
CHECKS, HOW TO 
INSTALL AND UPDATE 
ADDITIONAL PRO-
GRAM MODULES, AND 
HOW TO ADAPT THE 
SYSTEM TO YOUR 
NEEDS.

- PASSWORDS ON PROJECTS

- LOCKING PROJECT FILES

- INSTALLING MODULES

- REVISION MANAGEMENT

- ADAPTING THE SYSTEM

- SHORT-CUT KEYS

- SYSTEM COLORS

- REGISTERING PCSCHEMATIC FILE TYPES

- INDEXING

- DDE AND STARTING FUNCTIONS

- ZIPPING / COMPRESSED SAVING

- THE MOUSE CHASING SYSTEM

"APPENDICES"
(P. 807)

FOR REFERENCE, AND 
FOR ADJUSTING THE 
PROGRAM SETTINGS.

- PROGRAM SETTINGS

- DICTIONARY

- DATAFIELDS

- SPECIAL CHARACTERS IN THE PROGRAM

- INDEX

SECTION DESCRIPTION SUBJECTS

SUMMARY OF THE MANUAL, PART 2
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— Use the chapter headings as well as the index, to receive information on the 
desired subjects as quickly as possible. The first chapter in some of the sections 
also contains a general overview of the section.

You can also use the program on-line manual, as described in “The On-line man-
ual” on page 56.

Overall planning
In the section “Create Symbols, Lists and Projects” on page 657, you can get infor-
mation on how to prepare your projects as easy as possible. In this section you 
design your own symbols and lists, and specify which datafields can be used in the 
project.

Appendix
In the last section of the manual, you can read about the various program settings, 
and how to adjust these to your needs. Here you will also find a dictionary, explain-
ing commonly used terms in PCschematic ELautomation, in Windows or in the 
manual itself. Finally, you can see the special characters, that can be applied in your 
project diagrams.

Finding your way around the projects
To find your way around the projects, it is recommended to read “Getting started” 
on page 27, as well as the chapter “Find and Replace” on page 324.

DpS CAD-center homepage
For direct access to DpS CAD-center’s homepage, choose Help => Http://
www.pcschematic.com. Here you can for instance get information about the latest 
updates in the program.

Here you can also sign up for an e-mail service, which informs you when there are 
news on the PCschematic ELautomation support page.
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TYPOGRAPHY IN THE MANUAL

The following typographical elements are applied in the manual:

Furthermore, when you must click on one of the program buttons, this button will 
be displayed in the left margin of the text — facing where the button is mentioned.

Buttons mentioned shortly after another, will be displayed following the order in 
which they are mentioned in the text.

TYPOGRAPHY USE

ITALICS TEXTS WRITTEN IN ITALICS ARE TEXTS YOU HAVE TO TYPE IN YOURSELF.

BOLD BOLD TEXTS — NOT INCLUDING HEADINGS — ARE USED FOR PROGRAM 
FUNCTIONS, BUTTONS AND MENUS.

BOLD AND ITALICS ARE APPLIED FOR FIELD NAMES OR OPTIONS YOU CAN CLICK ON IN DIA-
LOG BOXES.

KEYS

<>
[]

[CTRL+G]

THE CONTROL KEY IS WRITTEN AS <CTRL>, THE ESCAPE KEY AS <ESC>, 
THE ENTER KEY AS <ENTER>, THE DELETE KEY AS <DEL>, WHILE THE 
SPACEBAR IS WRITTEN AS [SPACEBAR]. SINGLE LETTERS IN BRACKETS 
SUCH AS FOR INSTANCE [Z] SPECIFIES THAT THE "Z" KEY IS A SHORT-CUT 
KEY.
IF IT SAYS [CTRL+G] THIS MEANS THAT YOU MUST PRESS DOWN THE 
"CONTROL" KEY AND THEN PRESS DOWN THE "G" KEY TO ACTIVATE THE 
SHORT-CUT.

MENUS

=>
FILE => SAVE MEANS THAT YOU MUST CLICK ON THE MENU FILE (IN THE 
MENU BAR ON THE UPPER PART OF THE SCREEN) AND THEN CHOOSE THE 
MENU OPTION SAVE.

TYPOGRAPHY IN THE MANUAL
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This section describes:

- Installing PCschematic ELautomation.(p. 29)

- Working with Windows programs .........(p. 35)

- Keyboard short-cuts ...............................(p. 51)

- The On-line Manual...............................(p. 32)

- The Work area........................................(p. 59)

- Applying basic Image functions ............(p. 63)

Reading this section will save time using the 

program.

On www.pcschematic.com you can see product 

videos, which can give you a survey of various 

functions in the program.

G
etting started

http://www.dps.dk/english/Video/Product_videos.htm
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INSTALLATION

This chapter deals with installing PCschematic ELautomation.

SYSTEM REQUIREMENTS

Before installing the program, please check out if your computer meets the mini-
mum system requirements. If you run Windows programs without difficulty, you 
probably will not get any problems installing and using this program either. The 
minimum requirements are as follows:

INSTALLATION

This section describes how to install PCschematic ELautomation on your com-
puter.

If you have experience from installing other Windows programs, the installation 
procedure ought to bee self-explanatory.

When in doubt, you can always contact your local hot-line service.

THIS CHAPTER DESCRIBES

— THE SYSTEM REQUIREMENTS................................................................................(P. 29)

— HOW TO INSTALL PCschematic ELautomation .........................................(P. 29)

— THE LICENSE KEY .................................................................................................(P. 32)

— TANKING LICENSES ...............................................................................................(P. 34)

— THE FOLDER STRUCTURE IN THE INSTALLED PROGRAM.......................................(P. 34)

UNIT REQUIRED

COMPUTER 1 GHZ PENTIUM

HARD DISK 200 MB FREE SPACE AVAILABLE

MEMORY 256 MB RAM (1 GB FOR WINDOWS VISTA)

SCREEN 1024X768

OPERATING SYSTEM WINDOWS 98 OR LATER

SYSTEM REQUIREMENTS
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Installing PCschematic ELautomation
To prepare your PC for the installation, close down all active programs on the PC.

Then install PCschematic ELautomation:

1) Insert the PCschematic ELautomation CD into your CD-ROM drive. After a 
short while the installation menu is displayed.

2) Click on Install and follow the self-explanatory instructions, until the pro-
gram is installed.

Installing PCschematic ELautomation — Netserver version
In a network PCschematic ELautomation can be shared by many users by first 
installing the program on a common drive on the server. — Please refer to the 
enclosed papers to get further information on how to install your net license key!

The information itself takes place as described above, where the only difference is 
that you choose Netserver installation in stead of standard installation.

Then do the following on each individual workstation, from which you want to run 
the program:

1) Open the Windows Explorer.

2) Open the Pcselcad folder on the common drive on the server, where the pro-
gram is installed.

3) Double-click on the file setup.exe, and follow the program instructions.

IF THE INSTALLATION MENU DOES NOT START AUTOMATICALLY

IF THE PCschematic ELautomation INSTALLATION MENU DOES NOT START 
AUTOMATICALLY SHORTLY AFTER INSERTING THE CD, OPEN WINDOWS 
EXPLORER AND DOUBLE-CLICK ON THE FILE CDMENU.EXE ON THE CD.
THIS ACTIVATES THE INSTALLATION MENU, AND YOU CAN THEN INSTALL THE 
PROGRAM.

ADMINISTRATOR CONTROL

PLEASE MOTE THAT PCschematic ELautomation HAS SPECIAL OPTIONS 
FOR ADMINISTRATOR CONTROL OF THE INSTALLED PROGRAMS ON MULTIUSER 
SYSTEMS.

Click here for standard
installation

Click here for Netserver
installation
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STARTING PCschematic ELautomation

Now to start PCschematic ELautomation, you choose Start => Programs => 
PCschematic => PCschematic ELautomation.

The following message might occur:

If this happens, it tells you that you either have not mounted your license key cor-
rectly on your PC printer port, or that you have to change the license key setup for 
the program. Read more about this in the section to follow.

You can still start the program by clicking Yes, but it will be in demo mode only — 
see “Limitations in demo mode” on page 31. When the program runs in demo 
mode, this will be displayed in the upper right-hand corner of the document win-
dow.

If you do not receive the message above, this means that the license key is properly 
installed, and the program starts.

You can now start working with the program.

LIMITATIONS IN DEMO MODE

IN THE DEMO MODE YOU ARE ONLY ALLOWED TO SAVE PROJECTS CONTAINING LESS THAN 40 
SYMBOLS AND LESS THAN 200 CONNECTION POINTS. (AN UNLIMITED AMOUNT OF SYMBOLS 
WITHOUT CONNECTION POINTS CAN BE INCLUDED IN THE PROJECTS) .

YOU CAN OPEN ANY PROJECT TO SEE IT, PRINT ANY PROJECT, CREATE SYMBOLS AND DRAW-
ING HEADERS, WORK WITH THE DATABASE AND PRACTICE ALL THE PROGRAM FACILITIES.

PROJECTS CREATED IN THE DEMO MODE WILL ALWAYS REMAIN DEMO PROJECTS. PROJECTS 
CREATED IN THE DEMO MODE CANNOT BE ADDED TO PROJECTS CREATED IN NORMAL MODE.

WHEN YOU MOUNT A LICENSE KEY ON YOUR PC, YOU WILL BE ABLE TO CONTINUE WORKING 
ON THE PROJECT AND TO SAVE USING MORE SYMBOLS. BUT IF THE PROJECT HAS BEEN 
STARTED AS A DEMO PROJECT, YOU WILL NOT BE ALLOWED TO MERGE IT WITH OTHER 
PROJECTS. (PLEASE CLOSE DOWN THE PC BEFORE MOUNTING THE LICENSE KEY).

STATUS FOR PCSCHEMATIC PROJECT LIMITATIONS

WHEN YOU USE THE PCSCHEMATIC FLEX 
OR THE PCSCHEMATIC 40 VERSION — AND 
WHEN IN DEMO MODE —, AN EXTRA BUTTON 
IS DISPLAYED IN THE LOWER-RIGHT CORNER 
OF THE SCREEN. THIS BUTTON DISPLAYS THE 
LIMITATION STATUS FOR THE PROJECT.
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LICENSE KEY

If you are only allowed to start in Demo mode, the applied type of license key 
determines what to do next.

License keys on Networks
Working on a network, two options exist: Either you have received one (or more) 
Network license keys (floating version), which have to be inserted into the printer 
port / USB port of the PC you want to function as net license server (see “Installing 
the net license key on the license server PC” on page 34) — Or you have received a 
number of local license keys according to the number of licences you have pur-
chased.

Whether the PCschematic ELautomation program is installed locally on your 
machine, or it runs via the network, has no influence in this context. The license 
key system is a program of its own right, running independent of PCschematic 
ELautomation: The only thing that matters is whether you have a local license key, 
or whether you have received a net license key (floating version) for the entire sys-
tem.

License key for Stand alone / No network
If you do not work on a network, you have received a Local license key (unless you 
have ordered differently).

Local license key
If you have a local license key for your program, and physically have inserted the 
key into the PC printer port / USB port, it will typically not be necessary to take any 
further action.

If you have problems anyway, do as follows:

1) Check whether the license key is correctly mounted onto the PC printer / USB 
port.

READ THIS CHAPTER IF YOU START IN THE DEMO MODE

THE ONLY REASON TO READ THIS CHAPTER, IS IF YOU ARE ONLY ALLOWED TO 
START IN THE DEMO VERSION.

IMPORTANT FOR USB KEYS

DO NOT INSERT THE USB KEY BEFORE PCschematic ELautomation AND 
THE SENTINEL SYSTEM DRIVER IS INSTALLED.
THE SENTINEL SYSTEM DRIVER IS INSTALLED DURING THE INSTALLATION OF 
PCschematic ELautomation. (IF YOU ANSWERED NO TO THIS, PLEASE 
READ “LOCAL LICENSE KEY - AND SUBSEQUENT INSTALLATION OF SENTINEL 
SYSTEM DRIVER” ON PAGE 33).
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2) Start PCschematic ELautomation.

3) The Settings dialog box appears. Choose the tab System.

In the field below License key, SuperPro Local should already be selected. Is this 
not the case, click the down-arrow below License key, and select SuperPro Local. 
Click OK.

You now receive a massage telling you that the program should be restarted. Click 
OK, and click OK to leave Settings.

Terminate the program choosing File => Exit, and restart the program.

Are you still having problems, please contact your local hot-line.

Local license key - and subsequent installation of Sentinel System driver
If you answered No to install Sentinel system driver during the installation, and 
you now wish to use a local license key on your PC, you have to run an extra pro-
gram:

1) Insert the PCschematic ELautomation CD.

2) The PCschematic ELautomation installation menu appears: Click on Utility 
programs and drivers.

3) Then click on Install Sentinel System Driver.

4) Click on Exit to leave the installation menu.

5) Restart your PC after running the program.

If your program still starts in the demo mode, read “Local license key” on page 32.

Net license key, floating version
Are you working on a network with a net license key (floating version) in the net-
work server, and you are only allowed to start in the demo mode, please do as fol-
lows:

1) Start PCschematic ELautomation.

2) The Settings dialog box appears: Click on the System tab.

In the field below License key you click the down-arrow, and then select the net-
work to which you are connected. If you do not know to which type of network you 
are connected, you can choose Super pro All nets instead, which makes PCsche-

STARTING IN DEMO MODE IS THE ONLY RISK

PLEASE NOTE THAT CHOOSING AN INCORRECT LICENSE KEY WILL NOT CAUSE 
ANY DAMAGE; THE ONLY RISK IS THAT YOU ARE ONLY ALLOWED TO START IN 
THE DEMO MODE.
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matic ELautomation examine which type of network you are connected to. This 
has the disadvantage that the program will use longer time starting, because it has 
to examine on which type of network you are working, every time the program is 
started.

Choose a license key setting and click OK, after which you are told the program 
have to be restarted. Click OK, choose File => Exit, and restart the program.

Installing the net license key on the license server PC
If you have received a net license key (floating version) which you are responsible 
for installing on the PC, that shall function as license server, please read the 
enclosed papers on the subject.

If you have difficulties installing the license key, please contact your local hot-line 
service.

TANKING LICENSES

When using net license keys (floating version), tanking licenses is an option.

— Read more about this in “Tanking licenses” on page 772.

FOLDER STRUCTURE

To get a survey of how the program is installed, you can now see which folders 
have been created. The letters in brackets shows the standard extension of the vari-
ous types of files. Your project files will for example have the extension pro.

If you do not know what a folder is, please read “Folders” on page 40.

FOLDER FILES

Pcselcad SYSTEM FILES

DATABASE DATABASE FILES (*.DBF AND *.MDB)

LIST LIST FILES

PROJECT PROJECT FILES (*.PRO) AND UNIT DRAWING FILES (*.STD)

STANDARD STANDARD PROJECT FILES (*.PRO)

  DATATEMPLATE SUB DRAWINGS AND DATA TEMPLATES (*.PRO) AND EXCEL FILES 
(*.XLS) FOR AUTOMATIC CREATION OF PROJECTS.

  SUBDRAWING SUBDRAWINGS (*.PRO).

  TEMPLATE FOLDER CONTAINING THE PAGE AND PROJECT TEMPLATES IN VARI-
OUS SUBFOLDERS.

SYMBOL SYMBOL FOLDER WITH VARIOUS SUB FOLDERS (*.SYM)
— SEE “SYMBOL FOLDERS” ON PAGE 239.

PROGRAM FOLDERS
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WINDOWS

This chapter describes how to use the basic Windows functions. Please skip this 
chapter if you are an experienced Windows user.

THE MOUSE

When you are working with Windows, you are using the mouse a great deal of the 
time. The operations you can perform with the mouse are displayed below:

THIS CHAPTER DESCRIBES

— USING THE MOUSE............................................................................................... (P. 35)

— THE WINDOWS CONCEPT...................................................................................... (P. 36)

— SWITCHING BETWEEN OPEN WINDOWS ................................................................ (P. 37)

— MENUS ................................................................................................................. (P. 37)

— SHORT-CUT MENUS AND RIGHT-CLICKING........................................................... (P. 38)

— DIALOG BOXES..................................................................................................... (P. 39)

— FOLDERS............................................................................................................... (P. 40)

— OPENING FILES/PROJECTS.................................................................................... (P. 41)

 — SEARCHING FOR PCschematic ELautomation PROJECTS ......................... (P. 43)

— SAVING FILES/PROJECTS...................................................................................... (P. 47)

— DIALOG BOXES IN WINDOWS 2000/XP................................................................ (P. 48)

— SEARCH FIELDS IN DIALOG BOXES ....................................................................... (P. 48)

— SELECTING ELEMENTS IN LISTS............................................................................ (P. 49)

— DOCKING WINDOWS AND TOOLBARS .................................................................. (P. 49)

OPERATION DESCRIPTION

CLICK PRESS DOWN AND RELEASE THE LEFT MOUSE BUTTON ONCE.

DOUBLE-CLICK PRESS DOWN THE LEFT MOUSE BUTTON TWICE. IT IS IMPORTANT 
THAT YOU DO NOT MOVE THE MOUSE WHILE CLICKING.

RIGHT-CLICK PRESS DOWN AND RELEASE THE RIGHT MOUSE BUTTON ONCE.

DRAG AND DROP TO SELECT AN OBJECT POINT AT THE OBJECT WITH THE MOUSE CUR-
SOR, AND PRESS THE LEFT MOUSE BUTTON. KEEP THE MOUSE BUT-
TON PRESSED DOWN WHILE MOVING THE MOUSE POINTER ACROSS 
THE SCREEN. YOU SAY THAT YOU DRAG THE MOUSE ACROSS THE 
SCREEN. WHEN YOU RELEASE THE MOUSE BUTTON, THE OBJECT IS 
PLACED WHERE YOU POINT WITH THE MOUSE CURSOR.
YOU CAN MOVE BOTH OBJECTS, PROJECT PAGES AND ELEMENTS IN 
LISTS BY DRAG AND DROP.
— SEE “MOVING A PLACED SYMBOL” ON PAGE 193, “DRAGGING A 
REFERENCE DESIGNATION TO A NEW POSITION IN THE DIALOG BOX 
REFERENCE DESIGNATIONS” ON PAGE 346 AND “DRAG PAGES 
BETWEEN PROJECTS” ON PAGE 511.

BASIC MOUSE OPERATIONS
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The small arrow you control on the screen by moving the mouse, is called the 
mouse pointer. In Windows you can for instance specify the appearance of the 
mouse pointer, how rapidly it moves across the screen, and how fast you have to 
click when you double-click. Please refer to your Windows manual for further 
details.

WINDOWS / DIALOG BOXES

In Windows a lot of the work takes place inside some delimited areas called win-
dows. These windows can be moved on the screen by clicking on and dragging 
their title bars. The title bar is the colored bar you see as the uppermost part of any 
window.

Changing the size of a dialog box
In all relevant dialog boxes it is possible to adapt the 
size of the dialog box:

1) Place the mouse cursor above the lower-right 
corner of the dialog box, and the mouse 
pointer to change appearance on screen to a 
two-way arrow.

2) Press down the left mouse button, and drag the 
window until it has the desired size.

3) Release the left mouse button.

You can see that the size of the dialog box can be changed, when it has three slanted 
lines in the lower-right corner of the dialog box.

The size and position of the dialog box is memorized for the next time the program 
is started.

The dialog boxes can also be made larger or smaller by pointing at the frame of the 
dialog box. The mouse cursor then changes appearance to a two-way arrow. When 
the cursor looks like this, press the left mouse button down while dragging the dia-
log box to the desired size.

Title bar Here you can change
the size of the window

Place the cursor over the
lower-right corner, and
drag in the dialog box to
the desired size
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Besides, some dialog boxes can be removed temporarily, fill out the entire screen, 
be restored or closed by using the buttons in the upper-right corner of the dialog 
box.

Minimize a dialog box
You can minimize a dialog box by clicking on the so-called Minimize button in the 
upper-right corner of the dialog box — Please refer to the illustration below. A but-
ton bearing the name of the dialog box is then placed in the lower part of the screen. 
When you click on the Restore button, the dialog box returns.

Maximize a dialog box
If you click the Maximize button, the dialog box will fill out the entire screen. If 
you want the dialog box to return to it is previous size, please click the Restore but-
ton.

Close a dialog box
If you click the Close window button, the window disappears.

SWITCHING BETWEEN WINDOWS

When you want to change between several active projects (windows), press down 
<Ctrl> while pressing <Tab>. You then switch to another active project. You can 
also choose Window in the menu bar on the upper part of the screen, and then click 
on the open project you want to work on. If you have several project windows open 
simultaneously, you can also just click on the project you wish to work on. — 
Please refer to “Several Projects Simultaneously” on page 510.

When you press down the <Alt> key, and then press <Tab>, you can change to 
other active programs.

MENUS

When you have opened a project in PCschematic ELautomation, the uppermost 
line of the screen, will look like this:

This line is called the Menu bar, and clicking on any of the words here will make 
various menus appear. Here you specify which commands you want to execute in 
the program.

Minimize Maximize Close window Restore
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Choosing menus and commands in PCschematic ELautomation follows the com-
mon directions for Windows. Below you will see the View menu, as an illustration 
of how to choose a command using the menus. Click on View in the menu bar, and 
the following menu will appear:

— As you can see, the letter V is underlined in the 
word View. This means that you can also choose this 
command by pressing [Alt+v].

Click on the option you want to choose — for 
instance Screen. You can also choose by using the 
arrow keys on the keyboard, and then press <Enter> 
when you have found the desired function.

Most of the commands have an underlined letter. 
Once the menu have been chosen, you can choose the 
command by pressing down the underlined letter. In 
the menu to the left, Zoom can for instance be chosen 
by pressing down [z].

If the command has got a short-cut key — which 
means the command can be chosen without activating 
the menu at all — the short-cut combination is dis-
played to the right of the command. You can for 
instance choose Redraw by pressing down [Ctrl+g].

If an option is dimmed — written in grey — you are 
not allowed to execute this command for the moment.

Three dots succeeding an option — for instance 
Select page... — signifies that you by clicking there 
will get more options — for instance in a new menu 
or a dialog box.

SHORT-CUT MENUS AND RIGHT-CLICKING

When you right-click on something in a project, you 
will practically always get a so-called short-cut menu. 
This menu gives you some options, which are relevant 
for what you clicked on.

It will therefore frequently be most efficient to right-
click on an object and see which options you get.

The displayed menu appears by right-clicking on a page 
— the "paper" — in a project.

On new keyboards there also exists a short-cut menu 
key. Pressing this key has the same function as right-
clicking on an object.
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DIALOG BOXES

Below you will see a part of a dialog box (Settings => Pointer/Screen), together 
with an explanation of the various elements of the dialog box:

OK and Cancel
In most of the dialog boxes there will be an OK and a Cancel button as well. The 
OK button causes you to leave the dialog box, and the settings you have specified 
will be effectuated. Clicking on the Cancel button, causes you to leave the dialog 
box without activating the changes you specified.

Please note that the buttons OK and Cancel is not displayed in the figure above. 
However, they are located in the lower part of the dialog box.

In stead of clicking Cancel you can press <Esc>.

Using the keyboard in dialog boxes
— See “Keyboard short-cuts” on page 51.

Round buttons within 
an area signifies mutu-
ally exclusive options. 
In this case it is there-
fore only possible to 
specify that the gird 
(please refer to the dic-
tionary) is turned off, 
dotted or squared.

Click on the down-
arrow, and a drop down 
menu will display 
which options you have 
got. In this case you 
will see a list contain-
ing the possible units 
of measurement.

Squares signifies func-
tions you can enable or 
disable. When you 
have chosen a func-
tion, a check mark is 
placed within the 
square. In this case 
both Hints and Page 
tabs are selected.

The functions are not 
mutually exclusive, 
and can therefore be 
chosen at the same 
time.

Tabs Selected tab
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FOLDERS

If you make a standard installation of PCschematic ELautomation, the program 
will be saved in the folder c:\Pcselcad.

In order not to place all files (see “Dictionary” on page 850) on the computer in the 
same place, it is possible to gather files — for instance belonging to the same cus-
tomer — in the same folder. Within this folder you can create subfolders, which 
again can contain different types of files. To keep the survey of your projects, it is 
therefore a good idea to create different folders for different types of projects.

In “Folder structure” on page 34 you can see which folders PCschematic ELauto-
mation contains.

If for instance you click on File => Open, you will see this dialog box:

In the dialog box itself you will only see the name of the chosen folder, but you can-
not see whether it is the subfolder of another folder.

Changing to another drive or folder
If you click on the down-arrow in Survey of desktop, you will see the other folders 
and drives (see “Dictionary” on page 850) on your computer — as well as on the 
network, if you are connected to a network.

Files in the folder

Name of the folder Up one level Create new folder

Choose how to More file
information

Survey of desktop

display the files



PCschematic ELautomation 10.0 PAGE 41

WINDOWS

Here you can for instance see that the folder Project is a subfolder to the folder 
Pcselcad. If you want to change to another drive or folder, just double-click on the 
drive or folder. If for instance you wish to change to your floppy disk drive, you 
double click on 3½Floppy (a:). However, you can only do this if there is a floppy 
disk in your floppy disk drive.

If you selected the floppy disk drive, please click on C:\, double-click on the folder 
Pcselcad, and double-click on the Project folder. You have now returned to the 
“correct” folder.

One level up
If you are located in the c:\Pcselcad\Project folder, and want to change to the 
c:\Pcselcad\Standard folder, you do like this: Click the Up one level button, 
which brings you into the folder c:\Pcselcad. Here you double-click on the Stand-
ard folder. — Please return to the Project folder on your own.

Creating and Deleting folders
When you want to create a new folder, you click the Create new folder button. 
Type in the name of the folder, and press <Enter>. The folder is created as a sub-
folder to the folder you are currently located in.

If you want to delete a folder, right-click on the folder, and choose Delete in the 
appearing menu. Please note that this will also delete all of the contents in the 
folder!

OPENING FILES/PROJECTS

A special type of dialog boxes are the ones where you can open or save files. Below 
you see the dialog box that will appear when you wish to open a project in PCsche-
matic ELautomation. (If you are working in Windows 2000/XP, please refer to 
“The dialog boxes Open and Save in Windows 2000/XP” on page 48).

1) Locate the right folder 2) Specify type

3) Click on the file 4) Click here

of file
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It could be a good idea to create subfolders to the Project folder, to keep track of 
your files. — Please refer to “Folders” on page 40 to see how to do this. There you 
can also see how to change back and forth between folders.

Please note that only files of the type specified in the bottom of the dialog box (2, 
above), will be displayed.

When you wish to open a file of a different type, click on the down-arrow in the 
field Files of type in the lower part of the dialog box. You then get these options:

When for instance you click on Project files (*.pro), you will only see project files 
in the dialog box.

Now click on the type of file you wish to open, or click on All files (*.*) to see all 
of the files in the folder.

ALL SELECTED PROJECTS ARE OPENED

IF YOU SELECT MORE THAN ONE PROJECT IN THE DIALOG BOX OPEN, PCsche-
matic ELautomation OPENS ALL THE SELECTED OBJECTS.
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SEARCHING FOR PROJECTS

To search for a PCschematic ELautomation project, do the following:

1) Click on the Open project button.

2) In the dialog box Open Project: Click on the Find project button.

You now enter the dialog box Find PCschematic files, from where you can search 
for PCschematic ELautomation projects:

Choosing the folder to search in
To select the folder to search in, do the following:

1) In the dialog box Find PCschematic files: Click on Browse.

2) You now enter the dialog box Select search folder:

3) In the dialog box Select search folder: Find the desired folder, and click OK.

4) In the dialog box Find PCschematic projects: Select Search subfolders, if 
you also wish to search for projects in the subfolders for the selected folder.

Drag the elevator up and down
to find the desired folder

Click on Minus to close
a folder

Click on Plus to open
a folder
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In the dialog box Find PCschematic projects you can also type in the name of the 
folder and path in the field Look in.

Specifying search criteria
To specify a set of search criteria, do the following:

Specifying a search criterion
1) Select which type of information you wish to search for by clicking on the 

Down arrow in the field Property, and then click on the desired piece of 
information — such as Program version.

2) Dependant on which information you have chosen to search for, you can now 
choose between different searching conditions by clicking on the Down 
arrow in the field Condition — for instance click on equals.

3) Then type in a value in the Value field — for instance 4.00.

4) Then click on Add to List, and the specified criterion is added to the criteria 
list in the top of the dialog box. All of the criteria in this list must be fulfilled 
at the same time to give a search result.

5) Continue specifying search criteria until all necessary criteria have been spec-
ified.

Specifying more than one search criterion for the same type of information
6) If you specify more than one criterion for the same type of information — as 

if you for instance you also added Program version + older than + 4.00 — 
this dialog box is displayed:

7) This gives you the option to add these criteria as Or criteria. This meaning 
that the one criterion must be fulfilled or the other criterion must be fulfilled. 
In the example above this means that the program version must be older than 
or equal to version 4.00. Click on Yes to specify the criteria as Or criteria.
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Saving the search settings
1) Click on Save Search at the bottom of the dialog box, in order to be able to 

fetch the specified search settings some other time.

2) In the dialog box Save Search: Type in a name for the search settings, and 
click OK.

Activating the search and editing the found projects
1) Click on Find now to start searching according to the specified criteria, and 

the window Search files containing the search result is displayed:

2) If there are some of the found projects you do not need, then click on them in 
the list, and press <Delete>.

3) Click on Remember files to remember the search result.

4) Click on one of the projects in the list, and click on Open. The project is then 
opened, and the window Search after files and the dialog box Open are 
closed.

5) Make the desired changes in the project, save the project, and close it.

6) To edit the next project in the list: Click on the Open project button.
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7) In the dialog box Open Project: Click on the button Show list of Saved 
found, which only exists when you have chosen to memorize the result of a 
search.

8) You now return to the window Search files, where the list of projects is still 
displayed: Delete the edited project from the list, and Open the next project 
you wish to edit.

9) Continue running through the projects this way, until all the desired projects 
are corrected. When you have finished, click on Delete list in the window 
Search for files, if you need to delete the last projects in the list.

10) Click on Close.

Open a saved search
1) To open a saved search — see “Saving the search settings” on page 45 —, 

click the Open project button, and click on the Find project button.

2) In the dialog box Find PCschematic files: Click on Open Search at the bot-
tom of the dialog box.

3) In the dialog box Open Search: Click on the desired search, and click on 
Open. You now return to the dialog box Find PCschematic files, where the 
selected search criteria have been inserted.

In the dialog box Open Search you also have the option to change the title of 
the selected search. Accordingly, you can delete the selected search by click-
ing on Delete.
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SAVING PROJECTS/FILES

The first time you save a project in PCschematic ELautomation, choose File => 
Save as. (If you are working in Windows 2000/XP, please refer to “The dialog 
boxes Open and Save in Windows 2000/XP” on page 48).

You then enter the following dialog box:

If an undesired folder is specified in the upper-most line (1), click on the down-
arrow, and then click on the desired folder in the drop-down menu — as explained 
in “Folders” on page 40.

Check out whether the type of the file is correct (2) and type in the name of the file 
in the File name field (3). Please note, that if the character * is still a part of the file 
name, you will not be allowed to save the file.

You do not have to type in .pro in the end of the file name. This part is added auto-
matically when you save a project.

Click on Save (4), and the project is saved.

The next time you want to save the project, the program will remember these set-
tings for you, and you just have to choose File => Save, or click the Save button.

Status button / Info function for last save
In the right-hand side of the Status bar at the 
bottom of the screen, you will find a Status but-
ton / Info function for when the project was last 
saved.

When you click on it, it will display the period 
of time since last save. The function is activated 
automatically after 30 minutes, and is subse-
quently activated every five minutes, if the 
project is not saved. When you right-click on the button, a menu is displayed from 
which you can disable the automatic popup information.

1) Find the right folder 2) Check the type
of the file

3) Type in the name 4) Click here
of the project
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THE DIALOG BOXES OPEN AND SAVE IN WINDOWS 2000/XP

Extra options in the left-hand side of the dialog boxes Open and Save
If you are working on Windows XP or Windows 2000, you have some extra options 
in the left-hand side of the dialog boxes Open and Save:

History
Click here, and the documents you have most recently used, are 
displayed in the dialog box.

Desktop
Click here, and the contents of your desktop is displayed.

My Documents
Click here, and the folders which are set to contain documents, are 
displayed.

My Computer
Click here, and the disk drives connected to this computer, as well 
as the connected hardware, are displayed.

My Network Places
Click here, and short-cuts to network computers, web addresses and ftp protocols 
are displayed.

Different buttons in the dialog boxes Open and Save in Windows 2000/XP
The buttons at the top of the dialog boxes Open and Save has another appearance in 
Windows 2000/XP than previously:

— Please also refer to “Folders” on page 40.

SEARCH FIELDS IN DIALOG BOXES

In some dialog boxes you can find a search field. This search field is not displayed 
until you click on the Search button in the dialog box.

Go to the last
visited folder

One level up

Create new folder

Specify how
to display files/
folders
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This is described in more detail in “Searching in the Object Lister” on page 320.

SELECTING ELEMENTS IN LISTS

When elements are listed in a dialog box, these 
elements can be selected as described in 
“Selecting objects in the Object Lister” on 
page 316.

— See for instance “Copying, Cutting and 
Pasting more than one page” on page 495.

DOCKING WINDOWS AND TOOLBARS

In many Windows programs you can move the toolbars and dock windows to the 
sides of the screen. In the following you can see how to do this in PCschematic 
ELautomation.

Moving the Explorer window
When you start PCschematic ELautomation for the first time, the Explorer win-
dow is docked to the left toolbar. This means that it is placed at a fixed position just 
next to the left toolbar.

If you want to place the Explorer window at 
another location, you point at the two horizontal 
lines at the top of the Explorer window.

Then press down the mouse button, drag the win-
dow to another location on the screen, and release 
the mouse button.

If you just place it on the middle of the screen, it will cover for the details on the 
project page. When it is docked it is not in the way for viewing the page.

The Explorer window can be either a free window, or be docked to the left or to the 
right side of the screen.

Docking a window
When you wish to dock the window, click on its title bar, keep 
the mouse button pressed down, and move the window.

The frame of the window is now displayed as a grey box.
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When the mouse pointer — and not the edge of 
the grey box — is pointing on the edge you 
wish to dock the window to, release the mouse 
button.

Just before you release the button, the window 
will snap to its docked position.

Docking the Survey window
The Survey window can be docked in either 
the upper or the lower part of the Explorer window. Please note, that it is docked 
inside the Explorer window.

Docking the Elevation window
On pages of the page type Groundplan, you can see 
the Elevation window docked on the program tool-
bar.

By clicking on the two vertical lines, you can move 
the Elevation window correspondingly.

Docking the Pickmenu
The pickmenu can also either be a free window, be 
docked below the upper toolbars, or be docked in either of the sides in the program 
window.

You can only dock one window along any edge of the program window. This means 
that if you have docked the Explorer window to the left-hand side, you will not be 
allowed to dock the pickmenu to the left-hand side as well.

Docking the Program and Command Toolbars
The program toolbar and the command toolbar can change places following the 
same procedure as mentioned above.

They can also be placed in the same line, and if for instance you know the short-cut 
keys for some of the buttons in a toolbar by heart, you can place the other toolbar so 
that it covers these buttons.

Elevation window
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KEYBOARD SHORT-CUTS

To reduce the risk for repetitive strain injuries from using the mouse too much, it is 
possible to work with PCschematic ELautomation using the keyboard. This chap-
ter describes these options.

Furthermore, general Windows principles for working without the mouse can be 
applied.

CHOOSING MENU POINTS USING THE KEYBOARD

Choosing menu points using the keyboard follows the common Windows stand-
ards, as described in “Menus” on page 37.

— Please also refer to “Short-cut Keys” on page 766, where you will find a survey 
of the default short-cut keys, and you can read about how to define short-cut keys 
for all menu points in the toolbar.

THIS CHAPTER DESCRIBES

— CHOOSING MENU POINTS USING THE KEYBOARD .................................................(P. 51)

— CHOOSING BUTTONS/FUNCTIONS USING THE KEYBOARD .....................................(P. 52)

— CHOOSING IN DIALOG BOXES WITH THE KEYBOARD ............................................(P. 52)

— SELECTION IN PICKMENUS USING THE KEYBOARD...............................................(P. 53)

— PLACING OBJECTS USING THE KEYBOARD ............................................................(P. 53)

— CHOOSING OBJECTS USING THE KEYBOARD .........................................................(P. 54)

— CHOOSING MORE THAN ONE OBJECT WITH THE KEYBOARD .................................(P. 54)

— CHOOSING SYMBOLS WITH THE KEYBOARD .........................................................(P. 54)

— INCREASE/DECREASE SHORT-CUT USING THE KEYBOARD ....................................(P. 55)

— SHORT-CUTS FOR ACTIVATING THE PENCIL..........................................................(P. 55)

CONCURRENT LEARNING OF SHORT-CUT KEYS

IN “PREVENTING REPETITIVE STRAIN INJURIES” ON PAGE 779, YOU CAN SEE 
HOW YOU CAN LEARN THE SHORT-CUT KEYS FOR THE COMMANDS YOU TYPI-
CALLY CLICK ON WITH THE MOUSE — WHILE WORKING WITH THE PROGRAM.
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CHOOSING BUTTONS/FUNCTIONS USING THE KEYBOARD

You can create short-cut keys for all buttons in the pro-
gram. This is done by creating a short-cut key for the 
menu point that the button represents.

If for instance you wish to create a short-cut key for the 
Page menu button, you must create a short-cut key for 
the menu point View => Select page.

Please note that the Page menu button is displayed in 
front of the menu point, so that you can find the function 
in the menu easily.

There are menu points for all buttons in the program.

— See “Short-cut Keys” on page 766 to see how to cre-
ate keyboard short-cuts for all buttons.

Short-cuts displayed as hints
When you let the mouse cursor rest over a button, the short-cut 
key is displayed as a hint in brackets after the button name.

CHOOSING IN DIALOG BOXES USING THE KEYBOARD

When you have opened a dialog box, you can choose the different fields, buttons or 
tabs by pressing down the <Alt> key, and press on the key for the underscored char-
acter for the option in the menu.

If for instance you wish to choose the tab Ref.design. in the dialog box Compo-
nent data above, press down the <Alt> tab, and press the <d> button — because d 
is the underscored character on the tab.

If you wish to select OK, press down the <Alt> key, and press the <O> key.

Press down <Alt> and press <d>
to select the tab Ref.design.
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Using the tab key
In each dialog box there is pre-defined order, in which you jump between the differ-
ent options in the dialog box.

When you press the <Tab> key, you jump to the next option in the pre-defined 
order.

When you press down <Shift> and press the <Tab> key, you jump back to the pre-
vious option.

SELECTION IN PICKMENUS USING THE KEYBOARD

When you have selected a pickmenu for a component, the field with the first sym-
bol in the pickmenu is highlighted. This indicates that you will get this symbol in 
the cross-hairs, if you press <Enter>. You can use the right and the left arrow key to 
select another symbol in the pickmenu:

To use the keyboard to select symbols in the stationary pickmenu at the top of the 
screen, you must select View => Activate Pickmenu (Short-cut: 
<Shift+Ctrl+F12>).

You can then select the symbols by pressing the key-arrows, and change between 
the different pickmenus by pressing the <PageUp> and <PageDown> keys. When 
you press <Enter> you get the selected symbol in the cross-hairs.

If a symbol has different states, you can select the symbol states by pressing the 
arrow-down and arrow-up keys.

PLACING OBJECTS USING THE KEYBOARD

When you have an object in the cross hairs, place it like this:

1) Use the arrow-keys, which moves the objects with snap (see “Snap” on 
page 68) in the direction of the chosen arrow.

Left-arrow key Right-arrow key

Left-arrow key Right-arrow key

PageUp PageDown
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2) Press <Enter> to place the object. — If you hereby enter a dialog box, please 
refer to “Choosing in dialog boxes using the keyboard” on page 52.

3) Press <Esc> to remove the object from the cross hairs.

SELECTING OBJECTS USING THE KEYBOARD

To move the cross hairs to select an object, do this:

1) Press down the <Alt> key, and use the arrow-keys: The cross hairs now jump 
to the next object on the page, in the direction specified by the arrow key.

2) Press <Enter>, and the object is selected.

3) Press <Enter> once more, and you enter the component data dialog box / the 
text dialog box.

You can now edit data for the selected object.

SELECTING MORE THAN ONE OBJECT USING THE KEYBOARD

To select more than one object using the keyboard, do this:

1) When the cross hairs is above an object: Press down <Ctrl> and press the 
<Enter> key.

2) Move the cross hairs to the next object, press down <Ctrl> and press <Enter> 
— etc. until all desired objects are selected.

3) To enter for instance the dialog box Component data: Place the cross hairs 
over one of the selected objects, and press <Enter> (without pressing down 
<Ctrl>).

You can now edit data for the selected objects.

SELECTING SYMBOLS USING THE KEYBOARD

Type in the symbol file name
When working with symbols, and you press down the [k] key, you enter the dialog 
box Place symbol, where you are asked to type in a symbol file name. — Read 
more about this in “Typing in the symbol file name directly” on page 173.

Type in the symbol article number
When working with symbols, and you press down the [v] key, you enter the dialog 
box Place symbol, where you are asked to type in a symbol article number. — 
Read more about this in “Typing in the Article Number directly” on page 174.
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Type in the symbol type
When working with symbols, and you press down the [v] key, you enter the dialog 
box Place symbol, where you are asked to type in a symbol type. — Read more 
about this in “Typing in the Symbol Type directly” on page 175.

INCREMENT/DECREMENT USING THE KEYBOARD

See how to increment/decrement names for symbols, connection points and texts in 
“Short-cut keys for counting on texts” on page 144.

SHORT-CUTS FOR ACTIVATING THE PENCIL

When you are pressing a short-cut key to change from working with one type of 
drawing objects to another, you can activate the Pencil simultaneously, if you press 
the short-cut key twice.

Please note, that the short-cut key <Insert> always can be applied for the Pencil.

Lines
If for instance you press [l] to work with lines, you can press <Insert> to activate 
the Pencil.

You can also press [l][l] — which is pressing [l] twice. If you then want to deacti-
vate the Pencil, you can do this by pressing [l] once more.

Circles
Correspondingly, the short-cut [c][c] will make you change to Circles with the 
Pencil active.

Texts
If you press [t][t], you activate Texts, and the cursor will be placed in the text field 
in the texts toolbar.

Symbols
If you press [s][s], you get the last selected symbol into the cross hairs. If you have 
not chosen a symbol since you opened the project, you enter the Symbol menu.

If you have a symbol in the cross hairs and press [s], the symbol disappears from 
the cross hairs. When you press [s] once more, the symbol returns to the cross hairs.

Zoom
When you want to make a new Zoom, you can apply the short-cut key [z]. If you on 
the other hand press [z][z], the full project page is displayed.
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THE ON-LINE MANUAL

When using the on-line manual for PCschematic ELautomation, you have the ben-
efit of reading the manual directly on the screen while working with the program. 
The contents is identical to the printed manual, only have the pages been adapted 
for reading on the screen.

OPENING THE ON-LINE MANUAL

To open the On-line manual choose Help => Manual.

THIS CHAPTER DESCRIBES

— OPENING THE ON-LINE  MANUAL .........................................................................(P. 56)

— THE TABLE OF CONTENTS ....................................................................................(P. 57)

— THE BUTTONS IN THE ON-LINE  MANUAL ............................................................(P. 57)

— ZOOMING AND ADAPTING TO YOUR SCREEN .......................................................(P. 57)

— DIRECT ACCESS TO THE INDEX.............................................................................(P. 58)

— RETURNING TO PCschematic ELautomation.............................................(P. 58)

— PRINTING FROM THE ON-LINE MANUAL ...............................................................(P. 58)

Click di-

Up and

rectly to

About the elec-
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THE TABLE OF CONTENTS

In the left-hand side of the manual, you can 
click directly on the section you wish to read.

A + in front of a section means that the chapter 
is divided into subsections.

When you click directly on a title of a section, the chosen section is displayed.

You can adjust the size of the table of 
contents on the screen. This is done by 
pointing on the line between the table 
of contents and the manual text, and 
then drag the line to either the left or 
the right.

You can turn the displaying of the 
table of contents on and off by press-
ing [F5].

THE BUTTONS IN THE UPPER-RIGHT CORNER

In the upper-right corner of the on-line manual, 
you will find these four buttons.

When you click the ? button, you enter this 
chapter about using the on-line manual.

If you click the Return button, you jump back 
to the last page that you have viewed in the on-
line manual.

When you click the up and down buttons, you 
leaf one page up or down respectively. You can 
also use the [PageUp] and [PageDown] buttons 
on the keyboard.

ZOOMING AND ADAPTING TO YOUR SCREEN

When you open the on-line manual initially, it is opened to a size fitting your 
screen. If you need to zoom in on a detail in the manual, you click the Zoom button 
in the upper-left corner of your screen.

To re-size the on-line manual to fit your screen, you click the Fit in Window button 
on the upper part of the screen, or press [Ctrl+0].

Table of Contents Manual

Drag the line to the right or to the left

About the elec-
tronical manual

Return to the last
page you read

One page up

One page down
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DIRECT ACCESS TO THE INDEX

On the right-hand side of the on-line manual, you have direct access to the index.

To find an explanation about fx. the selection function, you click S index letter in 
the right-hand side of the manual. This then looks up under S in the index. Now 
click on the dotted line after the word Selection, to bring up to the desired informa-
tion.

Please note, that it is important that the cursor on screen has the appear-
ance of a hand with a pointing index-finger, when you click the dotted 
line — or the page number. If this is not the case, you zoom in on the 
text, and therefore can no longer see the full page on screen.

Click the Fit in Window button or press [Ctrl+0] to restore full page view.

RETURNING TO PCschematic ELautomation

In order to return to PCschematic 
ELautomation, you just click on its 
program Windows button at the bottom 
of your screen — or press down the 
<Alt> button while pressing the <Tab> 
button.

The reason why you have to change back and forth in this way, is because that the 
manual is a document in the independent program Adobe Acrobat reader.

PRINTING FROM THE ON-LINE MANUAL

If you wish to read the manual on print, it is recommended to see the printed man-
ual. To print out directly from the on-line manual, just click the Print button on the 
Acrobat program, and specify what to print out.

Please note, that the on-line manual buttons will also be printed.

Click here
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THE WORK AREA

After starting PCschematic ELautomation, you must choose whether to start a new 
project, or to continue working on an existing project.

Because this chapter exclusively deals with the work area on the screen, click the 
the New document (New project) button. (If you choose File => New, you can 
choose between different page and project templates, as described in “Pages and 
Chapters” on page 487).

The program automatically starts up showing the dialog box Project data, with the 
tab Settings activated.

At the top of the dialog box Settings you will find some tabs, each containing a 
menu defining various program, page and project settings.

Click Cancel, OK or press the <Esc> key to leave the dialog box. — You can read 
more about this dialog box in “Settings” on page 809.

When you have opened a project, your screen should look like this:

— Please note that you can change the position of the windows and the toolbars, as 
described in “Docking Windows and Toolbars” on page 49.

THIS CHAPTER DESCRIBES

THIS CHAPTER DESCRIBES THE WORK AREA OF THE PROGRAM.
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1. The menu bar 
In the menu bar you will find the menus, that contains all the functions in the pro-
gram. Choosing a subject in the menu bar, is either done using the mouse or by 
pressing down the <Alt> key while typing in the first underlined character in the 
menu. Files will for instance be selected by pressing [Alt+f]. — See “Menus” on 
page 37.

2. The program toolbar
The program toolbar contains program buttons. Here you can choose between the 
various program functions. The most common file and printing facilities are placed 
here, as well as the more general drawing and editing tools.

Like the other toolbars, this toolbar can be moved and docked at another location 
— as described in “Docking Windows and Toolbars” on page 49.

3. The command toolbar
The command toolbar has a varying appearance depending on which object type is 
selected in the program tool bar. It contains function and editing tools for the vari-
ous drawing facilities: Lines, Symbols, Texts, Arcs and Areas. The different 
appearances of the toolbar for each of these is described in “Basic Drawing facili-
ties” on page 71.

4. The pickmenu
Here you place the symbols, line types, text types and arc types you use the most, 
so that you can fetch them right away, and place directly in the diagram pages. 
When for instance you click on a symbol in the pickmenu, PCschematic ELauto-
mation change to working with symbols automatically, and you get the selected 
symbol in the cross hairs.

By clicking on the tabs at the bottom of the pickmenu, you select which of the cre-
ated to display. (The pickmenu was previously named the pickmenu because it con-
tained symbols only).

The pickmenu is described in “Fetching symbols from the Pickmenu” on page 161.

The pickmenu can be docked as described in “Docking the Pickmenu” on page 50.

5. The help frame
The help frame displays the standard margin on the paper. It can be deactivated eas-
ily — see “Pointer/Screen” on page 815. It is also possible to activate a printer help 
frame, displaying the margins of your printer.

6. The Explorer window
The Explorer window contains two tabs: The Projects tab and the SubDrawings 
tab.
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The Projects tab in the Explorer window
On the Projects tab you can get information about all open projects. You get a sur-
vey of the project pages, and a survey of all components on these pages. When you 
click on an Eye symbol for a project page, the page is displayed on the screen.

— The Explorer window is described in “The Explorer window: The Projects tab” 
on page 309.

The SubDrawings tab in the Explorer window
The SubDrawings tab is applied for handling e.g. placing, editing and displaying 
sub drawings. For instance you can drag sub drawings into the the active project 
page, or create new sub drawings based on copied areas from the active project.

— Read more about this in “Sub drawings” on page 266.

7. The left toolbar
The left toolbar contains various page and zoom functions, and — at the bottom — 
information about the page settings and status. These functions are elaborated in 
“Screen / Image Functions” on page 63.

8. The work area
The work area on the screen corresponds to the size of paper you have chosen to 
work on.

The size of the paper is specified in Settings => Page setup, as described in “Page 
setup” on page 823, or by inserting a drawing header, as described in “Insert draw-
ing headers/formulas” on page 525.

9. The survey window 
The survey window gives you a survey of the entire page. The part of the page that 
you are currently viewing on screen at the present (the zoom), is represented by the 
black box. — See “The Survey window” on page 67.

10. Page history buttons
By clicking on the Page history buttons, you can jump to the previously active 
pages in the project. — See “The Page history buttons” on page 488.

11. The status line
Among others you can see here coordinates, layer titles, guiding texts as well as 
various messages. When you let the mouse pointer rest over for instance a button 
on the screen, an explanatory text will appear here.

12. Current path numbers
Current path numbers are displayed in two different places: At the location you 
specify in your project, as well as on the lower part of the screen. When you zoom 
in on a part of a diagram, the current path numbers will still be displayed on the 
lower part of the screen. Thus you will always know where you are on the diagram.
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— See “Current path numbers / Reference System” on page 385.

13. Page tabs
Click on the page tabs to jump back and forth between the pages. — See “Direct 
access to menus and Tabs” on page 69 and “Choosing pages outside the Page 
menu” on page 487.

14. Scrollbars
Having zoomed in on an area, you can make the area move by dragging the scroll-
bars. — See “The Scroll button and Scrollbars” on page 64.

15. Chapter tabs
When you click on a chapter tab, you jump to the first page in the selected chapter. 
— See “Chapters” on page 499.
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SCREEN / IMAGE FUNCTIONS

This chapter has to do with the screen-related functions in the program. All buttons 
having this type of function, are located on the left hand side toolbar.

ZOOM, SCROLL, REDRAW

In PCschematic ELautomation you can specify which part of the page you wish to 
see on the screen.

Zoom
When you want magnify a part of 
the page, you can click on the 
Zoom button, and then select an 
area on the screen using the 
mouse. Do this:

1) Click and keep the mouse 
button pressed down.

2) Drag the mouse over the 
area you wish to enlarge, 
and let go of the mouse but-
ton.

THIS CHAPTER DESCRIBES

— THE FUNCTIONS ZOOM, SCROLL AND REDRAW................................................... (P. 63)

— HOME VIEW AND REDRAW................................................................................... (P. 65)

— SET USER HOME VIEW .......................................................................................... (P. 65)

— SHOW EXPANDED DRAWING AREA ....................................................................... (P. 66)

— THE EXPLORER WINDOW ..................................................................................... (P. 68)

— THE SURVEY WINDOW ......................................................................................... (P. 67)

— SNAP..................................................................................................................... (P. 68)

— GRID..................................................................................................................... (P. 68)

— THE CROSS HAIRS ................................................................................................ (P. 68)

— DIRECT ACCESS TO MENUS AND TABS................................................................. (P. 69)

— GENERAL PROTECTION ERROR ............................................................................. (P. 70)

ALL SHORT-CUT KEYS CAN BE CHANGED

PLEASE NOTE, THAT YOU CAN USE MANY SHORT-CUT KEYS IN THE PROGRAM. 
YOU CAN SEE THE PREDEFINED SHORT-CUT KEYS IN “SHORT-CUT KEYS” ON 
PAGE 766. THERE IT IS ALSO DESCRIBED HOW TO DEFINE YOUR OWN SHORT-
CUT KEYS.

1) Click here, and keep the mouse

2) Drag the mouse cursor across the
screen, and release the mouse button

button pressed down

when the desired area is selected
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When you release the mouse button, the chosen area is now enlarged.

View => Zoom or the short-cut key [z] has a similar effect.

On a three-button mouse, the button in the middle can also be used for zoom.

The Zoom All function
When you choose View => Zoom All, a zoom is made so that all objects in the 
work area is displayed — in the closest zoom possible.

If there only are a few objects placed next to each other, the program will zoom in 
on these objects.

If there, on the other hand, are placed objects outside the boundaries of the page, 
the program will zoom out, so that it becomes possible to select these objects.

The Zoom in/out button
When you click on the minus-part of the Zoom in/out button, you zoom out, which 
means you will see a larger area of the drawing. When you click on the plus-part of 
the button, you zoom in, which means a smaller area of your drawing will be 
enlarged on the screen.

To zoom in, you can also choose View => Zoom in (short-cut [Ctrl+Home]), and to 
zoom out you can choose View => Zoom out (short-cut [Ctrl+End]).

— See “Zoom and Scroll for mouse with a wheel” on page 64

The Scroll button and Scrollbars
The Scroll button makes the zoom move in the direction of 
the arrow (Which makes the objects within the zoom move 
in the opposite direction).

When you press down the <Ctrl> key, you can also apply 
the arrow keys to move the zoom — e.g. the short-cut key 
[Ctrl+RightArrow].

Having zoomed in on an area, you can also apply the scroll-
bars in the right side and the bottom of the screen. When 
you click on a scroll bar and drag it to another location, the 
displayed zoom is moved correspondingly.

The use of scrollbars can be activated/deactivated as described in “Pointer/Screen” 
on page 815.

Zoom and Scroll for mouse with a wheel
If you have a mouse with a wheel, the button in the middle — the wheel — can also 
be used for zooming. This gives the following options:

PRESS RESULTS IN

<WHEEL FORWARDS> THE ZOOM IS MOVED UPWARDS ON THE PAGE

<WHEEL BACKWARDS> THE ZOOM IS MOVED DOWNWARDS ON THE PAGE

ZOOM AND SCROLL ON MOUSE WITH A WHEEL

Scrollbar
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Keep page zoom
By choosing Settings => Pointer/Screen, you can decide whether to keep the 
zoom when changing back and forth between pages in the project. You specify the 
zoom settings by deselecting Keep zoom and Keep page zoom. Read more about 
this in “Pointer/Screen” on page 815.

View previous zoom
When you select View => Previous zoom, you jump back to the previously applied 
zoom on the active page. Because the program memorizes the two last applied 
zooms, you can jump back and forth between these by using this function.

As a short-cut for this function, you can use the <Tab> key, and you can also acti-
vate the function by pressing the <Ctrl> key while clicking the Zoom button.

All pages memorizes the two most recently applied zooms, until the project is 
closed. Please note that this enables you to use the <Tab> button to jump directly 
from full screen to the most recently applied zoom.

HOME VIEW AND REDRAW

When you click the Zoom to page button, the entire page will be shown on the 
screen area. Choosing View => Home view gives the same result.

The short-cut keys are [Home] or [z][z].

To refresh the image on screen, click on the Redraw button. Alternatively select 
View => Redraw; the short-cut key is [Ctrl+g].

This updates the image on the screen, as well as the survey window.

SET USER HOME VIEW

When you only want PCschematic ELautomation to display a specified section of 
the page when you click on the Home view button, do the following:

1) Choose View => Set User Home view.

2) The mouse cursor now changes appearance to a two-way arrow: Click to 
specify one corner of the new home view, and click once again to specify the 
opposite corner of the home view. (This is done similar to making a zoom — 
see “Zoom” on page 63).

<SHIFT+WHEEL FORWARDS> THE ZOOM IS MOVED TO THE LEFT

<SHIFT+WHEEL BACKWARDS> THE ZOOM IS MOVED TO THE RIGHT

<CTRL+WHEEL FORWARDS> ZOOMS IN WHERE THE CROSS HAIRS IS LOCATED

<CTRL+WHEEL BACKWARDS> ZOOMS OUT WHERE THE CROSS HAIRS IS LOCATED

PRESS RESULTS IN

ZOOM AND SCROLL ON MOUSE WITH A WHEEL
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The next time you click on the Home view button — or press [Home] — the speci-
fied area is displayed on the screen. This is the consequence for all project pages 
having the same page size, as the page you set the home view for — for instance A4 
horizontal.

If you wish to create other Home views for other page formats, this is also possible.

Short-cut to creating User Home view
1) Click on the Zoom button.

2) The mouse cursor changes appearance to a two-way arrow: Click to specify 
one corner of the new Home View, and press <Ctrl> down and click once 
again to specify the opposite corner of the Home view. (See “Zoom” on 
page 63).

Display the full page, and not just the User Home view
When you wish to see the full page, and not just the defined Home view, press [zz].

Remove Home View settings
When you want the Home view button to display the full page again, you choose 
View => Set User Home view again. You then get the following message:

Click Remove to make the Home view button display the full page again, or click 
New to create a new Home view.

EXPANDED DRAWING AREA

When you select View => Clean screen, the active project page will fill all of the 
program window. This makes the program toolbars and the Explorer window 
invisible.

You return to normal viewing by selecting View => Clean screen again.

The default short-cut key for the function is <Ctrl+0>.
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THE SURVEY WINDOW

The survey window is an independent 
window which can be docked inside the 
Explorer window, or be placed anywhere 
on the screen. — For further details about 
the location of the Survey window, 
please refer to “Docking Windows and 
Toolbars” on page 49.

Moving the displayed area
A black box within the window shows 
which section of the drawing (which 
zoom) is presently being displayed on the full screen. Click on the black box and 
drag it until it covers the part of the drawing you want to see on screen. When the 
mouse pointer is pointing on the black box, you will be noticed that you are now 
able to move the box.

Zooming in the Survey window
You can zoom in and out using the survey window. By placing the mouse pointer 
on the boundary of the black box, it will change into a two-way arrow. You can now 
resize the zoom by dragging the boundary.

Objects displayed in the Survey window
Objects (see “On Drawing objects” on page 75) located on the page, will also be 
displayed in the survey window. This gives you the option to keep the survey of the 
page while working in a zoom. You can select a new zoom using the placed objects 
as guides. Texts will not be displayed in the Survey window.

The survey window is updated when you click Redraw or display a new project 
page.

Placing the Survey window
You can move the survey window by clicking on the windows menu bar, keeping 
the mouse button pressed down, and then drag the window to a new preferred loca-
tion. The window can be enlarged or reduced by dragging its corners.

When you close down the program, the size and position of the window is memo-
rised.

The Survey window can be activated/deactivated by choosing View => Survey 
window. Short-cut key [F12].

Docking the Survey window in the Explorer window
See how to dock the Survey window inside the Explorer window in “Docking the 
Survey window” on page 50.
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THE EXPLORER WINDOW

In the left side of the screen you find the Explorer window. From here you can for 
instance choose what to display on the screen, change page data and project data, 
change symbol and cable component data, find symbols and close projects.

— Read more about this in “The Explorer window: The Projects tab” on page 309.

SNAP

When you place an object on a drawing, it is important that you can position it 
exactly where you want it. To support this, you can specify that objects only may be 
located in fixed spots, located at intervals of for instance 2.50mm. — If you then 
want to place a symbol, you will only be allowed to move it in steps of 2.50mm on 
the screen, which enables you to place the symbols accurately.

If the distance between the points where you can place the symbols is 2.50mm, you 
say that the snap is 2.50mm.

By clicking the Snap button in the left toolbar, you can toggle between normal snap 
(for instance 2.50mm) and fine snap (for instance 0.50mm).

If you are working in fine snap, the lower part of the left toolbar will display a red 
background under the size of the snap.

Choose Settings => Page settings to change the snap settings — or click on “2.5” 
in the lower part of the left toolbar.

If you have an object on the cross hairs that you want to place, you can place it 
using fine snap by pressing down <Shift>. After you place the object, the program 
automatically change back to normal snap.

Please note that 2.50mm is standard normal snap size for electro-technical draw-
ings.

GRID

The dots you see placed on the entire page in a drawing, is called the grid of the 
drawing. You can change the distance between the dots by choosing Settings => 
Page settings.

Choosing Settings => Pointer/Screen, you can disable the function completely, or 
choose to use squares instead of dots. See “Pointer/Screen” on page 815.

The size of the grid — in millimetres — only relates to what you see on screen, and 
not to the real size of the drawing. Thus changing the scale of the page from 1:1 to 
1:50, will not make the grid change on the screen.

THE CROSS HAIRS

While you are working on a project drawing, the location of the cursor is indicated 
by a crossing vertical and horizontal line. This is called the cross hairs.
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In Settings => Pointer/Screen you can see the 
cross hairs is set to be displayed right angled.

When you draw Straight lines (see “Straight 
lines” on page 94), a line will be displayed start-
ing from where you clicked last, pointing towards the cross hairs.

When you select Cross hairs displayed right angled, you will see the line that 
would be drawn if you clicked in this very moment. This line will not always be 
shown ending up in the cross hairs — due to the snap applied.

If the function is not selected, the line will always be shown from the place you 
clicked last and directly to the cross hairs. But this line is not necessarily the exact 
line that would be drawn if you clicked.

When Cross hairs figure with snap is selected, the figure (for instance a symbol) 
you have in the cross hairs will be shown in the nearest snap — exactly where it 
will be located when you click.

DIRECT ACCESS TO MENUS AND TABS

In the lower left-hand corner of the screen, you will se various information about 
fx. the snap settings and the title of the present layer. Clicking on these fields brings 
you directly into the menus, where these settings can be altered.

Snap
Grid
Page type
Page size

Scale
Page status

Coordinates Layer namePage tabs
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When you let the mouse cursor rest an instance over one of the fields, an 
explanatory text is displayed — as for Snap on the figure above.

Page status
In the field Page status the following status options exists:

S: The page has not been changed since last save.

S:+ The page has been changed since last save.

S:R+ The page has been changed since last revision start/stop, and has been 
changed since last save.

Page tabs
By clicking on the page tabs, you jump back and forth between the project 
pages. You can also use the short cut keys [PageUp] and [PageDown] to 
jump between the project pages.

Chapter tabs
When you click on a chapter tab in the right-hand side of the screen, the 
first page in the displayed chapter is displayed.

GENERAL PROTECTION ERROR

If a General protection error occur, the line at the bottom of the screen starts flash-
ing on a red background, giving a warning that the project should be saved under a 
new name, and that the program should be restarted.

Please follow the instructions before it is to late.

When you want to save the project, you automatically enter the dialog box Save as, 
to prevent that you save what might be a project containing errors, so that this 
project replace, the last saved version of the project.

However, if you do let this project replace the last saved version of the project, 
PCschematic ELautomation automatically creates a backup file (extension .~pr), 
so that the original version of the project also can be opened succeedingly.
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When you purchase an electro-techni-
cal documentation program as PCsche-
matic ELautomation, it should set you
free to concentrate on the technical as-
pects, so that you do not need to waste
time on the trivial parts of the electro-
technical documentation.
Before you get to this point, you natu-
rally - as a new user - need to become
familiar with a couple of things about
how the program functions. And this
can actually be done quite easily - if you
do not loose yourself in examining all
of the advanced functions in the pro-
gram.
To phrase it in a popular way, you can
say that there are 10 things you need to
know, in order to draw a wiring or power
control circuit diagram quickly and ef-
fectively in PCschematic ELautomation.

1. How to place symbols
The first thing you need to know - when
disregarding opening and saving
projects - is how to place symbols in a
diagram page in the program.
When you can place symbols, you are
already well on your way in creating the
documentation.
This is because the electrical symbols
are the core of an intelligent electro-tech-
nical documentation program.
From the very moment these symbols
are placed, they can have attached arti-
cle data from one of the 30 PCschematic
component vendor databases.
These article data can subsequently be
transferred to the lists, which the pro-
gram can update automatically, without
your typing in any component data.
When placing symbols, you can either
name them manually, or have them
named automatically by the program.

2. How to draw lines
Naturally, the placed symbols must be
connected by drawing some connect-
ing lines. You decide whether to start
by drawing these lines, or to start by
placing  the symbols - or place symbols

and draw lines in arbitrary order.
However, if you start by placing sym-
bols, you can apply the program func-
tion for automatic drawing of connect-
ing lines, the so-called router.
These lines can be drawn with different
line types, widths and colors - just like
you can draw circles and arcs.

3. How to place texts
Beyond the information attached to the
project symbols, you may need to place
other information/texts on the project
pages. This can either be the so-called
free texts, which you just type in directly
on the page, or the so-called datafields.
These datafields can be information,
which is attached to the individual

project page, or information attached to
the project. Hence you can e.g. display
customer name, constructor name or
page/project title.
Like for the symbol texts, the contents
of all these datafields can be transferred
directly to the automatically created lists
in the program.

4. How to transfer properties
between objects
The above mentioned symbols, lines,
circles/arcs and texts are with one word
called drawing objects.
When working in an electro-technical
documentation program, you will have
different options available, depending
on which type of drawing objects you

The 10 basic rules for drawing Wiring and
Power control circuit diagrams on PC

This article describes the 10 things you need to know in order to draw PLC/wiring/power
control circuit diagram pages quickly and effectively - in an advanced electro-technical

CAD-program as PCschematic ELautomation

When you become familiar with the 10 basic rules, you can quickly create the
necessary Wiring and Power control circuit diagrams in PCschematic ELauto-
mation



are working with.
To save time, it is therefore good to
know how to transfer properties be-
tween objects of the same type. If for
instance you have placed a five millime-
tre high blue text, you can therefore
make several other texts blue and five
millimetres high in a single operation.

5. The difference between
Placing objects and working
with Already Placed objects
You also need to know that there is a
difference between placing new objects,
and working with already placed ob-
jects.
Depending on whether you work with
already placed objects, or are placing
new objects, you will have different
options available.
In the program you specify whether to
do the one or the other by clicking a
button.

6. How to zoom
In the daily work, it is also practical to
know how to zoom in on parts of the
diagrams on the screen. This makes it
possible to see what you are working
with in greater detail.
Also, you should know how to zoom
out, to see a larger part of the page, or
to see the entire page.
Having zoomed in on a part of the page,
it is also practical to know how you can
scroll easily - this meaning how to
change which part of the diagram, that
you see on the screen.

7. How to position symbols
precisely
When placing objects, these are placed
with a specific accuracy - e.g. 2.5 mm. -
, which you can specify in the program.
For the sake of clarity - and the aes-
thetic appearance of the documentation
- you should also know how to make
the program align placed objects, or to
space the objects with a specified mu-
tual distance.

8. How to change texts/names
quickly
It is also for your benefit to know the
program functions for automatic count-
ing on texts, for multiple placed objects,
in a single operation. These texts could

for instance be symbol names, or termi-
nal names for symbols.

9. How to specify that an electri-
cal connection continues else-
where
Furthermore it is good to know how the
system supports you in specifying that
an electrical connection continues else-
where in the diagram - or on another
diagram page in the project. For doing
this, PCschematic ELautomation applies
the so-called signal symbols, which
automatically creates references to the
place(s) where the electrical connection
continues.

10. How to work with areas
When you wish to work more effec-
tively, you should know how to work
with areas. When you select a part of a
diagram, you can move or copy the se-
lected area, and place it elsewhere on
the page - or at another diagram page.
When copying areas, the program can
automatically rename the applied sym-
bols in the area when placing the copy.

More advanced options
All the points above can be learned
pretty quickly. But if you wish to be-
come an expert in working with symbols,
you can learn many different short-cuts
for finding and placing symbols. Thus
you can discover the workflow which
suits the different situations, and your
own preferences.
Beyond the mentioned points, there are
naturally a bunch of other options,
which it pays to become familiar with
along the way. These could for instance
be:

• How to insert sub drawings, e.g. with
attached article data, into diagram
pages

• How to jump between electrical sym-
bols for the same component

• How to change between reference
crosses and contact mirrors for dis-
playing the other symbols for a com-
ponent

• How to replace all occurrences for an
applied symbol automatically

• How to place wire numbers automati-
cally and/or manually

• How to edit all texts easily via the so-

called Object Lister
• How to set up current path numbers

on project pages
• How to apply automatic naming of

symbols according to current path
numbers

• How to apply page and project tem-
plates

• How  single line diagrams are sup-
ported

• How mounting correct drawing is sup-
ported

• How to keep the survey and control
the naming of PLCs

... and much more.

Learning the basic rules
In this context, however, the most im-
portant is that you get familiar with the
basic rules, and then get to know the
more advanced program facilities, when
you need to.
If you wish to get more to grips with the
program and learn faster workflows, it
can furthermore be recommended to take
a course in the program. The time spent
in such a course, will pay off quickly
via a faster daily workflow.

Further information
You may read more in the following arti-
cles:
• The 5 basic rules for working with elec-

tro-technical documentation projects
• The 5 basic rules for working with

Database and Lists in electro-techni-
cal documentation

• The 5 basic rules for working with
PLCs in electro-technical documen-
tation projects
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ON DRAWING OBJECTS

Any object you place on a drawing has got to be one of four different types of draw-
ing objects: It is either a symbol, a text, a line or a circle.

Also there is the Area-command, which makes it possible to work independently of 
object types.

In the Menu bar and the Program toolbar you have different options at hand, 
depending on which type of objects you have chosen to work with.

The buttons for command change
The buttons, you have to click on to select the various objects, look like this:

— Please see “Auto command change” on page 79 also.

THIS CHAPTER DESCRIBES

— THE BASIC WORKING MODES OF THE PROGRAM .................................................. (S. 76)

— SELECTING OBJECTS ............................................................................................. (S. 77)

— AUTO COMMAND CHANGE.................................................................................... (P. 79)

— HOW TO WORK WITH SELECTED OBJECTS ............................................................ (P. 79)

— SHOW OBJECT BELOW CURSOR............................................................................. (P. 81)

— THE UNDO FUNCTION........................................................................................... (P. 82)

— TRANSFERRING PROPERTIES BETWEEN OBJECTS.................................................. (P. 84)

— ALIGN, TRIM AND SPACE ..................................................................................... (P. 87)

— INVISIBLE OBJECTS ............................................................................................... (P. 90)

Symbols [s] Texts [t] Lines [l] Circles [c] Areas [a]

WHEN YOU CLICK ONE OF THESE BUTTONS YOUR OPTIONS CHANGE:
— THE PROGRAM TOOLBAR CHANGES

— THE OPTIONS IN THE PROGRAM MENUS CHANGES

— YOU ARE ONLY ALLOWED TO WORK WITH OBJECTS OF THE CHOSEN TYPE
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WORKING WITH THE PROGRAM

In PCschematic ELautomation there are two different modes to work in.

Which mode you work in is determined by the Draw button (the Pencil).

You either:

a) Draw/place new objects (activated/highlighted Pencil), or you work on

b) Already placed objects (not activated Pencil)

New objects
When you draw/place new objects, you do so like this:

1) Select the type of objects you wish to work with

2) Activate the Pencil

3) Draw / place the objects

Thus if you want to draw a line, you first click on the Lines button (1), then click on 
the Pencil (2), and draw the line (3).

Please note that in several occasions the program activates the Pencil by itself. For 
instance this happens when you have typed in a text in the text field, or when you 
have picked a symbol in order to place it.

Already placed objects
If you, on the other hand, have to work with objects that have already been placed, 
the procedure is like this:

1) Select the type of objects you wish to work with — see “Auto command 
change” on page 79 also

2) Deactivate the pencil (Press <Esc>)

3) Select the object(s) you want to deal with

4) State what you want to do with the objects

If for instance you want to copy a symbol, you first click the Symbols button (1) 
and deactivate the pencil pressing <Esc> (2). Then select the symbol by clicking on 
it (3), and specify that you wish to copy the symbol by clicking Copy (4).

The copied symbol can now be placed.

Displaying relative coordinates
When moving or copying objects, the object coordinates are displayed in the status 
line at the bottom of the screen.
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SELECTING OBJECTS

When you wish to do something with an existing object, you first have to select the 
object. This takes place in the following way:

Click on the button which corresponds to the type of the object — for instance the 
Texts or the Symbols button. Make sure that the Pencil button is not selected; click 
on it or use <Esc>. Click on the object you wish to select.

The selection will be indicated as a colored field surrounding each chosen object 
individually.

Below you can see how deselected as well as selected objects appear on screen:

When working with symbols, please note that a selection can include the entire 
symbol, or just one of its connection points.

If you select a text, the text toolbar (see “Dictionary” on page 850) will tell you 
which type of text you have chosen.

Remarks about selecting lines
A line is constructed of segments, depending on how many breaks it contains. First 
time you click on a line, all segments in the line will be selected. If you click at the 
line once more, only the segment you click on gets selected.

Electrical lines will be selected up to the next electrical point.

Selection by right-clicking
By right-clicking on an object (of the chosen object type), you will select the object 
and at the same time a short-cut menu will appear. In this menu you can e.g. choose 
Move, Copy or Delete. — Please refer to “Short-cut menus and Right-clicking” on 
page 38 for further details.

Selecting more objects of the same kind in one window
You can select more than one object of the same type at the same time. If for 
instance you want to select all texts in an area, click on the Texts button and select 
the desired area with the mouse. Do this by clicking in one corner of the area, and 
then, still pressing down the mouse button, drag the mouse to the opposite corner of 
the area. Thus a rectangle will be drawn with dashed lines, having one corner where 

Deselected Selected
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you first clicked and the opposite corner where the mouse pointer is located now. 
When all the desired objects are inside the rectangle, you let go of the mouse but-
ton. The texts in the area have now been selected.

If you wish to deselect one or more objects inside the window, press down the 
<Ctrl> key and click on the object(s). If you also wish to select objects outside the 
area, also press down the <Ctrl> key, and click on these objects.

Selecting more objects of the same kind using the mouse
Select the kind of objects you want to work with; for instance Symbols.

Press the <Ctrl> key while clicking on the desired objects. If you have selected a 
symbol you do not want after all, then click on the symbol again — still pressing 
the <Ctrl> key.

Selecting different types of objects in an area
Click on the Area button. Mark up a window as described in “Selecting more 
objects of the same kind in one window” on page 77. Hereby all object types inside 
the window are selected. If you wish to deselect one of the selected objects, press 
the <Ctrl> key and click on the object. If you also wish to select objects outside the 
area, also press down the <Ctrl> key, and click on these objects. — Read more 
about areas in “Areas” on page 254.

Selecting on different Layers and in different elevations
The ways of selecting objects described above, all assumes that you are working in 
the same layer as the objects you wish to select. — Read more about selecting and 
layers in “Selecting objects on different layers” on page 474, and read more about 
layers in general in “Layers, Elevation and Scaling” on page 471.

Selecting everything on a page
You can select everything on a page (including different layers) by selecting Edit 
=> Select all => All on page. Short-cut [Ctrl+a]. If the Area button is selected all 
objects on the page will be selected. If Symbols are selected, all symbols on the 
page will be selected — and so on.

1) Click here

2) Press down mouse button and drag

3) Place the cursor here and let go
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AUTO COMMAND CHANGE

If you want PCschematic ELautomation to change command for you automati-
cally, choose Functions => Auto command change.

When this function is activated, PCschematic ELautomation automatically 
changes between Symbols, Lines, Texts and Circles when you want to select, 
move or delete objects. The program automatically changes to the correct com-
mand when the object is selected.

The function can be deactivated by choosing Functions => Auto command 
change again.

The function can also be activated/deactivated by clicking the Auto command 
change button, placed to the left of the Lines button.

— Please see “Show object below cursor” on page 81 also.

WORKING WITH SELECTED OBJECTS

When you want to copy, move, delete or rotate objects, you have to:

1) Choose the type of objects you are interested in

2) Select the objects you want to deal with

3) Copy / move / delete / rotate the objects

Step one and two are dealt with in “Selecting objects” on page 77, and step three 
will be elaborated in the sections to follow.

To see how to place / draw new objects, you have to read the following sections:

“Lines” on page 93, “Arcs/Circles” on page 125, “Texts” on page 127 and “Sym-
bols” on page 158.

Where no further remarks are added, the following functions covers working with 
Symbols, Texts, Lines, Circles and Areas.

Moving selected objects
When you want to move selected objects, you have three options at hand:

a) Click the Move button. You thereby get the selected objects in the cross hairs, 
and just have to click where you want them placed.

b) Use click and draw: Click on the selected object(s), keep the mouse button 
pressed down, and drag them across the screen. Let go of the mouse button 
when you can see the objects where you want them located. Read more about 
drag and drop in “The mouse” on page 35.

c) Right-click inside the window. A menu emerge, and you choose Move. You 
get the selected object(s) in the cross hairs, and can move them across the 
screen. Click when the objects are where you want them located.
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Remarks about moving Symbols
When you have to move a symbol that is connected to lines, you can do this in two 
different ways:

a) The symbol remain connected to the lines: Click on the symbol, and drag it to 
the place you want it located.

b) The lines are parked and the symbol can be moved freely: Press down the 
<Ctrl> key while clicking on the symbol, and drag it to where you want it 
placed.

You can also move the symbol freely by clicking on the symbol, and then press 
down <Ctrl> while clicking Move.

Furthermore, if you place a two-poled symbol on top of a conducting line, the sym-
bol will automatically be connected to the line.

Copying selected objects
When you want to copy one or more selected objects, you have got two options:

a) Click the Copy button. You now get a copy of the selected object(s) in the 
cross hairs, and can place the objects as many times as you want by clicking.

b) Right-click on one of the selected objects. A menu emerge, and you choose 
Copy. You now likewise get a copy of the objects in the cross hairs, and can 
place the objects as many times as you want by clicking.

Deleting selected objects
If you want to delete one or more selected objects, you have also got two options:

a) Click the Delete button or press <Del>. Hereby the objects are removed form 
the screen.

b) Right-click on one of the selected objects. Choose Delete in the emerging 
menu. The objects are removed from the screen.

Please remember that you can undo your actions clicking the Undo button.

If parts of the deleted objects remain on screen, click the Redraw button to get the 
page refreshed.

Remarks when deleting a symbol
If you delete a symbol having conducting lines connected to it, the lines will be 
parked.

Rotating a selected object
This function works for Texts, Symbols and Arcs, but not for lines. The function 
also works for Areas, and lines within the selected area will also be rotated.
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All objects are rotated counter-clockwise.

There are four ways of rotating objects:

a) Press the [spacebar]. The object will be rotated 90 counter-clockwise.

b) Right-click on the object and choose Rotate.

c) Click on the Rotate button in the toolbar.

d) Click in the field V:, type in the rotation angle and press <Enter>. The angle 
can have an accuracy of 1/10 degree. You can also click the down-arrow in 
the field, select an angle, and press <Enter>.

Remarks about rotating symbols
A symbol connected to conducting lines in both ends, will rotate 180 degrees, and 
the connection to the lines will be exchanged. Press down <Ctrl> when you click 
Rotate if you want the symbol to rotate only 90 degrees, and the lines will keep 
their original connections to the connection points.

Rotating areas
You can also rotate an entire area in one operation. To this, you must first have the 
area in the cross hairs in connection with either moving or copying, as described in 
“Rotating areas” on page 263.

SHOW OBJECT BELOW CURSOR

The function View => Show object below cursor temporarily frames the objects 
below the cursor, as the cursor is moved across the project page.

For lines it is also specified where you would connect to the line, if you clicked on 
it at the given moment.

— Please see “Auto command change” on page 79 also.

For Symbols For Lines
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UNDO

An important function to know when working with objects, is the Undo function.

When you click the Undo button once (short-cut key [z]), you undo the last action 
the program has performed.

If you let the mouse cursor rest above the Undo button, the operation that you can 
undo, is displayed as a hint.

Undoing multiple actions/levels
When you click the down-button next to the Undo 
button, a list of the most recently performed actions 
are displayed. Here you can specify how many 
actions you wish to undo.

When for instance you click Connection data -X3:2 
in the figure to the right, all of the latest actions are 
undone, including when the connection data for
-X3:2 was changed.

See how many actions you undo
To begin with, the list only displays the five latest 
actions. When you place the cursor above the last 
point in the list, five more actions are displayed. 
This continues until you see all of the actions that 
can be undone.

The last point in the list also displays how many 
actions you have selected in the list at any moment.

Specifying the number of undo levels
Under Settings => System you can specify how many actions/levels it shall be pos-
sible to undo at your system. — See “Undo levels” on page 830.

Some functions can not be undone
Please note that there are functions which you can not undo, such as using the auto-
matic wire numbering or placing a drawing header on a page. In the first case you 
can save the project before assigning the wire numbers, and in the last case you 
have to take action yourself to remove the drawing header.

Place the cursor here, and
the next points in the list
are displayed

Click here, and the Undo
list is displayed
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TRANSFERRING DATA / PROPERTIES BETWEEN OBJECTS

You can transfer two types of information between objects of the same type in 
PCschematic ELautomation:

- Component Data, which contains information about the physical components 
attached to the objects, and

- Object properties, which only have to do with the appearance of the objects

Transferring Component Data for Symbols or Lines
It is only possible to transfer component data between symbols or lines.

Transfer component data for Symbols
When you transfer component data from one symbol to another, start by clicking 
the Symbols button, and deactivate the Pencil (Press <Esc>).

COPYING THE COMPONENT DATA

Right-click on the symbol you want to transfer component data from, and choose 
Component data. — Or click on the symbol and then click on the Object data 
button.

In the upper left hand corner of the Component data dialog box you 
click on Edit and then choose Copy. Leave the menu by pressing 
<Esc>.

TRANSFERRING COMPONENT DATA TO A SYMBOL

Right-click on the symbol you want to transfer the component data 
to, and choose Component data. In the Component data dialog box you choose 
Edit => Paste.

You have now transferred component data from one symbol to another.

Correct the symbol name if you want to, and click OK.

TRANSFERRING COMPONENT DATA TO MORE THAN ONE SYMBOL

If you want to transfer the copied component data to more than one symbol, you 
can for instance drag a window around the relevant symbols, as described in 
“Selecting more objects of the same kind in one window” on page 77.

Then right-click inside the selected area, and choose Component data. Insert the 
copied component data by choosing Edit => Paste.

Please note, that if for instance Type and Article data are dimmed when you enter 
the dialog box, this tells you that the selected symbols do not have identical con-
tents in these fields.

THIS CHAPTER DESCRIBES

— HOW TO TRANSFER COMPONENT DATA BETWEEN OBJECTS ................................(P. 83)

— HOW TO TRANSFER OBJECT PROPERTIES BETWEEN OBJECTS...............................(P. 84)

— TRANSFERRING OBJECT PROPERTIES TO MORE THAN ONE OBJECT .......................(P. 84)
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Transfer article data for Lines
If you want to transfer line article data from one line to another, the procedure is the 
same as described in “Transfer component data for Symbols” on page 83. The only 
difference is that you have to activate the Lines button instead of the Symbols but-
ton, and then choose Line article data.

Transferring Object properties between Objects
To all objects there are attached information about the attributes of the object, the 
so-called object properties. These attributes are for instance called line properties 
or text properties.

Below you can see which type of information you can transfer between the various 
types of objects:

Changing object properties on existing object
Select an object. In the toolbar (or in the dialog box Text properties for texts) you 
make the desired changes. Click on the Transfer properties button.

The changes have now been transferred to the chosen object.

Transfer object properties from one object to another
Select the object that carries the desired object properties, and click on the Copy 
properties button — or press down <Shift> while clicking on the object.

Select the object you want to transfer the properties to, and click on Transfer prop-
erties.

TRANSFER OBJECT PROPERTIES TO MORE THAN ONE OBJECT

It is possible to transfer object properties to several objects in a single operation. 
For instance you can give a number of texts the same height and/or color.

In this example you can se how this is done by placing the two texts Text1 and Text2 
— each carrying different text properties — and then give both texts the same 
height without changing the other attributes of the texts.

OBJECT PROPERTIES INFORMATION THAT CAN BE TRANSFERRED

LINE PROPERTIES THE TYPE, WIDTH, LINE DISTANCE AND COLOR, AS WELL AS WHETHER 
THE LINE IS A CONDUCTING LINE AND WHETHER IT IS A JUMPER LINK — 
SEE E.G. “LINES” ON PAGE 93. — BUT NOT THE COURSE OF THE LINE, OR 
IF IT IS DRAWN AS FOR INSTANCE A SLANTED OR CURVED LINE.
DURING THE CREATION OF A SYMBOL, FOLLOW CONNECTED IS ALSO 
TRANSFERRED. SEE “CREATING SYMBOLS” ON PAGE 670.

TEXT PROPERTIES ALL INFORMATION IN THE DIALOG BOX TEXT PROPERTIES (S. 145). 
THE TEXT ITSELF, AND THE ANGLE IT MIGHT BE ROTATED WITH, IS NOT 
TRANSFERRED.

CIRCLE/ARC PROPER-
TIES

ALL INFORMATION IN THE CIRCLES TOOLBAR (S. 125).

SYMBOL PROPERTIES ONLY THE SCALE OF THE SYMBOL.

WHICH OBJECT PROPERTIES ARE TRANSFERRED
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Place Text1
Click on Texts, click in the text 
field in the texts toolbar, type in 
Text1, and click on the Text prop-
erties button.

Set Height to 2.5, Width to 
AUTO, Alignment to left-down 
and Color to Black.

Click on OK and place the text 
somewhere on the page.

Place Text2
Then click in the text field in the 
texts toolbar once more, but type 
in Text2 this time. Click on Text 
properties, and set Height to 5.0, 
Width to AUTO, Alignment to 
centre-centre and Color to Red.

Click OK, and place the text on 
the page.

Transfer text properties
Select both of the texts, click on the 
Copy properties button and then 
on Text properties.

In the dialog box you now see 
which text properties the selected 
texts have in common — in this 
case both has the Width AUTO.

Now set Height to 8.0 and click 
OK.

As you can see, the texts now have 
the same height, but their other 
attributes have not been changed.
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Text1 is still black and aligned left-down, while Text2 still is aligned centre-centre 
and red.

You can use the same procedure for lines and circles.
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ALIGNING AND SPACING FUNCTIONS

In PCschematic ELautomation you also have some functions for trimming and 
spacing objects.

The Align function
As you will see, it is possible to align objects in PCschematic ELautomation.

In the following example symbols will be used, but you can do exactly the same 
using texts or circles.

These three symbols are to be aligned, at the same height as the symbol to the left:

Make sure that the Symbols button is activated, then click on the right most sym-
bol. Now press down <Ctrl> while clicking on the symbol in the middle. (Alterna-
tively, you could drag a window around the two symbols). These two symbols have 
now been selected:

Select Edit => Align, or right-click inside the window and choose Align.

A rubber band starting in the symbol in the middle and ending in the cross hairs is 
now displayed. (See the guiding text in the bottom right-hand corner of the screen).

THIS CHAPTER DESCRIBES

— THE ALIGN FUNCTION ..........................................................................................(P. 87)

— THE SPACE FUNCTION ..........................................................................................(P. 88)

http://www.dps.dk/english/Video/Product_videos.htm
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Click on the symbol to the left, and the two selected symbols are aligned with the 
symbol.

If the symbols had been closer to be arranged on a vertical line, they would have 
been placed on a vertical line instead.

Please note that the determining symbol may also be one of the selected symbols.

The Space function
There exists a similar function, placing symbols with fixed intervals. Unlike Align 
you relocate all the symbols when you use the Space command.

In the following example symbols are used once again, but texts or circles could be 
used as well.

Activate the Symbols 
button, and place some 
symbols as shown on 
the figure.

Then mark up a win-
dow surrounding the 
symbols, and choose 
Edit => Space — or 
right-click and choose 
Space.

Please note the guid-
ing text in the bottom 
right-hand corner of 
the screen.

A rubber band starting 
in the symbol in the 
middle and ending in 
the cross hairs is now 
displayed.

Click where you want the 
first of the symbols to be 
located.

A dialog box appear on 
screen, and you fill it out as 
shown.

Click OK.



PCschematic ELautomation 10.0 PAGE 89

ON DRAWING OBJECTS

The symbols are now 
placed aligned, with an 
interval of 20mm 
between them, sorted 
by name.

If you set the interval to 
be zero for X and Y, you 
will be asked to point out where the first and last symbols have to be located.

When there is not enough space to place the symbols, you will be asked to point out 
a new starting point, from where the remaining symbols can be placed.

Sort by name
When you select Sort by name — only possible for symbols — the symbols are 
placed sorted by their names. If you have marked up the window around the sym-
bols from left to right, the symbols will correspondingly be placed from left to 
right.

The first sorting criterion is the symbol name, then the Component Group number. 
If these are still identical, the are sorted according to the first connection name. — 
Read more about component grouping in “Component Grouping” on page 549.
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MAKING OBJECTS INVISIBLE

All drawing objects — Symbols, Lines, Texts and Circles/Arcs — can be made 
invisible. This means that the objects will not be displayed on print, but will be dis-
played as dimmed, when the project pages are displayed on the screen.

Making symbols invisible
You can make symbols invisible like this:

a) Via the Component data dialog box: Click on the Symbols button, double-
click on the symbol, which opens the dialog box Component data, where 
you remove the check mark in front of Visible, and click OK.
Or:

b) By right-clicking: Click on the Symbols button, right-click on the symbol, 
and choose Invisible.

If you right-click after having selected an area in which both visible and invisible 
symbols exists, you will both be able to choose Visible and Invisible. You can then 
choose whether all symbols in the area shall be visible or invisible:

For symbols with reference crosses, the reference crosses also becomes invisible.

— Please read “Visible” on page 181 also.

THIS CHAPTER DESCRIBES

— MAKING SYMBOLS INVISIBLE............................................................................... (P. 90)

— MAKING LINES INVISIBLE..................................................................................... (P. 91)

— MAKING TEXTS INVISIBLE ....................................................................................(P. 91)

— MAKING CIRCLES/ARCS INVISIBLE ......................................................................(P. 92)

— MAKING AREAS INVISIBLE...................................................................................(P. 92)

— SUB DRAWINGS AND INVISIBLE OBJECTS.............................................................. (P. 92)



PCschematic ELautomation 10.0 PAGE 91

ON DRAWING OBJECTS

Making lines invisible
Choose Lines, select an area 
containing the lines you wish to 
make invisible.

Then do the following:

a) Via the dialog box Line 
article data: Right-click 
and choose Line article 
data.
In the dialog box Line 
article data: Remove the 
Visible check mark, and click OK.
Or:

b) Directly from the right-click menu: Right-click in the area, and click on Invis-
ible.

The lines are made visible again by right-clicking and then choosing Visible, or by 
entering the Line article data dialog box, and setting a check mark in front of Visi-
ble.

Making texts invisible
You can make texts invisible like this:

a) Via the Text properties dialog box: Click the Texts button, click on the text, 
click on the Text properties button, remove the check mark in front of Visi-
ble text, and click OK. — See “Visible text” on page 147.
Or:

b) By right-clicking: Click the Texts button, right-click on the text and choose 
Invisible.

Invisible texts are not displayed on screen, and can be selected by pressing the 
<Alt> button while clicking where the text would have been, if it was visible.

To make the text visible again, you must then click on the Text properties button, 
select Visible text, and click OK.

Right-click and choose
Line article data
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Making circles/arcs invisible
Choose Circles, right-click on the circle reference 
point, and choose Invisible.

To make the text visible again, right-click on the cir-
cle reference point again, and choose Visible.

Making areas invisible
1) Click on the Area button and select the area — 

see “Areas” on page 254.

2) Right-click in the area and choose Invisible.

If you right-click after having selected an area in 
which both visible and invisible objects exists, you will both be able to choose Vis-
ible and Invisible. Hereby you choose whether to make all objects in the area either 
visible or invisible. — See the image below “Making symbols invisible” on 
page 90.

Sub drawings and Invisible objects
When inserting sub drawings, the functions described above makes it easy to subse-
quently make parts of the sub drawings invisible.

— See “Sub drawings” on page 266.
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When you work with lines, you always start by clicking the Lines button — or by 
using the short-cut key [l]. — See “Auto command change” on page 79 also. If you 
want to draw lines, you then click the Pencil, or right-click on the drawing area and 
choose Draw Line.

The general short-cut key for the Pencil is the [Ins] key, but you can also use the [l] 
key when you are working with Lines. Pressing the [Ins] or the [l] key activates/
deactivates the Pencil.

— See how to move, copy and delete lines in “Working with selected objects” on 
page 79, and see how to transfer data between lines in “Transferring Data / Proper-
ties between Objects” on page 83.

THIS CHAPTER DESCRIBES

— THE TWO TYPES OF LINES IN PCschematic ELautomation .......................(P. 94)

— THE FUNCTIONS IN THE LINES TOOLBAR..............................................................(P. 94)

— DISCONNECTING DRAWN LINES ............................................................................(P. 98)

— LINES IN THE PICKMENU ......................................................................................(P. 99)

— CONDUCTING (ELECTRICAL) LINES.......................................................................(P. 99)

— ARTICLE DATA ON LINES ....................................................................................(P. 100)

— AUTOMATIC INSERTION OF ELECTRICAL POTENTIALS ........................................(P. 102)

— JUMPER LINKS.....................................................................................................(P. 107)

— AUTOMATIC LINE DRAWING / ROUTER...............................................................(P. 109)

— EXTENDED LINES ................................................................................................ (P. 110)

— FOLLOW CONNECTED LINES ............................................................................... (P. 111)

— THE TRIM LINE FUNCTION .................................................................................. (P. 112)

— DRAWING BY MEASURES .................................................................................... (P. 113)

— MEASUREMENT OBJECTS .................................................................................... (P. 115)

— MOUNTING CORRECT DRAWING .........................................................................(P. 120)

AUTOMATIC LINE DRAWING

YOU CAN ALSO USE THE AUTOMATIC LINE DRAWING FUNCTION (ROUTER) IN 
PCschematic ELautomation. THIS FUNCTION CAN BE ACTIVATED WHEN 
YOU ARE WORKING WITH LINES AND SYMBOLS.
— SEE “AUTOMATIC LINE DRAWING / ROUTER” ON PAGE 109.

AUTOMATIC INSERTION OF ELECTRICAL POTENTIALS

PCschematic ELautomation CAN INSERT ELECTRICAL POTENTIALS AT THE 
UPPER AND LOWER PART OF DIAGRAM PAGES AUTOMATICALLY. — SEE 
“AUTOMATIC INSERTION OF ELECTRICAL POTENTIALS” ON PAGE 102.
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THE TWO TYPES OF LINES IN PCschematic ELautomation

You can draw two different types of lines in PCschematic ELautomation:

a) Conducting (electrical) lines

b) Non conducting / free lines

If Conducting lines is active, the line can only be used as an electric connection.

If not active, the line will be a general purpose (non conducting) line that can be 
used anywhere within the project.

When you click the Lines button, Conducting lines will be activated automatically.

Conducting lines are described in further detail in “Conducting (electrical) lines” 
on page 99.

THE LINES TOOLBAR

The toolbar for lines looks like this:

In the following you can see the functions of the buttons in the toolbar. — Please 
note that you can also place lines in the pickmenu, as described in “Lines in the 
Pickmenu” on page 99.

Straight lines
When you are drawing Straight lines, the lines are automatically drawn either 
right-angled or diagonally, then see “Pointer/Screen” on page 815).

Deactivate the Conducting lines button (click on the left-
most button if it is highlighted), and activate the Straight 
lines button. Click where you want your line to start.

Then click once for each time you want your line to change 
direction, and double click to stop drawing the line — or 
click once and press <Esc> to stop drawing.

If the Pencil is deactivated (press <Esc>), you can change the course of the line by 
clicking and dragging in its terminal points, or where the line breaks.

When you try to move a line by dragging the line from a connection point, an extra 
line point is inserted on the line.

JUMPER LINKS

IT IS ALSO POSSIBLE TO DRAW JUMPER LINKS, AS DESCRIBED IN “JUMPER 
LINKS” ON PAGE 107.
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If you want to insert an extra line point, you can right-click on the line, and choose 
Insert Line Point.

Slanted lines
When you draw Slanted lines, you determine the angles of the lines yourself.

Click the Slanted lines button, and draw a line like the 
one you see here.

The line will become as you draw it, depending on the 
snap you are working in. — Read more about snap in 
“Snap” on page 68.

If the Pencil is deactivated (press <Esc>), you can change 
the course of the line by clicking and dragging in its terminal points, or where it 
changes its direction.

Breaks on the line is indicated as for straight lines.

Angled lines
Drawing Angled lines you only 
have to point out where the line 
starts and ends. The program then 
creates an angled line automatically. 
To let the line bend in the opposite 
direction, press the [spacebar].

These are applied automatically in 
connection with mounting correct 
drawing. Please refer to “Mounting 
correct drawing” on page 120 for 
further details.

Curved lines
Click the Curved lines button.

Using this command enables you to draw curves. Click where you want the turn-
ings of the curve. Note the marks (+) that appear on the curve when you finish 
drawing it.

If the Pencil is deactivated (press <Esc>), you can change the 
curve by clicking and dragging in its marks (+).

Curved lines can only be drawn using solid lines.

Click here

... and here
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Round lines
Click the Round lines button.

This command enables you to create coherent round lines. 
These can be used for corrections or for “comics bobbles.”

Round lines are half circles, drawn counter-clockwise. Round 
lines can only be drawn using solid lines.

As for curved lines, you can change the round lines by click-
ing and dragging in the marks (+).

Rectangles
Click the Rectangle button.

Thus you draw a rectangle: Click where you want one of the corners to be located, 
drag the mouse, and when the rectangle is as desired, click again. You have now 
drawn a rectangle.

Filled areas
If you activate the Filled areas button before you start drawing, you can fill out 
colored areas in rectangles, circles and ovals as you draw lines. If Filled areas can 
not be selected, the button will be dimmed.

Line type: T
Click in the field specifying line types and select the type you wish to use for draw-
ing.

— Please note that the lower of the line types to the left is yellow/green, for PE 
connections.

These line types can not be
used as conducting lines

These line types can be used
as conducting lines
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Line width: B
Here you determine the width of the pen used to draw the line. 
If the line type is hatched or similar, the line width is the 
width of the two borders of the line. (See the figure).

Line distance: A
For line types that are drawn with two full drawn lines (as a 
hatched line), you must specify the distance between these 
two lines. This is called the line distance, and it is measured 
from the centre of the one line to the centre of the other (See 
the figure).

Line color: F
When determining the color of the line, you can choose four-
teen different colors. The color NP (Non Printable) will be 
shown on the screen, but will not be printed.

Extend line
See how to use the Extend line button in “Extended lines” on page 110.

Conducting lines
See how to use the Conducting lines button in “The two types of lines in PCsche-
matic ELautomation” on page 94.

Jumper links
See how to work with Jumper links in “Jumper links” on page 107.

Follow connected
When you are working in the Edit symbol mode, the button Follow connected also 
appears in the toolbar for Lines. Read more about this in “Follow connected lines” 
on page 111.

Insert potential
See how to use the Insert potential button for automatic insertion of electrical 
potentials in “Automatic insertion of electrical potentials” on page 102.

Line distance

Line width
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DISCONNECTING DRAWN LINES

You can disconnect a drawn line, and subsequently connect the end point of the line 
elsewhere in the diagram page. This can be done:

- For lines connected to symbols

- For lines connected to other lines

To move the end point for a drawn line, do this:

1) Press the <Ctrl> key while clicking on the line close to the end point. (Do not 
click directly on the end point, because this makes it unclear which of the 
lines meeting in the point, that you wish move).

2) Drag the end point to its new position.

3) Release the mouse button. The end point of the line is now moved.

1 2 3
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LINES IN THE PICKMENU

To get quick access to drawing lines with predefined properties, you can place lines 
with the desired properties in the pickmenu at the upper part of the screen.

When you click on one of the lines in the pickmenu, the program automatically 
changes to working with Lines and the Pencil button is activated. You can then 
draw lines with the selected properties. — Read more about line properties in 
“Transferring Data / Properties between Objects” on page 83.

To insert a line type in the pickmenu, right-click on an empty cell in the pickmenu, 
and select Place Line. The currently applied line type is hereby inserted in the 
selected cell in the pickmenu.

If the pickmenu is not displayed on the screen, you can activate the pickmenu by 
selecting Settings => Pointer/Screen and click on Pickmenu.

The pickmenu can also contain symbols, texts and arcs. — Read more about the 
pickmenu in “Fetching symbols from the Pickmenu” on page 161 and “Adapting 
the Pickmenu” on page 196.

CONDUCTING (ELECTRICAL) LINES

A conducting line is an electrical line. It can start and end in electrical points only. 
An electrical point can be another conducting line, a connection point on a symbol 
or a signal.

To specify that a line has to be conducting, you must activate the Conducting lines 
button.

If you try to start or end a con-
ducting line without specifying 
a electrical connection, you 
will be asked about a signal 
name or whether the line 
should be parked.

A signal symbol with a signal 
name signifies an electrical 
connection.

This means that all electrical 
points with identical signal 
names, are the same electrical 
potential.

— Read more about signal 
symbols in “Signal symbols” 

Symbols/drawing objects displayed in all pickmenus

Select different menus
in the pickmenu

Click on a line, and
place it in the diagram
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on page 218, and about reference designations on signal symbols in “Variant names 
on signal symbols” on page 224.

Parking
If you want to wait to decide what the conducting line is to be connected to, you 
choose Parking. Thus the line gets no electrical connection. However, this is just a 
temporary solution, and there should never be parked lines in a completed project.

Warning when connecting non conducting lines to symbols
If you connect a non conducting line with a symbol, you will be warned about this. 
You will be allowed to do so if you insist, but the program draws no connection dot.

Show conducting
At any time you can choose Functions => Show conducting to see which lines are 
conducting. Conducting lines turn green, and non conducting lines turn red. To dis-
able this function choose Functions => Show conducting once more.

Transferring data for conducting lines
Please note that non conducting lines can become electrical by using the transfer 
data function.

— Read more about this in “Transferring Data / Properties between Objects” on 
page 83.

ARTICLE DATA ON LINES

When you wish to place article data on a line, deselect the Pencil and double-click 
on the line — or right-click on the line, and select Line article data. You then enter 
the dialog box Line article data:

Here you can for instance click on Database, to fetch article data from the database 
— see “Using the database” on page 559, in particular “Using the database for 
Lines” on page 559.

— Please note that you can also attach article data to cable symbols, as described in 
“Working with cable symbols” on page 231.

Specify if the
line is visible
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Visible Line article data
When you select Visible for one of the article data fields, the contents of this field is 
displayed on the diagram, as illustrated for the Type field in the figure below.

When article data for a line is set to be visible, these are placed above the midle of 
the longest segment on the line. If this segment later disappears — e.g. by deletion 
or because a symbol is placed —, the text is made invisible.

You can move these article data texts, as you can move any other text in the pro-
gram.

If you select Replace line texts, the texts are placed where the program would place 
these.

Pop-up information with Line article data
If Settings => Pointer/Screen => Show popup information is selected, article 
data for lines are displayed when the cursor is placed over lines — when the Pencil 
is not activated.

Datafields for Line article data
In all electrical lists — this meaning terminal, cable, connection and PLC lists — 
you can insert datafields with Line-name, Line-type, Line-article no. and Line-
function. — See “Datafields” on page 834.
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AUTOMATIC INSERTION OF ELECTRICAL POTENTIALS

Inserting electrical potentials automatically
When you wish to let PCschematic ELautomation insert electrical potentials auto-
matically, click the Insert Potential button, or choose Functions => Insert Poten-
tial.

You then enter the dialog box Insert potential, where you specify which electrical 
potentials to insert:

From this dialog box you can place one or more electrical potentials, either on the 
upper or the lower part of the page — or both at the same time:

THIS CHAPTER DESCRIBES

— INSERTING ELECTRICAL POTENTIALS AUTOMATICALLY.....................................(P. 102)

— PLACING ELECTRICAL POTENTIALS ON THE UPPER PART OF THE PAGE..............(P. 103)

— PLACING ELECTRICAL POTENTIALS ON THE LOWER PART OF THE PAGE ............(P. 103)

— POSITION FOR THE ELECTRICAL POTENTIALS .....................................................(P. 104)

— REFERENCE TEXTS FOR AUTOMATICALLY PLACED ELECTRICAL POTENTIALS ...(P. 104)

— REFERENCE DESIGNATIONS FOR AUT. PLACED ELECTRICAL POTENTIALS .......... (P. 104)

— SETTINGS FOR AUTOMATICALLY PLACED ELECTRICAL POTENTIALS..................(P. 104)

— INSERTING SIGNAL NAMES IN THE SIGNAL NAME LIST ...................................... (P. 106)
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Inserting electrical potentials on the upper part of the page
In the Number field in the dialog 
box, you specify the number of 
potentials you wish to place at the 
upper part of the page.

Subsequently, you can specify 
which signal names to insert.

You have two options:

a) All signal names are fetched 
from the Signal name list: 
Select a signal name below 
Signal name, and click on 
Follow list from selected. 
The names for the selected 
Number of potentials, are 
selected from the Signal 
name list, starting from the 
selected signal name. If Number is set to 4, and you have clicked on L1 — as 
in the figure above — the potential names L1, L2, L3 and N are inserted.

b) The signal names are incremented starting with the selected Signal name: 
Choose a signal name under Signal name, and click on Count up from 
selected. The name on the first signal name is then selected from the Signal 
name list, and the subsequent names are incremented by one, as they are 
placed.
If Number is set to 4, and you have clicked on L1, the electrical potentials L1, 
L2, L3 and L4 are inserted.

To only place electrical potentials on the upper part of the page, click the Upper 
button in the right-hand side of the dialog box.

— Please also refer to “Specify Level for the electrical potentials” on page 104, 
“Reference text for automatically placed electrical potentials” on page 104, “Refer-
ence designations for automatically placed electrical potentials” on page 104, “Set-
tings for automatically placed electrical potentials” on page 104 and “Signal names 
on the Signal name list - for automatically inserted electrical potentials” on 
page 106.

Inserting electrical potentials on the lower part of the page
In the Number field below Lower potential in the dialog box, you specify the 
number of potentials you wish to place on the lower part of the page.

You can then specify which signal names you wish to apply, following the same 
principles as described in "Inserting electrical potentials on the upper part of the 
page" på side 103.

To only insert potentials on the lower part of the page, click the Lower button in the 
right-hand side of the dialog box.

Because Number is set to 4
these four signal names are

The signal names that
will be inserted

inserted from the list



PAGE 104 PCschematic ELautomation 10.0

LINES

If you wish to insert potentials on the upper and the lower part of the page in the 
same operation, click the Both button.

— See also “Specify Level for the electrical potentials” on page 104, “Reference 
text for automatically placed electrical potentials” on page 104, “Reference desig-
nations for automatically placed electrical potentials” on page 104, “Settings for 
automatically placed electrical potentials” on page 104 and “Signal names on the 
Signal name list - for automatically inserted electrical potentials” on page 106.

Specify Level for the electrical potentials
If it says 1 in the Level field, the first electrical potential is placed where the func-
tion is set up to place the first electrical potential.

If it e.g. says 3 in the Level field, the potentials are placed starting from where the 
function would have placed the third potential.

— See “Settings for automatically placed electrical potentials” on page 104.

Reference text for automatically placed electrical potentials
To use references for the inserted electrical potentials, select With reference, and 
type in a reference pretext in the Reference text field — if desired.

Reference designations for automatically placed electrical potentials
If you wish to attach reference designations to the automatically inserted electrical 
potentials, click on Select below Reference designations, and choose a reference 
designation as described in “Choosing reference designations when placing sym-
bols” on page 354.

If you want to display the full reference designation for the potentials, select Show 
full Reference designation, as described in “Show full Reference designation” on 
page 355.

Settings for automatically placed electrical potentials
The placing positions for the automatically placed electrical potentials can be set up 
individually for each individual page size.

This can be done by choosing Functions => Insert Potential, and then click on 
Setup. You then enter the dialog box Insert potential - Setup:

THE SELECTED LINE TYPE IS USED

WHEN INSERTING ELECTRICAL POTENTIALS AUTOMATICALLY, THE LINE TYPE 
YOU HAVE SELECTED BEFORE CHOOSING FUNCTIONS => INSERT POTENTIAL 
IS USED FOR DRAWING THE POTENTIALS.
— SEE “LINE TYPE: T” ON PAGE 96.
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Here you choose — at the top — which page size you wish to edit the settings for, 
make the changes, click on Apply, and then click OK.

Symbols inward
If you want to place the text for the signal symbols above the electrical potentials, 
click on Symbols inward.

Choosing signal symbols
To select which signal symbol to apply, click the SGSIGNAL button, and you enter 
the Symbol menu, where you select the symbol.

Individual setup of signal symbols
If you wish to use an individual setup for the applied signal symbols, click on Indi-
vidual setup of signal symbols.

Select page size for the settings

Y-position for the
upper potential

Y-position for the
lower potential

Distance between
potentials

X-position for right and left
side side of potentials

Click here to apply the
settings
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The dialog box then changes appearance, and you get the option to make an indi-
vidual Symbol inward setup, and to choose signal symbol for all four possible posi-
tions for the signal symbols:

Signal names on the Signal name list - for automatically inserted electrical potentials
To specify which potential names that 
appears in the Signal name list — see 
“Inserting electrical potentials on the 
upper part of the page” on page 103 —, 
you must choose Functions => Insert 
potential, click on Setup, and here click 
on the tab Signals.

Here the columns Upper signal names 
and Lower signal names appears, for 
specifying the signal names in the Signal 
name list for the upper and lower electri-
cal potentials respectively.

Edit the lists as described below, and then 
click Apply.

ADDING A SIGNAL NAME

Click on the Plus button, and type in a new signal name.

REMOVING A SIGNAL NAME

Click on the signal name in the list, and click the Minus button.

MOVING A SIGNAL NAME IN THE LIST

Click on the signal name in the list, and click the Up / Down arrows, until the name 
has the desired position in the list.

Click here for an individual setup for the applied signal symbols
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JUMPER LINKS

On drawing Jumper links
In PCschematic ELautomation it is possible to work with jumper links. Succeed-
ingly, these jumper links can be included in terminal lists and terminal plans auto-
matically. Jumper links are not assigned wire numbers during automatic wire 
numbering.

Drawing jumper links
To draw jumper links, do the following:

1) Click on the Lines button, and click on the Pencil.

2) Click on the Jumper links button, and draw the jumper links.

Jumper links can be drawn from all types of connection points. Jumper links can 
not start on the middle of another line, or on the middle of another jumper link.

When you start and end drawing a jumper link, a short message is displayed, 
informing you that you are drawing a jumper link.

THIS CHAPTER DESCRIBES

— ON DRAWING JUMPER LINKS ..............................................................................(P. 107)

— DRAWING JUMPER LINKS....................................................................................(P. 107)

— JUMPER LINKS IN LISTS AND TERMINAL PLANS..................................................(P. 108)
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Changing jumper links to electrical lines - or the reverse
You can change a jumper link to an electrical line — or change an electrical line to 
a jumper link — by transferring line properties, as described in “Transferring 
Object properties between Objects” on page 84.

Show jumper links
When you choose Functions => View Jumper Links, all jumper links are dis-
played as green lines on the screen, while everything else are displayed in red. To 
disable the function, choose Functions => View Jumper Links once again.

Jumper links in Lists and Terminal plans
Under Functions => Datafield, you will 
now find the datafield Terminals list => 
Jumper link.

This datafield is displayed graphically in 
terminals lists. The result of placing this 
datafield can be seen in the list to the right.

When the datafield is placed on the left-
hand side of the terminals, you must make 
it right-adjusted, so that it expands to the 
left.

When the datafield is placed on the right-
hand side of the terminals, you must corre-
spondingly make it left-adjusted, so that it 
expands to the right.

Jumper links in terminal plans
Jumper links can also be included in terminal plans. Here a special terminal symbol 
for displaying jumper links have been designed.

Read more about this in the PCschematic Tools manual.

THE LINE SETTINGS ARE MEMORIZED

THE PROGRAM AUTOMATICALLY USE THE LINE SETTINGS, WHICH YOU USED 
THE LAST TIME YOU WERE DRAWING JUMPER LINKS.
WHEN YOU FINISH DRAWING JUMPER LINKS, THE PROGRAM AUTOMATICALLY 
CHANGE BACK TO THE LINE SETTINGS, WHICH YOU USED BEFORE DRAWING 
JUMPER LINKS.
— READ MORE ABOUT LINE SETTINGS IN “THE LINES TOOLBAR” ON PAGE 94.

Place right-
adjusted data
fields here

Place left-
adjusted data
fields here
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AUTOMATIC LINE DRAWING / ROUTER

When you place symbols in a project, you can make 
PCschematic ELautomation draw the symbol connections 
automatically.

When drawing lines, you can also let the program do a part 
of the job for you.

Automatic line drawing when placing symbols
To use the router when placing Symbols, you first choose 
Router => Active, to set a check mark in front of Active.

To deactivate the router, choose Router => Active again, so 
that the check mark disappears.

You will find the following options in the Router menu:

— See a practical example on using the router when placing symbols in the 
PCschematic tutorial manual.

SHORT-CUT KEYS FOR OPTIMAL USE OF THE ROUTER

TO MAKE THE ROUTER FUNCTION THE BEST, YOU MUST CREATE SHORT-CUTS 
KEYS FOR THE ROUTER FUNCTIONS YOU USE THE MOST.
SEE “USER DEFINED SHORT-CUT KEYS” ON PAGE 768.

ROUTER => FUNCTION

ACTIVE [½] STARTS AND STOPS THE ROUTER

ONLY NOT CONNECTED 
SYMBOLS BY MOVE

THE ROUTER IS ACTIVATED WHEN A SYMBOL IS MOVED, IF THE 
SYMBOL IS NOT CONNECTED.

ONLY IF ALL IN DIRECTION 
POSSIBLE

THERE WILL ONLY BE ROUTED WHEN ALL CONNECTIONS IN THE 
CHOSEN DIRECTION CAN BE ROUTED.

ONLY TO NEAREST DIREC-
TION [2]

THERE WILL ONLY BE ROUTED FROM THE SIDE OF THE SYMBOL, 
WHICH I CLOSEST TO A LINE OR OTHER CONNECTION POINTS.

HORIZONTAL THERE WILL ONLY BE ROUTED HORIZONTALLY.

LEFT THERE WILL ONLY BE ROUTED TO THE LEFT.

RIGHT THERE WILL ONLY BE ROUTED TO THE RIGHT.

VERTICAL THERE WILL ONLY BE ROUTED VERTICALLY.

UP THERE WILL ONLY BE ROUTED UPWARDS.

DOWN THERE WILL ONLY BE ROUTED DOWNWARDS.

REVERSE ORDER [3] CHANGES THE ROUTING ORDER, WHEN ROUTING TO MORE THAN 
ONE LINE.

SKIP OVER LINE [<] THE ROUTER SKIPS A LINE AND ROUTES TO THE NEXT LINE.

ROUTE [1] IF AN ALREADY PLACED SYMBOL IS SELECTED, THE SYMBOL CAN 
BE ROUTED.

OPTIONS WHEN ROUTING SYMBOLS
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The router for lines
To apply the router for drawing Lines 
choose Router => Active, to set a 
check mark in front of Active.

To disable the router choose Router 
=> Active again, and the check mark 
disappears.

— See a practical example on using 
the router for lines in the PCsche-
matic tutorial manual.

You have the following options in the 
Router menu for lines

Pressing the spacebar changes the direction of the router.

 EXTENDED LINES

On all types of lines, you can determine that they shall be 
extended. Select the Extend line button on the toolbar. 
The line will now start half a line width before its starting 
point, and end half a line width after its ending point.

The lower example on the figure is drawn using Extend 
line.

When you draw continuously without stopping when the 
line breaks, extend lines will be chosen automatically.

The upper example is drawn as two independent lines, 
without selecting Extend line.

ROUTER => FUNCTION

ACTIVE [½] STARTS AND STOPS THE ROUTER.

ANGLED [CTRL-SPACEBAR] CHANGES BETWEEN STRAIGHT AND ANGLED LINES

HORIZONTAL LINES ROUTES ONLY HORIZONTAL LINES.

VERTICAL LINES ROUTES ONLY VERTICAL LINES.

UP/LEFT ROUTES UP/LEFT WHEN WORKING WITH ANGLED LINES.

DOWN/LEFT ROUTES DOWN/LEFT WHEN WORKING WITH ANGLED LINES.

DOWN/RIGHT ROUTES DOWN/RIGHT WHEN WORKING WITH ANGLED LINES.

UP/RIGHT ROUTES UP/RIGHT WHEN WORKING WITH ANGLED LINES.

SKIP OVER LINE [<] THE ROUTER SKIPS A LINE AND ROUTES TO THE NEXT LINE.

OPTIONS WHEN ROUTING LINES

1) Place the cursor here
2) Press the [<] button until the

desired line is selected
3) Click to draw the connection
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FOLLOW CONNECTED LINES

This button exists in Edit symbol only. If the symbol is designed using Follow con-
nected lines, the lines in the symbol will automatically get the same width and color 
as the conducting lines that are connected to the symbol in the project.

In the symbol to the left all lines are drawn using Follow connected. Therefore all 
lines in the symbol gets the same width and color as the conducting line, that can be 
seen between the connection points of the two symbols. The other symbol is 
designed without Follow conducting.

A symbol designed using Follow connected, adapt to the last line that was con-
nected to the symbol.

Follow connected can be deactivated as a general setting
Follow connected on symbols can be activated/deactivated by choosing Settings 
=> Text/Symbol defaults, and then activate/deactivate Activate Follow connected 
on symbols.

— See “Text/Symbol defaults” on page 832, especially “Activate Follow connected 
on symbols” on page 833.
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THE TRIM LINE FUNCTION

If you want to make two lines 
meet, you can apply the Trim line 
command.

Click on the Lines button, acti-
vate the Pencil, and draw two 
lines as you see them here.

You can now make those two 
lines meet.

Disable the Pencil again (press 
<Esc>), and select the vertical 
line by clicking on it. Then 
choose Edit => Trim line.

A thin line starting from the 
selected symbol and ending in the 
cross hairs is now displayed. 
Click on the horizontal line. 
Hereby the vertical line is 
extended to the point where the 
lines would have met, if they had 
both been prolonged.

Now prolong the vertical line cor-
respondingly, and the two lines 
meet.

If one of the lines had been so 
long that it continued past the 
intersection, it would have been shortened to stop at the intersection.

If the lines are parallel, using Trim line gives no meaning, due to the fact that par-
allel lines never meet.
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DRAWING BY MEASURES

It is also possible to type in the exact measures of what you want to draw.

In the status line at the bottom of the screen, you can see the X-Y co-ordinates for 
the cursors location on the screen.

The co-ordinates to the left state the absolute location, while the co-ordinates to the 
right states the co-ordinates relative to where you last clicked (also called the rela-
tive co-ordinates).

Click on the X-Y co-ordinate field in the status line, or use the short-cut [Ctrl+i]. 
You now see a dialog box for typing in co-ordinates.

You can also enter this dialog box choosing Functions => Coordinates.

When you want to draw by measures, you have three options at hand:

Absolute coordinates
The measures are typed in referring to the 
origo of the page, located in the lower-left 
corner of the page.

Relative coordinates
The measures are typed in referring to the 
point last chosen on the page.

Polar coordinates
Here you draw by determining the length 
of the line, and the angle between the line 
and a horizontal line.

As an example of how to use absolute and relative co-ordinates, you can now draw 
a rectangle of 100 x 50 mm in different ways.

Click the Lines button, select line type, deactivate Conducting lines, and activate 
the Pencil.

Using Absolute coordinates
Click on the X-Y co-ordinate field — or press [Ctrl+i] — and choose Absolute.

Type in the X and Y co-ordinates, to state where the line shall start in relation to the 
origo of the page.

Start in the point 50, 100.

In the X field you type 50, in the Y field 100. You do not have to state it is in milli-
metres, due to the system settings. Click OK. (This setting can be changed in Set-
tings => Screen/Pointer. Read more about this i “Pointer/Screen” on page 815).

Click on the X-Y co-ordinate field: Set X to 150 and Y to 100. Click OK.
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Click on the X-Y co-ordinate field: Set X to 150 and Y to 150. Click OK.

Click on the X-Y co-ordinate field: Set X to 100 and Y to 150. Click OK.

Click on the X-Y co-ordinate field: Set X to 100 and Y to 100. Click OK.

Press <Esc>. The rectangle is complete.

Using Relative coordinates
Start the line by clicking somewhere on the screen.

Click on the X-Y co-ordinate field — or press [Ctrl+i] — and choose Relative.

Press [Ctrl+i]: Set X to 100 and Y to 0. Click OK.

Press [Ctrl+i]: Set X to 0 and Y to 50. Click OK.

Press [Ctrl+i]: Set X to -100 and Y to 0. Click OK.

Press [Ctrl+i]: Set X to 0 and Y to -50. Click OK.

Press <Esc>. The rectangle is complete.

Using the Rectangle command with relative coordinates
Click on the Lines, the Rectangle and the Pencil buttons.

Start the rectangle by clicking where you want one of the corners of your rectangle.

Click on the X-Y co-ordinate field — or use short-cut [Ctrl+i] — and choose Rela-
tive.

To specify the opposite corner of the rectangle, you set X to 100 and Y to 50.

Click OK.

The rectangle is now complete.
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MEASUREMENT OBJECTS

Inserting measurement objects
To place measurement objects, which can 
place and calculate measurements 
between two points, choose Functions => 
Measurement.

The starting point for the measurement object
You now get a pencil in the cross hairs, 
which tells you, that you can now point 
out the starting point of the measurement 
object.

If you want to start the measurement from 
a symbol — e.g. from the symbol refer-
ence point or from a corner point on the 
symbol —, the program automatically 
examines the symbol definition, and finds 
the exact coordinates from this point.

If filled lines are applied, you can both 
measure from the center of the lines, and 
from the edges of the lines.

Circles can furthermore be measured at 
intervals of 90 degrees — see the figure to 
the right.

THIS CHAPTER DESCRIBES

— INSERTING MEASUREMENT OBJECTS...................................................................(P. 115)

— FREE MEASUREMENT ..........................................................................................(P. 117)

— ROTATING MEASUREMENT OBJECTS ...................................................................(P. 118)

— EDITING THE MEASUREMENT START AND END POINTS ......................................(P. 118)

— EDITING MEASUREMENT DATA ...........................................................................(P. 119)

— MEASUREMENT OBJECTS AND LAYERS ..............................................................(P. 119)

— DELETING MEASUREMENT OBJECTS....................................................................(P. 119)

MEASUREMENT ONLY ON GROUND PLAN / MECHANICAL PAGES

YOU CAN ONLY INSERT MEASUREMENT OBJECTS ON PAGES WITH THE PAGE 
TYPE GROUND PLAN / MECHANICAL.
— SEE “PAGE TYPE” ON PAGE 502.

http://www.dps.dk/english/Video/Product_videos.htm
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As displayed in the figure below, the program shows exactly which point you are 
selecting:

Click to point out the start point for the measurement object.

— When you wish to place a measurement object, which apparently does not relate 
to the placed objects on the drawing, please refer to “Free measurement” on 
page 117.

Pointing out the end point for the measurement object and place the measurement
Now click where you wish to place the end point for the measurement object.

You now get the text containing the measurement itself in the cross hairs. — When 
start and end points does not have the same vertical or horizontal coordinates, you 
can rotate the measurement, as described in “Rotating the measurement object with 
the [Spacebar]” on page 118.

Click to place the measurement object.
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Specifying the Measurement data
You now enter the dialog box Measurement:

Here you can specify the appearance of the measurement object, whether to attach a 
unit specification to the measurement, and how many decimals to apply.

At the bottom of the dialog box, you can choose which font you wish to use for the 
measurement texts, by clicking the Text properties button.

Click OK, and the measurement is placed on the drawing:

Free measurement
When you choose Functions => Measurement, the program will suggest start and 
end points for the measurement object, based on the objects in the diagram.

If you press the <Ctrl> button, you can place the start and end points for the meas-
urement object freely. This is called free measurement in PCschematic ELautoma-
tion.
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Rotating the measurement object with the [Spacebar]
When the start and end points of a measurement object do not have the same coor-
dinates vertically or horizontally, you can — when you have pointed out the end 
point for the measurement object — use the [Spacebar] to rotate the measurement 
object:

Editing the measurement start and end points
To edit the coordinates of start and/or end point of a measurement object, do the 
following:

1) Click on the Texts button, and select the measurement object by clicking on 
the measurement text:

2) Now click on the measurement start/end point, and drag it to the desired posi-
tion:

Click here
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3) Release the mouse button, and the position of the start/end point(s) have now 
been changed:

Editing Measurement data
To change the appearance of a measure-
ment object, do this:

1) Click on the Texts button, right-
click on the measurement text, 
and choose Measurement data.

2) You now enter the Measurement 
data dialog box, where you can 
edit the appearance of the meas-
urement object — see “Specifying 
the Measurement data” on 
page 117.

Measurement objects and Layers
When you press the <Alt> key, the measurement function is able to see objects 
placed in other layers on the page. You can therefore choose to place the measure-
ment objects in other layers on the page. When printing the page, it is then possible 
to control whether to print the measurement objects or not.

— See “Layers, Elevation and Scaling” on page 471, in particular “Printing pages 
with layers” on page 474.

Deleting a measurement object
To delete a measurement object, click the Texts button, select the measurement 
text, and click the Delete button.
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MOUNTING CORRECT DRAWING

PCschematic ELautomation is able to support mounting correct drawing automat-
ically. — In the IEC 61082 standard this is also called combined circuit and con-
nection diagram.

On mounting correct drawing
In PCschematic ELautomation you can — starting from version 9.0 — create 
mounting correct drawings on equal terms with how you normally draw diagrams 
with connection dots:

•Where a connection dot automatically occur in normal diagram drawings, a 
branch figure is inserted in mounting correct drawing mode.

•You can start and end lines on other lines — with automatical insertion of branch 
figures.

•You can also use automatical line drawing / the router for mounting correct 
drawn lines, starting/ending on other lines. — See “Automatic line drawing / 
Router” on page 109.

•Placing sub drawings by drag’n draw or by selecting Functions => Insert sub 
drawing also handles mounting correct drawing. — See “SUB DRAWINGS AND 
MOUNTING CORRECT DRAWING” ON PAGE 124.

•Branch figures are moved automatically along with the lines, which they are 
placed on. You can therefore move e.g. an electrical potential L1 — which is 
placed on the upper part of a page — up or down, just by moving one single 
line, branch figure or signal symbol on the electrical potential.

THIS CHAPTER DESCRIBES

— ON MOUNTING CORRECT DRAWING ................................................................... (P. 120)

— ACTIVATING MOUNTING CORRECT DRAWING.................................................... (P. 121)

— CHOOSING MOUNTING CORRECT DRAWING IN EXISTING PROJECT .................... (P. 122)

— SIGNAL NAMES IN MOUNTING CORRECT DRAWING ........................................... (P. 123)

— SUB DRAWINGS AND MOUNTING CORRECT DRAWING........................................ (P. 124)

— CHANGING TO MOUNTING CORRECT DRAWING ................................................. (P. 124)

— CHANGING TO NOT MOUNTING CORRECT DRAWING.......................................... (P. 124)

— CONVERTING PROJECTS FROM VERSION 8.0 AND PREVIOUS .............................. (P. 124)

MOUNTING CORRECT DRAWING RECOMMENDED

IF YOU ARE NOT SURE WHETHER TO DRAW MOUNTING CORRECT OR NOT IN 
YOUR DOCUMENTATION, IT IS RECOMMENDED TO DO SO IN PCschematic 
ELautomation. THIS IS BECAUSE YOU CAN EASILY CONVERT MOUNTING 
CORRECT DRAWN PROJECTS TO NORMAL DRAWING MODE WITH CONNECTION 
DOTS, AS DESCRIBED IN “CHANGE TO NOT MOUNTING CORRECT DRAWING” ON 
PAGE 124.
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In mounting correct drawing mode, there are no limitations on what you are 
allowed to draw. Errors in mounting correct drawing, are exclusively found via the 
Design Check function. — See “Design check for Mounting correct drawing” on 
page 123.

Activating Mounting correct drawing
When you want to work in mounting correct drawing mode, you choose Settings 
=> Project data, and select Mounting correct drawing.

If you are already working in a project, you will be told if the project is not drawn 
mounting correct, when you enable Mounting correct drawing. Please read more 
about this in “Choosing Mounting correct drawing in an existing project” on 
page 122.

Bend
On the Project data tab, you also specify the 
size of the bend of the lines on mounting cor-
rect drawings.

In the Bend field you can change the size of 
the bend by clicking the down-arrow, and 
selecting a bend size. In the figure to the right, 
you can see how the size of the bend is speci-
fied.

It is recommended not to use the bend size 
5.0mm, because this does not give a clear 
result when e.g. three electrical potentials are 
placed with a distance of 5,0 mm.

Click here Bend size

Bend size
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It is recommended to use a bend size of 2,0 or 2,5 mm.

CHANGING THE APPLIED BEND SIZE IN A PROJECT

If you change the bend size used in a project, you will be asked whether to change 
the bend size in the existing branch figures in the project.

Branch figures
After the bend size, you can choose which brand figure that the program shall sug-
gest initially, when drawing mounting correct:

In mounting correct drawing mode, the program will automatically place the latest 
applied branch figure. When pressing the <Spacebar> repeatedly before drawing 
further, you can change to one of the other branch figures.

Changing branch figures on lines
When you wish to use another branch 
figure on a line, then deactivate the Pen-
cil, click on the branch figure and press 
the <Spacebar> until the desired figure 
appears.

Having deselected the Pencil, you can 
also right-click on the branch figure, 
select Select figure, and select the new 
branch figure — as illustrated to the 
right.

Choosing Mounting correct drawing in an existing project
When you are working in a project, and select Mounting correct drawing, you will 
be informed if the project is not drawn mounting correct at the time being.
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Design check for Mounting correct drawing
To locate the parts that are not mounting correct, you can then choose Functions 
=> Design check, and enable Mounting correct.

When you click OK you get a list of the parts of the project, which are not mount-
ing correct.

Starting from this list, you can then make sure that your project are mounting cor-
rect drawn.

— Read more about design check in “Design Check” on page 328.

Signal names in Mounting correct drawings
— See “Variant names on signal symbols” on page 224.
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Sub drawings and mounting correct drawing
It is an advantage to draw all of your sub drawings mounting correct. Hereby you 
can use them for both mounting correct drawing, and for not mounting correct 
drawing.

When you drag one of these sub drawings into a project, which is not in mounting 
correct drawing mode, the branch figures are automatically converted to connection 
dots.

By drawing the sub drawings mounting correct, you therefore only need to main-
tain one single set of sub drawings, which can be applied for both purposes.

Change from Non mounting correct to Mounting correct drawing
Projects, which are drawn non mounting correct, can get branch figures inserted in
stead of the connection dots like this:

1) Select Mounting correct in Settings => Project data.

2) Select Functions => Special Functions => Convert Dots to Branches.

— Please check that PCschematic ELautomation have inserted appropriate branch 
figures where it is not obvious which figure to insert.

Change to Not mounting correct drawing
Projects, which are drawn mounting correct, can have inserted connection dots in 
stead of branches like this:

1) De-select Mounting correct in Settings => Project data.

2) Select Functions => Special Functions => Convert Branches to Dots.

Converting mounting correct projects from version 8.0 and previous
Starting from PCschematic ELautomation 9.0 an improved workflow for mount-
ing correct drawing have been introduced. To convert mounting correct drawings 
from version 8.0 and previously, select Functions => Special Functions => Con-
vert to Branches.

The connection dots in the proejct will then be converted to branch figures any-
where this is possible, and double-lines will be removed. — Please check that 
PCschematic ELautomation have inserted appropriate branch figures where it is 
not obvious which figure to insert.

Wire numbers when converting mounting correct drawings from previous versions
When converting mounting correct drawn projects from version 8.0 and previous, 
wire numbers will be moved, so that they uniquely identify which lines they are 
attached to.
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ARCS/CIRCLES

When you want to draw circles, you click the Circles button and activate the Pen-
cil. Circles have the short-cut key [c]. — See “Auto command change” on page 79 
also.

The general short-cut key for the Pencil is the [Ins] key, but you can also use the [c] 
key when you are working with Circles. Pressing the [Ins] or the [c] key activates/
deactivates the Pencil.

— Se how to move, copy, rotate and delete circles and arcs in the section “Working 
with selected objects” on page 79, and see how to transfer data between circles/arcs 
in “Transferring Data / Properties between Objects” on page 83.

Please note, that circles and arcs can not be rotated.

The Circles toolbar
The toolbar for circles looks like this:

R is for the radius of the circle/arc.

V1 is for the arc start angle, V2 is for the arc end angle. 
The drawing is made counter-clockwise.

To draw a full circle V1 has to be 0 and V2 has to be 
360.

To draw a quarter circle V1 can be 180 while V2 is 270.

To draw a half circle V1 can be 45 while V2 is 225.

Whether the circle is to be filled out, is determined by 
clicking the Filled circles button on the toolbar.

Line width is determined in the field B:, while the color 
of the line and filling is determined in the field F:.

Selected arcs can be rotated by pressing the [Spacebar].

Circles / Arcs in the Pickmenu
To get fast access to drawing arcs with predefined properties, you can place arcs 
with the desired properties in the pickmenu at the upper part of the screen. This is 
done as described for lines in “Lines in the Pickmenu” on page 99.

THIS CHAPTER DESCRIBES

THIS CHAPTER DESCRIBES HOW TO WORK WITH CIRCLES AND ARCS.
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Ellipses
Using the circle command also enables you 
to draw ellipses. The last field E: in the tool-
bar of the circle command is an ellipse factor.

If the factor is set to 1 you will get an ordi-
nary circle. Apart from this, see the impact of 
the different factors on the figure below.

When you fill out both V1 and V2 you can 
also draw arcs.

Converting circles and ellipses to lines
When you want to change a circle to lines, you 
do this by selecting the circle and then choosing 
Edit => Convert to lines.

When you do this, the circle is converted to lines.

To select these lines, you now have to click the 
Lines button.

Invisible arcs / circles
— See “Making circles/arcs invisible” on 
page 92.
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TEXTS

When you want to work with texts, you always start by clicking the Texts button — 
or press the short-cut key [t]. If you want to place new texts you click the Pencil 
button. — See “Auto command change” on page 79 also.

The general short-cut key for the Pencil is the [Ins] key, but you can also use the [t] 
key when you are working with Texts. Pressing the [Ins] or the [t] key activates/
deactivates the Pencil.

— See how to move, copy, delete and rotate texts in “Working with selected 
objects” on page 79, and see how to transfer data between texts in “Transferring 
Data / Properties between Objects” on page 83.

TEXT TYPES IN PCschematic ELautomation

There are various types of texts in PCschematic, as you will see below.

When the word text is mentioned in this manual, we will be referring to free texts — 
unless specified otherwise.

THIS CHAPTER DESCRIBES

— THE TEXT TYPES IN PCschematic ELautomation ................................... (P. 127)

— PROJECT AND PAGE DATA.................................................................................. (P. 138)

— GENERAL TEXT FUNCTIONS ............................................................................... (P. 139)

— LOCKING TEXT TYPES ........................................................................................ (P. 142)

— COUNTING ON TEXTS ......................................................................................... (P. 143)

— THE APPEARANCE OF TEXTS / TEXT PROPERTIES ............................................... (P. 145)

— WHICH TEXTS ARE DISPLAYED IN PROJECTS...................................................... (P. 150)

— THE READING DIRECTION FOR TEXTS................................................................. (P. 152)

— TEXT LINKS ........................................................................................................ (P. 153)

TEXT TYPE DESCRIPTION PAGE

FREE TEXTS TEXTS, THAT CAN BE USED ANYWHERE IN THE PROJECT. 128

SYMBOL TEXTS TEXTS, THAT ARE ATTACHED TO EACH SYMBOL, CONTAINING 
INFORMATION ON THE COMPONENT THAT IS COVERED BY THE SYM-
BOL.

131

CONNECTION 
POINT TEXTS

TEXTS, THAT ARE ATTACHED TO EACH OF A SYMBOLS CONNECTION 
POINTS.

133

DATAFIELDS TEXT FIELDS THAT ARE FILLED OUT AUTOMATICALLY. 134

TEXT TYPES IN PCschematic ELautomation
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GENERAL PURPOSE / FREE TEXTS

General purpose/free texts are texts that can be applied anywhere in diagrams, in 
symbol definitions (see “Creating Symbols” on page 670) or in drawing headers/
formulas.

The free texts can not be transferred to project lists — as opposed to the other types 
of texts.

If a free texts is a part of a symbol definition — see “Creating Symbols” on 
page 670 —, it can not be changed in a diagram later on.

Type in and place a free text
Click on the Texts and the Pencil button — or click inside the text field on the texts 
toolbar.

Type in the text as displayed above and press <Enter>. Please note that the toolbar 
informs you that you are dealing with a free text.

The text is now in the cross hairs. Click where you wish to place it.

You have now placed a free text on a project page.

When the Pencil is not activated, you can press the short-cut key [k], and you enter 
the dialog box Place text where you also can type in a text and then place it.

From here it is now possible to use the automatic counting functions, which can be 
found in the Texts toolbar. — Read more about these in “Counting on texts” on 
page 143.

Editing texts in projects
When you want to edit a text in a project, do the following:

1) Disable the Pencil (press <Esc>)

2) Click on the text and press the short-cut key [k]

3) Correct the text and press <Enter> — or click OK

If you press [F7] to enter the Object Lister, you can see all the project texts in one 
place. From there you can also edit the texts.

— See “Checking and editing project texts via the Object Lister” on page 322.

Text typeType in the text here
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Autocompletion of texts
PCschematic ELautomation memorizes all of the texts which have been used in 
the program.

While you type in texts, the program therefore gives you some suggestions to 
which text you are typing in.

You can then choose between the suggestions in the list, or continue typing in the 
text.

If no list appears with texts having the same initial letters, you can press 
[Ctrl+Spacebar] and get a list of matching texts, that do not have the same initial 
letters.

Creating a list of texts
As mentioned, the program memorizes all the texts you type in.

If you also want to add texts from existing projects, do like this:

1) Open the project containing the texts

2) Choose Functions => Special functions => Transfer Project Texts to Auto 
Completion function

This procedure is repeated for all the projects you want to transfer texts from.

Deleting texts from the autotext function
To delete texts from the autotext function, click on the undesired text in the autotext 
scroll menu, and press <Delete>.

Click here and
press <Delete>
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Special characters
Special characters that you need on drawings, 
but are not available from the keyboard, can 
be typed in pressing down the <Alt> key and 
the numerical keys. This goes for the signs for 
earth, frame and alternating current and char-
acters from other european languages.

— Please refer to “Texts in more than one line” on page 139, “Negate (invert) text” 
on page 139 and “Underline text” on page 140.

See these special characters in “Special charac-
ters” on page 856.

You can also right-click in the text field on the 
toolbar and choose Insert char.

The characters you can insert here, are only the 
special characters supported by Windows.

Default text properties for free texts
To edit the default text properties (text size etc.) which PCschematic ELautoma-
tion suggests for free texts, do this:

1) Choose Settings => Text/Symbol defaults.

2) On the tab Text/Symbol defaults: Click on Free, click on Free text and click 
the Text properties button:

3) In the dialog box Text properties: Specify the desired text properties, as 
described in “Specifying text properties / Appearance of text” on page 145, 
and click OK.

4) In the dialog box Text/Symbol defaults: Click the Save as default button, if 
you also want to apply these settings in other projects.

5) Click OK.
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TEXTS CONNECTED TO SYMBOLS

Symbols have attached symbol texts, and if the symbol has connection points, these 
have attached connection texts as well.

The fields for these texts can not be removed. However they neither have to be 
filled out nor visible. — Read more about symbol texts in “Creating Symbols” on 
page 670.

The symbol texts
To each symbol, some symbol texts are attached, which can contain the symbol/
component name as well as other information about the component, which the sym-
bol represents.

These symbol texts exist:

The information that you type into the symbol texts, can be used when for instance 
you want to generate parts lists automatically.

Filling out the symbol texts
When you place a symbol you automatically enter the Component data dialog 
box, where you can enter various information about the symbol, or just click OK 
and return later to fill in the missing data.

If you do not enter the Component data dialog box automatically, you can enable 
this function by entering Settings => Pointer/Screen and select Ask for Names.
— Read more about this in “Pointer/Screen” on page 815.

When you return later to type in the symbol texts, you have to start by clicking the 
Symbols button, or use the short-cut key [s]. Then right-click on the symbol whose 
symbol texts you want to change, and choose Component data in the appearing 
menu.

Instead of right-clicking, you can select the symbol by clicking and then click the 
Data button in the program toolbar.

TEXT TYPE DESCRIPTION

S NAME THE NAME OF THE SYMBOL/COMPONENT — I.E. -K1, -Q34.

S TYPE DESCRIBES THE TYPE OF THE COMPONENT — CAN BE FILLED OUT VIA THE 
DATABASE.

S ARTICLE NO A TEXT TELLING EXACTLY WHICH COMPONENT A SYMBOL DESCRIBES. THIS 
BEING EITHER A EAN 13 NUMBER OR A STOCK NUMBER. CAN BE FILLED OUT 
VIA THE DATABASE.

S FUNCTION THIS TEXT IS USED TO DESCRIBE THE FUNCTION OF THE SYMBOL. CAN BE 
FILLED OUT VIA THE DATABASE.

THE SYMBOL TEXTS
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You now enter the dialog box Component data, that for instance could be filled 
out like this:

Here you can fill out the symbol texts, and decide which of the symbol texts that 
should be displayed together with the symbol in the project. It is also possible to 
type in the connection point names. This is described in “Placing and Naming sym-
bols” on page 176.

Click OK when the data are as you want them to be.

Editing the symbol texts directly on a Diagram page
A symbol with visible symbol texts could look like this:

— Please note that references are only displayed when the symbol has references. 
— See “Creating Symbols” on page 670, especially “Position for references to 
other symbols” on page 672.

You can change the contents of a visible symbol text directly on a 
diagram page, by first clicking on Texts, then disable the Pencil 
(press <Esc>), and click on the text you wish to change. In the 
texts toolbar you will see which type of symbol text you have selected.

To indicate to which symbol the symbol text is connected, a line is being displayed 
going from the reference point of the symbol to the symbol text. Click in the text 
field of the toolbar — or press [k] —, edit the text, and press <Enter>. The symbol 
text has now been changed.
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Changing between the symbol texts by pressing [F5]/[F6]
Once you have selected a symbol text, you can change back and forth between the 
symbol texts connected to the same symbol by pressing [F5] and [F6]. When a 
symbol has references, pressing [F5]/[F6] will also jump to the reference text.

Please refer to “Locking text types” on page 142 for an easier way to change sym-
bol texts.

Moving symbol texts on a Diagram page
To move a symbol text you also have to activate the Texts button. Then you can 
move the text as you can move any other object in PCschematic ELautomation, 
for instance using drag and drop.

If you press down <Shift> while moving the text, you can place the text using fine 
snap — read more about snap in “Snap” on page 68.

CONNECTION POINT TEXTS

These texts are connected to the connection points of the symbol — where you con-
nect conducting lines to the symbol — and contain information about these.

The following types of connection point texts exist:

Connection point texts are filled out and moved like symbol texts. — Please refer to 
“Texts connected to symbols” on page 131 and “Symbol Connection points” on 
page 204.

When you have selected a connection point text, you can change back and forth 
between the texts connected to the connection point by pressing [F5] and [F6].

CONNECTION POINT TEXT CONTENTS

NAME (C.NAME) THE CONNECTION NUMBER OF THE CONNECTION POINT.

FUNCTION (C.FUNC) THE FUNCTION OF THE CONNECTION POINT.

LABEL (C.LABEL) THE SHORT DESCRIPTION (FOR INSTANCE FOR PLC DRAWINGS).

DESCRIPTION (C.DESCR) THE LONG DESCRIPTION (FOR INSTANCE FOR PLC DRAWINGS).

CONNECTION TEXTS
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DATAFIELDS

Another type of texts are called datafields. These can be filled out automatically by 
the program. Like free texts, they can be applied anywhere in drawings, in symbols 
and in drawing headers/formulas.

Choosing Settings you can specify the contents of some datafields once and for all. 
What you type in here will be inserted into the project any time you place one of 
these datafields. If you change the contents of one of the datafields in Settings, the 
project will be updated automatically. Read more about how to do this in “Project 
and Page data” on page 138.

— Please refer to “Page data and Project data Datafields” on page 663 for further 
details.

To insert a datafield choose Functions => Insert datafield.

You now enter the Datafield dialog box:

The various groups of datafields have the following contents:

DATAFIELD CONTENTS

SYSTEM DATA DATA ABOUT YOUR SYSTEM. FOR INSTANCE USER NAME WHICH IS 
THE NAME OF THE PERSON THAT IS TYPED IN AS USER IN SETTINGS 
=> SYSTEM. DATE AND TIME ARE THE ACTUAL DATE AND TIME, 
MINUTES AND SECONDS.

PROJECT DATA DATA CONCERNING THE ACTUAL PROJECT. YOU CAN DEFINE THESE 
IN SETTINGS => PROJECT DATA.

PAGE DATA DATA CONCERNING THE PAGE YOU ARE WORKING ON IN THE 
PROJECT. THERE ARE SOME PRE-DEFINED PAGE DATA DATAFIELDS, 
SUCH AS THE PAGE NUMBER. YOU CAN DEFINE ADDITIONAL PAGE 
DATA DATAFIELDS IN SETTINGS => PAGE DATA.

DATAFIELDS

The selected
datafield

Click here for
drop-down menu

Explanatory
text about the
datafield

The selected
field type

Supplementary
information
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— See the survey of datafields in “Datafields” on page 834.

The other fields in the menu have following functions:

SYMBOL DATAFIELDS DATAFIELDS YOU CAN DEFINE BY YOURSELF. — READ MORE 
ABOUT THESE IN “CREATING DATA SYMBOLS” ON PAGE 704.
YOU CAN ALSO PLACE SYMBOL DATAFIELDS FOR EACH INDIVIDUAL 
FIELD IN THE DATABASE. IN THE LIST OF SYMBOLDATA DATAFIELDS, 
THESE FIELDS ARE ASSIGNED THE NAMES DB[XXXXX], WHERE 
XXXXX IS THE NAME ON THE DATAFIELD IN THE DATABASE.

TABLE OF CONTENTS DATAFIELDS FOR TABLES OF CONTENTS.

PARTS/COMPONENTS 
LISTS

DATAFIELDS FOR PARTS- AND COMPONENTS LISTS.

TERMINALS LIST /
CABLE LIST

DATAFIELDS FOR TERMINALS- AND CABLES LISTS. IN THE SUPPLE-
MENTARY INFORMATION BOX YOU CAN FOR INSTANCE DETERMINE 
WHETHER A DATAFIELD IS FOR THE EXTERNAL OR THE INTERNAL 
PART OF THE LIST.

PLC LIST DATAFIELDS FOR PLC LISTS.

FIELD FUNCTION

ACTIVATE NEXT IS USED FOR LISTS WHEN A CERTAIN GROUP OF INFORMATIONS MUST BE 
REPEATED SEVERAL TIMES ON A PAGE. EACH TIME THE PROGRAM MEETS 
ACTIVATE NEXT, THE NEXT SET OF INFORMATION ON THE LIST CAN BE 
FILLED INTO THE LIST. SEE “DICTIONARY” ON PAGE 850.

WRAP TEXT IF THE TEXT CONTAINS MORE CHARACTERS THAN STATED IN THE WIDTH 
FIELD, THE REMAINING PART OF THE TEXT WILL NOT BE DISPLAYED. IF YOU 
ACTIVATE WRAP TEXT, THE TEXT WILL CONTINUE ON AN EXTRA LINE 
BELOW.

KEEP LINEBREAK 
(^)

WHEN YOU SELECT KEEP LINEBREAK (^), THE DATAFIELD WILL ALSO 
HAVE THE SPECIFIED LINEBREAK IN THE LISTS CREATED FROM THE 
PROJECT.

ONLY SHOW TEXT 
ON DATA

THIS OPTION ONLY APPEAR WHEN SOMETHING HAS BEEN TYPED INTO THE 
TEXT FIELD. IF YOU ACTIVATE THIS FUNCTION, THERE WILL NOT BE 
PRINTED ANYTHING ON THE SCREEN IN CASES WHERE THE TEXT FIELD IS 
FILLED OUT, BUT THERE ARE NO ACTUAL DATA IN THE DATAFIELD ITSELF.
ESPECIALLY USED IN LISTS.

THE RED ARROW TRANSFERS THE SELECTED DATAFIELD TEXT TO THE TEXT FIELD.

FILL CHARACTER A CHARACTER THAT WILL BE FILLED IN FROM THE END OF THE TEXT AND 
IN THE REMAINING WIDTH OF THE DATAFIELD. FOR INSTANCE A LINE OF 
DOTS IN A TABLE OF CONTENTS BETWEEN THE PAGE TITLE AND THE PAGE 
NUMBER. (3) ON THE FOLLOWING FIGURE.

TEXT HERE YOU CAN TYPE IN A TEXT TO PRECEDE THE CONTENTS OF THE 
DATAFIELD. (1) ON THE FOLLOWING FIGURE.

WIDTH THE MAXIMUM WIDTH OF THE DATAFIELD (NUMBER OF CHARACTERS).

THE DATAFIELD MENU

DATAFIELD CONTENTS

DATAFIELDS
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Two inserted datafields could for instance look like this:

Please note that this is how datafields look like when you are in Edit symbols — for 
instance because you want to create a list (Read more about creating lists in “Creat-
ing Lists” on page 727). If you just insert a datafield on a page, you will not see the 
name of the datafield itself (2), but the contents of the datafield.

Use Functions => Insert Datafield to select a datafield you want to insert. Click 
OK when the settings are as you want them.

You now get the chosen datafield into the cross hairs, and click where you want to 
place it.

When you want to edit a placed datafield, you right-click on the datafield and 
choose Datafield. This brings you into the Datafield dialog box.

Inserting the contents of the datafield in the text
By applying the % character, you can insert the contents of the datafield in the mid-
dle of the text in the Text field.

The following options exist:

INSERT DESCRIPTION

%S INSERTS THE VALUE/CONTENTS OF THE DATAFIELD UNCHANGED.
IF YOU TYPE IN "PRICE: %S $" — AND THE CONTENTS OF THE DATAFIELD IS 25 —THIS 
RESULTS IN THE TEXT "PRICE: 25 $"
— WHEN YOU HAVE TYPED IN THE CONTENTS OF THE DATAFIELD WITH NO DECIMALS, 
THE CONTENTS IS DISPLAYED WITHOUT DECIMALS. IF YOU HAVE TYPED IN THE CON-
TENTS WITH DECIMALS, THE CONTENTS IS DISPLAYED WITH DECIMALS.

%F INSERTS THE VALUE OF THE DATAFIELD AS FLOATING POINT VALUE, WHEN POSSIBLE.

INSERTING THE DATAFIELD CONTENTS IN A TEXT

The text in the
Text field (1)

The name of datafield itself (2)

Fill characters (3)



PCschematic ELautomation 10.0 PAGE 137

TEXTS

When you want to use the % character in a text, just type the % character twice. If 
you write "%.2f %%" this can result in the text "5,00 %".

%.1F INSERTS THE CONTENTS OF THE DATAFIELD AS FLOATING POINT WITH ONE DECIMAL. 
YOU CAN CHOOSE FROM 0 TO 9 DECIMALS.
IF YOU WRITE "PRICE: %.2F $"— AND THE CONTENTS OF THE DATAFIELD IS 25 — 
THIS RESULTS IN THE TEXT "PRICE: 25,00 $"
IF YOU WRITE "%.3F KG." — AND THE CONTENTS OF THE DATAFIELD IS 17,65 — THIS 
RESULTS IN THE TEXT "17,650 KG."

%- NO DATAFIELD VALUE IS INSERTED, AND THE TEXT IS ENDED RIGHT BEFORE THE % 
CHARACTER. IF FOR INSTANCE YOU WRITE "TOTALPRICE:%" THE TEXT "TOTALPRICE:" 
IS INSERTED IF THE CONTROLLING DATAFIELD HAS A CONTENT.
THIS CAN FOR INSTANCE BE USED AT THE BOTTOM LINE OF A LIST, WHERE THE 
DATAFIELD PRICE 1 TOTAL DOES NOT HAVE A CONTENT UNTIL ALL PAGES IN THE LIST 
HAVE BEEN ADDED. TO MAKE THIS WORK, YOU MUST PLACE THE DATAFIELD PRICE 1 
TOTAL WITH THE TEXT "TOTAL PRICE:%-" IN THE LEFT SIDE OF THE BOTTOM LINE, AND 
PLACE THE DATAFIELD PRICE TOTAL IN THE RIGHT SIDE OF THE BOTTOM LINE WITH 
THE TEXT "%S $"
SELECT ONLY SHOW TEXT ON DATA FOR BOTH DATAFIELDS.

INSERT DESCRIPTION

INSERTING THE DATAFIELD CONTENTS IN A TEXT
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PROJECT AND PAGE DATA

When you open a new project, the program will show you the tab Project data 
from the Settings dialog box. In this dialog box you also find the tab for Page data.

Here you can fill in various data for your project.

To fill out a field, you just click inside the field, and type in the information. You 
can jump between the fields by pressing the <Tab> key.

If you do not wish to enter these data now, press <Esc> or click Cancel.

If you want to fill out or change data later, choose Settings => Project data / Page 
data. Or you can click the Project data or the Page data button. You can also 
right-click on a project page, and select Page data.

If you want to change the name of a datafield in the Project or Page data menu 
(the grey fields in the left hand side of the menu), just right-click on the field name 
you want to change. Then a menu appears, from which you can change the name of 
the field, delete the field, or add new datafields. However, you will not be allowed 
to change the names of project- or page datafields, that are being used in the present 
project. You can change the contents of the fields at any time.

— Read more about this in “Page data and Project data Datafields” on page 663.

Remember to click Redraw to see the effects of the changes in your project.

See how you design drawing headers in “Creating Drawing Headers” on page 715, 
and how to design your own lists in “Creating Lists” on page 727.

Activating the Auto text function for Page title
To activate the auto text function when typing in a Page title, press [Ctrl+Space-
bar]. — See “Autocompletion of texts” on page 129.



PCschematic ELautomation 10.0 PAGE 139

TEXTS

GENERAL TEXT FUNCTIONS

When you are working with texts, there are some text functions you can apply for 
all text types.

Changing a text
If you want to change a text on a drawing, you first select the text by disabling the 
Pencil (press <Esc>), and then click on the text. The text is now in the text field on 
the toolbar. Click inside the field, correct the text, and press <Enter>.

If you double-click on the text in the text field, the text will be selected, and you can 
type in another text instead.

When a text is selected, you can also press the short-cut key [k], and you will enter 
a dialog box where you also can type in the text.

When you select a text, the type of the text is displayed in the texts toolbar.

Changing a text in the cross hairs
When you have a text in the cross hairs, click in the text field (or press [k]), type in 
a new text, press <Enter> and place the text. This can also be done while copying.

Texts in more than one line
Insert the character ^ where you want a line break. — On your keyboard it is proba-
bly located to the left of the <Enter> key. The character will not appear before you 
type in the following character.

— See also “Line length” on page 147 and “Wrap text” on page 147.

Negate (invert) text
Type in the text in the text field, select it and press [Ctrl+PageUp]. The negate bar 
will only be placed above the selected part of the text.

Alternatively you can select the text in the toolbar, right-click and choose Negate.

If you deselect the Pencil (press <Esc>) and right-click on a text, you can also 
choose Negate.

You can remove the negation by selecting the text, and then choose Negate again.

NEGATED TEXTS AND CHANGING FONTS

IF YOU CHANGE FONT, YOU MUST BE AWARE THAT THIS CAN HAVE AN EFFECT 
ON NEGATED TEXTS. — SEE “SPECIAL CHARACTERS WHEN CHANGING THE 
PCSCHEMATIC FONT TO A WINDOWS FONT” ON PAGE 146.
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Underline text
Select the text as mentioned above and press [Ctrl+PageDown] — or select the text, 
right-click and choose Underline.

If you deselect the Pencil (press <Esc>) and right-click on a text, you can also 
choose Under line.

You can remove the underline by selecting the text, and then choose Underline 
again.

Cut, copy and insert a text in the text field
A text in the text field can be transferred to the Windows 
clipboard, either by copying or by cutting from the text.

If you want to transfer text from the text field to the clip-
board, you select the text you want to transfer, right-click 
and choose Copy in the menu that appear. A copy of the 
text is now placed on the clipboard.

If you want to transfer a text from the clipboard to a text 
field, then activate the Texts button. Right-click in the 
text field and choose Insert. Press <Enter> and place the 
text on the drawing.

The text stays on the clipboard until another text is trans-
ferred to the clipboard.

Swopping texts
To swop texts and datafields, you can apply the function Edit => Swop texts:

1) Select a text by clicking on it.

2) Choose Edit => Swop texts.

3) Click on the other text, that you want to swop the text with.

You can also right-click on a text, and choose Swop texts.

UNDERLINED TEXTS AND CHANGING FONTS

IF YOU CHANGE FONT, YOU MUST BE AWARE THAT THIS CAN HAVE AN EFFECT 
ON UNDERLINED TEXTS. — SEE “SPECIAL CHARACTERS WHEN CHANGING THE 
PCSCHEMATIC FONT TO A WINDOWS FONT” ON PAGE 146.
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Information on texts
When you have chosen Texts and right-click on a text and choose Information, 
you enter the dialog box Information, which contains information about the text.

Here you find information about the text height, width, position, the used font, line 
length of the text, wrap text information etc.
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LOCKING TEXT TYPES

On the toolbar for texts it is possible to lock which type of texts you want to work 
with, as well as to carry out continuous counting on texts of the type chosen.

Locking a text type
On the toolbar for texts, you can specify, that you only want to work 
with texts of a specific text type.

If for instance you choose the type S.Name, only texts of the type Sym-
bol name can be selected in the project. If you then drag a window 
around some symbols in a project, only their symbol names are 
selected.

When you have locked the type to Symbol name, you can then assign a name to a 
symbol by typing in the name in the text field in the texts toolbar, press <Enter>, 
and click on the symbol.

Doing it this way, you do not have to click on the reference point for the text Sym-
bol name of the symbol.

If you want to place a connection point text, you lock the relevant text type, and 
click on the connection point itself.

When the text type is set to All, the selection of texts function on all text types.

RESET THE TEXT TYPE TO ALL AFTER USING THIS FUNCTION

TO BE ABLE TO SELECT ALL TYPES OF TEXTS IN THE PROJECT SUBSEQUENTLY, 
YOU SHOULD SET THE TEXT TYPE TO ALL AFTER USING THIS FUNCTION.

Increment/decrement Specify numbering system

Interval for incremen-
ting/decrementing Lock text type
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COUNTING ON TEXTS

When you want to place texts with increasing or decreasing numbers, you 
can specify according to which numbering system the texts shall be incre-
mented/decremented. Here you can choose between binary, octal, decimal 
and hexadecimal. You can also choose to increment/decrement upper- or 
lower case letters (ALFA or alfa respectively).

The initial value is typed into the text field in the texts toolbar.

If the texts are to be incremented following a specified interval, you type in the 
interval in the Interval field, as displayed on page 142.

When you click on +, the text in the text field is incremented with the value speci-
fied in the Interval field. This increment follows the number system chosen. If the 
interval is set to 1, and the number system to dec, the text K1 will be incremented to 
K2.

If you click on - instead, the text will be decremented following similar guidelines.

When you press down <Ctrl> and click on +, the text will be incremented automat-
ically each time you click on a new text.

Therefore, when you have chosen the text type S.Name, have typed in K1 in the 
Text field and 2 in the Interval field, and then press down <Ctrl> and click on +, the 
first symbol you click on will get the symbol name K1, the following K3, then K5 
and so on.

If you press down <Ctrl> and click on -, the texts will be decremented automati-
cally following the same directions.

Apply counting on texts in areas
To increment/decrement texts in areas, you do the following:

1) Click on Texts

2) Specify text type, interval and numbering system, as described above

3) Select the area containing the texts you want to count up/down (se below)

4) Type in the initial value in the text field in the toolbar

5) Press down <Ctrl> and click on +

6) Press <Enter>

The selected texts are now counted up according to the directions you have speci-
fied.
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Please note, that the program registers where you clicked the first, when you 
selected the area. The counting of the texts starts from there.

If the counting should be carried out starting from the left-hand side, you therefore 
start by clicking in the left-hand side, when you select the area.

Texts can be counted up on several symbols at the same time — as illustrated on the 
figure above.

— Please refer to “Changing symbol names in an Area” on page 202 to see alterna-
tive ways to apply automatic counting on symbol names, and to “Choosing connec-
tion points in Areas” on page 206 to see how to do it for connection point names.

Short-cut keys for counting on texts
When you have selected a symbol, a text or a connection point on a symbol — or 
have a text in the cross hairs —, it is possible to increment or decrement the text/
symbol name/connection name.

To increment, choose Functions => Count up, or press the [+] key on the numeri-
cal keyboard.

To decrement, choose Functions => Count down, or press the [-] key on the 
numerical keyboard.

Increment/decrement is done according to the interval specified in the Texts tool-
bar.

— Both short-cut keys can be changed as described in “User defined short-cut 
keys” on page 768.

Click in the left-hand side first when you select the area,
if you want the counting to be performed from left to right
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SPECIFYING TEXT PROPERTIES / APPEARANCE OF TEXT

Exit any dialog box that might be activated, click on the Texts button, and press the 
Text properties button.

When changing the various text settings, you click the down-arrow at the left hand 
side of the dialog box, and click on your choice in the drop down box that emerge.

Editing the properties of placed texts
When you want to edit the properties of a placed text, you first click the Texts but-
ton. Then click on the text, and click the Text properties button. — Or: Right-click 
on the text, and select Text properties.

Then make the changes described in this section.

If for instance you want to type in the text height directly, you can also click in the 
Height field itself, and type in the desired height.

The Text properties dialog box contains the following fields:

SELECTING TEXT PROPERTIES VIA THE PICKMENU

YOU CAN SELECT DIFFERENT SETS OF TEXT PROPERTIES VIA THE PICKMENU, AS 
DESCRIBED IN “TEXTS IN THE PICKMENU” ON PAGE 148.

Font
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Fonts
Here you choose which font you want to use.

On the list you can choose between the PCschematic font 
and the other fonts you have on the PC.

Please note that the Windows fonts should only be applied 
when strictly necessary. This is because they are not to be 
used on diagrams according to the EN standards, and 
because they take up extra space in the PC memory.

It can be an advantage to use these fonts in drawing headers, 
in tables of contents and in lists.

The PCschematic font follows the EN standards, and 
should therefore be used on diagrams.

Special characters when changing the PCschematic font to a Windows font
If you change texts written with the PCschematic ELautomation font to be written 
with a Windows font, use of special characters such as negated characters, under-
lined characters earth characters etc. will give an incorrect result.

— See “Printing PDF files / Acrobat files” on page 337 also.

Height
States the height of the text.

Width
States the width of the text. The width specifies the distance between characters and 
their appearance.

Selecting AUTO sets the width to 2/3 of the height of the text.

Alignment
There are nine different alignment 
options, such as centre-centre as shown 
above. When the text is placed in a point, 
it is actually the reference point of the 
text that is located in this point — as you 
can see on the figure.

In the field Alignment you determine 
where the reference point will be located 
in relation to the text.

If the text is rotated, it will be rotated around the reference point.

These reference points applies for both the PCschematic ELautomation font and 
for Windows fonts — see “Fonts” on page 146.

Frame
If you want a frame around the text, you pick one of the options in this field.
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Color
States the color of text and frame. If you choose the color NP (Non Printable), you 
will see the text on the screen, but not on print.

— See “Visible text” on page 147 and “Making objects invisible” on page 90.

Line length
Here you can specify the maximal number of characters that can be included in the 
text line. If the text is longer than this, the extra characters are truncated.

Wrap text
Set a check mark here if the text shall continue on a new line, if the line length is 
exceeded.

Suppress lineshift char
When you select Suppress lineshift char, the manually entered lineshift characters 
are suppressed. This function is activated individually, via the Text properties dia-
log box, for each individual text you wish to use it on.

The function can e.g. be used in connection with PLC reference symbols, when you 
do not wish to display the I/O connection description text with the same lineshifts, 
which is adapted to the design of the PLC symbol. — See “Working with PLC’s” 
on page 446.

The function can also be used in connection with text links, where you wish to sup-
press the lineshifts for some of the texts in the text link. — See “Text links” on 
page 153.

Check marks
Bold text, Italic text, Visible text and Fixed text direction are enabled and disabled 
by clicking inside the check boxes. A check mark is displayed when they are ena-
bled.

Bold text
The text will be bold.

Italic text
The text will be in italics.

Visible text
If you remove the check mark in the Visible text check box, the text will not be 
shown in the project. Thus if you remove the check mark for a text containing a 
symbol name, the name of the symbol will not be shown in the project.

If you then click Symbols, right-click on the symbol and choose Component data, 
you can see that it now is stated here as well, that the symbol name is not visible. 
You can turn symbol texts on and off in the Component data dialog box and in the 
dialog box Text properties.
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Fixed text direction
If this option is chosen, the text will always be directed as it is when you place it on 
the page. Therefore, if you change the general Reading direction of the page, the 
text will not change direction. Read more about reading direction in “Specify read-
ing direction” on page 152.

When you have finished specifying the text properties, you click OK.

Not translated
In the field Not translated you can specify not to translate this text, when translat-
ing project texts via the translation program PCschematic Translator.

Select text properties from Text/Symbol defaults
In the Text properties dialog box it is also possible to select the settings in the dia-
log box from the settings for a specified text type in Settings => Text/Symbol 
defaults.

When you click on the down-arrow in the Std.Text field 
in the upper part of the dialog box, you get a list of the 
various text types, you can set the standard size for under 
Settings => Text/Symbol defaults.

Please note, that you can also select the default settings 
for free texts.

If for instance you click on S.Type, the settings in the dia-
log box Text properties will then become the same as the 
current default settings for symbol type texts.

This makes it easier to place free texts having the same 
appearance as for instance symbol texts.

— Please refer to the “Text/Symbol defaults” on page 832 for further details on the 
default settings for texts.

Texts in the Pickmenu
To get fast access to drawing texts with predefined properties — see “Specifying 
text properties / Appearance of text” on page 145 —, you can place texts with the 
desired properties in the pickmenu at the upper part of the screen.

When you click on one of the texts in the pickmenu, the program automatically 
changes to working with Texts, and the cursor is placed in the text-field in the texts 
toolbar.

Symbols/drawing objects displayed in all pickmenus

Select different menus
in the pickmenu

Click on a text, and place texts
with the specified properties
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When you subsequently type in at text and press <Enter>, you get the text in the 
cross hairs. When you place the text in the project, the text gets the selected proper-
ties.

To insert a text type in the pickmenu, right-click on an empty cell in the pickmenu, 
and select Place Text. The currently applied text properties are hereby inserted in 
the cell in the pickmenu.

If the pickmenu is not displayed on the screen, you can activate the pickmenu by 
selecting Settings => Pointer/Screen and click on Pickmenu.

The pickmenu can also contain symbols, lines and arcs. — Read more about the 
pickmenu in “Fetching symbols from the Pickmenu” on page 161 and “Adapting 
the Pickmenu” on page 196.
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TEXTS DISPLAYED IN THE PROJECT (GENERAL SETTING)
Entering Settings => Text/Symbol defaults you can — as a general project setting 
— specify which types of texts that can be displayed in the project.

If you here decide that Symbol article number is not to be shown in the project, you 
will not be able to display the number for any symbol in the project — not even 
though you select the Visible field for Name in the Component data dialog box for 
the symbols in the project.

If you, on the other hand, in Symbol defaults have determined that for instance 
texts of the type Symbol article number can be shown in the project, you can for 
each individual symbol state that for this symbol, the number is not to be shown.

— Read more about this in “Texts connected to symbols” on page 131.

In the left hand side of the Text defaults section you determine which type of texts 
you want to change the settings for. On the right hand side you determine whether 
the various texts can be displayed in the project.

The contents of the right hand side of the text defaults vary depending on the text 
type chosen.

If for instance you want the option to display texts of the type Symbol article 
number in the project, you first click on Symbol, then on Article, and finally you 
select the Displayed in project box.

Click against Capital letters if you want the text in capital letters only. Hereby can 
only type in capitals, when you type in the text. Already placed texts are not 
changed.

Name format for symbol names
For symbol names you can determine whether the placing of the symbol on page 
and current path shall be included in the symbol name. Read more about this in 
“Naming symbols due to page and current path number” on page 388.

Save as default
If you want to save the current settings as future standard, you click the Save as 
default button. Click OK. Please note that you only change the default settings for 
the type of text you are displaying in the dialog box at the present. If you click on 
the button with the settings shown above, you will only change the settings for 
symbol names.
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If you want to change the default settings for more text types, you have to click the 
Save as default button each time you have changed the settings for one single text 
type.

If you want to fetch the current default settings for the text type chosen, you click 
the Load defaults button.

If you just want to see what the default settings are, you click the Show defaults 
button, which only displays the default settings as long as you press down the 
mouse button.

When you have saved settings as standard, new projects will get these settings. Pre-
viously created projects will not be changed.

When you return to the drawing, it is a good idea to click the Redraw button, to 
update the drawing with the new settings.

Changing text properties
On this tab you can also change the default appearance / which text properties the 
program shall suggest for the various text types.

When you have clicked your way to a text type, you determine its appearance by 
clicking the Text properties button. You now enter directly into the Text proper-
ties dialog box, as described in “Specifying text properties / Appearance of text” on 
page 145.

Other text standards
When you click on Reference, you can 
determine the appearance of the current path 
numbers by clicking on Horizontal refer-
ence and Vertical reference respectively.

If you click on Reference cross you can 
determine the appearance of the texts in the 
reference crosses that are placed in the 
project subsequently.

Clicking on Symbol reference, likewise determine the appearance of the reference 
texts between symbols that are placed in the project succeedingly. Signal reference 
can only be changed in the Edit symbol mode.

Text standards for Symbol and Connection
Please note that text defaults for Symbol and Connection only cover the text prop-
erties that will be suggested when you are designing symbols. Therefore they can 
only be changed in the Design/Edit symbol mode.

Already designed symbols will not be effected by the changes.
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SPECIFY READING DIRECTION

The corners of a piece of paper is always numbered in such a way, that the bottom 
left hand corner has got number zero, the bottom right hand corner has number one, 
the upper right hand corner number two, and the upper left hand corner has number 
three.

Whether the paper is in portrait or in landscape does not change this.

The texts on a drawing will normally only be read seen from two directions.

The texts on a landscape drawing will normally be read seen from the bottom right 
hand corner (corner one). However, if you are drawing on a landscape page, which 
you later print out and rotate to place it in a folder, you must choose reading direc-
tion 0 (texts are read from corner zero). The texts then appears correctly when 
placed in the folder.

The reading direction can be changed in Settings => Page setup => Reading 
direction. You can choose reading direction 0, 1, 2, 3 or -1. The number state the 
corner from which the texts can be read. This means that the rotation of texts, or of 
symbols with texts, will change automatically according to the chosen setting. If 
you wish to change the reading direction on a drawing, you just change the setting, 
and the texts will change accordingly.

If you set the reading direction to -1 the texts will keep the orientation they have 
when you place them in the project. Thus they will not be oriented according to a 
specific reading direction.

If you have got a drawing in landscape, which after printing have to be inserted into 
a portfolio, you have to set the reading direction to 0.

Please note that you have got the option to place individual texts with fixed reading 
direction. These will not be altered according to the general reading direction in 
Page setup. This facility can for instance be applied in company logos/drawings. 
See how to place texts with fixed reading direction in “Specifying text properties / 
Appearance of text” on page 145.
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TEXT LINKS

What is a text link?
To ensure that all project texts referring to the same contents are always identical, 
PCschematic ELautomation contains a function named text links. When you have 
linked two — or more — texts, and edit one of these texts, the other linked texts are 
changed automatically.

Any function, from which you can edit texts in the program, updates linked texts 
automatically when editing — see “Where to edit texts in link lists” on page 157.

This is also the case when importing PLC I/O data — see “Text links and importing 
PLC I/O lists” on page 157.

Indication of linked texts
When a text is linked, this is indicated in dialog boxes by a Flash in front of the text 
— for instance in the Component data dialog box:

This is also the case in the Object Lister — see “The Object Lister” on page 314.

In diagrams linked texts are indicated by an arrow drawn through the reference 
point of the text:

THIS CHAPTER DESCRIBES

— WHAT IS A TEXT LINK?.......................................................................................(P. 153)

— INDICATION OF LINKED TEXTS............................................................................(P. 153)

— CREATING LINKED TEXTS FROM THE TEXTS COMMAND.....................................(P. 154)

— CREATING LINKED TEXTS FROM THE SYMBOLS COMMAND ...............................(P. 154)

— THE DIALOG BOX TEXT LINK ..............................................................................(P. 156)

— EDITING A TEXT LINK .........................................................................................(P. 156)

— DELETING A TEXT LINK ......................................................................................(P. 157)

— TEXT LINKS AND LOADING PLC I/O LISTS .........................................................(P. 157)

— MAINTAINING TEXT LINKS..................................................................................(P. 157)
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Creating a text link from the Texts command
There are different ways of creating text links in PCschematic ELautomation. 
When working with texts, do the following:

1) Select a text in the project — for instance click at the Texts button, then right-
click on the text reference point, and choose Text link:

2) The dialog box Text link is displayed: Click on a new text in the project, and 
click on the Add text to link button to link the new text to the text in the dia-
log box:

3) Continue adding texts to the text links until all relevant texts are linked.

4) Close the dialog box Text link by clicking on the Close button in the upper 
right-hand corner of the dialog box.

— See “Creating text links from Component data and Connection data” on 
page 154 also.

Creating text links from Component data and Connection data
When working with symbols, you can link symbol texts like this:

1) Click on Symbols — to start working with symbols.

2) Right-click on a symbol and select Component data.



PCschematic ELautomation 10.0 PAGE 155

TEXTS

3) In the dialog box Component data: Right-click in one of the text fields (see 
“Symbol names and Connection names can not be linked” on page 155), and 
select Text link.

4) You now enter the dialog box Text link, from which you can link texts. — If 
the dialog box Text link is already open, the selected text is added to the 
active link list in the dialog box Text link).

5) Close the dialog box Component data for the selected symbol, and add new 
texts to the link via the Component data dialog box for other symbols in the 
project, or shift to the Texts command and link more texts as described in 
“Creating a text link from the Texts command” on page 154.

6) Continue linking texts until all relevant texts are linked.

7) Close the dialog box Text links by clicking the Close button in the upper 
right-hand corner of the dialog box.

You can do exactly the same for connection points in the dialog box Connection 
data.

SYMBOL NAMES AND CONNECTION NAMES CAN NOT BE LINKED

IN THE DIALOG BOX COMPONENT DATA YOU CAN LINK ALL TEXTS — EXCEPT 
THE SYMBOL NAME.
IN THE DIALOG BOX CONNECTION DATA YOU CAN LINK ALL TEXTS — EXCEPT 
THE CONNECTION NAME.
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The dialog box Text link
In the dialog box Text link a list of all texts which are linked together — a link list 
— is displayed:

Here you have the following options:

Linking texts to the texts in the link list
When working with Texts, and the dialog box Text link is open, you can add new 
texts to the link list by clicking on a text in the project, and then click on the Add 
text to link button in the dialog box Text link.

Removing texts from the selected link
When working with Texts, and the dialog box Text link is open, you can remove a 
text from the link list by clicking on the text in the dialog box, and then click on the 
Remove text from link button in the dialog box Text link.

Show text location
To jump to a text in the project from the dialog box Text link, you have the two fol-
lowing options:

a) Click on the text in the dialog box Text link, and click on the Show text loca-
tion button, or

b) Double-click on the text in the dialog box Text link

The program now displays the page in the project where the text is placed, and 
selects the text. The dialog box Text link remains active on the screen.

Load link list of selected text
When the dialog box Text link is open, and you select a new text in PCschematic 
ELautomation, and click on the Load link list of selected text button, the link list 
of the selected text is loaded in the dialog box.

Editing text links
When you wish to add texts to a link list after closing the dialog box Text link — or 
you wish to delete texts from the link list — do this:

1) Click on the Texts button — to work with texts.
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2) Right-click on one of the texts in the link list, and open the dialog box by 
selecting Text link.

3) In the dialog box Text link: Add texts to the link list as described in “Creating 
a text link from the Texts command” on page 154, or remove a text from the 
link list by clicking on the Remove text from link button.

4) When you have finished editing: Close the dialog box by clicking on the 
Close button in the upper-right corner of the dialog box.

The text used in the text link list can also be edited from the Object Lister, just like 
you edit non-linked texts. — See “The Object Lister” on page 314.

Deleting a text link list
1) Click on the Texts button — to work with texts.

2) Right-click on one of texts in the link list, and open the dialog box Text link 
by selecting Text link.

3) Click on the Remove text from link button in the dialog box until only one 
text remains in the dialog box.

4) The links are now deleted: Close the dialog box.

Text links and importing PLC I/O lists
When you import a PLC I/O list in PCschematic ELautomation — see “Reading 
PLC I/O lists” on page 460 — and a text hereby is changed (a PLC input/output 
description), which is linked to other texts in the project, these texts are automati-
cally changed to the imported text.

Where to edit texts in link lists
The texts in the link lists can be maintained the following places:

- From the Symbols command: In the dialog boxes Component data and Con-
nection data — see “Creating text links from Component data and Connection 
data” on page 154

- From the Texts command — see “Editing text links” on page 156

- From the Object Lister — see “The Object Lister” on page 314

- During import — see for instance “Text links and importing PLC I/O lists” on 
page 157

When you edit a linked text, all of the other linked texts are changed accordingly — 
no matter which way you edit the text.
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In PCschematic ELautomation you apply symbols when you want to represent an 
electrical component on a drawing. If for instance you want to place a lamp, you 
find the symbol for a lamp, and place it on the drawing.

When you want to work with Symbols, you always start by clicking the Symbols 
button — or use the short-cut key [s]. — See “Auto command change” on page 79 
also.

The general short-cut key for the Pencil is the [Ins] key, but you can also use the [s] 
key when you are working with Symbols. Pressing the [Ins] or the [s] key activates/
deactivates the Pencil.

THIS CHAPTER DESCRIBES

— FETCHING SYMBOLS WITH AND WITHOUT USING THE DATABASE .................... (P. 160)

— PLACING AND NAMING SYMBOLS ...................................................................... (P. 176)

— SYMBOL SUB NAMES.......................................................................................... (P. 185)

— SYMBOLS WITH STATES...................................................................................... (P. 187)

— UPDATING SYMBOLS FROM THE DATABASE ....................................................... (P. 189)

— MOVING AND DELETING PLACED SYMBOLS....................................................... (P. 192)

— THE SYMBOL TOOLBAR ...................................................................................... (P. 194)

— ADAPTING THE PICKMENU ................................................................................. (P. 196)

— CHANGING SYMBOL NAMES IN AREAS............................................................... (P. 202)

— SYMBOL CONNECTION POINTS............................................................................ (P. 204)

— CHOOSING CONNECTION POINTS IN AREAS........................................................ (P. 206)

— THE PINSWOP FUNCTION .................................................................................... (P. 207)

— REPLACING SYMBOLS......................................................................................... (P. 209)

— AUTOMATIC CREATION OF SYMBOLS ................................................................. (P. 212)

— THE SHOW NET FUNCTION AND THE NETLISTER ............................................... (P. 217)

— USING SIGNAL SYMBOLS.................................................................................... (P. 218)

— USING TERMINAL SYMBOLS ............................................................................... (P. 228)

— USING MULTILAYER TERMINAL SYMBOLS.......................................................... (P. 229)

— USING CABLE SYMBOLS..................................................................................... (P. 231)

— USING ACCESSORY SYMBOLS ............................................................................ (P. 238)

— SYMBOL FOLDERS IN PCschematic ELautomation ................................. (P. 239)

FUNCTIONS ON COMPONENT LEVEL

MORE SYMBOL FUNCTIONS ARE DESCRIBED IN “FUNCTIONS ON COMPONENT 
LEVEL” ON PAGE 241. THE RELATIONSHIP BETWEEN COMPONENTS AND SYM-
BOLS ARE DESCRIBED IN “THE RELATIONSHIP BETWEEN SYMBOLS AND COM-
PONENTS” ON PAGE 242.

http://www.dps.dk/english/Video/Product_videos.htm
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— Please refer to “Creating Data symbols” on page 704 to see how to use data 
symbols.

See how to move, copy, delete and rotate symbols in the section “Working with 
selected objects” on page 79, and see how to transfer object properties between 
symbols in “Transferring Component Data for Symbols or Lines” on page 83.

Designing your own symbols
If you can not find the symbol you need among the symbols that come with 
PCschematic ELautomation, then read “Creating Symbols” on page 670, to see 
how you design your own symbols.

PLC FUNCTIONS

READ MORE ABOUT THE SPECIAL OPTIONS FOR WORKING WITH PLC SYMBOLS 
IN “PLC FUNCTIONS” ON PAGE 441.
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FETCHING SYMBOLS

When working with symbols, you always start by clicking the Symbols button or by 
pressing the short-cut key [s].

Beyond copying an already placed symbol, there are several ways of fetching a 
symbol in PCschematic ELautomation:

Some of the functions are handy when you work without 
using the database, others when you know the exact article 
number of the component you want, others again when you 
know which type of component you want, but do not know 
its exact article number.

WAY TO FETCH SYMBOLS PAGE

FROM THE PICKMENU 161

FROM THE SYMBOL MENU 165

FROM THE DATABASE 172

TYPING IN A SYMBOL FILENAME 173

TYPING IN AN ARTICLE NUMBER 174

TYPING IN A SYMBOL TYPE 175

DIRECT CREATION OF SYMBOLS 212

FROM WINDOWS EXPLORER 338

USING A BARCODE SCANNER 608

WAYS TO FETCH SYMBOLS IN PCschematic ELautomation

AUTOMATIC LINE DRAWING WHEN PLACING

SYMBOLS

WHEN YOU PLACE A SYMBOL YOU CAN USE THE 
ROUTER FUNCTION, WHICH DRAWS THE LINES CON-
NECTING THE SYMBOL TO THE DIAGRAM AUTOMATI-
CALLY. — READ MORE ABOUT THIS IN “AUTOMATIC 
LINE DRAWING / ROUTER” ON PAGE 109.

http://www.dps.dk/english/Video/Product_videos.htm
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1. Fetching symbols from the Pickmenu
When working in PCschematic ELautomation, you have the Pickmenu available 
on the upper part of the screen. Here you place the symbols — and other drawing 
objects — you use the most.

When you click on a symbol in the pickmenu, you get the symbol in the cross hairs, 
and can place it in the project. The program changes automatically to work with 
Symbols, and the Pencil is activated.

If the pickmenu is not displayed, choose Settings => Pointer/Screen and click on 
Pickmenu.

The pickmenu can also contain line types, text types and arcs. — Read more about 
the pickmenu in “Lines in the Pickmenu” on page 99, “Texts in the Pickmenu” on 
page 148 and “Circles / Arcs in the Pickmenu” on page 125.

Selecting the different Pickmenus
The pickmenu contains several dif-
ferent menus, which you select by 
clicking on the tabs at the bottom 
of the pickmenu.

— See how to create new menus in 
the pickmenu in “Creating new 
menus in the Pickmenu” on 
page 198.

OTHER POSSIBILITIES WHEN USING THE PICKMENU

— CHANGING BETWEEN MENUS IN THE PICKMENU ................................................(P. 161)

— SYMBOLS / DRAWING OBJECTS DISPLAYED IN ALL PICKMENUS.........................(P. 162)

— SYMBOLS WITH COMPONENT DATA IN THE PICKMENU.......................................(P. 162)

— ENTERING THE DATABASE USING THE PICKMENU ..............................................(P. 163)

— ALTERNATIVE ELECTRICAL SYMBOLS ................................................................(P. 163)

— SYMBOLS WITH STATES IN THE PICKMENU.........................................................(P. 164)

— POSSIBILITIES AND LIMITATIONS WHEN USING THE PICKMENU .........................(P. 164)

Symbols/drawing objects displayed in all pickmenus

Select different menus
in the pickmenu

Click on a symbol, and place it
in the diagram

Click to select a new menu
in the pickmenu
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Symbols/ Drawing objects displayed in all Pickmenus
Symbols / drawing objects with a small triangle in the 
upper-left corner of the pickmenu cell, are displayed in 
all menus in the pickmenu.

— See how to give a symbol / drawing object this status 
in “Inserting a Symbol / Drawing object in all Pick-
menus” on page 196.

Symbols with component data in the pickmenu
The symbols in the pickmenu can be attached to components in the database. This 
way you automatically attach component data to the symbols when you place them 
in diagrams.

When you click on a symbol/component that contains more than one function in the 
database, you get a pickmenu containing the electrical symbols for the component.

Click on one of the symbols and place it. Press [Ctrl+F9] to get this pickmenu for 
the component on screen again. — See “The function Show available” on page 245 
or “The function Show available window” on page 247.

When you let the cursor rest for a moment over one of the symbols in the pick-
menu, the component data is displayed below the symbol (as a hint) and at the bot-
tom line of the screen.

SYMBOLS WITH MULTIPLE SETS OF DATA IN THE PICKMENU

You can also assign multiple sets 
of component data to a symbol (a 
cell) in the pickmenu. This way 
the same cell can contain the 
same component with e.g. differ-
ent capacities.

When you let the mouse rest over 
a cell containing multiple sets of 
component data, a submenu is 
displayed for the different sets. — See “Automatic popup of submenus in the pick-
menu” on page 197.

You can see that a symbol cell contains component data, by the light-blue rectangle 
in the lower-right corner of the cell.

— See how to create multiple sets of component data for a symbol in a cell in 
“Adding component data to symbols in the pickmenu” on page 199.

Displayed in
all pickmenus

Displayed in selected
pickmenu only
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Entering the database using the pickmenu
If you press down <Ctrl> while clicking on a symbol in the pickmenu, you enter the 
database. Here you can see the components that have got the picked symbol as the 
first symbol in the Symbol field of the database. — See “Database settings” on 
page 591 and/or the PCschematic Database manual.

It is also possible to right-click on the symbol in the pickmenu, and choose Data-
base.

Select the desired component in the database and click OK.

Alternative electrical symbols
When you fetch a component via the database — for instance by using the pick-
menu — it is some times possible to choose between alternative electrical symbols 
for the functions of the component.

If for instance a component has a relay coil and two switch functions, the switch 
functions can be used as either a switch, a make contact or a break contact.

When you get the pickmenu for such a component, it could look like this:

When you choose one of these alternative symbols, the other alternatives for the 
function disappears.

If for instance you choose the symbol for the make contact for the first switch func-
tion, the two alternative symbols for switch and break contact disappears form the 
pickmenu for the component.

— Please also see “Symbols with states” on page 164.

Other options for using alternative symbols
There exists many other ways to use alternative symbols than just the example 
above.

Power control circuit symbols can for instance exist in a normal version and a ver-
sion for one-line diagrams. You can also choose whether to use PLC modules or 
single I/O symbols.

Alternative electrical symbols Alternative electrical symbols
(1-2-3) (1-2-3)
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— See how to specify the alternative symbols in the database in “Specifying alter-
native electrical symbols via the database” on page 577.

Symbols with states
Symbols with states can also be placed in the pickmenu. When a symbol in the 
pickmenu has states, a dark blue triangle is displayed in the lower-right corner of 
the cell in the pickmenu.

You can specify whether to display a submenu automatically, as described in 
“Automatic popup of submenus in the pickmenu” on page 197. When you let the 
mouse rest over the state for a symbol, the title for the state is displayed, if a title for 
the state exists.

— See “Symbols with states” on page 187, “Symbols with states for single line dia-
grams” on page 478 and “Creating symbols with states” on page 686.

Possibilities and limitations when using the pickmenu
You have the option of creating 999 different pickmenus. By clicking the up- and 
down arrows in the left side of the pickmenu, you can jump from one pickmenu to 
another. — See how to place symbols in the pickmenu in “Adapting the Pickmenu” 
on page 196.

The pickmenu can be moved around on the screen as an ordinary window in Win-
dows, and can also be docked. When it is docked it will always be displayed on the 
screen. You can read more about this in “Docking the Pickmenu” on page 50.
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2. Fetching symbols using the Symbol menu
Click the Symbols button and the Symbol menu button — or press the short-cut 
key [F8], which can be applied from all commands.

In the Symbol menu you then pick the symbol you need:

Placing the found symbol
Click on the desired symbol and click OK — or double-click on the desired symbol 
—, and you return to your diagram with the symbol in the cross hairs.

Place the symbol in the project, and press <Esc> to remove the symbol from the 
cross hairs.

POSSIBILITIES IN THE SYMBOL MENU

— SYMBOL LIBRARIES / PROJECT SYMBOLS IN THE SYMBOL MENU.......................(P. 166)

— REPRESENTATION OF SYMBOLS IN THE SYMBOL MENU .....................................(P. 166)

— SEARCHING IN THE SYMBOL MENU ....................................................................(P. 167)

— BOOKMARKS IN THE SYMBOL MENU ..................................................................(P. 168)

— ENTERING THE DATABASE VIA THE SYMBOL MENU ...........................................(P. 171)

— CREATING NEW SYMBOLS FROM THE SYMBOL MENU ........................................(P. 171)

AUTOMATIC UPDATE OF THE SYMBOL MENU

IF SYMBOLS, OR THE CONTENTS OF THE SYMBOL DIRECTORY DISPLAYED IN 
THE SYMBOL MENU CURRENTLY, ARE CHANGED FROM OUTSIDE THE PRO-
GRAM — E.G. VIA WINDOWS EXPLORER OR OTHERS ON THE NET — THE SYM-
BOL MENU IS UPDATED AUTOMATICALLY.
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Displaying symbol libraries / project symbols in the Symbol menu
When you wish to locate symbols in the Symbol menu, you can choose which 
symbols to display, in the following way:

Display Library via Folders
Click the Select Libraries from Folders button. You then get an explorer structure 
in the left-hand side of the Symbol menu, where you can find the folder in which 
the desired symbol library is placed.

In the folder Pcselcad on the C:\-drive, you find the folder Symbol. In this folder 
you find a number of sub folders containing various symbol libraries.

When you have chosen a folder here, such as EN60617, you see these symbols dis-
played in the window in the Symbol menu. When there are more symbols than can 
be displayed in the window, there will be a scroll bar in the window.

The contents of the symbol libraries is described in “Symbol folders” on page 239.

If you need to know more about changing folders and opening files, please read 
“Windows” on page 35.

Selecting Libraries via Alias
Click on the Select Library from Alias button. Hereby a list of the created aliases 
in the left-hand side of the Symbol menu. Each of these aliases points on a folder, 
which contains a symbol library.

When installing PCschematic ELautomation, aliases for the installed symbol 
libraries are created automatically.

— Read more about alias in “Show directory alias” on page 820.

Showing the Project Symbols
Click on the Show Project Symbols button. Hereby all symbols in the project are 
displayed.

Show the most recently used symbols
Click on the History button. Hereby the last 50 symbols fetched via the Symbol 
menu are displayed. This also includes symbols fetched via the Symbol menu 
when working in other projects.

Representation of symbols in the Symbol menu
In the upper right-hand corner of the Symbol menu, you will find three buttons to 
specify how the symbols are displayed in the Symbol menu:

YOU CAN USE ALIASES, WHICH POINTS ON SYMBOL LIBRARIES PLACED ALL 
OVER THE WORLD.
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Symbols displayed as Large icons
When you click on the Large icons button, the 
symbols are displayed in the Symbol menu.

When placing the mouse cursor over a symbol, 
the Title, Name and Type of the symbol is dis-
played as a hint.

Symbol names displayed in a List
When you click on the List button, a list of the sym-
bol file names are displayed.

When placing the mouse cursor over a symbol name, 
the symbol is displayed in the right-hand side of the 
menu, and the Title, Name and Type of the symbol is 
displayed as a hint.

Symbol names displayed with Details
When you click on the Detail button, a list of the symbol file names is displayed, 
containing detailed information on the selected symbols.

When placing the mouse cursor over a line in the list, the symbol is displayed in the 
right-hand side of the menu.

Searching in the Symbol menu
When you need to search after a symbol in the 
selected library, click the Search button — or 
press [Ctrl+f].

A search field is then displayed. Here you can type in the text you are searching for.

Click on the down-arrow to the right of the Search button to specify which type of 
information you are searching for:

Then type in the symbol text you are searching for in the search field. As you type 
in the text, the program will select the first symbol in the symbol library, having a 
symbol text beginning with the text you have typed in so far. To jump to the next 
symbol matching the text, click the Search again button — or press [F3].

Click here, and specify
which type of information
you are searching for
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It makes no difference for the program whether the text has been written as upper 
case or lower case letters.

Begins with/Contains
If you take no special action, the program starts searching for texts beginning with 
the text you type in. When you wish to search for a text that just exists somewhere 
in the selected text type, click on the Begins with/Contains button, so that it 
changes appearance from T... to ..T...

When this happens, the program searches for the text fragments anywhere in the 
selected text types.

To return to searching for texts beginning with the typed in text, click on the Begins 
with/Contains button again, so that it changes appearance from ..T.. to  T....

Bookmarks in the Symbol menu
When the Symbol menu displays aliases or folders, it is possible to insert book-
marks. When you click on a bookmark, you jump down to the selected bookmark in 
the folder.

Creating a bookmark in the Symbol menu
To create a bookmark, right-click on a symbol in 
the Symbol menu, and choose Create book-
mark.

You then enter the dialog box Create Bookmark:

Type in the name of the bookmark, and click OK.

The bookmark is now displayed in the lower left-hand corner of the dialog box, 
when you select the alias or library in question in the Symbol menu.

Click on the
bookmark
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Editing or Deleting created bookmarks
To edit or delete a created bookmark, right-click on the bookmark and choose Edit 
bookmark or Delete bookmark.

Bookmarks and copying symbol libraries
Information about bookmarks are saved in the relevant symbol libraries. This has 
the following consequences:

1) When there is access to the library from other PCs on the network, the book-
marks can also be seen from these PCs.

2) When you copy the library, the applied bookmarks are included automatically.

Hierarchical displaying of symbols in the Symbol menu
In PCschematic ELautomation, the symbols are placed in different folders, with-
out any hierarchical structure (see “Bookmarks in the Symbol menu” on page 168 
also).

When you click the Symbol groups button in the Symbol menu, you get the option 
of creating your own hierarchical structure, which can make it easier for you to find 
the symbols. You then enter the folder SymbolGroups, which is placed under Pcsel-
cad\Symbols:

Here you can create your own grouping of the symbols, which you already have 
access to.

This is done by first creating a structure of folders 
with relevant names. In these folders, you create 
the so-called groups, and it is in these groups that 
you can place the symbols. Please note, that it is not 
possible to place the symbols in a folder, they can 
only be placed in a group.

Example on creating a hierarchical structure
1) Create the first folder: Right-click on the 

folder SymbolGroups, and select Add folder. 
Type in the folder name Contacts, and click 
OK.

2) Create sub folders: Right-click on the folder Contacts, and create the sub 
folder Make, just like you created the first folder. Under the Contacts folder, 
you also create the sub folders Break and Switch.
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3) Create a group: Right-click on the folder Switch and select Add group. Type 
in the group name 1P, and click OK. In this group 1P, you can now place 
symbols.

You have now created a hierarchical structure, containing a group, in which you can 
place symbols.

Placing symbols in a hierarchical structure
To place symbols in a group in the hierarchical structure, do this:

1) Select the group in the left side of the Symbol menu.

2) Right-click in the right side, and select Add symbol:

3) The dialog box Get symbol is now displayed: Select the folder where the 
symbol is placed, by clicking on the folder in the left side of the window.

SYMBOLS ARE NOT PLACED DIRECTLY IN THE GROUPS

THE SYMBOLS ARE NOT PLACED DIRECTLY IN THE CREATED GROUPS. IN 
STEAD, A LINK (OR A REFERENCE) IS CREATED TO THE FOLDER WHERE THE 
SYMBOL IS PLACED IN THE SYMBOL MENU. WHEN A SYMBOL IS CHANGED VIA 
THE EDIT SYMBOL FUNCTION, THE SYMBOLS ARE THEREFORE AUTOMATI-
CALLY CHANGED IN ALL THE GROUPS, WHICH REFERS TO THE THE EDITED 
SYMBOL.
THE SAME SYMBOL CAN APPEAR IN DIFFERENT GROUPS.

1) Select group 2) Right-click and select Add symbol
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4) Now find the symbol in the right side of the window, and double-click on the 
symbol to add it to the group. You can also drag the symbol from the Get 
symbol window, and place it in the group:

Remove symbol from group
If you wish to remove a symbol from a group, right-click on the symbol, and select 
Remove symbol.

Entering the database from the Symbol menu
To find symbols in the database which has attached symbols of a specific type, do 
the following:

1) Enter the Symbol menu.

2) Find the desired symbol, and click on it.

3) Click on the Database button, and you enter the Database menu.

In the database you now see all the components which has the selected symbol as 
the first symbol in the Symbol field in the database. — See “Database settings” on 
page 591 and/or the PCschematic Database manual.

— Read more about fetching symbols via the database in “Fetching symbols from 
the database” on page 172.

Creating symbols or Editing existing from the Symbol menu
To create a new symbol, click on the Create new symbol button.

When you wish to edit an existing symbol, click on it in the Symbol menu, and 
click on the Edit symbol button.

— Read more about this in “Creating Symbols” on page 670.

3) Find the folder
where the symbol
is placed

4) Double-click on
the symbol, or drag
it into the group
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3. Fetching symbols from the database
If you already know which components you are going to use, you can fetch the 
symbol directly from the database.

Entering the database
Click the Symbols button, press down <Ctrl> and click the Symbol menu button. 
You then enter the database directly, if it is on (See “Using the database” on 
page 559 for how to turn a database on). You can also press the short-cut key [d].

Selecting a symbol in the database
Click on a folder, for instance Automatic switches / connection material, and 
choose e.g. a Fabricate in the upper right-hand corner of the dialog box, and select 
a component.

Select for instance the component with EAN number 4022903075387 — as dis-
played above. Click OK.

— Read more about searching in the Database menu in “Using the database” on 
page 559.

OPTIONS IN THE DATABASE MENU

— SELECTING A SYMBOL IN THE DATABASE ..........................................................(P. 172)

— PLACING SELECTED SYMBOLS FROM THE DATABASE.........................................(P. 173)

— DISPLAY THE PICKMENU FOR THE COMPONENT AGAIN...................................... (P. 173)

Select
component
group

Components

Searching
and navigation

Choose e.g.
Fabricate

http://www.dps.dk/english/Video/Product_videos.htm
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Placing the selected symbols from the database
A special pickmenu, containing all the electrical symbols for the component, now 
appear on the screen.

If the component consists of just one symbol, you automatically get this symbol in 
the cross hairs.

Otherwise, click on the symbol you want to use, and place it where you want it. 
When you click on a symbol, the pickmenu disappear automatically.

Displaying the pickmenu for the component again
To make the pickmenu reappear, choose Functions => Show available again or 
press the short-cut key [Ctrl+F9]. Please refer to “The function Show available” on 
page 245 for further details.

— See also “The function Show available window” on page 247.

4. Typing in the symbol file name directly
When you have activated Symbols and press the short-cut key [k], you enter this 
dialog box:

Type in the file name of the symbol you want, and press <Enter>. The program now 
search the contents of the folder you used last time you used the Symbol menu. If 
the program does not find the symbol there, the program searches the symbol 
libraries with alias — as described in “Show directory alias” on page 820.

If the program can not find a matching symbol, you will enter the Symbol menu. If 
there exists a symbol in the Symbol menu whose name starts with the text you 
typed in, it will be selected.

— In “Automatic creation of symbols” on page 212 you can see how to create sym-
bols directly from this dialog box.
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5. Typing in the Article Number directly
When you have activated Symbols and choose Functions => Database => Find 
Article — or press the short-cut key [v] — you enter this dialog box:

Here you type in as much you can remember of the article number, and click OK.

You then enter the database, which displays all components having an article 
number matching what you typed in.

If you typed in 40 — as in the figure above — the database will look like this:

Click on the desired component, and click OK. You now get the electrical symbol 
for the component in the cross hairs — or a pickmenu containing all electrical sym-
bols for the component.

If you type in a complete article number, you get the symbol directly in the cross 
hairs without entering the database menu.
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6. Typing in the Symbol Type directly
When you have activated Symbols and choose Functions => Database => Find 
Type — or press the short-cut key [b] — you enter this dialog box:

Here you type in as much you can remember of the symbol type, and click OK.

You then enter the database, which displays all components having a symbol type 
matching what you typed in.

If you typed in S you get a list of all components in the database of a type starting 
with S — similar to explained above. Click on the desired component, and click 
OK. You now get the electrical symbol for the component in the cross hairs, or a 
pickmenu containing all electrical symbols for the component.

If you type in a complete type specification, you get the symbol directly in the cross 
hairs without entering the database menu.

UPPER AND LOWER CASE CHARACTERS IN THE DATABASE

WHEN YOU TYPE IN THE SYMBOL TYPE, THE PROGRAM DISTINGUISHES 
BETWEEN UPPERCASE AND LOWERCASE LETTERS WHEN YOU ARE APPLYING A 
DATABASE FORMAT, WHICH IS ABLE TO MAKE THIS DISTINCTION.
IF FOR INSTANCE YOU ARE USING AN ACCESS DATABASE, THERE WILL BE NO 
DISTINCTION BETWEEN UPPER AND LOWER CASE CHARACTERS.
THE DBASE FORMAT, ON THE OTHER HAND, MAKES THIS DISTINCTION.
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PLACING AND NAMING SYMBOLS

When you have got a symbol in the cross hairs — using one of the ways mentioned 
in “Fetching symbols” on page 160 — you can place it by clicking where you wish 
to place it on the drawing.

When you place the symbol, you will automatically be asked about the Component 
data in the following dialog box:

In the dialog box Component data above you type in the component name, and 
other relevant information. — Please refer to “Texts connected to symbols” on 
page 131 for details about the contents of these text fields.

If you have selected the symbol via the database, all the fields are filled out auto-
matically — except for the symbol/component name.

Click OK when you are satisfied with the settings, or click Cancel to cancel the 
changes in the contents of the dialog box.

Press <Esc> to remove the symbol from the cross hairs.

CHANGES CAN BE TRANSFERRED TO ALL SYMBOLS FOR THE COMPONENT

WHEN TEXT PARAMETERS ARE CHANGED IN THE DIALOG BOX COMPONENT 
DATA, THE MESSAGE ALL=CHANGE ALL SYMBOLS FOR THE COMPONENT IS 
DISPLAYED IN THE UPPER-LEFT CORNER OF THE DIALOG BOX.

IF YOU THEN CLICK THE ALL BUTTON IN THE DIALOG BOX, THE CHANGES IN 
THE FIELDS NAME, TYPE, ARTICLE NO, FUNCTION AND THE REFERENCE DES-
IGNATIONS ARE TRANSFERRED TO ALL THE OTHER SYMBOLS FOR THE COMPO-
NENT. AT THE SAME TIME ALL SYMBOLS FOR THE COMPONENT ARE UPDATED 
FROM THE DATABASE, AS DESCRIBED IN “UPDATE FROM DATABASE WHEN 
CHANGING SYMBOL ARTICLE NO” ON PAGE 244.
 IF YOU CLICK OK, DATA IS ONLY CHANGED FOR THE SELECTED SYMBOL.

When the component has an attached refe-
rence designation, it is displayed here

Reference desig-
nations and sub
names are edited
here
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Automatic naming of symbols
When you activate the Auto name button, the symbols you place are assigned the 
next available symbol name for that type of symbol without entering the Compo-
nent data dialog box.

The button is located in the Symbol toolbar on the upper part of the screen. — See 
“The Symbol toolbar” on page 194.

How not to enter the dialog box Component data automatically
If you do not want to enter this dialog box each time you place a symbol, you can 
disable the function by deselecting Ask for names in Settings => Pointer/Screen. 
— See “Pointer/Screen” on page 815.

AUTO NAMING OF SYMBOLS ON AUTOMATIC PROJECT GENERATION

WHEN GENERATING PROJECTS AUTOMATICALLY, THE SYMBOLS IN THE CRE-
ATED PROJECT CAN BE NAMED CONSECUTIVELY AUTOMATICALLY.
— READ MORE ABOUT THIS IN “GENERATING AND UPDATING PROJECTS VIA 
EXCEL” ON PAGE 614, “MERGING PROJECTS VIA EXCEL” ON PAGE 625 AND 
“AUTO NAME SYMBOLS DURING GENERATION” ON PAGE 630.

OPTIONS IN THE DIALOG BOX COMPONENT DATA

— SPECIFYING THE COMPONENT NAME..................................................................(P. 178)

— DISPLAYING/EDITING THE PARTS OF A COMPONENT NAME ..............................(P. 179)

— SPECIFYING TYPE AND ARTICLE NO ...................................................................(P. 179)

— SPECIFYING FUNCTION .......................................................................................(P. 180)

— VISIBLE/INVISIBLE TEXTS ...................................................................................(P. 180)

— THE TAB GENERAL .............................................................................................(P. 180)

— THE TAB REF.DESIGN..........................................................................................(P. 181)

— THE TAB REFERENCE..........................................................................................(P. 182)

— CHANGING CONNECTION DATA ..........................................................................(P. 182)

— THE TAB SYMBOL DATA .....................................................................................(P. 184)

— COPYING COMPONENT DATA ..............................................................................(P. 184)

— COLLECTING INFORMATION FROM THE DATABASE ............................................(P. 184)

— ATTACHING UNIT DRAWINGS TO SYMBOLS ........................................................(P. 184)
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Specifying the Component name
In the Name field in the dialog box Component data you can either type in a 
name, or use one of the following options:

Automatic counting in the Component data dialog box
If you press down <Ctrl> when you click on + in the dialog box Component data, 
the names of the following symbols of the same type that you place, will be 
increased by one as you place them in the project.

When this function is activated, you will see a + in front of the Name field in the 
dialog box.

If you press down <Ctrl> when you click on -, they will automatically be decreased 
by one. A - will be displayed in front of Name when this function is activated.

If you press <Ctrl> while clicking on ?, subsequently placed symbols will automat-
ically be assigned the next available symbol name. When this function is activated, 
a ? will be displayed in front of the Name field.

Other options for naming symbols
To see how to rename more symbols at the same time, please refer to “Changing 
symbol names in an Area” on page 202.

Please note that you can also change the symbol texts directly on the diagram page, 
as described in “Editing the symbol texts directly on a Diagram page” on page 132.

More advanced ways to change texts directly on diagrams are described in "Lock-
ing text types" and “Counting on texts” on page 143.

Current path names in symbol names
To include current path names in symbol names automatically, please refer to 
“Naming symbols due to page and current path number” on page 388.

BUTTON FUNCTION

INCREASE THE NUMBER IN THE SYMBOL NAME BY ONE.

DECREASE THE NUMBER IN THE SYMBOL NAME BY 
ONE.

GIVES YOU THE NEXT AVAILABLE SYMBOL NAME FOR 
THE RELEVANT SYMBOL TYPE.

GIVES YOU A LIST, WHERE YOU CAN CHOOSE BETWEEN 
THE ALREADY USED SYMBOL NAMES.

GIVES YOU A SELECTED LIST OF SYMBOL NAMES FOR 
ALL RELEVANT SYMBOLS IN THE ACTUAL SITUATION.

BUTTONS IN THE COMPONENT DATA MENU
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Button for Displaying/Editing the parts of a Component name
The text for the Name field in the dialog box Component data is also a button, 
which you can click on. When clicking this Name button, you enter the following 
dialog box:

In this dialog box you can see and edit the different parts of the symbol name: 
Name (-), Function (=), Location (+) and Sub name.

— Please also see “The tab Ref.design.” on page 181 and “Sub names on symbols” 
on page 185.

Options for the Type and Article no fields
For the fields Type and Article no in the dia-
log box Component data, you can either 
type in data, or fetch these via the Used and 
Used related buttons.

Here the Used button displays all used types 
and article numbers in the project, while the 
Used related button displays all used types 
and article numbers in the project for sym-
bols of the same type.

In the appearing dialog box you can either 
choose type or article number separately, or 
both at the same time.

— Article number and type data can also be transferred automatically when choos-
ing components via the database, as described in “Fetching symbols from the data-
base” on page 172.

Update from database when changing article number
When changing the Article no for a symbol, all symbols for the component are 
updated, if you subsequently select Change all symbols for the component and 
click OK in the Component data dialog box. If the new article number exists in 
the database, the symbols for the component are also updated with component data 
from the database.

The options for how this is done can be specified in Settings => Database => 
Update Components when changing Article No. => Settings, as described in 
“Update from Database when changing symbol Article no” on page 244.

Click here and choose
between the applied
reference designations
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— See also “Updating symbols from the database” on page 189.

Options for the Function field
For the Function field in the dialog box Component data, you can either type in 
data, or apply the buttons Used, Count up and Count down.

The Used button displays the currently applied texts in the project, while the Count 
up / Count down buttons counts up/down on the current function text.

Visible texts
By setting a check mark in the Visible fields, you determine which information will 
be displayed in the project. Read more about the texts in this dialog box in “Texts 
connected to symbols” on page 131.

Please note that the texts will only be displayed in the project if you have not disa-
bled this in Settings => Text/Symbol defaults — see “Texts displayed in the 
project (general setting)” on page 150.

The tab General
On the tab General in the dialog box Component data you can see information 
about the symbol, such as the symbol file name, the symbol type, scale, visibility 
and rotation angle.

Quantity
The field Quantity is for instance used for single line diagrams (see “Single line 
diagrams” on page 477), and specifies how many occurrences of the component the 
symbol represents.

For instance this can be used if you need five support symbols and only want to 
place one symbol on the drawing. In the project lists, five support symbols will then 
be included.

Symbol type
By clicking the down-arrow in the field Symbol type in the dialog box Component 
data you can change the symbol type. — Read more about symbol types in “Sym-
bol types” on page 680.
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Symbol data in Electrical and Mechanical lists
You can also specify whether the symbol shall be represented in electrical and/or 
mechanical lists.

When you select Electrical, the symbol will be represented on terminals-, cables- 
and PLC lists and in connection list files, if the symbol contains the type of infor-
mation you choose to include in the various lists.

If you select Mechanical, the symbol will be represented in components- and parts 
lists.

When you place a symbol, both Electrical and Mechanical are selected automati-
cally, unless specified otherwise in the symbol definition. — See “Symbol settings: 
Advanced” on page 682.

Visible
When Visible is not selected, the symbol is not displayed on print — See “Making 
objects invisible” on page 90.

Include in Mechanical Load
If Include in Mechanical Load is selected for the symbol, a mechanical symbol 
will be placed for the symbol during mechanical load, if a mechanical symbol 
exists for the component in the database.

Please note that this setting is selected by default, and that the setting covers all 
symbols for the component.

— Read more about mechanical load in “Mechanical Load from the Database” on 
page 609.

The tab Ref.design.
When you use reference designations in the active project, the tab Ref.design. will 
also appear in the dialog box Component data.

From here you choose the reference designations for the symbol, as described in 
“Reference designations for symbols” on page 353. — Another way of selecting 
reference designations for the symbol, is described in “Button for Displaying/Edit-
ing the parts of a Component name” on page 179.

— See also “Show full Reference designation” on page 355 and “Individual control 
of reference designations with line breaks from Component data” on page 355.
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The tab Reference
In PCschematic ELautomation all symbols can have attached references. For sym-
bols which does not have attached references by default, you will therefore find an 
extra Reference tab in the dialog box Component data.

— Read more about the use of this tab in “References on symbols” on page 375.

Changing Connection data
If you click on the tab Conns., and click in one of the text fields, you can change 
the connection texts for the symbols connection points.

If the connection names are changed in this dialog box, they are set to be visible 
automatically.

This can also be done from the dialog box Connection data, as described in “Sym-
bol Connection points” on page 204.

Changing connection Name from the Component data box
From the dialog box Component data you can edit the symbol connection names 
in two ways:

CONNECTION NAMES WITH VARIABLE PART IN THE SYMBOL DEFINITION

If there exists a variable part in the connection name either in the PINDATA infor-
mation from the database or in the symbol definition — see “Connection data with 



PCschematic ELautomation 10.0 PAGE 183

SYMBOLS

a variable part in the name” on page 675 —, there will exist an extra text field in the 
dialog box Component data.

Here you can type in the variable part of the connection name. If there is a question 
mark, this represents one single character. If there is an asterisk, you can type in all 
of the connection name. This can for instance be applied for terminal symbols. — 
See “Wildcards/jokers” on page 542 for further information about the wildcards ? 
and *.

Please note in the figure above that the connection names ?1 and ?2 are both 
changed to 61 and 62 respectively, when 6 is written in the text field for the variable 
part of the connection name.

When you have selected the text field Variable part of pin name, the buttons 
Count up, Count down, and Next free for automatic counting has effect on this 
text field:

These button functions as described in “Specifying the Component name” on 
page 178.

— Please refer to “Symbols with variable connection names” on page 582 and 
“Connection data with a variable part in the name” on page 675.

EDITING CONNECTION NAMES DIRECTLY FROM THE NAME FIELD IN COMPONENT DATA

You can also change the connection names directly from the Name field in the 
Component data dialog box. If you type in the Name -K1:13,14, the connection 

Type in the variable part, and
the connection names are updated

Click the
+ button
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points are named 13 and 14 respectively. The connection names are changed 
according to the numbering order of the connection points in the definition of the 
symbol. — For further details about this, please refer to “Place connection points” 
on page 673.

If the connection names are changed in the Component data dialog box, they are 
automatically set to be Visible.

The tab Symbol Data
When a symbol is created containing extra datafields — see “Reference designa-
tions for symbols” on page 353 — the tab Symbol Data — will also appear.

Click on the tab Symbol Data and type in the relevant values.

When you place a symbol containing datafields of the type Project data or Page 
data, which does not exist in the project, you will be asked whether to include these 
datafields in the project.

Copying Component data
If you wish to copy component data from one symbol to another, please refer to 
“Transfer component data for Symbols” on page 83.

Collecting information from the database
Information about the symbol can be collected directly from the database, which 
you enter by clicking Database. Here you find the appropriate component, and 
click OK.

When you have selected the symbols for the component from the database, all text 
fields, except the Name field, are filled out with information from the database.

— Read more about this in “Using the database” on page 559.

Attaching Unit drawings to Symbols
If you connect a unit drawing to the symbol, you do this by clicking on Unit. This is 
elaborated in “Attach a symbol on a diagram to the unit drawing” on page 555.
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SUB NAMES ON SYMBOLS

In PCschematic ELautomation sub names on symbols can be handled intelligently.

What is sub names on symbols?
Sub names on symbols are applied where a component contains functions, which 
must be identified separately.

This could for instance be the case for a reversing contactor with two coils, where it 
must be possible to identify which contacts that are controlled by the individual 
coils. The names of the two coils could here be -Q1.Q1 and -Q1.Q2.

Another example could be a push-button with a build-in lamp, where the symbols 
could be named -S1.S and -S1.P respectively.

Specifying sub names on symbols
To specify a sub name for a symbol, do this:

1) Enter the dialog box Component data for the symbol — 
e.g. by double-clicking on the symbol.

2) In the dialog box Component data: Click on Name:

3) In the dialog box Name: Click in the field Sub name, and type in a sub name 
— or use the buttons Count up, Count down, Next free or Used related to 
specify the sub name.

FUNCTIONALLY UNDERSTOOD AS DIFFERENT COMPONENTS

SYMBOLS FOR THE SAME COMPONENT, WHICH HAS DIFFERENT SUB NAMES, 
ARE FUNCTIONALLY UNDERSTOOD AS DIFFERENT COMPONENTS IN THE 
PROJECT, WHILE THEY IN PARTS LISTS ARE UNDERSTOOD AS PARTS OF THE 
SAME COMPONENT.
IF A COMPONENT THEREFORE CONTAINS TWO COILS WITH THE NAMES -Q1.Q1 
AND -Q1.Q2, THESE ARE EACH ASSIGNED THEIR OWN REFERENCE CROSS IN 
THE PROJECT, BUT ARE REPRESENTED AS ONE COMPONENT IN THE PARTS LIST.

2) Click here
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4) Click OK, and click OK in the dialog box Component data.

Sub names can be specified in the database
Sub names can also be specified via the database, as described in “Specifying sym-
bol sub names from the database” on page 588.

Sub names included in lists
Sub names on components can also be included in all electrical lists. For this pur-
pose, all datafields containing a component name, have included the option With 
sub name in the dialog box DataField. — See “Datafields” on page 134.

SUB NAMES CAN ONLY BE SPECIFIED IN THE DIALOG BOX NAME

SUB NAMES CAN ONLY BE SPECIFIED IN THE DIALOG BOX NAME.
THEREFORE, IF YOU WRITE -Q1.1 IN THE FIELD NAME IN THE DIALOG BOX 
COMPONENT DATA, THIS IS UNDERSTOOD AS THE COMPONENT NAME, AND 
NOT AS A COMPONENT NAME FOLLOWED BY A SUB NAME.
BECAUSE OF THIS, THE SUB NAME IS NOT DISPLAYED IN THE NAME FIELD IN 
THE DIALOG BOX COMPONENT DATA.



PCschematic ELautomation 10.0 PAGE 187

SYMBOLS

SYMBOLS WITH STATES

Symbols can be placed with differ-
ent states on the project pages, so 
that the symbols change appear-
ance when their state number is 
changed.

This is only possible for symbols, 
which have been designed with 
different states. — See how to cre-
ate symbols with states in “Creat-
ing symbols with states” on 
page 686.

Select a state for the symbol
When you click to place a symbol 
with a special state in the project, 
you must select the state in the 
Component data dialog box — 
see the figure to the right.

When you subsequently need to 
change the symbol state, enter the Component data dialog for the symbol, select a 
new state, and click OK.

— Please also see “Symbols with states for single line diagrams” on page 478 and 
“Placing symbols with selected states in the pickmenu” on page 200.

Select the state to display
for the symbol
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NAVIGATION BETWEEN SYMBOLS FOR THE SAME COMPONENT

When you have selected a symbol and choose View => Goto symbol — or if you 
right-click on a symbol and choose Goto symbol — you can select which of the 
other symbols for the component to jump to in the project:

In the Goto symbol function, you have the following options:

•Mechanical: Hereby you jump to the mechanical drawing, when such a drawing 
exist. The mechanical symbol for the component is selected, and the cross-
hairs points out the symbol.

•Diagram: The first of the diagram symbols for the component is selected, and 
the cross-hairs points out the symbol.

•Next: The next diagram symbol for the component is selected, and the cross-
hairs points out the symbol.

•Previous: The previous diagram symbol for the component is selected, and the 
cross-hairs points out the symbol.

•Select: Here a menu containing all symbols for the component is displayed. For 
each symbol you see the names of the first two connection points, as well as 
the symbol and page type, the page number and reference designation (if any). 
When you select a symbol in the menu, the symbol is selected in the project, 
and the cross-hairs points out the symbol.

JUMPING BETWEEN SYMBOLS BY CLICKING ON REFERENCES ON THE PAGE

PLEASE ALSO SEE “AUTOMATICALLY UPDATED REFERENCES” ON PAGE 373,  
IN PARTICULAR “AUTOMATIC JUMP BETWEEN REFERENCES ON DOUBLE-
CLICK” ON PAGE 374. HERE YOU SEE HOW TO JUMP BACK AND FORTH 
BETWEEN THE SYMBOLS FOR THE COMPONENT, BY DOUBLE-CLICKING ON REF-
ERENCES PLACED NEXT TO THE SYMBOLS ON THE PROJECT PAGES.
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UPDATING SYMBOLS FROM THE DATABASE

To make sure that e.g. the type texts and/or the connection names for the symbols 
for a component — or for all symbols on a page or in the project — matches the 
given information for the specified EAN numbers in the database, do the following:

1) Select the symbol(s) you wish to update from the database. If no symbols are 
selected, all symbols in the project — or on the selected page — can be 
updated.

2) Choose Functions => Database => Update from Database.

3) You now enter the dialog box Update from Database:

UPDATING SYMBOLS WHEN CHANGING ARTICLE NUMBERS

WHEN CHANGING THE ARTICLE NUMBER FOR A SYMBOL, ALL SYMBOLS FOR 
THE COMPONENT CAN ALSO BE UPDATED FROM THE DATABASE.
— SEE “UPDATE FROM DATABASE WHEN CHANGING SYMBOL ARTICLE NO” 
ON PAGE 244 AND “UPDATE FROM DATABASE WHEN CHANGING ARTICLE 
NUMBER” ON PAGE 179.
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Here you have the following options:

Select the desired settings, and click OK.

OPTION DESCRIPTION

UPDATE ONLY 
COMPONENTS ON 
THE CURRENT PAGE

THIS OPTION IS ONLY DISPLAYED WHEN YOU HAVE NOT SELECTED 
ANY SYMBOLS ON THE PROJECT PAGE.
WHEN YOU SELECT THIS OPTION, ONLY THE SYMBOLS ON THE 
PAGE ARE UPDATED (AS WELL AS ALL RELATED COMPONENTS IN 
THE PROJECT).
WHEN YOU DO NOT SELECT THIS OPTION, ALL COMPONENTS IN 
THE PROJECT ARE UPDATED.

TYPE TEXTS YOU CAN HERE CHOOSE EITHER DO NOT UPDATE, UPDATE MISS-
ING ONLY OR UPDATE ALL.

FUNCTION TEXTS IF YOU IN THE DATABASE SETTINGS HAVE SPECIFIED THAT THE 
PROGRAM SHALL TRANSFER CONTENTS TO THE FUNCTION FIELD 
FOR SYMBOLS, YOU WILL ALSO GET THE OPTIONS DO NOT 
UPDATE, UPDATE MISSING ONLY AND UPDATE ALL FOR FUNC-
TION TEXTS.
(THIS IS SPECIFIED IN SETTINGS => DATABASE => DATABASE 
SETUP => COMPONENT DATA IN THE FUNCTION FIELD — SEE 
“TRANSFERRING ARTICLE DATA TO SYMBOLS AND LINES” ON 
PAGE 593).

UPDATE CONNEC-
TION POINTS

UPDATES ALL CONNECTION POINTS, SO THAT THEY ARE ASSIGNED 
THE CONNECTION POINT NAMES DESCRIBED IN THE DATABASE.

CHECK FOR COR-
RECT SYMBOLS

ISSUES A WARNING FOR EACH PLACE ANOTHER SYMBOL HAS BEEN 
USED, THAN THE ONE SPECIFIED IN THE DATABASE FOR THE ARTI-
CLE NUMBER, AND FOR EACH PLACE THERE E.G. HAS BEEN USED A 
BREAK CONTACT TOO MUCH, COMPARED TO WHICH FUNCTION THE 
COMPONENT CONTAINS ACCORDING TO THE DATABASE.
FOR SECURITY REASONS, YOU SUBSEQUENTLY HAVE TO MAKE 
THE NECESSARY CHANGES MANUALLY.

CHECK FOR 
UNKNOWN ARTICLE 
NO.

ISSUES A WARNING FOR EACH PLACE ARTICLE NUMBERS HAVE 
BEEN USED, WHICH DOES NOT EXIST IN THE DATABASE.
FOR SECURITY REASONS, YOU SUBSEQUENTLY HAVE TO MAKE 
THE NECESSARY CHANGES MANUALLY.

CHECK FOR MISS-
ING ARTICLE NO.

ISSUES A WARNING FOR EACH PLACE NO ARTICLE NUMBERS HAVE 
BEEN SPECIFIED.
FOR SECURITY REASONS, YOU SUBSEQUENTLY HAVE TO MAKE 
THE NECESSARY CHANGES MANUALLY.

OPTIONS FOR UPDATE FROM DATABASE
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4) The type texts for the symbols and/or connection names are now updated, and 
you get a status for the update:

Here you can click on each individual warning in the window, and the pro-
gram points out the symbol in the project. The window remains on the screen 
until you click the Close button in the upper-right corner.
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MOVING AND DELETING PLACED SYMBOLS

In the following it is described how to move and delete symbols in PCschematic 
ELautomation. You can also cut and paste symbols, as described in “Cutting and 
Pasting areas” on page 261.

Deleting a placed symbol
You can delete a placed symbol in two different ways:

a) Deleting a symbol and Redrawing the lines
1) Click on the Symbols button — to start working with symbols.

2) Select the symbol.

3) Click on the Delete button: You are now asked whether to delete all symbols 
with the current symbol name: Answer Yes or No.

The symbol is now deleted, and the line which the symbol was placed on, is now 
closed — if this is possible.

b) Deleting a symbol and Parking the lines
1) Click on the Symbols button —to start working with symbols.

2) Press down <Ctrl> and click the Delete button: You are now asked whether to 
delete all symbols with the current symbol name: Answer Yes or No.

The symbol is now deleted, and the lines which the symbol was connected to, are 
parked.

Click here to close
the lines for all
deleted symbols

a) Click on the
Delete button

b) Press down <Ctrl> and
click the Delete button
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Deleting more than one symbol
You can also delete more than one symbol at the same time, by selecting the sym-
bols at the same time — as described in “Changing symbol names in an Area” on 
page 202 — and then delete them as described above.

Moving a placed symbol
You can move a placed symbol in two different ways:

a) Moving a symbol with Connected lines
1) Click on the Symbols button — to start working with symbols.

2) Click on the symbol, press down the mouse button, and drag the symbol to a 
new location.

The symbol is now moved, and is still connected to the same lines as before.

b) Moving a symbol and Parking the connected lines
1) Click on the Symbols button — to start working with symbols.

2) Press down the <Ctrl> key, and drag the symbol to a new location.

The symbol is now moved, and the lines which it was previously connected to, now 
becomes connected.

Moving more symbols at the same time
You can also move more symbols at the same time by selecting the relevant sym-
bols — as described in “Changing symbol names in an Area” on page 202 — and 
then move them as described above.

Moving symbols with overlapping connection points
When two symbols are placed so that their connection points are connected directly, 
and one of the symbols are moved, a connecting line is automatically drawn 
between the two previously connected connection points.

a) Drag the symbol to
a new location

b) Press down <Ctrl>
and drag the symbol
to a new location
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THE SYMBOL TOOLBAR

When you have selected a symbol, you get information about the symbol in the 
symbol toolbar:

T: The file name of the symbol you last had in the cross hairs

N: The name of the currently selected symbol

S: The scale of the symbol

Automatic naming of symbols
When the Auto Name button is activated, symbols are automatically assigned the 
next available symbol name when placed in the project.

The automatic naming function can also be started/stopped by choosing Functions 
=> Auto Name.

Scaling symbols
If you want to scale one or more symbols up or down, you can 
use Symbol scale. You can scale a symbol by picking a scale fac-
tor from the drop down list and press <Enter>, or type in a value 
and press <Enter>. This can be done either when you have got the symbol in the 
cross hairs, or by selecting the symbol(s), typing in a value and then click the 
Transfer properties button. Symbol scale is rarely used in electrical diagrams (not 
standard).

Read more about scaling symbols in “Symbol settings: Advanced” on page 682.

Mirroring symbols
Select a symbol, click the Mirror symbol vertically button, and the symbol will 
mirrored vertically. Or click the Mirror symbol horizontally button, and the sym-
bol will be mirrored horizontally.

Rotating symbols
By clicking the Rotate symbol button, you can rotate the selected symbol — see 
“Rotating a selected object” on page 80.

Choose symbol type in an area on the screen
When you are working with symbols, and mark up an area on the screen using the 
mouse, you can specify which of the symbols in the area to select. Do the follow-
ing:

1) Choose which type of symbols to select: AUTO (= the most common symbols 
in the area), Symbols (all symbols, which are not wire numbers or signals), 
Signals, Wire numbers or All (all symbols of any type in the area).
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2) Select the area using the mouse, and release the mouse button.

The selected symbols in the area are now selected.

Selecting symbols using Select all or by selecting in areas
When you choose Edit => Select All => Everything on page (short-cut key 
[Ctrl+a]), or when you select symbols in an area, all symbols in the area becomes 
selected, no matter the type.

1) Choose symbol type

2a) Click here
2b)Press down the mouse button and
drag the mouse cursor over the screen

3) The selected type of sym-
bols are selected in the area
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ADAPTING THE PICKMENU

In the pickmenu you can place the symbols you use the most for easy access. Below 
the following aspects are elaborated,

— See how to fetch symbols — and other drawing objects — from the pickmenu in 
“Fetching symbols from the Pickmenu” on page 161.

The pickmenu can also contain line types, text types and arcs. — Read more about 
this in “Lines in the Pickmenu” on page 99, “Texts in the Pickmenu” on page 148 
and “Circles / Arcs in the Pickmenu” on page 125.

Placing symbols in the pickmenu
To place a symbol directly in an empty cell in the pickmenu, you have to have a 
symbol in the cross hairs, and then click inside an empty cell in the pickmenu. You 
can fetch the symbol from either the Symbol menu or from a drawing.

Or, you can right-click inside an empty cell in the pickmenu and choose Place sym-
bol, which brings you into the Symbol menu, where you click your way to the 
symbol you want to place in the pickmenu, and click OK.

Include component data when inserting a symbol in the pickmenu
When you hold a symbol in the cross hairs, and press down <Ctrl> while placing 
the symbol in the pickmenu, the component data is also transferred to the symbol in 
the pickmenu.

Inserting a Symbol / Drawing object in all Pickmenus
To insert one or more drawing object(s) to be displayed 
in all pickmenues, do the following:

THIS CHAPTER DESCRIBES

— PLACING SYMBOLS IN THE PICKMENU................................................................(P. 196)

— PLACING SYMBOLS IN THE PICKMENU WITH COMPONENT DATA .......................(P. 196)

— INSRETING A SYMBOL/DRAWING OBJECT IN ALL PICKMENUS ............................(P. 196)

— CREATING A NEW MENU IN THE PICKMENU ....................................................... (P. 198)

— SPECIFYING COMPONENT DATA IN THE PICKMENU ............................................(P. 199)

— PLACING SYMBOLS IN THE PICKMENU VIA THE DATABASE................................ (P. 200)

— PLACING SYMBOLS WITH SELECTED STATES IN THE PICKMENU ........................(P. 200)

— RIGHT-CLICKING IN THE PICKMENU ...................................................................(P. 200)

Displayed in
all pickmenus

Displayed in selected
pickmenu only
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1) Right-click on the pickmenu, select Properties, and you enter the dialog box 
Pickmenu properties:

2) Set the number of fixed cells, click OK, and the new cell(s) are displayed:

3) Place a new symbol / drawing object in the cell, as described in “Placing sym-
bols in the pickmenu” on page 196 or “Include component data when insert-
ing a symbol in the pickmenu” on page 196.

4) The symbol is now represented in all pickmenues.

Removing fixed cells from the pickmenues
To remove a number of symbols from being displayed in all pickmenues, right-
click on the pickmenu, select Properties, and reduce the number of Fixed Cells to 
desired number of cells. Please note that the right-most fixed cells are removed 
first.

Automatic popup of submenus in the pickmenu
You can specify whether to display a popup menu for symbols with states (see 
“Symbols with states” on page 187) or for symbols with multiple sets of article data 
attached (see “Symbols with multiple sets of data in the Pickmenu” on page 162), 
when you let the mouse rest over the symbol in the pickmenu.

To do this, right-click in the pickmenu, and 
choose Properties. You then enter the dia-
log box Pickmenu properties, where you 
select Automatic popup of submenus.

2) Correct the num-
ber of fixed cells

Place a new symbol
/ drawing object
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Under Popup delay you can specify whether the popup menu appears instantly, 
when the mouse cursor rests over a symbol with states / sets of atricle data, or 
whether to insert a delay before the popup menu appears. To insert a delay has the 
advantage that submenus are not displayed when the mouse cursor just passes the 
pickmenu, in order to make selections in other of the program menus or toolbars.

When Automatic popup of submenus is not activated, 
small buttons are displayed in the pickmenu in the rele-
vant cells. When you click this button, the submenu is 
displayed.

Creating new menus in the Pickmenu
To create a new menu in the pickmenu, do the following:

1) Right-click on a cell in the pickmenu (and not one of the tabs), and select 
Create new Menu.

2) The menu is now created: Right-click on a cell in the pickmenu (and not one 
of the tabs), and select Properties.

3) In the dialog box Pickmenu properties: Name the menu, and click OK.

Deleting a menu
To delete a menu, do the following:

1) Select the menu by clicking on the tab for the menu at the bottom of the pick-
menu.

2) Right-click on a cell in the pickmenu (and not on one of the tabs), select 
Delete Menu, and answer OK to delete the menu.

Click for submenu
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Adding component data to symbols in the pickmenu
You can attach multiple sets of component data to the 
symbols in the pickmenu.

To do this, right-click on a symbol in the pickmenu and 
choose Component Article Data. You then enter the 
Component data dialog box:

Here you have the following options:

Create a new line with component data
Click the Plus button. In the new empty line you can either type in component data 
by clicking in the relevant fields, or click the DB button to enter the Database 
menu to select a component. — You can read more about the Database menu in 
“About the Database menu” on page 563.

When you have filled out a component line in the dialog box, and then click the DB 
button, you are asked whether to overwrite the selected line, when returning from 
the database. You also get the option of choosing Add, to create a new line with 
component data.

Deleting a line with component data
Click on the line you wish to delete, and then click the Minus button.

Multiple symbols of the same kind in the pickmenu
Placing multiple symbols of the same kind in the pickmenu, is also an option. When 
you place a symbol which exists in the pickmenu already, you are informed about 
this.

When you let the mouse cursor rest over one of the symbols in the pickmenu, the 
symbol title is displayed both below the symbol (as a hint), and at the bottom of the 
screen.
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Placing symbols in the pickmenu using the database
It is also an option to place a symbol in the pickmenu using 
the database. When you right-click on an empty cell in the 
pickmenu, and choose Place symbol, you enter the Symbol 
menu, where you click on the Database button in the dia-
log box.

You now enter the database, where you choose the desired 
component, and click OK. The symbol and its attached 
component data is hereby being transferred to the pick-
menu.

If the component contains more than one symbol, the first 
of its symbols is placed in the pickmenu. — See “The func-
tion Show available” on page 245.

Placing symbols with selected states in the pickmenu
You can also place symbols, with a specified state selected, in the symbol toolbar. 
To transfer the selected state to the symbol toolbar, press down <Ctrl> when click-
ing the symbol in the symbol toolbar.

— Read more about symbols with states in “Symbols with states” on page 187 and 
“Creating symbols with states” on page 686.

Right-clicking in the pickmenu
To the left in the pickmenu title bar the name of the menu is 
displayed. To the right there are two arrows, with which you 
can scroll back and forth between the various pickmenus.

If the active pickmenu contains more symbols than can be 
shown at a time, there will also be a scroll bar at the bottom 
of the pickmenu.

Insert new cell
Right-click on a filled out cell in the pickmenu, choose 
Insert Cell, and an empty cell is inserted where you right-
clicked.

Delete cell
Right-click on a cell and choose Delete Cell. The cell is now deleted. This goes for 
empty cells as well cells containing symbols.

Create new menu
Right-click on the pickmenu, and choose Create new Menu.

Give a menu a title
Right-click and choose Properties, and type in a title for the active pickmenu. Here 
you can also determine the size of the pickmenu on the screen. Click OK. The title 
can be seen after the number of the pickmenu.
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Go to a specific pickmenu
Right-click and choose Go to Menu. You now get a survey of the menus, contain-
ing their numbers and titles. Click on the menu you wish to use.

Delete a menu
Right-click and choose Delete Menu. The displayed pickmenu — and all of its 
symbols — will be deleted.

Information about the symbol
Right-click on the symbol in the pickmenu and choose Symbol information.
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CHANGING SYMBOL NAMES IN AN AREA

Changing more than one symbol name
When you want to change more than one symbol name at the same time, you can 
select the symbols by dragging a window around them, right-click inside the 
selected area, and choose Component data.

You then enter the Component data dialog box.

In the Component data dialog box you apply the automatic counting facility by 
typing in the name of the first symbol, pressing <Ctrl> while clicking on ?, and 

THIS CHAPTER DESCRIBES

— CHANGING MORE THAN ONE SYMBOL NAME .....................................................(P. 202)

— THE NAMING ORDER OF SYMBOLS......................................................................(P. 203)

— OTHER OPTIONS..................................................................................................(P. 203)
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then click OK. — Please refer to “Automatic counting in the Component data dia-
log box” on page 178 for further details.

The symbol names are now changed. Click outside the selected area to deselect the 
symbols.

The naming order of the symbols
It is important how you select the symbols. If you click in the left-hand side of the 
screen, and then drag a window to the right, the numbering of the symbols will be 
carried out from left to right.

If you select the window from right to left, the symbol names are named from the 
right to the left. Thus, the counting direction follows the movement you make when 
you select the window.

If you select the symbols by <Ctrl>-clicking, the symbols are named in the order 
you selected them.

Other options
See how to do the same for connection points in “Choosing connection points in 
Areas” on page 206.

You can also change the symbol texts directly on the diagram page, as described in 
“Editing the symbol texts directly on a Diagram page” on page 132.

Other advanced ways to change texts directly on diagrams are described in “Lock-
ing text types” on page 142 and “Counting on texts” on page 143.
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SYMBOL CONNECTION POINTS

Connection points for symbols can be selected
The connection points for the symbols can be 
selected as well as the symbols themselves.

On the figure to the right, a connection point 
of a terminal symbol is selected.

Specifying Connection data
If you right-click on a symbols connection 
point and then choose Connection data, you can change the connection data for 
the connection point — e.g. the connection name.

— If you accidentally select the whole symbol, and not just the connection point, 
just right-click on the connection point again.

In this dialog box you can type in connection data, and specify which connection 
point texts is visible on the diagram. The connection point texts are described in 
“Connection point texts” on page 133.

THIS CHAPTER DESCRIBES

— CONNECTION POINTS FOR SYMBOLS CAN BE SELECTED.....................................(P. 204)

— SPECIFYING CONNECTION DATA.........................................................................(P. 204)

— EDITING CONNECTION TEXTS FROM COMPONENT DATA DIALOG BOX............... (P. 205)

— EDIT NEXT/PREVIOUS FOR CONNECTION POINTS...............................................(P. 205)

Symbol name Connection name
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The Visible setting only applies for the selected connection 
point. The texts are only visible if they are allowed to be so by 
the over-all visibility settings for connection texts. Please 
refer to “Texts displayed in the project (general setting)” on 
page 150 for further details.

The function of the four buttons in the dialog box, is described 
in “Specifying the Component name” on page 178.

With reference
— See “With reference” on page 675.

No dot generation
— See “No dot generation” on page 675.

Connection data as Info Tips
When the cross hairs is placed above a connection point, the connection data for the 
connection point is displayed as an Info Tip.

Connection name displayed in the toolbar Symbols
When a connection point is selected, the connection name is 
displayed in the symbol name field in the toolbar Symbols. 
This also applies for invisible connection names.

Editing connection texts from the Component data box
When you click on the Conns. tab in the Component data dialog box, you can edit 
the connection texts by clicking in the relevant fields, and then type in the texts. — 
Please refer to “Changing Connection data” on page 182.

Edit Next/Previous for Connection points
When you have selected a connection point, you can jump back and forth between 
the connection points for the same symbol, by pressing [F5] and [F6] — or by 
choosing Edit => Next or Edit => Previous. You jump between the connection 
points according to their connection numbers.

The function also applies for symbol texts.
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CHOOSING CONNECTION POINTS IN AREAS

When you have activated the Symbols function, start dragging a window around an 
area and press <Ctrl> when releasing the mouse button, you select the connection 
points in the area. The symbols in the area are not selected.

If you press <Ctrl> and click on connection points outside the area, these will also 
be included. If you press <Ctrl> and click on a selected connection point, it 
becomes deselected.

When you have selected an area and deselected the unwanted connection points — 
as displayed above — you right-click inside the area and choose Connection data.

Then apply the automatic counting facility 
by typing in the first Name (1), pressing 
<Ctrl> while clicking on +, and then click 
OK. The selected connection points are then 
renumbered automatically.

— Please refer to “Automatic counting in the 
Component data dialog box” on page 178 for 
further details.

Then rename the remaining connection 
points one by one.

Numbering order for <Ctrl> click
If you select the connection points one by 
one by pressing <Ctrl> while clicking on the 
connection points, they will be renumbered 
according to the order in which you selected 
them.

Select the connection points by
pressing <Ctrl> when you release
the mouse button

Press <Ctrl> and click on the
unwanted connection points
in the area
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PINSWOP

Letting the connection points of symbols swop places is an option, under the name 
pinswop. This can be done within the same symbol, as well as between symbols.

Pinswop for symbols with two connection points
To perform a pinswop on a symbol with two connec-
tion points, you first click the Symbols button, and 
right-click on the symbol. Then choose Pinswop, and 
the two connection points of the symbol swop places.

Pinswop in Areas for symbols with two connection points
To perform a pinswop on all symbols with two connection points within an area, 
you also click on the Symbols button first, select an area, and right-click within the 
area. Then choose Pinswop, and the connection points of all symbols with two con-
nection points within the area swop places.

In this way you can for instance easily change a terminal row, from having the out-
put side turning upwards to downwards. — Please refer to “Creating Terminal sym-
bols” on page 691 for further details about the input- and output side of terminals.

The connection points in the area for the symbols not having two connection points 
are left unchanged.

The function can also be activated by choosing Edit => Pinswop.

THIS CHAPTER DESCRIBES

— PINSWOP FOR SYMBOLS WITH TWO CONNECTION POINTS ..................................(P. 207)

— PINSWOP IN AREAS FOR SYMBOLS WITH TWO CONNECTION POINTS ..................(P. 207)
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— MOVING CONNECTION POINTS ............................................................................(P. 208)
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Free Pinswop
Swopping connection points between symbols, and 
within symbols having more than two connection 
points, is also an option.

To do this, you also have to activate the Symbols 
button. Then right-click on one of the two connec-
tion points, you want to swop places.

Now choose Pinswop, and you get a rubber band 
in the cross hairs. Then click on the connection 
point you want to swop with, and the connection 
points swop places.

Please note, that this swopping can be performed 
within the same symbol, or from one symbol to 
another.

Moving connection points
To move a connection point, do this:

1) Activate the Symbols button, right-click on 
the connection point, and choose Move.

2) You now get the connection point in the cross hairs: Click where you wish to 
place the connection point.

When you move connection points on symbols, connected lines are moved also.

DO NOT MOVE CONNECTION POINTS ON STANDARD SYMBOLS

THE POSSIBILITY TO MOVE CONNECTION POINTS IS DESIGNED FOR SPECIAL 
PURPOSES, SUCH AS BLOCK SYMBOLS.
CONNECTION POINTS CAN NOT BE MOVED OUTSIDE THE FRAME OF THE SYM-
BOL (DISPLAYED WHEN SELECTING SYMBOLS).
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REPLACING SYMBOLS

Replacing symbols automatically
Automatic replacing of all occurrences of a symbol in a project is also an option.

If you decide to use e.g. an open contact instead of a close contact, you can replace 
the symbols in the project.

To do so select one of the open contacts, and choose Functions => Replace sym-
bol (short-cut key [F4]). You then enter the following dialog box:

When you enter the dialog box, it is presumed that you wish to keep the contents/
value of the symbol texts from the old symbol, while the positions of the texts fol-
lows the text-positions for the new symbol.

The symbol text Value when replacing
When you set a check mark for a Value for some of the texts for the present symbol, 
these texts are not replaced when you change symbol.

THIS CHAPTER DESCRIBES

— REPLACING SYMBOLS AUTOMATICALLY ............................................................(P. 209)

— CONNECTION POINTS WHEN REPLACING SYMBOLS.............................................(P. 211)

— TEXT PROPERTIES WHEN REPLACING SYMBOLS ..................................................(P. 211)

— REPLACING OLDER VERSIONS OF SYMBOLS........................................................(P. 211)

Click here to re-
place all symbols

Choose a symbol
in the Symbolmenu

Click here to select
the symbol

Click here to keep
the position of the
function text

in the project or
on the page

http://www.dps.dk/english/Video/Product_videos.htm
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The symbol text Position when replacing
You can for instance enable Position for the function text of the present symbol. 
This ensures you, that the location and the orientation of the function text remains 
unchanged, even though you change symbol.

The symbol text Visibility when replacing symbols
Likewise you can specify whether the selected Visibility shall remain unchanged 
for the new symbol, or whether the visibility shall be specified by the symbol defi-
nition for the new symbol. — By keeping the visibility for the original symbol 
when replacing terminal symbols, you can therefore avoid having to change the vis-
ibility for the names of the terminal symbols after the replacement.

Replace all symbols in the project or on the page
Select Replace all in project in order to replace all symbols, of the selected type, in 
the project. If you wish to replace all symbols of the selected type on the active 
page in the project, select Replace all on page.

If you do not select any of these options, only the selected symbol will be replaced.

Selecting a new symbol
Click on Select at the bottom of the dialog box, to choose which symbol you wish 
to use instead.

You then enter the Symbol menu, where for instance you choose the symbol 07-
07B02.

Click OK. — See “Fetching symbols using the Symbol menu” on page 165.

You now return to the dialog box Replace Symbol, where you click OK.

The symbol(s) have now been replaced in the project.

— Please note, that it is possible to undo the replace symbol function.

1) Find the EN60617

3) Click on the symbol

2) Type in fx. 07-07B02

4) Click OK
folder
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Connection points when replacing symbols
If the connection points of the old and the new symbol are not placed on identical 
positions, you get a warning:

Click OK. However, you can still choose to replace the symbol(s) by clicking OK 
in the Replace Symbol dialog box.

If the new symbol has less connection points than the old one, you get an error mes-
sage. If the new symbol has more connection points, this will be accepted when it 
has connection points on the same locations as the old one.

Transferring connection point texts when Replacing symbols
For symbols with just one connection point, the Replace symbol function also 
transfers connection point texts from the old symbol to the new symbol, when these 
connection points does not have the same position.

When the symbols have more than one connection point, and some of these connec-
tion points does not have the same positions, the connection point texts are trans-
ferred when the connection points are created with the same name in the symbol 
libraries.

Text properties when replacing symbols
The text properties for the symbol texts follows the definition of the new symbol.

Replacing older versions of symbols
Using the Replace symbols function you can replace all the old versions of the 
project symbols. You can see that a newer version exists of a symbol, if it has a 
question mark (?) in its symbol file name.

YOU ONLY GET THIS WARNING WHEN THE CONNECTION POINTS ARE CON-
NECTED ELECTRICALLY. WHEN YOU CLICK OK THE NOT MATCHING CONNEC-
TION POINTS ARE PARKED.
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AUTOMATIC CREATION OF SYMBOLS

In PCschematic ELautomation it is possible to create rectangular and circular 
symbols automatically, by entering their dimensions. This can both be done "on the 
fly" while working on a project, and by specifying the symbol dimensions via the 
database.

When you want PCschematic ELautomation to generate symbols for you automat-
ically, while working on a project, you can do this in two ways:

a) Using the Symbol generator: Read “Automatic generation of symbols — 
using the Symbol generator” on page 212. (If you enter the Symbol gener-
ator this way, you can furthermore save the symbol, and continue working on 
the symbol, as described in “Creating Symbols” on page 670).

b) By manually typing in the syntax for the appearence of the symbol: Read 
“AUTOMATIC CREATION OF ELECTRICAL AND MECHANICAL SYMBOLS - BY SYNTAX” ON 
PAGE 214.

Automatic generation of symbols — using the Symbol generator
You can enter the Symbol generator in two ways:

a) Select Symbols, and press [k]. In the dialog box Place symbol: Select Acti-
vate Symbol generator and click OK.

b) Select Symbols, click the Symbol menu button, and click the Symbol gener-
ator button.

You now enter the Symbol generator.

THIS CHAPTER DESCRIBES

— AUTOMATIC CREATION OF SYMBOLS — USING THE SYMBOL GENERATOR .......(P. 212)

— AUTOMATIC CREATION OF SYMBOLS — BY SYNTAX ........................................(P. 214)

— SYNTAX FOR DIRECT CREATION OF SYMBOLS ....................................................(P. 215)

— AUTOMATIC CREATION OF ELECTRICAL SYMBOLS FROM THE DATABASE .........(P. 216)

— AUTOMATIC CREATION OF MECHANICAL SYMBOLS FROM THE DATABASE .......(P. 216)
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Options in the Symbol generator
In the Symbol generator you specify the design of the symbol. In the window in 
the top-right corner of the dialog box, you can see the symbol, based on the present 
settings. The syntax for the generated symbol is displayed in the title bar for the 
dialog box:

SELECT RECTANGULAR OR CIRCULAR

At the top of the dialog box, you select whether to create a Rectangular or a Circu-
lar symbol, and specify Width/Height or Radius.

LINE COLOR AND FILL COLOR

Under Line color, you select which color to use for the lines in the symbol. If you 
select Filled, you can also select a fill color.

CONNECTIONS: NUMBER, NAMING AND POSITION

You can place connec-
tions to the symbol on 
the top, at the bottom, 
and at the right and the 
left side of the symbol.

All of these places, you 
can either specify a 
number of connections 
(which names the con-
nections 1,2,3,...), or specify the names by typing in a name list. — Please remem-
ber to see the selected connections in the upper-right corner of the dialog box.

Here the syntax for the gene-
rated symbol is displayed

Here the symbol is displayed
based on the specified settings
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SPECIFYING A DESIGN CHARACTER

In the right side of the dialog box, you can specify 
a designation character for the symbol. Please 
note that it is not necessary to place a dash (-) 
before the symbol name, because the program can 
handle this for you automatically for all symbols 
in the project. — See “Preceding “-” in symbol 
names” on page 356.

ELECTRICAL OR MECHANICAL SYMBOL

By default the symbol is created as an electrical 
symbol, but if you select Mechanical symbol, it is 
created as a mechanical symbol.

Beyond the different properties connected to 
these two different types of symbols, the texts are 
placed and oriented differently for the two sym-
bol types.

POSITION OF CONNECTIONS

Under Position of connections you can choose 
between:

- Inside symbol: The connections are placed on the symbol, and the connection 
texts are placed inside the symbol.

- Outside symbol: The connections are placed on the symbol, and the connection 
texts are placed outside the symbol.

- Outside with lines: The connections are placed outside the symbol, with con-
necting lines to the connections. You can specify the length of the connecting 
lines in the field Line length.

Automatic creation of electrical and mechanical symbols - By syntax
When you need to create a simple symbol quickly, do the following:

1) Click the Symbols button, and press the [k] button. The dialog box Place 
Symbol is displayed:
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2) Type in the dimensions of the symbol, and the 
number of connection points — see “Syntax for 
automatic creation of symbols” on page 215.

3) Place the symbol in the project, and you enter 
the dialog box Component data.

4) Specify the component data — for instance just 
the symbol name — and click OK.

You have now created a symbol, which you have 
placed directly in the project.

Symbol type for automatically created symbols
Symbols, which are created automatically, are assigned the symbol type Normal.

SYNTAX FOR AUTOMATIC CREATION OF SYMBOLS

Two types of symbols can be created directly: Circle- and Box symbols.

Circle symbols
When you type #r40mm, the program creates a circle with radius 40 mm as a sym-
bol.

Box symbols
To create a box symbol with the dimensions 20x30 mm, type #x20mmy30mm.

Specifying connection points
To assign two connection points to the left and to the right, add l2r2 after the physi-
cal dimensions of the symbol. The letter l stands for "left", the letter r stands for 
"right".

To assign two connection points on each side of the symbol above, you must there-
fore write #x40mmy50mml2r2.

When you write l2, the counting is done top-down. If you write l-2, the counting is 
done bottom-up.

Accordingly, you can write t for "top" and b for "bottom". If you also wish to spec-
ify the connection point names, you can write these in brackets in stead of the 
number of connection points.

ACCORDING TO IEC / EN STANDARDS

WHEN YOU GENERATE SYMBOLS AUTOMATICALLY ON ELECTRICAL PAGES, 
THE IEC / EN STANDARDS FOR PLACING TEXTS ARE APPLIED AUTOMATI-
CALLY.
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Thus you can write #x40mmy50mmt(13,21)b(14,22). Hereby you get a symbol 
with the dimensions 40x50, with the connection points 13 and 21 on the top, and 
the connection points 14 and 22 at the bottom.

Connecting line for connection points
To place a 2,5mm connecting line to the connection 
points in the symbol, add a "-" to the end of the format 
string.

E.g.: #x40mmy20mmt2b2-

All connection points are hereby assigned a 2,5mm 
connecting line.

Placing the connection point names
If you take no special action, the connection point names are placed outside the 
symbol. When you want these to be placed inside the symbol, write i at the end of 
the text. If you write #x10mmy20mml2r2i, you get a symbol with two connection 
points to the left and two to the right, where the connection point names are placed 
inside the symbol.

For symbols placed on mechanical pages, the names are typically placed inside the 
symbol, while they are typically placed on the outside for symbols on electrical 
pages.

Automatic creation of Electrical symbols via the Database
To create a symbol directly from the database, type in the symbol dimensions in the 
PCSTYPE field for the component.

Read more about the syntax in “Syntax for automatic creation of symbols” on 
page 215.

Automatic creation of Mechanical symbols via the Database
To any component in the database, you can attach a mechanical symbol. The name 
of the file you have saved this symbol in, you can write in the MECTYPE field.

Creating a Mechanical symbol automatically
When you wish PCschematic ELautomation to automatically create a symbol with 
the dimensions 30x50 mm, you must write #x30mmy50mm in the MECTYPE 
field. If you in stead write #r40mm, the program creates a circle with radius40 mm 
as a mechanical symbol. Read more about this in “Syntax for automatic creation of 
symbols” on page 215.

— Read more about mechanical symbols in “Mechanical symbols” on page 586.
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SHOW NET

If you right-click on a connection point of a symbol — or on a signal symbol — and 
choose Show net, you can see which symbols are connected to the same potential.

It is also specified which connection points on the symbols are connected to the 
potential, and the position of the symbols are also displayed.

After the name of the net, the wire numbers in the net are displayed in brackets, in 
the title bar of the dialog box.

If you double-click on one of the lines, you return to the diagram, and the cross 
hairs point out the location of the connection point of the chosen symbol.

Generate connection lists
To generate a connections list file, choose Lists => Connection List File.

— Read more about generating list files in “Exporting List Files” on page 625.

— See also “Connections list for wire numbering” on page 409.

Wire numbers in the net
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SIGNAL SYMBOLS

What is a signal symbol
A special kind of symbols are called signal symbols. They are used when you start 
or end a conducting line on a non electrical point in a diagram, or simply wish to 
name an electrical potential for easy identification.

A signal symbol can be placed in all electrical points, and the signal symbol speci-
fies an electrical connection.

All signal symbols with the same name are connected electrically
To identify an electrical connection from a point, you place a signal symbol, and 
assign a name to this symbol.

The program views all signal symbols with the same signal name as the same elec-
trical connection (potential). This means that all signal symbols for instance using 
the name L1 are connected electrically.

Please note that it is only the name of the potential, that identifies the electrical con-
nection. This means that you can use the signal symbol itself for different poten-
tials, if only you remember to assign different names to the signal symbols.

— See “Automatic insertion of electrical potentials” on page 102.

THIS CHAPTER DESCRIBES

— WHAT IS A SIGNAL SYMBOL ...............................................................................(P. 218)

— THE APPEARANCE OF SIGNAL SYMBOLS.............................................................(P. 219)

— DESIGNING SIGNAL SYMBOLS............................................................................. (P. 219)

— PLACING SIGNAL SYMBOLS WHEN DRAWING LINES ........................................... (P. 219)

— SIGNAL SYMBOLS WITH REFERENCE DESIGNATIONS ..........................................(P. 222)

— PLACING SIGNAL SYMBOLS ON PARKED LINES...................................................(P. 223)

— PLACING SIGNAL SYMBOLS DIRECTLY................................................................(P. 223)

— VARIANT NAMES ON SIGNAL SYMBOLS ..............................................................(P. 224)

— INSERT REFERENCE DESIGNATIONS ON SIGNALS AUTOMATICALLY ...................(P. 225)

— UNREFERRED SYGNAL SYMBOLS........................................................................ (P. 225)

— IMPLIED SIGNALS FOR TERMINALS AND CABLES ................................................(P. 226)
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The appearance of signal symbols
Signal symbols can for instance look 
like this:

Various types of signal symbols are 
located on the symbol folder, in the sub 
folder MISC.

To distinguish the signal symbols from 
other types symbols, they all have 
names starting with SG.

Designing signal symbols
See how to design your own signal 
symbols in “Creating Signal Symbols” 
on page 710.

Placing signal symbols when drawing lines
Activate the Pencil, click on Lines, and make sure the Conducting lines button is 
activated (Highlighted).

Then click on the diagram where you want the signal symbol to be located.

You now enter the dialog box Signals:

Parking
If you wish to wait to connect the conducting line, you can park the line. To do this 
click on Parking, and then click OK. Hereby you get a conducting line with no 
electrical connection.

However, this is a temporary solution only, which gives you the option to return 
later on, and then assign a name to the signal.

— See how to locate parkings in a project in “Design Check” on page 328.
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Placing the signal symbol
If you, on the other hand, wish to place a signal symbol, click on Signal.

SPECIFY SIGNAL NAME

In the field Signal name you can either type in a name, or use one of the following 
options:

You can also click on the down-arrow in the field Signal name. This gives you the 
option to choose between predefined signal names.

— See the section “Frequently used signal symbol Names” on page 713 to see how 
you can add names to this list by yourself.

BUTTON FUNCTION

INCREASE THE NUMBER IN THE SIGNAL NAME BY 
ONE.

DECREASE THE NUMBER IN THE SIGNAL NAME BY 
ONE.

GIVES YOU THE NEXT AVAILABLE SIGNAL NAME OF 
THE SYMBOL TYPE CHOSEN.

GIVES YOU A LIST, WHERE YOU CAN CHOOSE 
BETWEEN THE SIGNAL NAMES ALREADY USED IN THE 
PROJECT.

GIVES YOU A LIST OF USED VARIANT NAMES FOR THE 
SELECTED SIGNAL SYMBOL — SEE “VARIANT NAMES 
ON SIGNAL SYMBOLS” ON PAGE 224.

BUTTONS IN THE SIGNALS MENU
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SELECT SIGNAL SYMBOL

When you click the up- and down-arrow in the Signal symbol field in the right hand 
side of the dialog box, you can scroll between the signal symbols that are known to 
the system. The chosen symbol will then be shown in the dialog box.

— See how to place signals in this menu in the section “Frequently used signal 
symbols” on page 712.

ROTATE OR MIRROR THE SIGNAL SYMBOL

Below the symbol itself, you can click the buttons Mirror vertically or Rotate to 
mirror or rotate the symbol.

SIGNAL SYMBOLS FOLLOWING THE LINE DIRECTION

When you select Place in line direction, the signal symbol will follow the direction 
of the line. When you also select Place name on line, the name of the signal sym-
bol will be displayed above the line. The program memorizes the selected settings 
for the different signal symbols in the project — for up to 25 different signal sym-
bols.

PAGE REFERENCES ON SIGNAL SYMBOLS

In With reference you can assign the symbol reference texts, that refers to the other 
places the same signal symbol is being used.

SIGNAL NAMES ASSIGNED FROM FUNCTION TEXT / IO ADDRESS

WHEN YOU START A LINE FROM A CONNECTION POINT, AND LET IT END WITH 
A SIGNAL, AN EXTRA BUTTON IS DISPLAYED IN THE SIGNALS DIALOG BOX. 
WHEN YOU CLICK THIS BUTTON, THE SIGNAL NAME IS FETCHED FROM THE 
FUNCTION TEXT FROM THE CONNECTION POINT, FROM WHICH THE LINE 
STARTED:

WHEN THE LINE STARTS FROM A PLC CONNECTION POINT — AS IN THE FIG-
URE ABOVE —, YOU CAN THEREFORE EASILY ASSIGN THE ADDRESS FOR THE 
PLC CONNECTION TO THE SIGNAL NAME. THE SHORT-CUT KEY FOR THIS 
FUNCTION IS <ALT+S>.
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Selecting Show from/to sets references to the nearest previous and to the next fol-
lowing page on which the same signal name occur.

Clicking on Show all will show references to all places the same signal name 
occurs. The program can handle references of an unlimited length.

When you select Show all and In Column, you can specify the maximum number 
of references in each column in the field Max. Number of references pr. column.

If you click in the field Reference text, you can type in the reference text, that will 
be displayed in front of the reference — such as Page_.

REFERENCE DESIGNATIONS ON SIGNAL SYMBOLS

When you wish to include reference designations in the signal name, you can do 
two things:

a) Click on Select, and you get the option of selecting references via the dialog 
box Reference designations, as described in “Reference designations for 
symbols” on page 353, or:

b) Click on the button Insert current page Function/Location aspect for the 
fields Function and/or Location. This assigns the function/location aspect to 
the signal name.

If you click the Delete button for the fields Function / Location, the displayed 
function/location aspect is deleted.

If you click on Show full Reference designation, the full reference designation is 
displayed for the symbol. If not, only parts of the reference designation different 
from the page reference designation, are displayed.

CLICK OK WHEN THE SETTINGS ARE OK
When you are contempt with the settings, click OK, otherwise click Cancel.
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Placing signal symbols on parked lines
To get the signal symbol in the cross hairs, click the Symbols button, and fetch a 
signal symbol — just like you would fetch any other symbol. Read more about this 
in “Fetching symbols” on page 160.

When you have the signal symbol in the cross hairs, you can place it on a parked 
line. — See “Parking” on page 219.

When you click on the parking point on the drawing, you enter this dialog box:

Because you have already selected a signal symbol, you are not asked about this 
here. Fill out the dialog box following the guidelines given above.

Placing signal symbols directly
You can place a symbol in the cross hairs — for instance via the Symbol menu — 
and place it by clicking on the page. This makes you enter the Signal data menu, 
which you fill out and click OK.

The program now automatically activate the Lines command, and you get a line in 
the cross hairs, starting from the signal symbol.

If you delete the line later on, the signal symbol remains on the page.

Signal symbols can also be placed directly on the connection point of a symbol, or 
on a conducting wire.
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Variant names on signal symbols
PCschematic ELautomation handles variant names on signal symbols:

What are variant names on signal symbols used for?
Variant names on signal symbols are applied for specifying branches of the same 
signal.

This being for instance the source point from which three signals with the name L1 
branches off. These three branches can for instance be named L1:1, L1:2 and L1:3.

The program sees these as the same signal.

Furthermore, the signal flow follows the variant names. You can change variant 
name on a page, where for instance the name in the left-hand side is L2:4 and in the 
right-hand side is L2:5. — See the figure below.

This makes it possible to keep track of the signal flow.

This supports the correct automatic placing of wire numbers for signals, and can 
make the diagrams mounting correct, with respect to signals.

Comments on variant names
Comments can be attached to variant names, as for instance L1:1 (230 VAC).

Reference to
other project
page (double-
click to jump)

Supply panel

Using Variant names, you can follow the signal branches in the project



PCschematic ELautomation 10.0 PAGE 225

SYMBOLS

Show signal
When you select Functions => Show signal, you enter a dialog box from where 
you select a signal name according to the same principle as described in “Find all 
symbols with identical names” on page 248.

When you have selected a signal name and click OK, the selected signal is dis-
played in green on all project diagram pages, while everything else is displayed in 
red.

To deselect the function, choose Functions => Show signal again.

Insert Reference designations on Signals automatically
When you wish to let PCschematic ELautomation insert reference designations on 
signal symbols automatically, choose Settings => Project data => Reference des-
ignations, and select Insert Reference designations on Signals.

When you place signal symbols on pages with assigned reference designations, the 
signal symbol will then get these reference designations.

When you place signal symbols in areas with assigned reference designations, the 
signal symbol will then also get these reference designations.

Insert Reference designations on Signals is by default not selected when installing 
the program. You can always place reference designations manually.

Unreferenced signal symbols
If you wish to set all unreferenced signal symbol in the project invisible, just 
choose Functions => Special Functions => Set unreferenced signal symbols 
invisible.

— See also “Unreferenced cable symbols” on page 238.

SIGNAL NAMES WITH REF. DESIGNATIONS ACCORDING TO EN61346
A SEMICOLON (;) IS AUTOMATICALLY PLACED BETWEEN SIGNAL NAMES AND 
REFERENCE DESIGNATIONS, AS PRESCRIBED IN EN61346.
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Implicit references for connection points on  terminals and cables
In some cases references/connections between connection points will be implicit:

Implicit signals for terminals only connected on the internal or external side
When two terminal symbols with the same names and the same connection names, 
both connection points have activated With reference, and both are only connected 
in one end, they are understood as two representations of the same symbol.

References will automatically be displayed for the connection points:

The terminal symbols in the figure above are understood as representations of the 
same symbols, because:

1) They have same connection names (1U2, 1V2 and 1W2) for the same termi-
nals (=G1+A2-X4)

2) With reference is activated for the connection points on the terminal symbols, 
and

3) Both sets of terminals are only connected in one end

Understood as the
same symbols

References are
inserted

To select multiple connection points:
Remember to press <Ctrl> before
releasing the mouse button

Set With reference on the
connection points for both
rows of terminals
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Implicit signals on cable wires
When two cable symbols with the same names and the same cable wire names, and 
the cable wire connection points for both cables have activated With reference, and 
the cable wire connection points for both cables are only connected in one direc-
tion, the cable wires for the symbols are understood as two representations of the 
same cable wires for the same symbol.

The cable wires in the figure above are understood as the same symbols, because:

1) They have the same cable wire names (BN, BK and BU) for the same cable 
(=G1+A2-W1)

2) With reference is activated for the cable wire connection points for both of 
the cable symbols, and

3) Both sets of cable wires are only connected in one direction

Understood as the
same cable wires

Inserted

Set to With reference
on the connection points
for both cables
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TERMINAL SYMBOLS

When you place terminal symbols, you indicate which connection points are input, 
and which are output for the terminal. This is important when you fill out the termi-
nals lists of the project. — Read more about terminals lists in “Creating a Terminals 
list” on page 736.

— See “Multi layer terminals” on page 229 also.

Input and Output on terminal symbols
On the terminal symbol itself, the output con-
nection point is solid red.

If you want to change whether a connection 
point is input or output, you click the Symbols 
button, right-click on the connection point, and 
choose Connection data.

Clicking on the down-arrow in the Main type 
field in the Connection data dialog box, ena-
bles you to choose whether the connection point is of the type input or output — or 
ext/output, ext/input, int/output or int/input for terminals with additional status 
PLC, which you can read more about in “Creating terminal symbols with an addi-
tional status” on page 693, “Terminal symbols with additional status PLC” on 
page 694 in particular.

For terminals Extension is set to TERM — or to TERM/PLC, see “Creating termi-
nal symbols with an additional status” on page 693, “Terminal symbols with addi-
tional status PLC” on page 694 in particular.

If you accidentally select the entire symbol instead of the connection point, then 
right-click on the connection point once more.
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Changing connection names for terminal rows
See “Renumbering pinnumbers for a terminal row using Select name” on page 251.

Designing terminal symbols
See how to design terminal symbols in “Creating Terminal symbols” on page 691.

MULTI LAYER TERMINALS

On multi layer terminals
In order to handle multi layer terminals, an extra column have been added in the 
component grouping named Pos.no., that specifies which layer on the terminal the 
terminal symbol refers to.

— See “Component Grouping” on page 549.

Multi layer terminals on diagram pages
When a multi layer terminal with more than one terminal symbol is placed via the 
database, the first placed symbol from the database pickmenu is assigned Pos.No. 
1. The next placed is assigned number 2 etc.

THIS CHAPTER DESCRIBES

— ON MULTI LAYER TERMINALS.............................................................................(P. 229)

— MULTI LAYER TERMINALS ON DIAGRAM PAGES .................................................(P. 229)

— MULTI LAYER TERMINALS ON MECHANICAL PAGES ...........................................(P. 230)

1

2
3

The numbers marks
the order in which the
symbols are placed
- and thereby their
assigned Pos.No.
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The position numbers can be specified/changed in Functions => Component 
Grouping.

Multi layer terminals on Mechanical pages
The connection point having the connection number 1 on the mechanical symbol, is 
assigned the connection number from the connection point having Pos.No. 1 on the 
symbol on the diagram.

1

2 3

Pos.No. 1

Pos.No. 2

Pos.No. 3

Terminal symbols
on electrical diagram

Definition on
Mechanical symbol

Mechanical symbol
in the project



PCschematic ELautomation 10.0 PAGE 231

SYMBOLS

WORKING WITH CABLE SYMBOLS

This section deals with how to apply cable symbols on your diagrams.

The database in PCschematic ELautomation can contain information about cable 
wire names. If you are using the database, the names of the cable wires can there-
fore be supplied automatically.

When you work with cables you enter different dialog boxes when selecting the 
cable wires, depending on whether the system has cable wire names for the cable or 
not.

You can find cable symbols in the pickmenu, and by opening the folder MISC from 
the Symbol menu. In the database, you will find cables in the folder Flexible 
cables.

Placing cable symbols without Cable wire names from the Database
When you have a cable symbol in the cross hairs, you place it next to some of the 
wires you want to include into the cable. You then enter the Cable data dialog box:

Number of cable wires in the cable
In the field No. of Wires, you can specify how many wires that exists in this cable. 
When this amount of wires have been placed, it will not be possible to place any 

THIS CHAPTER DESCRIBES

— PLACING CABLE SYMBOLS WITHOUT WIRE NAMES FROM THE DATABASE .........(P. 231)

— PLACING CABLE SYMBOLS WITH WIRE NAMES FROM THE DATABASE................(P. 234)

— PLACING SYMBOLS FOR THE SAME CABLE IN ONE OPERATION ..........................(P. 235)

— MOVING CONNECTION POINTS FOR CABLE WIRES ..............................................(P. 235)

— ADDING CABLE WIRES TO PLACED CABLES ........................................................(P. 236)

— REMOVING CABLE WIRES FROM PLACED CABLES...............................................(P. 236)

— ADDING A SCREEN ON A PLACED CABLE ............................................................(P. 237)

— REVERSE DIRECTION ON PLACED CABLES ..........................................................(P. 238)

— UNREFERENCED CABLE SYMBOLS ......................................................................(P. 238)

— SETTINGS FOR DEFAULT CABLE DIRECTION........................................................(P. 238)

Specify the number
of wires in the cable



PAGE 232 PCschematic ELautomation 10.0

SYMBOLS

more wires for this cable. — If the cable is fetched via the database, the field No. of 
Wires is filled out automatically.

Filling out the dialog box Cable data
Apart from this, you can fill out the dialog box Cable data as described in “Placing 
and Naming symbols” on page 176. Click OK.

The illustration below is a part of a larger drawing, where the three vertical lines are 
wires.

When you place the cable, a rubber band now starts in the reference point of the 
symbol, and ends up in the cross hairs. This indicates that you can now point out 
which wires to include in the cable.

You have two options: Pointing out the wires individually, or selecting more than 
one wire at the time:

Pointing out individual cable wires
Click on the wires you want to include one at a time. Each time you click on a wire, 
you are asked to type in Connection data.

NUMBER OF WIRES IN COMPONENTS LISTS

WHEN CREATING COMPONENTS LISTS, IT IS POSSIBLE TO INSERT INFORMATION 
ABOUT THE NUMBER OF WIRES AND USED WIRES FOR THE CABLES IN THE LIST 
VIA THE DATAFIELD CABLE WIRES.
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When you click OK the symbol expands to include this wire as well.

When you do not wish to include more wires into the cable you press <Esc>, and 
the "rubber band" disappears. If the number of cable wires is specified in the dialog 
box Cable data, the "rubber band" disappears when the specified number of cable 
wires have been placed in the project.

Pointing out more than one cable wire in a single operation
When you have placed the cable symbol — and a thin line (the "rubber band") 
starts in the reference point of the symbol, and ends up in the cross hairs — you can 
mark up a window over the wires, which you wish to include in the cable:

When you release the mouse button, you enter the dialog box Connection data, 
from where you can name cable wires — for instance by using automatic counting:

Click here Keep the mouse button pressed down,
and drag the mouse cursor across the wires

Release the mouse button
when all wires are included
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If for instance you write 1 in the Name field, press down <Ctrl> while clicking on 
+, and then click OK, the three wires in the example will get the names 1, 2 and 3 
respectively. — See e.g. “Automatic naming of symbols” on page 194.

When you are using a cable with specified wire names from the database, the 
selected wires are automatically assigned wire names according to the order in 
which the wires appear in the database.

Place cables with Cable wire names from the database
When you use the database, you can let the database supply the cable wire names 
automatically.

The procedure for selecting the cable symbol, and pointing out the cable wires is 
the same as described in “Placing cable symbols without Cable wire names from 
the Database” on page 231.

Only, when you select a cable wire, you enter this dialog box instead:

Here you choose which of the cable conductors you wish to apply, and click OK.

Each time you enter this dialog box, you can see which cable wire names are Avail-
able and which are Used.

If you have changed a cable wire name to a name unknown to the database, you 
also see the tab Unknown.

— Please note that it is also possible to choose cable wires from the tab Used. This 
makes it possible to display the cable wire more than one place in the project.

Try a cable with cable wire names
If you want to try working with a cable having cable wire name information in the 
database, use the cable with the EAN number 5702950901288 in the database 
eldemo.

For a practical example, please refer to "Placing cables with color codes from the 
database" in the PCschematic Tutorial manual.
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Placing symbols for the same cable in a single operation
You can place more than one symbol for the same cable at different locations in the 
diagrams, in a single operation. When these symbols have the same cable name, the 
program knows they represent the same cable.

Select the cable symbol only once
When you place a cable symbol and include some cable wires in the cable, and then 
click exactly over, or exactly under, the cable symbol, a new cable symbol with the 
same cable name is placed in the diagram:

To do as in the figure above, do the following:

1) Place the cable symbol -W3 and include the cable wires in the cable

2) Do not press <Esc> to stop including cable wires, but click vertically under 
the -W3 cable symbol

3) A new cable symbol with the name -W3 is placed in the diagram

FREE PLACING OF THE SUBSEQUENT CABLE SYMBOL

When you need to place the other cable symbol for the same cable anywhere in the 
diagram, do the following:

1) Place the cable symbol -W3 and include the cable wires in the cable

2) Do not press <Esc> to stop including cable wires, but press <Ctrl>, and click 
where you wish to place the next cable symbol

3) A new cable symbol with the name -W3 is now placed where you clicked

Moving connection points for cable wires
It is possible to move the connection points for a cable in relation to the cable sym-
bol. The connection points can only be moved along the axis of the symbol, and can 
not be moved to the opposite side of the reference point of the symbol. To move a 
connection point, do the following:

1

3

2
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1) Make sure that the Symbols button is activated, right-click on the connection 
point, and select Move

2) You now get the connection point in the cross hairs: Click where you wish to 
place the connection point.

Moving connection points for cable wires in areas
If you select the connection points in an area — by dragging a window over them 
and pressing <Ctrl> when releasing the mouse button — you can also move the 
selected connection points for the cable in the area.

Adding wires to cables
If you want to add another wire to the cable after having deselected the cable sym-
bol, first make sure the Symbols button is activated, then right-click on the cable 
symbol, and choose Add cable core. A rubber band now radiates from the refer-
ence point and ends in the cross hairs.

Now click on the wire(s) that are to be included in the cable, and each time you 
click on a wire, the symbol expands to include this wire as well.

If you are using a cable with color codes from the database, you will be asked to 
select color codes for each individual wire, as described in “Place cables with Cable 
wire names from the database” on page 234.

You can also select more than one wire in one operation, as described in “Pointing 
out more than one cable wire in a single operation” on page 233.

Press <Esc> when you have finished.

Removing a wire from a cable
If you later on want to remove a core from the cable, you make sure the Symbols 
button is activated, right-click on the connection point for the wire you want to 
exclude, and choose Delete.
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Adding a screen to a placed cable symbol

To add a cable screen to a placed cable symbol, do this:

1) Click the Symbol button — to work with symbols.

2) Right-click on the cable symbol, and choose Add Cable screen:

3) In the dialog box Connection data: Type in a name for the cable screen, and 
click OK.

4) A connection point for the cable screen is now inserted on the cable symbol, 
the program changes to the Lines command automatically, and initiates the 
drawing of a line starting from the connection point for the cable screen:

THE CABLE SYMBOL MUST HAVE A SCREEN CONNECTION POINT

TO USE THE FUNCTION ADD CABLE SCREEN, THE APPLIED CABLE SYMBOL 
MUST HAVE A CONNECTION POINT FOR A CABLE SCREEN IN ITS SYMBOL DEFI-
NITION.
— SEE “CONNECTION POINT FOR CABLE SCREEN” ON PAGE 695.
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5) Change line type if necessary, and connect the line to the desired symbol.

Reversing the cable direction
To reverse the direction of the cable, right-click on the reference point of the cable, 
and choose Reverse direction.

The direction is of importance when the cable lists are filled out.

Unreferenced cable symbols
When you create a project by using sub drawings or sub projects, where one end of 
a cable is displayed on one project page, and the other end is displayed on another 
project page, it may occur that one end of a cable is not used in a project. If With 
reference is activated for the cable connection points, these will be unreferenced.

These cables can be set to be invisible by choosing Functions => Special Func-
tions => Set unreferenced cable symbols invisible.

— See also “Unreferenced signal symbols” on page 225.

Default Cable direction
In Settings => Text/Symbol default you can specify the cable direction as an over-
all setting, vertically as well as horizontally.

USING ACCESSORY SYMBOLS

To specify that a symbol needs an accessory, do this:

1) Make sure the Symbols button is activated, 
right-click on the symbol, and choose Place 
accessory (or choose Functions => Place 
Accessory).

2) You now get the accessory symbol in the cross 
hairs: Click where you wish to place the acces-
sory symbol — e.g. next to the symbol.

LINE SETTINGS MEMORIZED FOR CABLE SCREENS

THE PROGRAM AUTOMATICALLY USE THE LINE SETTINGS, THAT YOU USED THE 
LAST TIME YOU CONNECTED A CABLE SCREEN.
AFTER CONNECTING THE CABLE SCREEN, THE PROGRAM AUTOMATICALLY 
SWITCH BACK TO THE LINE SETTINGS, THAT YOU USED BEFORE CONNECTING 
THE CABLE SCREEN.
— READ MORE ABOUT LINE SETTINGS IN “THE LINES TOOLBAR” ON PAGE 94.

Support symbol for -Q1
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3) In the dialog box Component data: The accessory symbol is automatically 
assigned the name of the selected symbol (here -Q1). Type in the article 
number for the accessory, or click on Database, to select the accessory com-
ponent in the database.

Data from accessory symbols are included in the lists, but the accessory symbol 
itself is not included when printing the diagram pages.

SYMBOL FOLDERS

The symbols in PCschematic ELautomation are located in 
various folders, depending on their use.

When you wish to fetch a symbol, it is a good idea to know 
in which folder the symbol is located.

Typically, the symbols will be located in folders under the 
folder c:\Pcselcad\symbol. Here is a survey of the contents 
of these folders:

FOLDER CONTENTS

ALARM SYMBOLS FOR ALARM SYSTEMS. NOT STANDARD.

BUILDING SYMBOLS FOR GROUND PLAN DRAWINGS: DOORS, WINDOWS, WHITE GOODS 
ETC.

DB60617 SYMBOLS CREATED BECAUSE OF THE DATABASES FOR THE PROGRAM. THE SYM-
BOLS FOLLOWS THE STANDARD EN 60617.

DEMOMEC EXCLUSIVELY MECHANICAL SYMBOLS FOR SWITCHBOARD DRAWINGS. AT 
PRESENT THE FOLDER ONLY CONTAINS EXAMPLES USED IN "AUTOMATION 
PROJECT TUTORIAL" IN THE PCschematic Tutorial MANUAL.

EIB SYMBOLS FOR INTELLIGENT BUILDING INSTALLATION (EIB).

EN1861 SYMBOLS ACCORDING TO EN 1861, REFRIGERATING SYSTEMS AND HEAT PUMPS 
- SYSTEM FLOW DIAGRAMS AND PIPING AND INSTRUMENT DIAGRAMS - LAYOUT 
AND SYMBOLS.

SYMBOL FOLDERS IN PCschematic ELautomation
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EN60617 THE FOLDER CONTAINS SYMBOLS ACCORDING TO THE EUROPEAN STANDARD 
IEC/EN 60617, GRAPHICAL SYMBOLS FOR DIAGRAMS.
THE SYMBOLS FOLLOWS EN 81714-2, CONSTRUCTION OF GRAPHICAL SYMBOLS. 
THE SYMBOL NAMES FOLLOWS THE EN 61346 STANDARD FOR LETTER CODES.
DPS CAD-CENTER HAS A LICENSE FOR USING THE IEC STANDARDS.
THE SYMBOLS ARE SAVED UNDER THEIR SERIAL NUMBER, FOR INSTANCE 04-02-
14.
IF A SYMBOL IN THE IEC STANDARD IS ONLY SHOWN AS A MAKE-FUNCTION (N/
O, NORMALLY OPENED SYMBOL), AN EVENTUAL CORRESPONDING BREAK-FUNC-
TION (N/C, NORMALLY CLOSED SYMBOL) WILL THEN HAVE A B INSTEAD OF THE 
LAST HYPHEN - AND AN S IF THE OPPOSITE IS THE CASE.
POWER CONTROL CIRCUIT SYMBOLS, THAT ARE NOT COVERED BY THE IEC 
STANDARDS, HAVE BEEN ASSIGNED A NAME STARTING WITH H FOLLOWED BY 
AN IEC SERIAL NUMBER, WHERE 0 IS EXCLUDED. THE FIRST HYPHEN HAVE 
BEEN REPLACED BY THE NUMBER OF CONTACTS. FOR INSTANCE: H7303-04.
AT THE SAME TIME A NUMBER OF SYMBOLS NOT SHOWN IN IEC HAVE BEEN 
CREATED, FOLLOWING THE STANDARD.
THE SYMBOLS ARE DESIGNED WITHOUT A MINUS IN FRONT OF THE SYMBOL 
NAMES. THIS IS BECAUSE THE PROGRAM AUTOMATICALLY INSERTS A MINUS IN 
FRONT OF THE NAMES OF THE SYMBOLS YOU PLACE IN THE PROJECTS, IF YOU 
CHOOSE SETTINGS => POINTER/SCREEN AND SELECT INSERT - IN FRONT OF 
SYMBOL NAMES — SEE “POINTER/SCREEN” ON PAGE 815.
IF YOU CHOOSE FUNCTIONS => SPECIAL FUNCTIONS => PREFIX ALL SYMBOL 
NAMES WITH -, A MINUS IS INSERTED IN FRONT OF ALL SYMBOL NAMES IN THE 
SYMBOLS IN THE PROJECT.

FLOWCHAR SYMBOLS FOR (COMPUTER) FLOWCHARTS.

IBIICONS IBI LIBRARY, DESIGNED BY COWI A/S.

IECINST SYMBOLS FOR ELECTRICAL INSTALLATIONS, FROM EN 60617, GRAPHICAL SYM-
BOLS FOR DIAGRAMS - PART 11: ARCHITECTURAL AND TOPOGRAPHICAL 
INSTALLATION PLANS AND DIAGRAMS.

IECPNEU SYMBOLS FOR PNEUMATICS AND HYDRAULICS, FROM EN 60617, FLUID POWER 
SYSTEMS AND COMPONENTS - GRAPHIC SYMBOLS AND CIRCUIT DIAGRAMS ACC. 
TO ISO 1219 AND BASIC SYMBOLS ACC. TO EN 60617.

MISC SPECIAL SYMBOLS, WHICH ARE NOT OFFICIAL STANDARD, BUT ARE INCLUDED IN 
PCschematic ELautomation: DRAWING HEADERS, FORMULAS FOR PARTS 
LISTS AND TABLES OF CONTENTS, UNIT TABLES FOR UNIT DRAWINGS, SIGNAL 
SYMBOLS, CABLE SYMBOLS, LOGOS ETC.

PLC346 PLC SYMBOLS WITH LETTER CODES ACCORDING TO EN 61346. THE PLC SYM-
BOLS ARE CREATED IN COOPERATION WITH A BOARD OF PLC VENDORS. NOT 
STANDARD.

TELEDATA SYMBOLS FOR TELE AND DATA COMMUNICATION. NOT STANDARD.

USER FOLDER FOR YOUR OWN SYMBOLS.

FOLDER CONTENTS

SYMBOL FOLDERS IN PCschematic ELautomation



PCschematic ELautomation 10.0 PAGE 241

FUNCTIONS ON COMPONENT LEVEL

FUNCTIONS ON COMPONENT LEVEL

When you are working with symbols in PCschematic ELautomation, the individ-
ual symbol will frequently just be one symbol among other symbols for the func-
tions in a component.

Therefore, there are both functions for working on symbol level and component 
level.

— For other ways to get a survey of the symbols in the project, please refer to “The 
Object Lister” on page 314.

— See also “Fetching symbols” on page 160 and “Placing and Naming symbols” 
on page 176.

THIS CHAPTER DESCRIBES

— THE RELATIONSHIP BETWEEN SYMBOLS AND COMPONENTS .............................(P. 242)

— FETCHING SYMBOLS FOR A COMPONENT VIA THE DATABASE ...........................(P. 243)

— UPDATING FROM THE DATABASE WHEN CHANGING ARTICLE NO......................(P. 244)

— THE FUNCTION SHOW AVAILABLE......................................................................(P. 245)

— THE FUNCTION SHOW AVAILABLE WINDOW.......................................................(P. 247)

— FINDING SYMBOLS BASED ON THE SYMBOL NAME.............................................(P. 248)

— SELECT COMPONENT...........................................................................................(P. 252)

— PLACE AVAILABLE SYMBOLS FOR A COMPONENT ..............................................(P. 253)
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THE RELATIONSHIP BETWEEN SYMBOLS AND COMPONENTS

Components containing more than one function, have an electrical symbol for each 
function in the component.

These electrical symbols can be placed freely in the diagram pages in the project.

To specify that two symbols belongs to the same component, they must have the 
same symbol name.

When you type in the same symbol name for two electrical symbols in a project, 
this specifies that they are part of the same component — please also see “Function 
assemblys” on page 243.

When you choose a component via the database, you automatically get its electrical 
symbols on the screen, and can place these in the diagrams. — See “Fetching sym-
bols for a Component from the Database” on page 243.

Symbols for -K1, placed on different project pages
(Two electrical symbols, and one mechanical)
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— See “Update from Database when changing symbol Article no” on page 244 
also.

Function assemblys
When you are working with advanced contactors, the symbols for -K1 can be an 
assembly of several components.

The program knows that two — or more — symbols belong to the same component 
when they have the same name and article number.

This also applies for terminal rows and other function assemblys.

— See “Sub names on symbols” on page 185 also.

Symbols, lists and databases
When you have attached article numbers to the symbols on the diagrams, the pro-
gram can update lists automatically by fetching the necessary information from the 
database.

— Read more about this in “Using the database” on page 559.

Practically all components in the component vendor databases for PCschematic 
ELautomation also have an attached mechanical symbol, which can be used for 
mechanical layouts. — Read more about this in “Mechanical Load from the Data-
base” on page 609.

FETCHING SYMBOLS FOR A COMPONENT FROM THE DATABASE

When you place the elec-
trical symbols for a com-
ponent using the 
database, you get a pick-
menu for the electrical 
symbols available for the 
component. These sym-
bols can then be placed in 
the project diagrams.

This is described in fur-
ther detail in “Fetching 
symbols from the data-
base” on page 172.

Placing symbols using the database, enables you to generate project lists automati-
cally. You will find the relation between components, databases and automatic 
updating of lists described in further detail in “Using the database” on page 559.
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UPDATE FROM DATABASE WHEN CHANGING SYMBOL ARTICLE NO

When the Article no is changed for one of the symbols for the component, it is pos-
sible to have the component updated from the database, as described in “Update 
from database when changing article number” on page 179.

Therefore, if you have changed Article no for one symbol for the component -K1, 
and subsequently select Change Data for all symbols for the component and click 
OK in the dialog box Component data, all symbols for the component -K1 are 
updated.

Settings for updating individual components via the Database
The settings for how to update via the database, are specified the following way:

1) Choose Settings => Database.

2) Select Update components when changing Article No., and click on Set-
tings.

3) You now enter the dialog box Update from Database:

4) Here you specify how to update the symbols for individual components when 
changing article number — see a description of the options in “Updating 
symbols from the database” on page 189.

UPDATING COMPONENT, PAGE OR PROJECT

IT IS ALSO POSSIBLE TO UPDATE COMPONENTS WITHOUT CHANGING ARTICLE 
NUMBER, AND TO UPDATE ALL COMPONENTS ON THE ACTIVE PAGE, OR IN THE 
ENTIRE PROJECT.
— SEE HOW TO DO THIS IN “UPDATING SYMBOLS FROM THE DATABASE” ON 
PAGE 189.
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THE FUNCTION SHOW AVAILABLE

When you place a symbol via a pickmenu from the database, the pickmenu disap-
pears.

To get the pickmenu for the component back on screen, right-click on one of the 
electrical symbols for the component — e.g. the one you just placed —, and choose 
Show available.

— See also “The function Show available window” on page 247.

You now see the electrical symbols for the component, that has still not been used 
in the project.

Also, you can click on a symbol and choose Functions => Show available, or 
press the short-cut key [F9].

Show available again
When you choose Functions => Show available again, or press the short-cut key 
[Ctrl+F9], the pickmenu for the component is displayed again. This makes it easier 
to work with for instance PLC’s and multi terminals.

Lists of Used names in the dialog box Show available
When you have selected Symbols, and choose Functions => Show available, you 
enter the following dialog box:

When you click on the Used names button you get a list of all the components that 
are used in the project.

When you click on the Used names with available symbols button, a list of all 
project components with available symbols is displayed.
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Click on the component you want to use electrical symbols from, and you enter a 
pickmenu for the component. This way you can fetch symbols from components, 
that are placed on other pages in the project.

Wildcards/jokers in Show available
You can also use wildcards/jokers in the dialog box Show available — as described 
in “Wildcards/jokers” on page 542.

Show available for Mechanical symbols
When only a mechanical symbol is placed for a component, Show available can 
also be used for placing the electrical symbols for the component. Read more about 
this in “From Mechanical to Electrical drawing” on page 620.

IF A SYMBOL CONTAINS FUNCTION OR TYPE INFORMATION, THIS INFORMA-
TION IS TRANSFERRED TO THE OTHER SYMBOLS FOR THE COMPONENT WHEN 
YOU USE THE SHOW AVAILABLE FUNCTION.
IF THE DATABASE CONTAINS INFORMATION ABOUT FUNCTION OR TYPE, THIS 
INFORMATION IS ADDED TO THE PLACED SYMBOL IN STEAD.

BUTTON FOR SELECTED LIST FOR ACTUAL FUNCTION

WHEN A BUTTON WITH THE SAME APPEARANCE AS THE USED NAMES WITH AVAILABLE 
SYMBOLS BUTTON APPEARS IN A DIALOG BOX, IT CAN GIVE YOU A SELECTED LIST, BASED ON 
THE NEEDS IN THE ACTUAL SITUATION.

WHEN FOR INSTANCE YOU ARE ABOUT TO PLACE A BREAK CONTACT, THE PROGRAM DIS-
PLAYS THE POSSIBLE NAMES FOR A BREAK CONTACT — SUCH AS FOR INSTANCE THE NAMES 
FOR THE APPLIED CONTACTORS AND PUSH-BUTTONS. WHEN FOR INSTANCE YOU ARE PLAC-
ING A TERMINAL, ONLY NAMES FOR THE APPLIED TERMINALS ARE DISPLAYED.
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THE FUNCTION SHOW AVAILABLE WINDOW

The function View => Show available window displays all components in the 
project, that has available functions/symbols.

You can also right-click on the page, and choose Show available window.

Pickmenus for components - via the Show available window
When you double-click on one of the components in the Show available window, 
you get a pickmenu for the component, containing symbols for all available func-
tions in the component:

The Show available window remains on screen when you double-click on a com-
ponent in the list, and you therefore continuously have easy access to all compo-
nents with available functions/symbols in the project.

The window is closed by clicking the Close button in the dialog box.

Select name window for components - via the Show available window
If you click on a component in the window, and then click the Show where the 
component is placed button, the Select name window is displayed for the compo-
nent.

Update the contents
of the window

http://www.dps.dk/english/Video/Product_videos.htm
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— See “Find all symbols with identical names” on page 248.

FINDING SYMBOLS BASED ON THE COMPONENT NAME

— See “Select Component” on page 252 also.

Find all symbols with identical names
When you want to get a survey of where the electrical symbols for the component 
are placed in the project, you choose Functions => Select name.

You then enter a dialog box where you specify the name of the component:

When you wish just to find the symbols for a specific component, type in the com-
ponent name, and press <Enter>.

When you need a list of component names in the project, click the Used names but-
ton, select a name from the list of component names, and click OK.

THE SELECT NAME FUNCTION CAN BE USED FOR:
— TO FIND SYMBOLS IN THE PROJECT QUICKLY.

— TO EDIT COMPONENT DATA FOR MORE THAN ONE SYMBOL AT THE TIME.

THIS CHAPTER DESCRIBES

— FIND ALL SYMBOLS WITH IDENTICAL NAMES.....................................................(P. 248)

— SEARCHING FOR MORE COMPONENTS USING WILDCARDS .................................(P. 249)

— JUMP TO THE NEXT SYMBOL IN THE SELECT NAME LIST AUTOMATICALLY .......(P. 250)

— CHANGING SYMBOL REF. DESIGNATIONS USING SELECT NAME.........................(P. 250)

— RENUMBER CONNECTION NAMES FOR TERMINAL ROW USING SELECT NAME.... (P. 251)
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When there is more than one symbol with the same name, the Select name window 
is displayed:

Here you can see all the places the symbol name occurs in the project, as well as 
different information about the symbols; their connection names, symbol types, 
which project page they are placed on, the page type of this page, and their position 
on the page.

You can remove symbols from the window by selecting them and press <Delete>. 
(Please note that this does not remove the symbols from the project, but only from 
the Select name window). Read more about selecting in “Selecting objects in the 
Object Lister” on page 316.

The contents of the window can be sorted as described in “The sorting order of the 
data in the Object Lister” on page 316.

Searching after more components using Wildcards
When you wish to find all components of a specific type, or do you not know all of 
the component name, you can use the so-called wildcards — as described in “Wild-
cards/jokers” on page 542.

When for instance you write * and click OK all project symbols are selected, as if 
you had pressed <Ctrl> and selected the symbols one at the time.

If you have followed the naming standard about - in symbol names, you can also 
write *-*, whereby all project symbols are selected — except wire number symbols 
and signals (when these do not contain a "-" in their symbol names).
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Jump to a symbol from the Select name list
When you click on the different electrical symbols in the Select name box, you 
automatically jump to where the selected symbols are placed in the project — hav-
ing the cross hairs pointing out the symbol.

You can also activate the function by right-clicking on a symbol, and then choose 
Select Name.

Changing the symbol reference designations using Select name
When for instance you wish to change reference designations, you can do the fol-
lowing:

1) Activate the Symbols button, right-click on the page and choose Select 
Name.

2) In the dialog box Select Name: Write for instance *+A1* (see “Searching 
after more components using Wildcards” on page 249) and click OK.

3) In the window Select Name: Remove the symbols from the list, which you do 
not wish to change the reference designations, and click on the Component 
data button in the toolbar for symbols.
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4) In the dialog box Component data: Click on the tab Ref. design. and click 
on Select.

5) In the dialog box Reference designations: Select the new reference designa-
tion — for instance +A2 —, and click OK.

6) In the dialog box Component data: Click OK.

7) In the window Select name the new reference designations are now dis-
played. Click the Close button in the upper right-hand corner to close the 
window.

Renumbering pinnumbers for a terminal row using Select name
Do you wish to renumber pinnumbers for a terminal row, so that the pinnumbers 
increase from the start to the end of the project, do the following:

1) Click on the Symbols button, right-click on the page and choose Select 
Name.

2) In the dialog box Select Name: Click on the Used button, select the terminal 
row (for instance =G1+A2-X3) and click OK — hereby all symbols for 
=G1+A2-X3 are selected in the project:

3) In the Select name window: Click on the 
column header Position so that the displayed 
arrow in the field points upwards — hereby 
the symbols are sorted according to the order 
they are placed on the pages.

4) Click on the column header Page so that the dis-
played arrow in the field points upwards — hereby 
the symbols are sorted in page order, and accord-
ing to the order they are placed on the project 
pages.

5) Click on the Component data button in the toolbar for symbols.

6) In the dialog box Component data: Assign names to the pinnumbers — write 
for instance -X3:1, press down <Ctrl> and click on +, and click OK. The pin-

Click here

Click here
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numbers are hereby incremented according to the order in which they are 
placed in the list (and hereby in the order in which they are placed in the 
project).

Please note that existing holes in the numbering disappears at the same time.

Changing component data for the selected symbols
Changing component data from the Select name dialog box is done like this:

1) Select the symbols in the Select name dialog box.

2) Click on the Object data button — on the top of the screen —, to change arti-
cle data for all of the selected symbols at the same time.

3) In the Component data dialog box: Click for instance on Database and 
select a new component in the database.

SELECT COMPONENT

If you right-click on a symbol and choose Select Component, you select to all 
symbols having the same name and the same article number as the selected symbol.

This is an option because a component can consist of several parts, each having 
their own article number.

— See “Finding symbols based on the Component Name” on page 248 also.
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PLACE AVAILABLE SYMBOLS

If you want to place all symbols which have not been placed for a component, you 
choose Functions => Place available Symbols. You then enter this dialog box, 
where you click on Load selected and type in the symbol name.

Click OK, and the cross hairs changes appearance to a pencil. Click where you 
want the remaining symbols to be placed.

The symbols are now placed on top of each other.

In order to separate the symbols, drag a window around them, right-click within the 
selected area, and use the Space function — as described in “The Space function” 
on page 88.

If you choose Load all in the dialog box, all unused symbols for all components in 
the project will be placed.

If you choose Load selected and for instance write -K*, all symbols starting with -K 
are placed. — Read more about this in “Wildcards/jokers” on page 542.
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AREAS

In PCschematic ELautomation you use the Area command when you want to 
select all symbols, lines, texts and circles from an area in a project.

To work with areas, start by clicking on the Area button, or by pressing the short-
cut key [a].

SELECTING ALL TYPES OF OBJECTS IN AN AREA

Click on the Area button. Mark up a window. All object types within the window 
will now be selected. If you want to exclude any objects, press the <Ctrl> key and 
click on the objects.

If you also want to select objects outside the area, press down <Ctrl> and click on 
the objects.

— Read more about selecting objects in “Selecting objects” on page 77.

THIS CHAPTER DESCRIBES

— SELECTING OBJECTS IN AREAS...........................................................................(P. 254)

— INTELLIGENT COPYING OF AREAS ......................................................................(P. 255)

— ASSIGNING REFERENCE DESIGNATIONS WHEN COPYING AREAS ........................(P. 257)

— MOVING OR DELETING SELECTED AREAS ..........................................................(P. 259)

— CUTTING AND PASTING AREAS...........................................................................(P. 261)

— MOVING OR COPYING AREAS TO OTHER PROJECT PAGES ..................................(P. 260)

— MAKING AREAS INVISIBLE..................................................................................(P. 259)

— ROTATING AREAS ...............................................................................................(P. 263)

— SCALING AREAS..................................................................................................(P. 263)

— COPYING AREAS TO SYMBOL DEFINITIONS........................................................(P. 265)

INSERTING SUB DRAWINGS

PLEASE NOTE THAT YOU CAN ALSO INSERT SUB DRAWINGS — “SUB DRAW-
INGS” ON PAGE 266.
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INTELLIGENT COPYING OF AREAS

When you want to copy an area in PCsche-
matic ELautomation you click the Area 
button, and use the mouse to select the area 
you want to copy — see “Selecting all types 
of objects in an area” on page 254.

You can then either:

a) Click on the Copy button on the upper 
part of the screen, and then click where 
you wish to place the copy

b) Right-click inside the selected area and 
choose Copy, and click where you 
wish to place the copy

c) Click inside the area, press down 
<Ctrl> and drag the copied area to 
where you wish to place the copy

When you place the copied area, you enter a dialog box, where you specify the 
directions for renaming the names in the copied area:

http://www.dps.dk/english/Video/Product_videos.htm
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The options in this dialog box depends on which types of symbols exists in the cop-
ied area.

Renaming symbols when copying areas
If you want to renumber the symbols in the area, click on Rename symbols. If you 
want to renumber all symbols in the area, so that they start from a specific number, 
you specify this number in the field Start No. (0=Next avail.).

When you only want to assign the next available symbol name to the symbols, just 
type 0 in this field. If for instance you write 20, the symbols are renumbered start-
ing from 20.

When you do not want to renumber the symbols, click on Do NOT rename Sym-
bols.

Please note that you can copy the area as many times as you want. Press <Esc> for 
removing the copied area from the cross hairs.

Page/Current path numbers in symbols in copied areas
If you use page/current path numbers in the names of the copied area, the names 
will adjust to the new page/current path numbers automatically.

Renaming terminals when copying areas
With respect to renumbering terminals, you can here choose between the following 
options:

FULFILLING STANDARDS WHEN COPYING AREAS

ESPECIALLY IN CONNECTION WITH NAMING OF TERMINALS, DETAILED RULES APPLIES FOR 
NAMING/NUMBERING. THUS MOTOR TERMINALS, SUPPLY TERMINALS AND INPUT- AND OUT-
PUT TERMINALS ARE NUMBERED ACCORDING TO DIFFERENT PRINCIPLES.

WHEN YOU COPY AN AREA THE PROGRAM FIRST EXAMINES WHETHER THE AREA IS DRAWN 
ACCORDING TO THE RULES IN EN60204-1,14.2.1 CONDUCTOR AND CABLE RUNS. IF THIS IS 
THE CASE, THE PROGRAM THEN ANALYSE WHICH TERMINAL TYPES IT CONTAINS, AND 
RENAMES THESE ACCORDING TO THE DIFFERENT PRINCIPLES.

BECAUSE NO HOLES ARE ALLOWED IN THE NUMBERING, THE PROGRAM ALSO KEEPS TRACK 
OF WHICH NAMES/NUMBERS ARE USED FOR THE DIFFERENT TYPES OF TERMINALS.

OPTION CONSEQUENCE

DO NOT RENAME 
TERMINALS

NEITHER THE TERMINALS NOR THEIR CONNECTION POINTS ARE RENUM-
BERED.

RENAME TERMINALS ONLY THE TERMINAL NAMES ARE RENUMBERED, NOT THEIR CONNEC-
TION POINTS.

RENAME TERMINAL 
CONNECTION POINTS

THE NAMES OF THE TERMINAL CONNECTION POINTS ARE RENUMBERED, 
THE TERMINAL NAMES ARE NOT CHANGED. — SEE “FULFILLING 
STANDARDS WHEN COPYING AREAS” ON PAGE 256.

RENUMBERING TERMINALS
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Renaming wire numbers when copying areas
If the copied area contains wire numbers, you can click on Rename Wire Numbers. 
This assigns the next available wire numbers to the copied area. The wire numbers 
are assigned according to the principle you have used to apply for wire numbering 
— See “Automatic wire numbering” on page 395.

Copying an area to another page
If you want to move the copied area to another project page, see how to do this in 
“Moving or Copying areas to other pages” on page 260.

ASSIGNING REFERENCE DESIGNATIONS WHEN COPYING AREAS

If reference designations are used in the area you copy, the button Ref.des. is dis-
played in the dialog box Rename symbols. This gives you the option to assign 
other — or new — reference designations to the copied area.

When you click the Ref.des. button, you enter this dialog box:

In the columns Designation and Description the current reference designations are 
displayed along with their descriptions.

REF. DESIGNATIONS FOR SUB DRAWINGS, PAGES AND FULL PROJECTS

THIS CHAPTER DESCRIBES HOW TO EDIT REFERENCE DESIGNATIONS WHEN 
COPYING AREAS. YOU HAVE THE EXACT SAME OPTIONS WHEN COPYING FULL 
PAGES AND WHEN INSERTING STANDARD PROJECTS.
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See symbols using the listed reference designations
When you click on the line for one of the refernce designations in the dialog box, a 
Show symbols button is displayed. When you click on this button, all symbols 
using this reference designation in the copied area are displayed.

Editing a reference designation
If you wish to edit a reference designation, first click on the line with the reference 
desgination. Then click on the down-arrow in the column New designation, and 
you get the option of selecting a new reference designation:

By default (Unchanged) is selected, but you get the option of choosing by all 
applied reference designations in the project. You can also choose (none), to delete 
this reference designation from the symbols in the copied area.

CREATING A NEW REFERENCE DESIGNATION

When you need to create a new reference designation, click the Create new button 
to the right in the dialog box, and you enter the dialog box Reference designations, 
from which you can create new reference designations. — See how to do this in 
“Defining reference designations for the project” on page 342, in particular 
“Specifying function/location reference designations” on page 344.

ASSIGNING TEMPORARY REFERENCE DESIGNATIONS

When you can not decide how to name reference designations in the copied area, 
you can create temporary reference designations, which you can use until you have 
found the correct names. You do this by clicking the Create Temp button in the 
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right-hand side in the dialog box. Hereby all reference designations in the dialog 
box are assigned a temporary reference designation:

These temporary refernce designations are assigned a ~ sign after the reference des-
ignation prefix. This temporary reference designation is created from the initial ref-
erence designation, so that =G1 becomes =~G1. If this temporary value is alreday 
used in the project, the temporary reference designation with the next available 
name using the same referenceletter is applied. If =~G1 is used, =~G2 is then used 
in the project — if not used already. The description remains unchanged, with a 
preceeding ~ character.

The temporary reference designations are deleted automatically, when they are no 
longer used in the project.

MOVING OR DELETING SELECTED AREAS

Moving and deleting of areas is done as described in “Working with selected 
objects” on page 79.

If you want to move an area to another page in the project, please see “Moving or 
Copying areas to other pages” on page 260.

MAKING AREAS INVISIBLE

— See “Making areas invisible” on page 92.
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MOVING OR COPYING AREAS TO OTHER PAGES

When you have an area in the cross hairs — when moving or when copying — you 
can move the area to another page in the project.

This is done by clicking the page tab for the relevant page, which brings you to the 
new page, where you still carry the area in the cross hairs.

Click to place the area.

When you have a copied area in the cross hairs, you can change project page by 
pressing the [PageUp] and [PageDown] buttons, or by using the Explorer window.

— See “Copying an area from one project to another” on page 512 also.

The dialog box Rename Symbols can be deactivated after first placement
When you have copied an area and 
insert it for the first time, you enter 
the dialog box Rename Symbols.

Here you specify how to rename the 
copied symbols.

When you select Do NOT show this 
dialog at next placement, these set-
tings are memorized the next time 
the area is placed — and dialog box 
is therefore not displayed.

When placing a new copied area, the 
dialog box appears again.

Renaming settings are memorized for copying Areas
The settings in the dialog box Rename Symbols are memorized by the program.

Component grouping when copying terminals
When copying terminals — individually or in areas and pages — PCschematic 
ELautomation keeps the individual component grouping, so that the copied sym-
bols are separated from the originals.

— See “Component Grouping” on page 549.

Copying an area to another project
When you have the area in the cross hairs, you can copy it to another project by:

a) Clicking on the other project in the Explorer window, and press [Ctrl+v].

b) Following the description in “Copying an area from one project to another” 
on page 512.

Click here NOT to show
the dialog box again
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CUTTING AND PASTING AREAS

You can cut and paste an area in the following way:

1) Click on the Area button, and select the area by dragging a window over it 
with the mouse.

2) Click on the Cut button, or right-click inside the area and choose Cut.

3) The area is deleted: Shift to another page — if necessary — and click the 
Paste button. You now get the area in the cross hairs.

4) Click where you wish to place the area, and you are asked how/whether to 
rename the symbols in the area, as described in “Intelligent copying of areas” 
on page 255. Select the appropriate options, and click OK. — See the figure 
below.

Select the area and
choose Cut (or Copy)

The area is deleted and the
connected lines are parked
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5) The area is now placed at its new position, with updated symbol names.

Lines are cut along the edges of areas when copying
When cutting a connected area, PCschematic ELautomation cuts the lines con-
nected to the area, along the edges of the selected area. Where the area is cut out, 
the connecting lines are parked.

When you place the area, the lines in the area are connected to other lines, if you 
place them on these. Otherwise, the lines are parked.

Only lines are cut. Symbols, texts and circles can not be cut in two this way.

USING THE CUT FUNCTION FOR OTHER COMMANDS

THE CUT FUNCTION CAN ALSO BE USED WHEN WORKING WITH SYMBOLS, 
TEXTS, LINES AND CIRCLES.

Parked connection point

Connected to
existing line

Click to place the area, and rename the symbols
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ROTATING AREAS

You have also got the option to rotate an entire 
area. All kinds of objects in the area — sym-
bols, texts, lines and circles/arcs — will be 
rotated.

First click the Area button, and then select the 
area you want to rotate by dragging a window 
around it.

Click inside the area, keep the mouse button pressed down 
and move the mouse. Press [spacebar]. Hereby the area is 
rotated around the point the mouse is pointing at.

Every time you press [spacebar] the area is rotated 90 
degrees counter-clockwise.

When you have selected the area, you can also click the 
Move button, click in the angle field in the command tool-
bar, and type in the angle in which the area is to be rotated.

SCALING AREAS

You can use scaling when you make drawings as well as when you create/edit sym-
bols (see “Creating Symbols” on page 670).

To scale an area do the following:

1) Click on the Area button, and mark up the area you want to scale

2) Choose Edit => Scale

3) Type in a scaling factor. — If for 
instance you want the area in 
half size, you type in 0,5. In 
double size, you type in 2

4) Click OK

The area have now been scaled. If you are editing a symbol, this can require adapta-
tion of texts, and moving of the reference point, because they are now placed in 
another distance to the scaled objects.

— See for instance how to scale a company logo, to make it fit a drawing header in 
“Placing a Company Logo on a drawing header” on page 725.
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Scaling texts in areas
When you have selected an area and choose Edit => Scale, it is possible to specify 
whether to scale the free texts in the area. This is done by choosing Scale free texts 
in the dialog box:

Scaling everything on a page
If you want to scale everything on the entire page, you activate the Area button, 
choose Edit => Select all => All on page, and choose Edit => Scale as above.

Read more about selections in areas in “Selecting objects” on page 77.

Specifying the scale of the page
You can also specify the scale of the entire page. — Read more about this in “Set-
ting the scale of the page” on page 476.
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COPYING AREAS INTO EDIT SYMBOL MODE

To copy an area from a project drawing into a symbol, 
do the following:

1) Click the Area button, and select the area you 
wish to copy.

2) Right-click, and choose Copy.

3) Click on the Symbols button, and then on the 
Symbol menu button.

4) In the Symbol menu: Click on the Create new 
Symbol button.

5) In the Edit symbol mode: Choose Edit => 
Paste.

6) You now get the area in the cross hairs: Click to 
place the area in the symbol definition.

7) Press <Esc> to remove the area from the cross 
hairs.

The copied area is now inserted in the Symbol editor.

You can now place the connection points for the new 
symbol, edit the symbol etc. as described in “Creating 
Symbols” on page 670.

Copying areas between projects

ALL SYMBOLS IN THE INSERTED AREA ARE 
AUTOMATICALLY CONVERTED TO LINES WHEN 
THE AREA IS INSERTED IN THE SYMBOL DEFINI-
TION.

THE COPIED AREA CAN ALSO BE INSERTED 
DIRECTLY INTO ANOTHER PCschematic 
ELautomation PROJECT, BY JUMPING TO THE 
OTHER PROJECT, AND CHOOSING EDIT => 
PASTE.

Copying an area from
a diagram to a
symbol definition

http://www.dps.dk/english/Video/Product_videos.htm
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SUB DRAWINGS

In PCschematic ELautomation it is possible to save parts of diagrams as sub draw-
ings, which you can then drag directly into project pages in other projects. This is 
in PCschematic ELautomation called Drag’n Draw.
— Hereby you can also drag project pages or full projects into the active project.

All of the symbols in the sub drawings can have individual article data attached, 
and you can — as a general setting — specify the settings for how to rename the 
symbols, when the sub drawings are placed in projects.

Furthermore you can create different sets of model values for each individual sub 
drawing, so that you can choose between placing e.g. a 1 kW or a 15 kW motor-
starter circuit when placing the sub drawings.

You can also apply the sub drawings in connection with automatic project genera-
tion, as described in the Project generator manual.

THIS CHAPTER DESCRIBES

— THE SUBDRAWINGS TAB IN THE EXPLORER WINDOW .......................................(P. 267)

— ON INSERTING SUB DRAWINGS ...........................................................................(P. 268)

— MANUAL PLACING OF SUB DRAWINGS ...............................................................(P. 269)

— PLACING SUB DRAWINGS BY DRAG’N DRAW.....................................................(P. 273)

— DRAG’N DRAW SETUP ........................................................................................(P. 274)

— CREATING SUB DRAWINGS FOR MANUAL PLACING ........................................... (P. 276)

— EDITING SUB DRAWINGS.....................................................................................(P. 276)

— CREATING SUB DRAWINGS BY COPYING FROM PROJECTS ..................................(P. 277)

— ON PAGES AND SUB DRAWINGS FOR DRAG’N DRAW .........................................(P. 280)

— CREATING PROJECT PAGES FOR AUTOMATIC PLACING OF SUB DRAWINGS........(P. 281)

— PREPARING SUB DRAWINGS FOR DRAG’N DRAW / AUTOMATIC PLACING.........(P. 286)

— THE FUNCTION OF THE INSERTION POINTS .........................................................(P. 288)

— INSERTING VARIABLES IN SUB DRAWINGS, PAGES AND PROJECTS....................(P. 290)

— CREATING MODEL DATA FOR SUB DRAWINGS ...................................................(P. 293)

— INVISIBLE AREAS AND SUB DRAWINGS...............................................................(P. 296)

— SUB DRAWINGS WITH INTELLIGENT LINE CONNECTION .....................................(P. 297)

SUB DRAWINGS IN NETWORKS

WHEN YOU ARE WORKING IN A NETWORK, IT COULD BE A GOOD IDEA TO PRO-
DUCE A SET OF STANDARD SUB DRAWINGS, AND PLACE THESE IN A FOLDER, 
WHICH EVERYBODY HAS ACCESS TO IN THE NETWORK.

http://www.dps.dk/english/Video/Product_videos.htm
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THE EXPLORER WINDOW: THE SUBDRAWINGS TAB

In the Explorer window in the left-
hand side of the screen, you find the tab 
SubDrawings.

From here you can fetch the sub draw-
ings and projects/project pages, which 
you choose to drag into the active 
project.

If the Explorer window is not displayed 
on the screen, please read “General set-
tings for the Explorer window” on 
page 309.

— Read more about the Explorer win-
dow in “The Explorer window: The 
Projects tab” on page 309.

Specifying what to display on the SubDrawings tab
To select — and lock — which folder to dis-
play the contents of on the SubDrawings tab, 
you can right-click on the folder in the tab.

You can then choose between:

Show from here: The SubDrawings tab dis-
plays the contents of the selected folder.

One level up: The SubDrawings tab displays 
the contents of the folder one level above the 
selected folder.

Show all: The SubDrawings tab displays eve-
rything you have access to from your PC.

Other options in the right-click menu
Beyond this, you can choose between:

Place: Hereby you get the selected sub draw-
ing in the cross hairs, and can place it in the 
active project, as described in “Manual plac-
ing of sub drawings” on page 269.

Edit: Hereby the selected sub drawing is 
opened in the Edit sub drawing mode, and 
you can edit the sub drawing, as described in 
“Editing sub drawings” on page 276.

New: Hereby the program enters the Edit sub 
drawing mode, from which you can create a 

(Click on Folder)

(Click on Sub drawing)
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new sub drawing, as described in “Creating sub drawings by Copying from 
projects” on page 277.

Delete: Hereby the selected sub drawing is deleted. It is not possible to delete 
forlders from the SubDrawings tab.

Rename: Hereby you can rename the selected sub drawing.

Drag’n Draw setup: — See “Drag’n Draw setup” on page 274.

ON INSERTING/PLACING SUB DRAWINGS

When inserting sub drawings in PCschematic ELautomation, this can be done in 
two different ways:

1) Manually: When you drag the sub drawing from the SubDrawings tab into 
the project page, you get the sub drawing in the cross hairs, and place it man-
ually on the project page. — See “Manual placing of sub drawings” on 
page 269.

2) By Drag’n Draw / Automatic placing of sub drawings: When you drag the 
sub drawing from the SubDrawings tab, and release it as soon as it is over 
the project page, the sub drawing is connected automatically e.g. to the drawn 
potentials on the pages. — See “Placing sub drawings with drag’n draw” on 
page 273.

For both methods applies: Control of Article data, Texts and Model data
When applying both methods, the symbols in the sub drawings can contain article 
data — e.g. from the database. Furthermore, all texts can be controlled via varia-
bles, and you can select between different sets of model data for the sub drawings, 
if variables and/or sets of model data, that have been created for sub drawings.

For manual placing of sub drawings
All sub drawings can be placed manually.

You can start by creating sub drawings for manual placing, and later prepare them 
for applying drag’n draw.

For Drag’n Draw
To get the full benefit of applying drag’n draw, you need to make some extra prepa-
rations, as described in “On Pages and Sub drawings for Drag’n Draw” on 
page 280.

Having made these preparations, you achieve a faster workflow — and you have 
made practically speaking all of the necessary preparations for applying sub draw-
ings for automatic project generation, as described in the Project generator manual.
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MANUAL PLACING OF SUB DRAWINGS

To insert a sub drawing manually — see “On inserting/placing sub drawings” on 
page 268 — on the active project page, do the following:

1) Click on the SubDrawings tab in the Explorer window.
If the Explorer window is not visible, press <Ctrl+F12> or choose Settings 
=> Pointer/Screen and select Explorer window).

2) Click on the name of the desired sub drawing, and drag it into the project 
page.

3) You now get the sub drawing in the cross hairs, and click where you wish to 
place the sub drawing in the project.

If the sub drawing contains Model data
4) If different models have been created for the selected sub drawing, you enter 

the dialog box Rename symbols, in which you select which model you want 
to apply. — Read more about this in “Inserting sub drawings: With model 
data” on page 270.

The sub drawing is now inserted: Symbols are renamed and Article numbers added
5) The sub drawing is now placed in the project page, and:

— The symbols have been renumbered automatically (see “Drag’n Draw 

1) Click here 2) Click on the sub drawing, and
drag it into the project page

3) Click where you
want to place
the sub drawing

4-6) The symbols in the sub drawing are renumbered automatically
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setup” on page 274)
— The symbols in the placed sub drawing contains the same article numbers, 
texts and variables as the sub drawing in the SubDrawings tab.

— Please also see “Creating Project pages for aut. placing of sub drawings” on 
page 281 and see how to apply sub drawings for automatic project generation in the 
Project generator manual.

Sub drawings displayed in window
When you click on a sub drawing in the 
SubDrawings tab, the sub drawing is 
displayed in a small window, so that 
you can see which sub drawing you are 
selecting.

To select the sub drawing, double click 
on the name of the sub drawing — or 
click and drag in the same operation. 
Hereby you get the sub drawing in the 
cross hairs, and you can place it in the 
project.

Inserting sub drawings: With model data
When you insert a sub drawing — see 
“Manual placing of sub drawings” on 
page 269 —, where the sub drawing 
have different sets of model data 
attached, you can select which model 
to apply at the bottom of the dialog box 
Rename symbols:

When you have selected which model 
data to assign to the inserted sub drawing, you can click the Variables button in the 
upper-right corner of the dialog box, and the values of variables for the model are 
displayed:

THE SUB DRAWING IS NOW INSERTED

THE SUB DRAWING IS NOW INSERTED IN THE PROJECT, AND YOU CAN 
CONTINUE WORKING WITH THE SYMBOLS, LINES ETC. IN THE SUB DRAW-
ING, JUST AS IF YOU HAD DRAWN IT FROM SCRATCH.
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Here you can edit data — if necessary — by double clicking on a field and then 
editing the text. When you have placed the sub drawing in the project, you can edit 
the texts in via this dialog box, as described in “Editing variables for inserted sub 
drawings” on page 271.

Click OK, and click OK in the dialog box Rename symbols.

Variable markers (/@..) in sub drawings are removed when sub drawings are placed 
in projects.

— See also “Drag’n Draw setup” on page 274, “Drag’n Draw settings: For model 
data” on page 274 in particular.

— See also how to create models for a sub drawing in “Creating Model data for sub 
drawings” on page 293.

Editing variables for inserted sub drawings
To edit the text fields, which had variables on an inserted sub drawing, do this:

1) Select the project page on which the sub drawing is inserted.

2) Choose Edit => Variables.

3) You now enter the dialog box Variables.

Here you see a survey of all variables on the page. If more than one sub draw-
ing is inserted on the page, these are all displayed in the dialog box. When in 

THE PURPOSE OF VARIABLES

VARIABLES MAKES IT POSSIBLE TO EDIT SOME OF THE DATA, THAT CAN BE 
INCLUDED IN A SUB DRAWING.
— READ MORE ABOUT THIS IN “INSERTING VARIABLES IN SUB DRAWINGS, 
PAGES AND PROJECTS” ON PAGE 290, SPECIALLY “INSERTING VARIABLE 
MARKERS ON A SUB DRAWING (OR ON A DRAWING TEMPLATE)” ON PAGE 290.

Click on the variable

points out its position
on the page

field, and the cross hairs
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doubt about which datafield is listed in the dialog box, click on it in the dialog 
box, and the cross hairs points it out on the diagram page.

4) Double-click on one of the fields in the dialog box, and edit the text. Continue 
like this until all relevant texts are edited.

5) Click OK.

You can also edit the texts in the sub drawing exactly as you would edit any other 
text in PCschematic ELautomation.
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PLACING SUB DRAWINGS WITH DRAG’N DRAW

To place sub drawings by applying the drag’n draw technique, both the sub drawing 
and the pages they are placed in, must be prepared for drag’n draw / automatic plac-
ing. — See “On Pages and Sub drawings for Drag’n Draw” on page 280.

When the project pages and the sub drawings are prepared, you can place the sub 
drawings like this:

1) Click on the SubDrawings tab in the Explorer window.
(If the Explorer window is not visible, then choose Settings => Pointer/
Screen and select Explorer window).

2) Click on the name of the desired sub drawing, drag it into the project page, 
and release it as soon as it is over the project page — or just press the <Ctrl> 
key and click on the sub drawing. Hereby the sub drawing is placed automat-
ically on the project page, and connects automatically to e.g. the electrical 
potentials on the page:

If variables are placed in the sub drawing, or if you can select different sets of 
model data for the sub drawing, you now get the option of specifying which data to 
insert in the sub drawing. You can read more about this by continuing the explana-
tion under “If the sub drawing contains Model data” on page 269.

1) Click here 2) Click on the sub drawing, drag it over the
project page, and release the mouse button

The sub drawing is placed automatically, and connected to the existing
e.g. electrical potentials. The symbols in the sub drawing are renamed
automatically.

http://www.dps.dk/english/Video/Product_videos.htm
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DRAG’N DRAW SETUP

When sub drawings are placed automatically in project pages, PCschematic ELau-
tomation can rename symbol names in these sub drawings automatically.

To specify how to do this, right-click somewhere inside the SubDrawings tab, and 
select Drag’n Draw setup:

Here you specify whether to rename symbols in the sub drawings you insert, and 
how to rename these symbols. — Read more about this in “Intelligent copying of 
areas” on page 255.

Beyond this, you have the following options:

Keep page numbers
Because you can also drag full pages / projects into the active project, you can 
select Keep page numbers to specify that you wish to keep the existing page num-
bers, so that these are not changed when you drag new pages into the project. This 
includes both the page numbers in the active project, and the page numbers in the 
project / the project pages, which you drag into the project.

Drag’n Draw settings: For model data
When you select Show dialog if sub drawing contains model data, you always 
enter the dialog box Rename symbols — see “Manual placing of sub drawings” 
on page 269, “Inserting sub drawings: With model data” on page 270 in particular 
— when placing a sub drawing containing model data. From this dialog box you 
can select which model you wish to place.
If the option is not selected, the sub drawing is placed without model data, or with 
the data from the original sub drawing, if the sub drawing contains data values.

Update from database after Model selection
When you select Update from database after Model selection, the sub drawing is 
updated from the database, when you select the model.
If this option is not selected, the symbols in the sub drawing are assigned exactly 
the same data values as the sub drawing.
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When you select Update from database after Model selection, a Setup button 
appears in the dialog box: Click on it, and you enter the dialog box Update from 
database:

Here you specify how to perform the update from the database. These options are 
described in “Updating symbols from the database” on page 189.
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CREATING SUB DRAWINGS FOR MANUAL PLACING

A sub drawing can be any project, containing one single 
diagram page. — See also “Creating sub drawings by 
Copying from projects” on page 277.

For instance you can create a sub drawing like this:

Enter the Edit Sub drawing mode
1) In the SubDrawings tab in the Explorer window:

Right-click in the folder that you wish to place the 
sub drawing in, and choose New:

2) PCschematic ELautomation now changes to the Edit 
sub drawing mode, which you can see because the 
Page type field at the bottom of the left toolbar blinks 
green. You can now create a new sub drawing.

3) Draw a sub drawing — for instance as displayed in 
the figure above — and attach article data from the 
database to the symbols, if necessary. It has no impor-
tance where on the page you draw the sub drawing.
— You can also insert a copied area from an existing 
project, as described in “Creating sub drawings by 
Copying from projects” on page 277.

4) Continue as described in “Inserting e.g. variable 
markers and/or model data” on page 278.

EDITING SUB DRAWINGS

To edit a sub drawing, right-click on the sub drawing in the SubDrawings tab in 
the Explorer window, and choose Edit. Hereby you can edit the sub drawing as 
described in “Creating sub drawings for manual placing” on page 276.

DO NOT INCLUDE LOGOS IN SUB DRAWINGS.

Blinks green in the
Edit sub drawing
mode
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CREATING SUB DRAWINGS BY COPYING FROM PROJECTS

If you wish to create a sub drawing based on existing 
material from a project, you can do like this:

Copying the desired area
1) Click the Area button.

2) Select the area you wish to copy, right-click in 
the area, and choose Copy — see the figure to 
the right.

Entering the Edit sub drawing mode
3) On the SubDrawings tab in the Explorer win-

dow: Right-click on the folder you wish to place 
the sub drawing in, and select New:

SAVE COPIED AREAS USING SAVE AS

IN STEAD OF CHOOSING NEW, YOU CAN 
CHOOSE SAVE AS. YOU ENTER THE DIA-
LOG BOX SAVE AS, WHERE YOU TYPE IN 
THE NAME OF THE SUB DRAWING AND 
CLICK SAVE. THE SUB DRAWING IS THEN 
CREATED, AND IS DISPLAYED IN THE 
SELECTED FOLDER IN THE SUBDRAWINGS TAB.
TO EDIT THE SUB DRAWING, YOU MUST THEN RIGHT-CLICK ON IT AND 
CHOOSE EDIT.

Copying an area from
a project ...

http://www.dps.dk/english/Video/Product_videos.htm
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4) PCschematic ELautomation now change to the Edit sub drawing mode, 
which you can see because the Page type field at the bottom of the left tool-
bar blinks green. You can now create a new sub drawing.

Inserting the copied area
5) Right-click on the page and choose Paste.

6) You are now asked whether to rename the sym-
bols in the area — and get the option of changing 
reference designations (if any) in the area:

— See which options you have in “Intelligent 
copying of areas” on page 255.
Select the desired settings and click OK.

7) The copied area is now displayed including all 
component data and reference designations for 
the symbols in the area. — See the figure to the 
right. Press <Esc> to remove the copied area 
from the cross hairs.

Adapting the sub drawing
8) Now adapt the copied area, so that it becomes exactly the sub drawing you 

want.

Inserting e.g. variable markers and/or model data
9) If you want to, you can now place variable markers in the sub drawing, as 

described in “Inserting variables in Sub drawings, Pages and Projects” on 
page 290, and you can create different sets of model data for the sub drawing, 
as described in “Creating Model data for sub drawings” on page 293.

Blinks green in the
Edit sub drawing
mode

Inserting a copied area
when creating a new
sub drawing
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10) If you wish to use the sub drawing for drag’n draw or in automatic project 
generation, you must also place insertion points in the sub drawing, as 
described in “The function of the insertion points” on page 288. (It might be 
easier to place the insertion points in the project before you copy the area — 
see "Points to consider in Project generation" in the Project generator man-
ual).

Saving the sub drawing
11) When you have adapted the sub drawing, click on the Save button, and you 

enter the Save as dialog box. Here the same folder is selected as the one you 
clicked on in the SubDrawings tab, when you chose New.
Assign a name to the sub drawing, and click Save.

12) Choose File => Close to leave the edit sub drawing mode.

You have now created a new sub drawing from a copied area in a project, and have 
inserted the sub drawing in a folder, which is accessible from the SubDrawings tab 
in the Explorer window.

SUB DRAWINGS FOR DRAG’N DRAW / AUTOMATIC PLACING

IF YOU WISH TO USE THE SUB DRAWING FOR DRAG’N DRAW / AUTOMATIC 
PLACING, YOU MUST ALSO READ “ON PAGES AND SUB DRAWINGS FOR 
DRAG’N DRAW” ON PAGE 280 AND “PREPARING SUB DRAWINGS FOR DRAG’N 
DRAW / AUT. PLACING” ON PAGE 286.
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ON PAGES AND SUB DRAWINGS FOR DRAG’N DRAW

To apply the automatic functions in PCschematic ELautomation for drag’n draw / 
automatic placing of sub drawings, you need to create:

1) The project pages where you place the sub drawings. Here you must specify 
the area in which you can place sub drawings on the page.

2) The sub drawings which PCschematic ELautomation shall be able to place 
automatically on the project pages. Here you must specify how much space 
the sub drawing needs when it is placed in a project.

The project pages are created just like you create sub drawings — see “Preparing 
Sub drawings for Drag’n Draw / Aut. placing” on page 286. Here it is also 
described how to place the so-called insertion points, used for specifying the size of 
sub drawings and for specifying in which area sub drawings can be placed on 
project pages.

On project pages you will — as opposed to sub drawings — also place a drawing 
header.

Variable markers and Models
In project pages you can, just as for sub drawings, insert variable markers for the 
texts in the page / sub drawing, that you wish to specify the contents of, when you 
drag the page or sub drawing into the project.

For sub drawings you can furthermore specify different sets of model data, which 
you can choose between when placing the individual sub drawing.

Example
An example on creating a drawing template can be found in “Creating Project 
pages for aut. placing of sub drawings” on page 281.

+ 4x =

Project page prepared for + 4 sub drawings = Automatic filled out
automatic placing of sub
drawings by drag’n draw

    project page    for drag’n draw
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CREATING PROJECT PAGES FOR AUT. PLACING OF SUB DRAWINGS

When using drag’n draw you can make PCschematic ELautomation place sub 
drawings on project pages automatically.

To get full benefit of this powerful tool, you must first create a project page, on 
which you specify within which area the sub drawings can be placed automatically. 
As you will see, you will only have to create this page once.

Creating a Page Template prepared for automatic placing of sub drawings
1) Choose File => New, and you enter the dialog box New:

2) Click on the tab Normal pages, click on Template in the right-hand side — 
see "Automatic project generation: Creating drawing templates" below —, 
click on the page DPSA4H, and click OK.

AUTOMATIC PROJECT GENERATION: CREATING DRAWING TEMPLATES

WHEN YOU WISH TO CREATE A DRAWING TEMPLATE FOR AUTOMATIC GENERA-
TION OF PROJECTS — SEE "CREATING DRAWING TEMPLATES FOR AUTOMATIC 
PROJECT GENERATION" IN THE Project generator MANUAL — YOU MUST 
CHOOSE PROJECT, AND SAVE THE CREATED PROJECT IN THE FOLDER WHERE 
YOU KEEP DRAWING TEMPLATES. — SEE "SETTINGS FOR THE PROJECT GEN-
ERATOR" IN THE Project generator MANUAL.

2a) Click on the tab Normal pages 2b) Click on Template

2c) Click on DPSA4H 2d) Click OK

Or: Click
on Project
when crea-
ting drawing
templates
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3) Select Functions => Insert Potential — or click the Insert Potential button:

4) In the dialog box Insert Potential: Specify which electrical potential to insert 
— see “Automatic insertion of electrical potentials” on page 102 — and click 
on Upper.
The electrical potential is now inserted on the upper part of the page.

Placing insertion points on project pages for automatic placing
5) Click on the Symbols button and then on the Symbol menu button.

6) In the Symbol menu: Choose the Alias or the folder MISC, select the symbol 
INSPOINT.SYM, and click OK. — Read more about the Symbol menu in 
“Fetching symbols using the Symbol menu” on page 165.

7) In the left-hand side of the drawing: Place the insertion point 
symbol to the right-hand side of L1. — See the figure.

8) In the right-hand side of the drawing: Insert another insertion 
point symbol on the left-hand side of L1, and press <Esc> to 
remove the symbol from the cross hairs.
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Save the Template page / Drawing template
9) Click on the Save button.

10) In the dialog box Save: Write for instance the name Example.std, select the 
folder Pcselcad\Standard\Template\Normal, and click Save.
(If you have created a drawing template for automatic generation of projects, 
you must remember to save it in the folder where you save drawing tem-
plates. — See "Settings for the Project Generator" in the Project generator 
manual).

11) Choose File => Close to close the page.
You have now created a template page, prepared for automatic placing of sub 
drawings by drag’n draw.

YOU HAVE NOW SPECIFIED WHERE TO INSERT SUB DRAWINGS

BY PLACING TWO INSERTION POINT SYMBOLS, YOU HAVE NOW SPECI-
FIED THE AREA IN WHICH THE PROGRAM CAN NOW PLACE THE SUB 
DRAWINGS AUTOMATICALLY.
— READ MORE ABOUT INSERTION POINT SYMBOLS IN “THE FUNCTION 
OF THE INSERTION POINTS” ON PAGE 288.
— SEE "POINTS TO CONSIDER IN PROJECT GENERATION" IN THE 
Project generator MANUAL ALSO.
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Placing sub drawings automatically on a project page

12) On the SubDrawings tab in the Explorer window: Click on the template 
page Example (which above was saved in the folder Pcselcad\Stand-
ard\Template\Normal), drag it into the active project, and release it as soon 
as you have dragged it out of the Explorer window. This is called drag’n 
draw.

The template page, which was created above, has now been dragged into the 
active project, and you can now see the two insertion points on L1. (The next 
time you need this page, you can just drag in the page from here again).
— In stead of using Drag’n Draw you can also press the <Ctrl> key and click 
on the template page.

13) In the Explorer window: Open the folder Pcselcad\Standard\Subdrawing, 
click on the sub drawing MOTORDEMO3.PRO (which have already been 
prepared for drag’n draw — see “Preparing Sub drawings for Drag’n Draw / 
Aut. placing” on page 286), drag the sub drawing into the project page, and 
release it as soon as you have dragged it out of the Explorer window.

14) PCschematic ELautomation have now placed the sub drawing on the page 
automatically, and have connected the sub drawing to the electrical potentials 
on the page.

THE FOLLOWING IS BASED ON THAT YOU CREATED A TEMPLATE PAGE — AS 
DESCRIBED ABOVE —, PREPARED FOR AUTOMATIC PLACING OF SUB DRAW-
INGS BY DRAG’N DRAW.
IF YOU CREATED A DRAWING TEMPLATE FOR AUTOMATIC GENERATION OF 
PROJECTS, YOU MUST IN STEAD DRAG IN THIS PAGE FROM THE FOLDER YOU 
HAVE SPECIFIED AS DEFAULT FOLDER FOR DRAWING TEMPLATES AND SUB 
DRAWINGS FOR THE CREATED TEMPLATE — SEE "SETTINGS FOR THE PROJECT 
GENERATOR" IN THE Project generator MANUAL.

Drag’n Draw:
Click and drag and
release - the page is
now placed in the
project

http://www.dps.dk/english/Video/Product_videos.htm
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15) Now drag the sub drawing MOTORDEMO3.PRO into the project page 
three more times. The sub drawing have now been placed four times on the 
page by using drag’n draw:

— If you could only get room to place the sub drawing three times on the 
page, this is because the insertion points on the page are placed to close to 
make room for four sub drawings on the page. For the future use of the page, 
you might therefore consider to make room for exactly four sub drawings on 
the page. — See e.g. "Points to consider in Project generation" in the Project 
generator manual, "Creating sub drawings as Modules" in particular.

Subsequent update of text fields with variables
Though the variable markers are removed when placing the sub drawings, you still 
have the option of editing text fields from the sub drawing, which had variables.
— See “Editing variables for inserted sub drawings” on page 271.

AUTOMATIC RENAMING AND ARTICLE DATA

ALL SYMBOLS, TERMINALS AND CABLES HAVE HEREBY BEEN RENAMED AUTO-
MATICALLY. FURTHERMORE ALL SYMBOLS CONTAIN DATA FROM THE DATA-
BASE, BECAUSE THE PLACED SUB DRAWING CONTAINED ARTICLE NUMBERS 
FOR THE SYMBOLS.
— SEE “DRAG’N DRAW SETUP” ON PAGE 274 TO SEE HOW TO SPECIFY THE 
SETUP FOR RENAMING ETC. WHEN APPLYING DRAG’N DRAW.
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PREPARING SUB DRAWINGS FOR DRAG’N DRAW / AUT. PLACING

When a sub drawing has been prepared for automatic placing, PCschematic ELau-
tomation can automatically place the sub drawing correct, when you drag it into a 
page which has been prepared for this. — See “Placing sub drawings with drag’n 
draw” on page 273.

— See how to prepare project pages for automatic placing of sub drawings by 
drag’n draw in “Creating Project pages for aut. placing of sub drawings” on 
page 281.

1) Open an existing sub drawing, or draw a new one, as described in “Creating 
sub drawings for manual placing” on page 276, or copy an area from an exist-
ing project, and create a sub drawing from this area, as described in “Creating 
sub drawings by Copying from projects” on page 277.

2) Click on the Symbols button, and then on the Symbol menu button.

3) In the Symbol menu: Choose the Alias or the folder MISC, choose the sym-
bol INSPOINT.SYM, and click OK. — See e.g. the figure under “Placing 
insertion points on project pages for automatic placing” on page 282 or read 
more about the Symbol menu in “Fetching symbols using the Symbol menu” 
on page 165.

4) Place the two insertion points, so that they mark how much space the sub 
drawing needs horizontally during the automatic placing — see “The func-
tion of the insertion points” on page 288 (and see "Points to consider in 
Project generation" in the Project generator manual).

5) If you also wish to control the texts in the sub drawing (e.g. for automatic 
project generation — see the PCschematic ELautomation): Insert some so-
called variable markers, which makes it possible to control the texts of the 

SUB DRAWINGS FOR AUTOMATIC GENERATION OF PROJECTS

WHEN YOU WISH TO APPLY A SUB DRAWING FOR AUTOMATIC PROJECT GENER-
ATION, IT MUST BE PREPARED FOR AUTOMATIC PLACING.
— READ MORE ABOUT THIS IN "GENERATE AND UPDATE PROJECTS AUTOMAT-
ICALLY" IN THE Project generator MANUAL. PLEASE PAY ATTENTION TO THE 
GENERAL CONSIDERATIONS ON CREATING SUB DRAWINGS IN "POINTS TO CON-
SIDER IN PROJECT GENERATION".

The left
insertion point

The right
insertion point
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sub drawing when placing the sub drawing (or to control the texts from a 
project definition file during automatic project generation). Read how to do 
this in “Inserting variables in Sub drawings, Pages and Projects” on page 290.

6) If the sub drawing shall contain sets of model data — which you subsequently 
will be able to choose between when placing the sub drawing by drag’n draw 
—, then also create these, as described in “Creating Model data for sub draw-
ings” on page 293.

7) Save the sub drawing in a folder where you place sub drawings. — If the sub 
drawing shall be used for automatic generation of projects, you can for 
instance save it in the folder which is set to Default folder for drawing tem-
plates and sub drawings, as described in "Settings for the Project Generator" 
in the Project generator manual.

You have now created a sub drawing, which can be used for drag’n draw / auto-
matic placing, as described in “Placing sub drawings with drag’n draw” on 
page 273. There you can also see a complete workflow for placing sub drawings on 
project pages using drag’n draw.
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THE FUNCTION OF THE INSERTION POINTS

When you only wish to apply a sub drawing for manual placing, you do not need to 
place insertion point symbols on the sub drawing. However, if you need to be able 
to insert the part drawing automatically — by drag’n draw or by automatic project 
generation —, it must have two insertion points. — See “Insertion points and auto-
matic placing of sub drawings” on page 288.

The left insertion point on the part drawing is the point you get in the cross hairs, 
when you place the sub drawing manually. You could therefore choose to insert just 
one single insertion point with just this purpose.

The insertion point symbols of the sub drawings are removed when you place the 
sub drawing on a project page.

The created insertion point symbols are not displayed when printing project pages. 
This is because they are created using the color NP.

Insertion points and automatic placing of sub drawings
When using automatic placing of sub drawings, there exists two sets of insertion 
points:

1) The insertion points of the sub drawing: They tell the program how much 
space the sub drawing needs when it is placed automatically.

2) The insertion points of the project page: They tell the program where sub 
drawings can be placed on the page. (The project page can be fetched directly 
from a template page, or it can be a drawing template — see “On Pages and 
Sub drawings for Drag’n Draw” on page 280).

During the automatic placing the sub drawing is placed so that its left insertion 
point is placed on the left insertion point of the project page. The left insertion point 
of the project page is then moved, so that it now is placed on the position of the 
right insertion point of the sub drawing. The insertion points of the sub drawing are 
deleted from the page.

A sub drawing can not be placed automatically if there is not enough room for this 
sub drawing between the insertion points on the project page.

The left insertion point of the project
page before inserting the sub drawing

The left insertion point of the project
page after inserting the sub drawing
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Insertion points and automatic project generation
During automatic project generation — see "Generate and Update projects auto-
matically" in the Project generator manual — the situation mentioned above would 
result in inserting an extra project page, on which the sub drawing would be placed.

Placing the insertion point symbols carefully
When applying insertion point symbols, you must be careful to let the insertion 
points for the sub drawings match the electrical lines on the drawing templates, on 
which the sub drawings are going to be placed.

It is important to make sure of the following (observe the figure above):

1) Place the insertion point symbols on the sub drawing so that they are at the 
same height as the uppermost parked line.

2) Also place the insertion point symbols on the project page on the uppermost 
of the phases to which the sub drawing is going to be connected.

3) Adjust the vertical distance between the parked lines on the sub drawing to 
the distance between the phases on the project page.

4) Make sure to place the insertion points on the sub drawing so that there are 
room enough for the texts, which can be inserted via automatic project gener-
ation.

— Please also read "Points to consider in Project generation" in the Project genera-
tor manual. Here you will find a survey of additional aspects to consider, when cre-
ating sub drawings.

SUB DRAWINGS CAN ALSO BE PLACED VERTICALLY

ABOVE YOU FIND A DESCRIPTION OF PLACING SUB DRAWINGS FROM THE LEFT 
TO THE RIGHT.
PLEASE NOTE THAT SUB DRAWINGS CAN ALSO BE PLACED VERTICALLY FROM 
THE TOP TO THE BOTTOM.

1

2

3

Sub drawingProject page
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INSERTING VARIABLES IN SUB DRAWINGS, PAGES AND PROJECTS

When a sub drawing contains variables, you can for instance control symbol article 
numbers, symbol datafields e.g. containing motor data, or free texts placed under 
electrical circuits. —See e.g. “Manual placing of sub drawings” on page 269.

To do this you must:

1) Insert variables in the sub drawing, as described in “Inserting variable mark-
ers on a sub drawing (or on a drawing template)” on page 290.

2) Create a variable list, as described in “Creating a variable list for a sub draw-
ing / drawing template” on page 292.

When applying sub drawings for automatic project generation, you can control all 
texts and names in the project. — See the Project generator manual.

Inserting variable markers on a sub drawing (or on a drawing template)
When you wish to create variables, you do this by inserting so-called variable 
markers in the project. All data can be controlled via these variables.

To insert a variable marker, you write /@1 behind the first text in the sub drawing / 
project, that you wish to turn into a variable. Then you write /@2 behind the next, 
then /@3, and so on, until all variables in the sub drawing have been specified.

When you right-click on the page and choose Variables, you can subsequently see 
the created variables and edit them, if you wish to.

— Please also see “Editing variables for inserted sub drawings” on page 271 and 
“Manual placing of sub drawings” on page 269.

CREATE A VARIABLE LIST

WHEN YOU HAVE PLACED THE RELEVANT VARIABLES ON THE PAGE, CHOOSE 
TOOLS => CREATE VARIABLE LIST IN (SUB) DRAWING TO CREATE A VARIA-
BLE LIST FOR THE SUB DRAWING (OR DRAWING TEMPLATE).

The text with the variable @1 is placed
in the first text column in the project

The text with the variable @2 is placed
in the second text column etc.

definition file.
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Variables specifying parts of a project text
A variable can also be inserted so that it is only part of an otherwise constant 
project text. This is specified by placing the variable between the characters "<" 
and ">".

When for instance you write -M</@1>, and the variable @1 is assigned the value 
7, this results in the text -M7.

This can for instance be useful if you are using a system where several symbols in a 
sub drawing must always have the same number. If for instance the symbols in the 
sub drawing shall be named -F1, -Q1, -W1 and -M1 one place, and -F2, -Q2,
-W2 and -M2 in the next, this can be controlled using a single variable: -F</@1>,
-Q</@1>, -W</@1> and -M</@1>.

DEFAULT VALUE FOR INSERTED VARIABLES

When an inserted variable has a text between the "<"-character and a "/"-character, 
this is regarded as the default value for the variable.

This can for instance be applied when creating project definition files, so that you 
can make it clear to yourself what to insert at this exact position in the file. If for 
instance you write Control of <MOTOR/@1>, the variable @1 will get the value 
MOTOR in the project definition file.

Sub drawings with model data
If you wish to create different sets of variable values for a sub drawing, so that you 
can choose between different models when placing the sub drawing, please read 
“Creating Model data for sub drawings” on page 293.

Variables for Page title and Page data
On drawing templates — and in ordinary 
project pages — you can also insert variables 
on all Page data datafields, and in the Page 
title.

VARIABLES ON ORDINARY PROJECT PAGES

YOU CAN ALSO INSERT VARIABLES ON ORDINARY PROJECT PAGES.
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When you have inserted these variables in the pages, and have executed Tools => 
Create variable list, you can choose Edit => Variables. Here the created variables 
for the page will always be placed in the first section:

Variables for Page article data - including the page reference
It is also possible to create variable for Page article data for pages (Name, Type, 
Article no and Function) on drawing templates for automatic project generation 
via Excel.

When you wish to be able to control the 
page reference designation, place a varia-
ble marker in the Name field in the Page 
article data dialog box for the page.

You enter the dialog box Page article 
data by right-clicking on the page, and 
then choose Page article data.

Variables on Symbol datafields
If you are using symbols with specially created symbol datafields — see “Extra 
symbol Datafields in symbols” on page 685 —, you can also insert variables on 
these.

Creating a variable list for a sub drawing / drawing template
When you have placed the relevant variables on the page, choose Tools => Create 
variable list in (Sub) drawing. You have now created a variable list.

Click OK.
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CREATING MODEL DATA FOR SUB DRAWINGS

You can use the same sub drawing for representing different models for e.g. a 
motorstarter circuit. Hereby you use one single drawing, but attach different article 
data / texts to the symbols in the sub drawing.

The same sub drawing can therefore be used for e.g. a 55 kW and a 250 kW motor-
starter circuit.

To create models for a sub drawing, do this:

1) Draw the sub drawing, as described in “Creating sub drawings for manual 
placing” on page 276 or “Creating sub drawings by Copying from projects” 
on page 277. — If the sub drawing shall be used for drag’n draw, please also 
see “Preparing Sub drawings for Drag’n Draw / Aut. placing” on page 286.

2) Insert variable markers on the texts in the sub drawing, that are different from 
model to model. — See “Inserting variables in Sub drawings, Pages and 
Projects” on page 290.

Creating models for a sub drawing
3) While you are working on the sub drawing (in the Edit sub drawing mode): 

Right-click on the page, and choose Variables:

4) In the dialog box Variables: Click on Add model:

5) In the dialog box New model: Type in the name on the new model you wish 
to create, and click OK.

VIDEO ABOUT SUB DRAWINGS WITH MODEL DATA

ON WWW.PCSCHEMATIC.COM UNDER VIDEOS, YOU CAN SEE A VIDEO 
ABOUT HOW TO WORK WITH SUB DRAWINGS WITH MODEL DATA.
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6) In the dialog box Variables: Double-click in the fields for the different varia-
bles in the model, and type in the data for the model — or right-click on the 
field and select Database, and you enter the Database menu, from which 
you select the desired component:

Creating a new model by copying data
7) Click on Add model and type in a title for the new model.

8) Right-click on the first created model, and choose Copy model data:

9) Right-click on the new model, and choose Paste model data:

10) Answer OK to overwrite the model data for the new model (do not select to 
insert the title), and the data are inserted as data for the new model.

Double-click in the
fields, and type in
the data
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11) For the text fields you wish to edit: Double-click on the field, and edit the 
contents. — Or right-click on the field and select Database, and you enter the 
Database menu, from which you select the desired component.

12) Click OK.

You have now created model values for a sub drawing. The created sets of model 
values, are the model values you can choose from, when the sub drawing is placed 
in a project. — See “Manual placing of sub drawings” on page 269, “Inserting sub 
drawings: With model data” on page 270 in particular.

Creating a model variable
For use in automatic project generation, you can create a so-called model variabe, 
so that you via the project definition file can specify which of the models in the sub 
drawings to insert.

Read more about this in "Create model variable" in the Project generator manual.

Model data: Options when right-clicking
When you right-click in the dialog box Variables when creating model data, you 
get the following options:

Database: Gives you the option of 
choosing components from the database. 
Appears when right-clicking on an 
S.Article or a S.Type variable.

Model title: You can edit the title for the 
selected model.

Model variable: See “Creating a model 
variable” on page 295.

Insert model: Inserts a new model 
where you have clicked.

Add model: Adds a new model.

Delete model: Deletes the selected model.

LINE ARTICLE DATA CAN ALSO CONTAIN VARIABLES

LINE ARTICLE DATA IN SUB DRAWINGS CAN ALSO CONTAIN VARIABLES. THIS 
APPLIES FOR BOTH DRAG’N DRAW AND IN CONNECTION WITH AUTOMATIC 
PROJECT GENERATION.
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Move left: Moves the selected model one position to the left. — See also “Drag and 
drop Models in the dialog box” on page 296.

Move right: Moves the selected model one position to the right. — See also “Drag 
and drop Models in the dialog box” on page 296.

Copy model data: Copies the values for the selected model — see “Creating a new 
model by copying data” on page 294.

Insert model data: Inserts the copied model values — see “Creating a new model 
by copying data” on page 294.

Drag and drop Models in the dialog box
To move a model to another position in the dialog box, you can click on the title of 
the model, and drag it to another position in the dialog box.

INVISIBLE AREAS AND SUB DRAWINGS

When inserting sub drawings, you can subsequently make parts of these sub draw-
ings invisible, as described in “Making objects invisible” on page 90.



PCschematic ELautomation 10.0 PAGE 297

SUB DRAWINGS

SUB DRAWINGS WITH INTELLIGENT LINE CONNECTION

To create sub drawings with intelligent line connection, you must use a line connec-
tion symbol, as described in “Creating Line Connection symbols” on page 702.

This line connection symbol can for instance be placed as displayed in the figure 
below.

Controlled via variable marker in the symbol name
To control the connection, you must insert a variable marker in the symbol name. 
When the variable in the name gets the same value as one of the connection points 
— e.g. 3 —, the wire, which is connected to the symbol, will connect to where con-
nection point 3 is placed. It can therefore be controlled if for instance a wire in a 
sub drawing connects to L1, L2 or L3.

This aspect can therefore be different depending on which model of the sub draw-
ing you choose. Below the models L1, L2 and L3 have been created:

Insert e.g. the
line connection
symbol here
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When you place the sub drawing in a project, you can therefore get the following 
result by placing the three different models:

When the sub drawing is placed on the project page, the line connection symbol is 
converted to an ordinary line, and is therefore no longer a symbol.

Model L1 selected Model L3 selectedModel L2 selected
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RENAME SYMBOLS

When you select Tools => Rename symbols, you enter the dialog box Rename 
selected symbols, from which you can rename the used symbols in the project.

GENERAL INFO ON THE DIALOG BOX RENAME SELECTED SYMBOLS

When you select Tools => Rename symbols, you enter the dialog box Rename 
selected symbols:

THIS CHAPTER DESCRIBES

— GENERERAL INFO ON THE DIALOG BOX RENAME SELECTED SYMBOLS..............(P. 299)

— SELECTING SYMBOLS IN THE DIALOG BOX .........................................................(P. 301)

— DIRECTION FOR RENUMBERING SYMBOLS ..........................................................(P. 302)

— SPECIFY START VALUE........................................................................................(P. 303)

— SHOW NEW SYMBOL NAMES ...............................................................................(P. 303)

— NAMING WHEN RENUMBERING TERMINALS........................................................(P. 304)

— INSERTING SYMBOL NAMES OR CONNECTION NAMES.........................................(P. 305)

— SORTING ON COLUMN CAPTIONS ........................................................................(P. 306)

INSERT SYMBOL / CONNECTION NAMES

IT IS ALSO POSSIBLE TO RIGHT-CLICK ON A SYMBOL IN THE PROJECT, AND 
SELECT INSERT NAME. — READ MORE ABOUT THIS IN “INSERT NEW SYMBOL 
NAMES OR CONNECTION NAMES” ON PAGE 305.
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When you wish to rename symbols in the project, do this:

1) Select which symbols to rename — see “Selecting symbols in the Rename 
symbols dialog box” on page 301.

2) Specify a direction for renaming the symbols — see “Direction for renaming 
symbols” on page 302.

3) Specify how to rename terminals (if any) — see “Naming when renaming ter-
minals” on page 304.

4) Specify a start number for the renamed symbols, see which names this will 
result in, and execute the renaming — see “Specify Start value for Renaming 
symbols” on page 303.

The function Rename selected symbols can also be handy when you wish to keep 
control of the symbol names when merging projects.

Which symbol names are renamed
Only symbol names ending with a number, are renamed/renumbered. If a symbol 
name contains a number before a letter, this number is not changed.

Undo renumbering
Please note that it is possible to undo the renaming by using the Undo function 
after closing the dialog box Rename selected symbols.

WORKS ONLY WHEN USING FREE NAME FORMAT FOR SYMBOLS

THIS FUNCTION ONLY WORKS IF YOU USE FREE NAMING FORMAT FOR THE 
SYMBOLS IN THE PROJECT — THIS MEANING THAT YOU DO NOT USE CURRENT 
PATH NUMBERING.
IF YOU DO NOT USE FREE NAMING FORMAT, THE FUNCTION CAN ONLY BE USED 
FOR RENAMING TERMINALS.
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SELECTING SYMBOLS IN THE RENAME SYMBOLS DIALOG BOX

When you click on Execute, all symbols listed in the dialog box Rename selected 
symbols are renamed.

You can select which symbols to rename in three different ways:

1. Selecting/deselecting in the list
When you select symbols in the list, you can use the <Shift> and/or the <Ctrl> key, 
as you normally do in Windows, and e.g. in the Object Lister. — See “Selecting 
objects in the Object Lister” on page 316.

The selected symbols can then either be selected or deselected:

• If you click on Select in the right-hand side of the dialog box: The selected sym-
bols are now the only symbols in the list.

• If you click on Deselect in the right-hand side of the dialog box: The selected 
symbols are deleted from the list. (You can also press the  <Delete> button to 
delete the selected symbols from the list).

2. Selecting by specifying symbol names
In the field Select name(s) you can type in which symbols you 
wish to select, among the names already displayed in the list.

Then click on Select in the right-hand side of the dialog box. Now only symbols 
fulfilling the entered criterion are displayed.

3. Selecting project symbols by right-clicking
You can also select multiple symbols in the project — before entering the dialog 
box Rename selected symbols:

3a) Select the symbols by dragging a window over them with the mouse — if 
necessary please see “Selecting objects” on page 77, in particular “Selecting 
more objects of the same kind in one window” on page 77.



PAGE 302 PCschematic ELautomation 10.0

RENAME SYMBOLS

3b) Right-click and select Rename (see the figure below) — or select Tools => 
Rename symbols.

3c) You now enter the dialog box Rename selected symbols, where only the 
selected symbols are displayed:

DIRECTION FOR RENAMING SYMBOLS

When you rename symbols, it is only their position in the project, that determines 
which names the symbols are assigned.

The direction for the renaming always starts from the first project page, and ends at 
the last project page.

THE OTHER SYMBOLS FOR THE COMPONENT ARE ALSO RENAMED

PLEASE NOTE, THAT ONLY THE SELECTED SYMBOLS ARE DISPLAYED IN THE 
DIALOG BOX. WHEN A COMPONENT HAS MORE SYMBOLS IN THE PROJECT, 
WITH THE SAME NAME AS THE SELECTED SYMBOL, ALL SYMBOLS FOR THE 
COMPONENT ARE RENAMED IN THE PROJECT.
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How the renaming is performed on the individual 
project page, can be specified in the upper-left corner 
of the dialog box Rename selected symbols.

Here you select one of the four corners, to specify 
from which corner to start the renaming.

Furthermore, you specify the numbering direction 
Vertical or Horisontal.

What is important for which number a component is 
assigned, is therefore the first time a symbol for the component appears in the 
project.

— The function and location aspects in reference designations (if any) remains 
unchanged under the renaming.

SPECIFY START VALUE FOR RENAMING SYMBOLS

When you wish to specify a start value for the renamed symbols, type in the 
number in the Start value field.

Hereby the new symbol names starts with e.g. the number 100.

SHOW NEW SYMBOL NAMES BEFORE RENAMING SYMBOLS

When you have selected which symbols to rename, have specified a direction for 
the renaming, and have specified a start value (optional), you are ready to execute 
the renaming.

Before you do this, you can click the Show button in the right-hand side of the dia-
log box. The new names are now displayed in the column New Name — see the 
figure above.

When you are satisfied with the new names, click the Execute button, and the listed 
symbols are renamed in the project.

UNDO THE RENAMING

PLEASE NOTE THAT IT IS POSSIBLE TO UNDO THE RENAMING BY USING THE 
UNDO FUNCTION, AFTER CLOSING THE DIALOG BOX RENAME SELECTED SYM-
BOLS.
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NAMING WHEN RENAMING TERMINALS

In the dialog box Rename selected symbols 
you can specify how to rename the terminals in 
the list.

You have the following options:

— These options are precisely the same as the options for intelligent copying of 
areas. See more about this in “Intelligent copying of areas” on page 255.

Example on renaming terminals
When you select e.g. Rename Terminal Connection Points, and click on Show, 
you can see the new connection names for the terminals in the column New Pinno:

— See also “Insert new Symbol names or Connection names” on page 305.

OPTIONS ACTION

DO NOT RENAME 
TERMINALS

NO TERMINALS AND NO TERMINAL CONNECTION POINTS ARE RENAMED.

RENAME TERMINALS ONLY THE TERMINALS ARE RENAMED. TERMINAL CONNECTION POINTS 
ARE NOT RENAMED.

RENAME TERMINAL 
CONNECTION POINTS

THE TERMINAL CONNECTION POINTS ARE RENAMED. TERMINAL NAMES 
ARE NOT RENAMED. — SEE “FULFILLING STANDARDS WHEN COPYING 
AREAS” ON PAGE 256.

RENAMING TERMINALS IN RENAME SELECTED SYMBOLS

RULES FOR RENAMING TERMINALS

TERMINAL CONNECTION NAMES ARE ONLY RENAMED WHEN THESE ARE NUM-
BERS. TERMINAL CONNECTION NAMES ARE ONLY RENAMED WHEN BOTH

(/ALL) CONNECTION NAMES FOR A TERMINAL ARE IDENTICAL.
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INSERT NEW SYMBOL NAMES OR CONNECTION NAMES

It is also possible to use the Rename selected symbols dialog box to insert new 
symbol names or connection names in the project:

1. Insert new symbol names
To insert e.g. three new symbol names start-
ing from -P2 in the project, do this:

1a) Select -P2 in the project.

1b) Select Functions => Rename sym-
bols — or right-click on -P2 and 
select Insert name.

1c) In the dialog box Insert name: Click 
in the Insert new names field, and 
type in how many names to insert:

1d) Click on Execute.

The symbol -P2 is hereby renamed to -P5, and the subsequent -P symbols are 
renamed correspondingly. (-P3 are renamed to -P6 — etc.).

The symbol names -P2, -P3 and -P4 are now available in the project.

2. Insert new connection names on terminals
To insert e.g. five new connection 
names in terminal -X1, starting 
from connection 4, do this:

2a) Select the terminal which 
has the connection 4 in the 
project.

2b) Select Functions => 
Rename symbols. (Or 
right-click directly on the 
terminal symbol and select 
Insert name).
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2c) In the dialog box Insert name: Click in the Insert free names field, and type 
in how many connection names to insert:

2d) Click on Execute.

The new connection names are now inserted for the terminal, according to the same 
principle as described in “Insert new symbol names” on page 305.

SORTING ACC. TO COLUMN NAMES IN THE DIALOG BOX

When you open the dialog box Rename selected symbols, the information in the 
dialog box are sorted by symbol name, but if you wish to e.g. sort according to type, 
you just click on the column caption Type.

When you wish to sort in reverse order, just click on the column caption again. The 
sorting is alphabetical/numerical.

All columns can be sorted in both directions.



This section describes functions, which gives 

you a survey of projects:

- The Explorer ........................................(p. 309)

- The Object Lister .................................(p. 314)

- Find and Replace .................................(p. 324)

- Design check........................................(p. 328)

- Printing.................................................(p. 332)

- The Explorer as Project/Symbol menu (p. 338)

- Reference designations ........................(p. 339)
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THE EXPLORER WINDOW: THE PROJECTS TAB

The Explorer window contains two different tabs: The Projects tab and the Sub-
Drawings tab. This chapter describes the Projects tab, as well as the general 
options in the Explorer window. The SubDrawings tab is described in “Sub draw-
ings” on page 266.

In the Projects tab in the Explorer window, you can display all types of informa-
tion about the active projects, and can navigate back and forth between the project 
pages in all of the open projects. Furthermore, you can edit Project data, Page Data 
and component data directly from the Explorer window.

GENERAL SETTINGS FOR THE EXPLORER WINDOW

You can specify where to place the Explorer window, as explained in “Docking 
Windows and Toolbars” on page 49.

If you do not want to use the Explorer window, you can turn it off by choosing Set-
tings => Pointer/Screen, and deselect Explorer window.

View Explorer window
View => Explorer window is a menu point which shows/hides the Explorer win-
dow, if Explorer window has been selected in Settings => Pointer/Screen. The 
function has the short-cut key <Shift+F12>, so that you can show/hide the 
Explorer window quickly.

The Explorer window in Edit symbol mode
When you are designing symbols — being in the Edit symbol mode — you most 
likely do not need the Explorer window.

Therefore you can choose Settings => Pointer/Screen => Explorer window and 
subsequently deselect Show in Edit symbol, which specifies whether to show the 
Explorer window in the Edit symbol mode.

THIS CHAPTER DESCRIBES

— GENERAL SETTINGS FOR THE EXPLORER WINDOW ............................................(P. 309)

— DISPLAYING AND HIDING INFORMATION IN THE PROJECTS TAB ........................(P. 310)

— EDITING PROJECT, PAGE AND ARTICLE DATA FROM THE PROJECTS TAB ..........(P. 310)

— SELECTING SYMBOLS FROM THE PROJECTS TAB................................................(P. 311)

— JUMPING BETWEEN PROJECT PAGES IN DIFFERENT PROJECTS............................(P. 312)

— UPDATING THE PROJECTS TAB ...........................................................................(P. 312)

— CLOSING PROJECTS FROM THE PROJECTS TAB....................................................(P. 313)
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DISPLAY AND HIDE INFORMATION IN THE EXPLORER WINDOW

In the Projects tab in the Explorer window, you 
will see three different types of symbols: The Plus, 
the Minus and the Eye.

A Plus means that the subject in that line contains 
more information. If you click on the Plus this 
information is displayed.

If for instance you click on the Plus in the Project 
Data line above, you see the project data for the 
project.

As you can see, the symbol in the Project Data line 
has now changed to a Minus. When you click on 
this Minus the project data datafields are hidden, 
and the Explorer window looks like the first figure 
again.

CHANGING DATA FROM THE PROJECTS TAB

From the Projects tab in the Explorer window you can change project data, page 
data and component data.

Editing Project data from Projects tab
To edit Project data from the Projects 
tab, right-click on the line Project data, 
and choose Edit Project data.

You then enter the dialog box Project 
data, from where you can edit the 
project data for the project. This dialog 
box is described in “Project and Page data” on page 138.

Make the changes and click OK.

Editing the contents of a single Project data datafield
When you want to edit the contents of a single Project data datafield — for instance 
Customer name — you right-click on the datafield in the Explorer window, and 
choose Edit Customer name. You then enter the following dialog box:

Make the changes and click OK.
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Editing Page data and Project data
Page data datafields are changed directly from the Projects tab in the Explorer 
window, as described in “Editing the contents of a single Project data datafield” on 
page 310.

When you edit a Page data datafield, you also get the option of changing the con-
tents of all Page data datafields of the chosen type in the entire project by choosing 
Change on All Pages.

The contents of Page data datafields can also be edited from the Object Lister 
(short-cut key [F7]), as described in “Editing Page data in the Object Lister” on 
page 322.

Editing Component data from the Projects tab in the Explorer window
When you want to edit the Component data 
for at symbol, this can be done by right-click-
ing on the symbol in the Projects tab in the 
Explorer window, and choosing Edit Sym-
bol Data.

This brings you into the dialog box Compo-
nent data, where you edit the component data 
and click OK.

You can also make changes in article data for cables and signals from the Projects 
tab in the Explorer window.

Component data and cable article data can also be changed directly from the 
Object Lister (short-cut key [F7]), as described in “Check and edit component data 
and cable data” on page 321.

SELECTING A SYMBOL ON A PAGE

When you click on an Eye, the work area displays what you clicked on. You will 
only see an Eye in front of a line, if there is something to display in the project by 
clicking on the Eye.

When you click on the Plus in front of Pages, you see the pages in the project. If 
you open the chapter divider Control Circuits: Circuit designs, and then open page 
2: Control circuit diagram, you can see that you can get further information about 
Page Data, Components, Cables and Signals on the page.

Open Components, and then open =G1+A2-Q1.

You now see the three =G1+A2-Q1 symbols on the chosen page.
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If you then want to find the Open symbol for =G1+A2-Q1, click on the Eye in the 
line :13,14 (Open) ..., and the cross hairs now points out the symbol for you on the 
diagram page.

The line you clicked on can contain information about the connection names for the 
symbol (13,14), the type of the symbol (Open), the symbol file name (07-02-01) 
and the title of the symbol.

Due to the size of the Explorer window, you will probably not be able to see all 
that information. If you let the mouse pointer rest a short while over the line, the 
entire line will be displayed.

Please note, that you can do the same for Cables and Signals.

JUMP BETWEEN PAGES IN MORE THAN ONE PROJECT

When you have more than one project open at the time, 
you can find all the open projects in the Projects tab in 
the Explorer window.

When you open Pages for the projects, you can jump 
back and forth between the pages in the different 
projects, just by clicking on the Eye for the relevant 
project page.

By opening Project Data for the projects, you can for 
instance compare project data for the projects.

UPDATING THE EXPLORER WINDOW

When you delete a project page, which is displayed in the 
Explorer window, this page is also deleted from the 
Explorer window.
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CLOSING PROJECTS FROM THE PROJECTS TAB

If you want to close a project from the Projects tab in the Explorer window, right-
click on the project file name and choose Close.

You can also right-click on a project in the Projects tab in the Explorer window, 
and choose Go to. This activates the last page you worked on in the project.
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THE OBJECT LISTER

To navigate quickly in your projects, you can use the Object Lister.

The Object Lister makes it possible for you to locate any given component in a 
project and/or information about the applied symbols/components.

From the Object Lister you can also edit component data, PLC I/O data, page data 
and free texts for all of the project. Furthermore, you can print and create files con-
taining selected information to for instance Excel.

— See also “The Explorer window: The Projects tab” on page 309 and “Find and 
Replace” on page 324.

THIS CHAPTER DESCRIBES

— ON THE DIALOG BOX OBJECT LISTER ................................................................(P. 315)

— SELECTING OBJECTS VIA THE OBJECT LISTER....................................................(P. 316)

— LOCKING THE OBJECT LISTER TO A REFERENCE DESIGNATION .........................(P. 316)

— THE SORTING ORDER OF DATA IN THE OBJECT LISTER...................................... (P. 316)

— SELECTING OBJECTS ...........................................................................................(P. 316)

— COUNTING ON SELECTED OBJECTS .....................................................................(P. 317)

— DISPLAYING INFORMATION ................................................................................(P. 318)

— PRINTING ............................................................................................................(P. 319)

— SAVE TO FILE......................................................................................................(P. 319)

— CHOOSING NEW COMPONENTS IN THE DATABASE..............................................(P. 319)

— SEARCHING......................................................................................................... (P. 320)

— SHOWING THE NUMBER OF FOUND OBJECTS ......................................................(P. 320)

— EDITING SYMBOL AND CABLE DATA VIA THE OBJECT LISTER.......................... (P. 321)

— EDITING PLC I/O DATA VIA THE OBJECT LISTER ..............................................(P. 321)

— EDITING PROJECT TEXTS VIA THE OBJECT LISTER.............................................(P. 322)

— EDITING PAGE DATA VIA THE OBJECT LISTER...................................................(P. 322)

— OBJECT LISTER FOR ONE COMPONENT ...............................................................(P. 322)

— TEXT LINKS IN THE OBJECT LISTER ...................................................................(P. 323)

http://www.dps.dk/english/Video/Product_videos.htm
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ON THE OBJECT LISTER DIALOG BOX

To enter the Object lister you choose Functions => Object Lister, or press the 
short-cut key [F7]:

By clicking in the upper-left corner you determine whether to find Symbols, Sig-
nals, Texts, Wire numbers, Cables, PLC I/O, Pages or Reference frames. Please 
note, that the dialog box is not filled out until you have chosen one of these options.

If you, as above, have chosen Symbols, all project symbols will appear in alphabet-
ical order — independently of which page you are working on at present.

Signals in the Object Lister
When you select Signals in the Object 
Lister, the signal references are also dis-
played:

+ before the reference, means that the signal 
is With reference, and displays From/To.

THE OBJECT LISTER REMAINS ON SCREEN

THE OBJECT LISTER REMANIS ON SCREEN WHILE YOU ARE WORKING WITH 
THE PROJECT. WHEN THE OBJECT LISTER DISPLAYS DATA, THE PROGRAM 
UPDATES THESE DATA AUTOMATICALLY, WHEN YOU MAKE CHANGES IN THE 
PROJECT.
— THE OBJECT LISTER CAN BE SET TO BECOME TRANSPARENT, WHEN YOU 
ARE WORKING ON THE DRAWING AREA, WHILE YOU LET THE OBJECT LISTER 
REMAIN ON THE SCREEN — SEE “POINTER/SCREEN” ON PAGE 815.

Choose which type of
objects to display

Update

Fetch data
from database

Search

Click on an
object, and it
is displayed
in the project Save as file

e.g. for Excel
For scrollling up/down
and left/right in the list

Edit data

View object
in project

Lock Object Lister
to reference designation



PAGE 316 PCschematic ELautomation 10.0

THE OBJECT LISTER

* before the reference, means that With reference is not selected, and displays All.

- before the reference, means that With reference is not selected.

SELECTING OBJECTS DIRECTLY FROM THE OBJECT LISTER

If for instance you have chosen to work with Symbols, and wish to find the symbol 
=G1+A2-Q2 in the project, scroll down to it and double-click on =G1+A2-Q2. This 
automatically places you on the page in the project where the symbol is located, 
and the symbol will be selected.

This also applies for other types of objects in the Object Lister.

LOCKING THE OBJECT LISTER TO A REFERENCE DESIGNATION

When you click on the Lock list to reference 
designation button, you enter the dialog box 
Reference designation, from which you can 
select which reference designation to display 
in the Object Lister.

Subsequently, only objects with the selected 
reference designation are displayed in the 
Object Lister. In the title bar of the Object 
Lister, you can see the selected reference des-
ignation.

Show all objects with any reference designation again
To make the Object Lister displays objects with any project designation again, 
click on the Lock list to reference designation button, and select Top node = none 
for both the function and the location aspect in the dialog box Reference designa-
tions.

THE SORTING ORDER OF THE DATA IN THE OBJECT LISTER

Initially the objects will be sorted by symbol name (page name and text contents 
respectively), but if you want them sorted by for instance article, click on the col-
umn heading Article.

When you wish to see the objects in reverse order, click the column heading again. 
The sorting order is alphabetical/numerical. You can sort all columns in both direc-
tions.

SELECTING OBJECTS IN THE OBJECT LISTER

Selecting objects in the Object Lister follows the common Windows guidelines:

Only objects with this reference
designation is displayed
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Selecting a single object in the Object Lister
To select one single object in the Object Lister, just click on it.

Choosing a block of objects in the Object Lister
To select a block of objects listed in succession in the Object Lister, click on the 
first object in the block, and press down <Shift> while clicking on the last object in 
the block.

Selecting and deselecting single objects in the Object Lister
To select more than one object individually, press down <Ctrl> while clicking on 
the objects. When you wish to deselect a selected object, without deselecting the 
other selected objects, you must also press down <Ctrl> while clicking on the obe-
ject.

Selected objects and Printing in the Object Lister
When you have selected more than one object when clicking on Print in the Object 
Lister, only the selected objects are printed. When only one object is selected, all of 
the list is printed. — See “Printing from the Object Lister” on page 319.

This also applies when you click on Save to save a file. — See “Save as File from 
the Object Lister” on page 319.

Example on choosing objects in the Object Lister
To select the selected objects in the Object Lister below, do the following:

1) Click on the first object in 
the list.

2) Press down <Shift>, and 
click on the last object in the 
list.

3) Press down <Ctrl>, and click 
on the object you wish to 
deselect.

The chosen objects can now for instance be printed, saved to a file, or the article 
data for the selected objects can be edited.

COUNTING ON SELECTED OBJECTS IN THE OBJECT LISTER

When you have selected more than one object in the Object Lister, it is possible to 
apply the automatic counting functions in the program for various of the object 
texts.

When for instance you wish to change the function texts (the PLC addresses) for 
the output on a PLC, do the following:

1

3

2
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1) In the Object Lister: Click on PLC I/O — to work with PLCs.

2) Click on the Pencil — to edit texts in the Object Lister.

3) Select the relevant symbols — see “Selecting objects in the Object Lister” on 
page 316 —, and press <Enter> or <F2>:

4) You now get the option to change the selected texts automatically, as 
described in “Changing a text” on page 139. Click OK.

DISPLAYING INFORMATION IN THE OBJECT LISTER

Under the menu point View, you can specify 
which information to display in the Object 
Lister for the different types of objects.

If for instance you choose View => Symbols, 
you can see which information that is displayed 
for symbols in the Object Lister.

Viewing the different types of information can 
be selected/deselected by placing/removing a 
check mark in front of each type of information.

When a check mark is placed in front of a type 
of information which is dimmed, this specifies 
that this information can not be deselected in the 
Object Lister.

Removing a column from the Object Lister by right-clicking
When you right-click on a column heading in 
the Object Lister, a right-click menu 
appears, from which you can also specify not 
to display a column in the Object Lister.

In the example to the right there is right-
clicked on the column heading Function, and 
a right-click menu appeard. When Function 
is deselected, this column is no longer dis-
played in the Object Lister.

3a) Click here
3b) Press down

 <Shift> and
click here

2) Click the Pencil

3c) Press <F2>
or <Enter>
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PRINTING FROM THE OBJECT LISTER

When you have selected more than one object, only the selected objects are printed, 
when you click on Print. When only one object is selected, all of the list is printed. 
— Read more about selecting objects in “Selecting objects in the Object Lister” on 
page 316.

When you click on Print, you enter the dialog box Print, in which you choose 
printer and print the selected.

SAVE AS FILE FROM THE OBJECT LISTER

When you have selected more than one object, only the selected objects are saved, 
when you click on Save. When only one object is selected, all of the list is saved. 
— Read more about selecting objects in “Selecting objects in the Object Lister” on 
page 316.

When you click on Save you enter the dialog box Save. Here you can save the 
selected objects in three different ways:

1) Text files (*.txt): The file is saved in column format.

2) Comma separated (*.csv): The file is saved in comma separated format.

3) Microsoft Excel (*.xls): The file is saved in Microsoft Excel format.

Select file type, type in a file name, and click OK.

CHOOSING NEW COMPONENTS IN DATABASE VIA OBJECT LISTER

This is only possible when working with Symbols or Cables in the Object Lister:

When you click the DB button, you enter the database, located at the article number 
of the chosen component. You can then change the component in the project by 
choosing another article number in the database.

Only the selected symbol(s) in the Object Lister have their data changed. — See 
“Selecting objects in the Object Lister” on page 316.

EXCEL MUST BE INSTALLED

IT IS ONLY POSSIBLE TO SAVE IN EXCEL FORMAT WHEN EXCEL IS INSTALLED 
ON THE PC.

THIS IS BECAUSE PCschematic ELautomation LETS EXCEL HANDLE THE 
SAVING. THIS WAY YOU ARE NOT DEPENDANT OF WHETHER PCschematic 
ELautomation CAN HANDLE THE VERSION OF EXCEL INSTALLED ON YOUR 
PC.
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SEARCHING IN THE OBJECT LISTER

When you click on the Find button, you can search among the selected objects in 
the Object Lister.

Click on the Down arrow, and choose which type of text you wish to search on.

When for instance you choose Type this is marked in the column Type.

Then type in the search text. While you are typing in the text, the Object Lister 
automatically jumps down to the first object in the list, that matches what you have 
typed in for the moment.

Click on the Search again button to find the next object in the list, that matches 
what you have typed in. When no objects matches what you have typed in, the 
Search again button is dimmed.

PCschematic ELautomation can either search for texts that begins with what you 
have typed in, or just contains the text.

This depends on whether the Begins with button is activated, or the Contains but-
ton is activated. The button is placed to the right of the Find again button, and 
changes appearance between Begins with and Contains when you click on it.

SHOW USED AND COUNT

When you select Show used and 
count, each symbol name will only 
be displayed once in the list.

You can also see how many times 
each symbol is used in the project.

When you double click on a symbol 
name in the list, you get the same 
detailed information about the symbol as you can see in “Object lister for selected 
symbol” on page 322.

To return to the list of all project symbols, select Show used and count again.

Click here and
choose what to
search for

Type in the search
text and press <Enter>

Shows that you are
searching on Type
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CHECK AND EDIT COMPONENT DATA AND CABLE DATA

When you click on Symbols 
and then click the Pencil, you 
can correct the article data for 
the symbols directly from the 
Object Lister.

If for instance you want to 
change the symbol type, click 
in the Type field for the relevant symbol, and make the change.

When you click on Cables you can make similar changes for Cable data.

See how to edit article data for more than one cable at the time in “Editing PLC I/O 
data via the Object Lister” on page 321.

EDITING PLC I/O DATA VIA THE OBJECT LISTER

To edit PLC I/O data in PCschematic ELautomation, click on PLC I/O in the 
Object Lister.

You can then choose either Used I/O — which gives you all used PLC I/O symbols 
in the project — or From reference symbols — which gives you all mentioned 
connection points in the PLC reference symbols in the project.

When you click on the Pencil, you can start editing PLC I/O data directly from the 
Object Lister.

Searching for PLC I/O data is done as described in “Searching in the Object Lister” 
on page 320.

See how to edit PLC I/O data for more than one PLC symbol at a time in “Counting 
on selected objects in the Object Lister” on page 317.

PLC I/O data can be saved to a file — for instance in Excel format — as described 
in “Save as File from the Object Lister” on page 319.



PAGE 322 PCschematic ELautomation 10.0

THE OBJECT LISTER

CHECKING AND EDITING PROJECT TEXTS VIA THE OBJECT LISTER

It is a good idea to check the project texts by 
clicking on Texts. If you need to make cor-
rections, click the Pencil, and click in the 
text field you wish to edit.

The changes is transferred to the diagrams 
automatically.

When you want to jump to the text in the 
project, first deactivate the Pencil, then dou-
ble-click on the text in the Object Lister.

— See how to edit more than one text at a time in “Counting on selected objects in 
the Object Lister” on page 317.

EDITING PAGE DATA IN THE OBJECT LISTER

When you click on 
Pages, you get a survey 
of all the project pages.

When you then click the 
Pencil, you get the 
option of editing the page 
titles.

OBJECT LISTER FOR SELECTED SYMBOL

If you select a symbol when you are working in the 
project — for instance -F1 — and press [F7], you 
will get a survey of all the places -F1 is used in the 
project.

Alternatively you can right-click on a symbol, and 
choose Show used.

You then get the following survey of the symbol:

These functions are also available for signals and wire numbers.
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When you want the list on print, click on Print. Click Save to save it as a file.

Click on the Pencil to correct the component data, or click the DB button to find the 
symbol in the database.

TEXT LINKS IN THE OBJECT LISTER

Information about linked text is also displayed in the Object Lister.

— See “Text links” on page 153.
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FIND AND REPLACE

To find objects in projects quickly, you either use the Object Lister — see “The 
Object Lister” on page 314 — or the Find function, which is described in this chap-
ter.

The Object Lister gives you the possibility to locate components in the project and/
or locate article data for the applied symbols/components. Also, you can change 
texts using the Object Lister.

The Find function gives you the option to find symbol texts, and the replace func-
tion gives you the option to replace them as well.

 — Other ways to find symbols quickly are described in “Functions on Component 
Level” on page 241.

FINDING SYMBOL TEXTS

If you want to find symbol texts, you choose Edit => Find (short-cut key [Ctrl+f]) 
and enter this dialog box:

THIS CHAPTER DESCRIBES

— FIND SYMBOL TEXTS..........................................................................................(P. 324)

— REPLACE SYMBOL TEXTS................................................................................... (P. 326)

— THE DIALOG BOX FIND AND REPLACE REMAINS ON SCREEN.............................(P. 327)

— NEGATED AND UNDERLINED TEXTS IN FIND AND REPLACE..............................(P. 327)

Click here to see a list containing
project texts of the chosen Text type
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Here you type in the type of text you want to find, and state which type of symbol 
text you want to find, and in which direction you want the search carried out. The 
search direction determines whether you search the full project, the page you are 
working on, or in the direction forwards or backwards. — Please note that if you 
search for Symbol datafields, you search for the values in the symbol datafields. 
Correspondingly, you can only replace the values of the symbol datafields, and not 
their names.

When you set Text type to All, PCsche-
matic ELautomation search in all texts 
types in the project.

When a text is found, the text is dis-
played in the dialog box.

Text recognition
If you select Match Case, you will only find the texts using upper case and lower 
case letters exactly the way you type them in. If you write X1, the text x1 will not be 
found. However, this text will be found if you have not selected Match case.

If you select Find Whole Text Only, you will only find the symbol texts that con-
tains exactly the letters/characters you typed in. If you have typed in Component, it 
will not find the text Component A38. But this text will be found if you have not 
selected Find Whole Text Only.

Please note, that if you have not selected Find Whole Text Only, the program will 
find all texts having the text you typed in as a part of the text. If you typed in tact, it 
would find the text contact.

Searching with Reference designations
When searching for symbols with reference designations, it is possible only to 
specify either the location or the function part of the reference designation.
If you type in the search text =G1-Q1 and select Match Whole text only, you will 
therefore also find the symbols for the component =G1+A2-Q1.

Zoom during Find and Replace
When a found text is selected on a diagram, it is sometimes an advantage to zoom 
in on the symbol. In the Zoom in mm field you specify how close you want to zoom 
in on the found text.

Find next symbol
When you want to find the text in the project, you click on Find Next, and the next 
text matching the search criteria will be found.

If you exit the Find dialog box, you will find the next text matching the search cri-
teria by choosing Edit => Find next, or by pressing the [F3] key.

Found text
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When no more text matches the search criteria, you get the following message:

REPLACING SYMBOL TEXTS

If you want to find and replace symbol texts, you choose Edit => Replace and 
enter this dialog box:

You specify what you want to find as explained above, and in the Replace with 
field you type in the text you want to replace.

When you have clicked on Find Next, and a symbol text has been found, you click 
on Replace to replace the text. After replacing the text, you automatically jump to 
the next text matching the search criterion.

If you do not want to change the text you have found, just click on Find next, and 
you jump to the next text matching the search criterion.

Clicking on Replace All will replace all matching texts in the specified area.

Click on Close when you have finished.

— Please note that if you search for Symbol datafields, you search for the values in 
the symbol datafields. Correspondingly, you can only replace the values of the 
symbol datafields, and not their names.

Find and Replace for connection names
Connection names can also be replaced from the dialog box 
Replace. If you wish to replace the connection name 13 for 
the symbol -Q1, write -Q1:13 in the Find What field, and 
only write the new connection name in the Replace with 

Click here to see a list containing
project texts of the chosen Text type
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field — e.g. 23 — because the program knows that it is the connection name, that is 
going to be replaced.

FIND AND REPLACE REMAINS ON SCREEN

When you have chosen Find and Replace, the dialog box remains on screen while 
you perform operations, so that you can continue searching easily.

— The Find and Replace dialog box can be set to be transparent, when working on 
the drawing area while the Find and Replace dialog box remains on screen — see 
“Pointer/Screen” on page 815.

NEGATED AND UNDERLINED TEXTS IN FIND AND REPLACE

In the dialog boxes for Edit => Find and Edit => 
Replace you can search for negated and underlined 
texts.

To search for a negated text, do the following:

1) Type in the text, and select the part of the text 
that is negated.

2) Right-click on the selected, and choose 
Negate.

Searching for underlined texts takes place by 
choosing Underline.

To neutralise the negation of a text, select the text, right-click and choose Negate 
again. To neutralise the underlining of an underlined text, choose Underline.
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DESIGN CHECK

The designcheck function can give you some help checking your design.

PERFORMING A DESIGN CHECK

To activate the function, choose Functions => Design Check, which gives you the 
following options:

Select which of the options you want your project checked for. To maintain a sur-
vey, it might be a good idea to check the project for one design check option at the 
time.

THIS CHAPTER DESCRIBES

— PERFORMING A DESIGN CHECK ..........................................................................(P. 328)

— THE DESIGN CHECK DIALOG BOX.......................................................................(P. 329)

— THE DESIGN CHECK ERROR MESSAGES ..............................................................(P. 330)

— DISABLING USED MORE THAN ONCE IN THE SYMBOL DEFINITION ....................(P. 331)

USE THE DESIGN CHECK FUNCTION FREQUENTLY

IT IS A GOOD IDEA TO APPLY THE DESIGN CHECK FUNCTION FROM TIME TO 
TIME WHILE YOU ARE DRAWING. THIS WAY YOU DO NOT HAVE TO BOTHER 
WITH TOO MANY ERROR MESSAGES AT THE SAME TIME.
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— Please note that the check for Mounting correct only appears if you have chosen 
to work in mounting mode. — See “Mounting correct drawing” on page 120.

Click on OK.

If the design check finds errors of the selected types, you will get a list of errors and 
warnings — as described in “The Design Check dialog box” on page 329. Other-
wise, you will be told that no errors have been found.

THE DESIGN CHECK DIALOG BOX

When you choose Functions => Design Check, and click OK to execute a design 
check, you enter the dialog box Design Check:

This dialog box remains on screen while you are working in the project. — The dia-
log box can be set to be transparent, as described in “Pointer/Screen” on page 815.

Here you have the following options:

Double-click on errors in the list
When you double-click on an error message in the list, the program jumps to the 
place in the project, which have provoked the message, and the relevant object is 
pointed out by the cross hairs.

Update the Design Check list
When you have made changes in the project, you can click the Update list button. 
This automatically updates the list according to the performed changes.

ACTIONS PERFORMED BEFORE DESIGN CHECK CAN NOT BE UNDONE

WHEN EXECUTING A DESIGN CHECK, THE PROJECT IS AUTOMATICALLY OPTI-
MISED.
THEREFORE, YOU DO NOT HAVE THE OPTION TO UNDO THE ACTIONS MADE 
BEFORE EXECUTING THE DESIGN CHECK.
WHEN YOU ACTIVATE THE DESIGN CHECK FUNCTION, LINES WHICH HAVE 
BEEN EDITED ARE CORRECTED TO BE CONTINUOUS LINES.
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When you have corrected the errors on the list, there may still be errors in the 
project, due to subsequent obsolete errors.

Therefore it is a good idea to perform another design check, once you have cor-
rected the errors mentioned in the original list.

Accordingly, it may happen that correcting one error will make more than one error 
message disappear.

Design check settings
When you click the Design Check settings button, you enter the Design Check 
menu, from where you specify which types of design check you wish to perform. 
The design check list is automatically updated according to these directions.

Save and Print
Furthermore, you have the following options:

Click on the Save button to save the list in a file.

Click the Print button to print the list.

Close the Design Check list
To close the design check list, click the Close button in the upper right-hand corner 
of the dialog box.

ERROR MESSAGES

When you perform a design check, you may see the following error messages, 
accompanied by information about the page on which the error occurs, and the 
coordinates for exactly where on the page it occurs:

ERROR MESSAGE SIGNIFIES

MISSING SYMBOL NAME THE SYMBOL ON THE POSITION STATED HAVE NOT BEEN ASSIGNED 
A SYMBOL NAME.

MISSING CONNECTION 
NAME

YOU HAVE NOT ASSIGNED A NAME FOR THE CONNECTION POINT OF 
THE SYMBOL ON THE STATED POSITION.

CONNECTION K1:14 IS 
USED IN SEVERAL NETS

THE CONNECTION POINT WITH THE CONNECTION POINT NAME 14 IS 
USED IN MORE THAN ONE ELECTRICAL POTENTIAL.

L1 AND L2, ARE USED IN 
THE SAME NET

THE SIGNAL NAMES L1 AND L2 ARE USED IN THE SAME NET.

ONLY ONE CONNECTION 
IN NET L7

YOU HAVE DRAWN A CONDUCTING LINE WITH JUST A SIGNAL SYM-
BOL — AND NOTHING ELSE. A CONNECTION TO A SYMBOL, OR TO 
ANOTHER SIGNAL SYMBOL, COULD BE MISSING.

PARKED LINE YOU HAVE PARKED A LINE ON THE STATED POSITION.

MORE SIGNALS IN SAME 
POINT

YOU HAVE PLACED MORE THAN ONE SIGNAL SYMBOL AT THE SAME 
POSITION.

ERROR MESSAGES FOLLOWING DESIGN CHECK
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If you are having difficulties handling errors in your project, please contact your 
local hot-line.

DESELECT USED MORE THAN ONCE IN THE SYMBOL DEFINITION

It is possible to deselect Functions => Design Check => Used more than once for 
individual symbols via the symbol definition for a symbol.

This is because it for some symbols — specially for pneumatics symbols — is 
allowed to have more connection points with the same name.

— Read more about this in “No double check” on page 676.
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PRINTING

In PCschematic ELautomation you can choose between just printing out the page 
you are presently working on, without changing any page settings, or specify which 
pages you wish to print, and how they shall be printed etc.

If you only want to print out the page you are working on, and do not wish to make 
changes in the printer settings, click the Print this page button.

OPENING THE PRINT DIALOG BOX

The printing dialog box shown below is activated by choosing File => Print or by 
clicking on the Print pages button on the program toolbar. The short-cut key is 
[Ctrl+p].

THIS CHAPTER DESCRIBES

— OPENING THE PRINT DIALOG BOX ......................................................................(P. 332)

— THE RIGHT-HAND SIDE OF THE DIALOG BOX ......................................................(P. 333)

— SELECT PAGES ....................................................................................................(P. 333)

— SETUP .................................................................................................................(P. 335)

— CHOOSE PRINTER ...............................................................................................(P. 336)

— CREATING ACROBAT/PDF FILES ........................................................................(P. 337)

— BATCH PRINTING ................................................................................................(P. 337)

— IF DIAGRAMS ARE MINIMIZED WHEN PRINTING ..................................................(P. 337)
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THE RIGHT-HAND SIDE OF THE PRINTER DIALOG BOX

The right-hand side of the dialog box is identical for the tabs Select pages, Setup 
and Printer. Here you get an overview of what printing a page will result in.

You can also determine the number of copies, whether you want the pages printed 
in reverse order, or if you only want to print pages changed later than a specified 
date.

Projects are printed out as one document. This means the printing can not be inter-
rupted by other jobs on a network printer.

When printing more than one copy of the project, an information is sent to the 
printer, specifying the number of copies. — This, however, requires that the printer 
driver is able to handle this information. If the printer driver can handle the infor-
mation "10 copies", this is obviously a lot faster than if the program should send the 
project to the printer ten times.

When more than one page and more than one copy is chosen, you can also choose 
Collate, if the chosen printer driver can handle the collate information.

If you wish to display the pages in the dialog box Print as they are printed, click on 
Print with preview.

The print settings are saved when you click on Close, and are in effect the next time 
you print pages.

Printing for Revision
If you are working on a revision — see “Revision 
control” on page 788 — and select From date, you 
get the option of choosing From revision date. This 
makes it possible only to print pages which has been 
changed since the start of the revision.

— See “Printing during revision control” on page 789 also.

SELECT PAGES

Choosing the Select pages tab, you 
specify which pages to print.

If you want to print page 2 to 4 in the 
project, you click on page 2, and 
press down <Shift> while clicking 
on page 4.

If you, on the other hand, want to 
select page 1 and 3, you click on 
page 1, and press down <Ctrl> while 
clicking on page 3.

If you choose All pages, Even 
pages, Odd pages or Current page, the selected pages are singled out in the list of 
project pages.
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Pages marked with a preceeding ! character, have been changed since the project 
was opened.

Pages marked with a preceeding + character, have been changed since the project 
was last saved.

Printing Chapters and Dividers
When you click the Print pages button and click on the tab Select pages, you have 
the option to handle chapters and dividers easily:

This for instance makes it possible to print dividers on a different type of paper.

When you are printing on a duplex printer, you can also specify not to print dividers 
on duplex, by clicking on Dividers NOT duplex. This checkbox is dimmed if the 
selected printer can not handle duplex.

Printing layers
If you click on Show layer settings, you can specify which layers on the drawing 
to print. — See “Printing pages with layers” on page 474.

If you select Dim not active layers, will those layers, which are dimmed when dis-
played on screen, also be dimmed when printing. This is only an option when there 
exists more than one layer on the page.

— Read more about this in “The Layer menu” on page 472.

All pages in the chapter
are printed

Only Dividers are
printed

Prints all selected pages
apart from the selected
dividers
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SETUP

Selecting Setup enables you to 
define margins and orientation. But 
to do this, you first have to select 
Paper and margin setup.

When you click Adjust to printer, 
the program gives you the printable 
area of your printer through the fig-
ures in the margin fields.

When you have done this, you will 
see the area, specified by the margin 
settings, displayed by a red dash 
line. At the same time you will see 
the area the drawing fills out, indicated by a fully drawn rectangle.

Also there are a number of functions, which make it easier to alter the printout to 
meet your requirements. The drawing can be scaled up and down, and can be 
moved on the paper.

If you want a margin with room for holes in the paper, you must set the left margin 
to 20mm.

If you click on Auto below Orientation, PCschematic ELautomation automati-
cally orientates the page according to the paper.

If you deselect Centre drawing and set Scale to and Orientation to Auto, your 
drawing will be adapted to the chosen printer — with respect to the location and 
scaling.

If you choose Even pages under Mirror margin, the margin will be mirrored for the 
even pages in the project — In this context the first page in the project is page 
number 1. If you choose Odd pages the margin of the odd pages will be mirrored.

When you choose Duplex the project will be printed in duplex. — Margins are only 
mirrored when you choose Even pages or Odd pages.

Choose Color when you want to print the project in color.

On black and white printers, selecting Color gives you a printout using a grey tone 
scale. Please note that your printer might convert some colors to the color white. 
The color white will not be seen on the print.

Print zoom
To print a zoom, do the following:

1) Click on the Zoom button, and make a zoom — see “Zoom” on page 63.
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2) Click the Print pages button, and click on the tab 
Settings.

3) Choose Print zoom. If you need to move the 
selected zoom, click on the arrows next to Move 
drawing. When you press down <Shift> while 
clicking the arrows, the zoom is moved with three 
times bigger steps.

4) Click on Print, and the chosen zoom is printed.

Print test page
If you are having difficulties printing the drawing on your printer, click Print test 
page. This will make the printer print out a test page, displaying the printable area 
of your printer, drawn with a thin line along the edges. The right, left, top and bot-
tom margins will also be printed in figures. These are given using one thousandth of 
a millimetre, making 5865um equal to 5.865mm. These settings are specified in 
your printer driver, and therefore are not changeable from the PCschematic ELau-
tomation program. If the test print does not include all four lines, you have not cho-
sen the correct printer driver for your printer.

A biased left or right margin, suggests that the printer is not feeding the paper cor-
rectly. If the printable area is biased towards the left- or the right hand side, placing 
the paper differently in the tray might help.

If you are having further difficulties, please contact your local supplier.

CHOOSE PRINTER

The last option is the Printer tab, which opens up the general Windows Print 
setup dialog box. The settings in this dialog box have lower priority than the ones 
you define in the rest of the dialog box Print, and can be overruled.

When all settings have been set, click on Print in the right hand side of the dialog 
box.

The last used printer and settings for each printer is memorized by the program.

Alternative PCschematic font
— See “Applying the Arial font for printing to PDF files” on page 337.

Displaying the printer name as a hint
When you let the mouse cursor rest over 
the Print pages button, the name of the 
selected printer is displayed as a hint.

Click here to move the
chosen zoom
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PRINTING PDF FILES / ACROBAT FILES

If you want to create a PDF file — also called an Acrobat file — you just have to 
choose the printer driver Acrobat PDFwriter on the tab Printer.

To do this, you first have to install the program Adobe Acrobat on your PC. Please 
note, that it is not sufficient just to have installed the free program Adobe Acrobat 
Reader.

Fonts when creating PDF files
When printing a project as a PDF file, all PCschematic ELautomation fonts will be 
turned into graphics.

Due to the search facilities in the Acrobat program, it is possible to search on texts 
using Windows fonts in the original PCschematic ELautomation project.

Please note, that it is not correct to use Windows fonts on diagram pages according 
to the standards.

Applying the Arial font for printing to PDF files
However, when a project is printed to a PDF file, it is possible to substitute the 
PCschematic font with the Arial font, which is the Windows font most similar to a 
CAD font. This function is specially designed for creating PDF files.

This makes it possible to apply the PCschematic font in the project, and to get texts 
which you can search on in the PDF file. These texts will also become smoother in 
the PDF files than texts using the PCschematic font.

To do this, you must select the Printer tab, and select Alternative PCschematic 
font: Arial.

— Please refer to “Special characters in PDF files” on page 337 also.

Special characters in PDF files
If you change texts written with the PCschematic ELautomation font to a Win-
dows font, special characters such as e.g. negation will give an incorrect result.
— See “Special characters when changing the PCschematic font to a Windows 
font” on page 146.

BATCH PRINTING

Read more about this in “Batch printing” on page 802.

IF DIAGRAMS ARE MINIMIZED WHEN PRINTING

When printing, PCschematic ELautomation squeezes all objects in the work area 
for each diagram page. This may result in that the drawing might be placed in e.g. 
the lower-left corner of the printed page. This is because objects are placed outside 
the frame of the normal diagram page.

Read more about this in “The Zoom All function during DWG/DXF import” on 
page 635 and “The Zoom All function” on page 64.



PAGE 338 PCschematic ELautomation 10.0

WINDOWS EXPLORER AS SYMBOL/PROJECT MENU

WINDOWS EXPLORER AS SYMBOL/PROJECT MENU

USING THE WINDOWS EXPLORER AS A PROJECT MENU

In PCschematic ELautomation it is possible to use Windows Explorer as a kind 
of Project menu.

When you have opened Windows Explorer, you can therefore drag project files 
from the Explorer to the PCschematic ELautomation program, whereby the 
projects are opened.

When you select several projects at a time, all of the selected projects will be 
opened in PCschematic ELautomation:

USING THE WINDOWS EXPLORER AS A SYMBOL MENU

In PCschematic ELautomation it is possible to apply Windows explorer as a kind 
of Symbol menu.

As described for projects, you can apply the Windows Explorer to drag symbols 
into an open project. Hereby you get the symbol directly in the cross hairs in 
PCschematic ELautomation. You can therefore apply the Windows Explorer as an 
alternative symbol menu, which you can keep open while working with PCsche-
matic ELautomation.

You can only fetch one symbol at the time from the Windows Explorer.

If you open two copies of Windows Explorer, you can apply the one to open 
projects from, and the other to fetch symbols from.

THIS CHAPTER DESCRIBES

— USING THE WINDOWS EXPLORER AS A PROJECT MENU.....................................(P. 338)

— USING THE WINDOWS EXPLORER AS A SYMBOL MENU.....................................(P. 338)

Select the files in the
Explorer, and drag
them over to the active
PCschematic program
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REFERENCE DESIGNATIONS

In PCschematic ELautomation you can apply reference designations in the naming 
of your symbols. This makes it for instance possible to follow the IEC/EN 61346 
standard (IEC750 previously) for naming of symbols.

The reference designations in PCschematic ELautomation can be defined freely, 
and is therefore not tied up to a specific standard. This makes it both possible to fol-
low an internal company standard, and to follow changing international standards. 
If you need to change standard for using reference designations, this is also an 
option.

ON REFERENCE DESIGNATIONS

— Please skip this explanation if you are already familiar with reference designati-
ons.

Reference designations are used for identifying components, functions or locations 
where e.g. a component is placed. The reference designation for a component must 
be placed next to the symbol in the diagram, and on / next to the physical compo-
nent, where it is placed/mounted.

A reference designation must consist of a prefix, followed by a capital letter, follo-
wed by an integer. For instance -M01.

A reference designation must be attached to one of three different aspects, depen-
ding on how you need to observe what the reference designation describes:

THIS CHAPTER DESCRIBES

— ON REFERENCE DESIGNATIONS...........................................................................(P. 339)

— DEFINING REFERENCE DESIGNATIONS ................................................................(P. 342)

— REFERENCE DESIGNATIONS FOR SYMBOLS.........................................................(P. 353)

— REFERENCE DESIGNATIONS FOR PAGES..............................................................(P. 357)

— REFERENCE DESIGNATIONS IN AREAS ON PAGES ...............................................(P. 359)

— REFERENCE DESIGNATIONS FOR CHAPTERS .......................................................(P. 363)

— REFERENCE DESIGNATIONS FOR MORE THAN ONE PAGE AT A TIME ..................(P. 363)

— REFERENCE DESIGNATIONS VIA CHAPTER TABS ................................................(P. 366)

— DATAFIELDS FOR SPECIFYING REFERENCE DESIGNATIONS IN PROJECTS ............(P. 368)

— LISTS ACC. TO FUNCTION OR LOCATION ASPECT ...............................................(P. 369)

LEARN MORE ABOUT REFERENCE DESIGNATIONS

IN THE BOOK "ELECTRO-TECHNICAL DOCUMENTATION ACCORDING TO STAND-
ARDS", YOU CAN READ MORE ABOUT APPLYING REFERENCE DESIGNATIONS IN 
ELECTRO-TECHNICAL DOCUMENTATION. THE BOOK IS PUBLISHED BY DPS 
CAD-CENTER APS.
2. EDITION IS PUBLISHED IN THE THIRD QUARTER OF YEAR 2006.
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- When you observe a function (function aspect), the prefix = is applied

- When you observe a location (location aspect), the prefix + is applied

- When you observe a product (product aspect), the prefix - is applied

In the example above the function designation =M1 specifies that the symbol/com-
ponent is a part of the function =M1. This could for instance be "Pumping1". The 
location designation +R2 — for where the component is placed — could for 
instance be "Hall2".

The product designation -K5 is used to identify the component among the compo-
nents being a part of Pumping1 (=M1), which also exist in Hall2 (+R2).

By using the reference designation system with the three different aspects, you can 
for instance describe a complete industrial plant. The reference designation system 
gives you the possibility to make one list containing all products, another contai-
ning all functions, and a third containing all locations required to identify every-
thing in the industrial plant.

It is possible to specify that all symbols on a project page e.g. belongs to Pumping1 
(=M1) which is located in Hall2 (+R2). If you had specified the reference designa-
tion =M1+R2 in the title block of the drawing header in the example above, you 
would only have need to display the reference designation -K5 next to the symbol.

PRODUCT REFERENCE DESIGNATION / SYMBOL NAME

IN STEAD OF THE PRODUCT REFERENCE DESIGNATION FOR A SYMBOL, THE TERM 
SYMBOL NAME IS USED IN THE REST OF THIS MANUAL.

Function ref. designation

Location ref. designation

Symbol name
(function aspect)

(location aspect)

(product aspect)

For a symbol you can see the following three reference designations:

The reference designation in the block =M1+R2-K5 is interpreted like this:
The product/component -K5 exists in the location +R2 and is attached
to the function =M1.

/ Product ref. designation
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If there exists a symbol/component which is not attached to the reference designa-
tions for the page, PCschematic ELautomation automatically displays those of the 
reference designations for the symbol, which differs from the reference designa-
tions for the page.

Before creating the reference designations, you should have a survey of which 
functions, as well as which switchboards/racks/drawers or other location aspects, 
you will need in your project.

Character for specifying full reference designation (exclude concatenation)
If the character > is displayed in front of a reference designation — e.g. >-K1 — 
this means that -K1 is the full reference designation for the component. -K1 there-
fore uniquely identifies the component.

Please note, that this character can therefore also appear when you have forgotten to 
specify a reference designation for the component.

The > character is called "exclude concatenation", which you can read more about 
in “Use full exclude of concatenation” on page 348.

Reference designations in more than one line
If a reference designation is written in more than one line, this means — according 
to the standards — that each line uniquely identifies the symbol.
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DEFINING REFERENCE DESIGNATIONS FOR THE PROJECT

To create reference designations in your project, you enter Settings => Project 
data, which is the only place in PCschematic ELautomation where you can see 
anything about reference designations, as long as no reference designations have 
been defined in the project. 

Here you click on Reference designations, and enter the dialog box Reference 
designations:

REFERENCE DESIGNATIONS MUST BE DEFINED FIRST

IT WILL NOT BE POSSIBLE TO REFER TO REFERENCE DESIGNATIONS ANYWHERE 
IN PCschematic ELautomation UNTIL YOU HAVE CREATED REFERENCE 
DESIGNATIONS IN THIS DIALOG BOX. HAVING DONE THIS, HOWEVER, YOU CAN 
SELECT REFERENCE DESIGNATIONS IN SETTINGS => PAGE DATA AS WELL AS 
IN THE DIALOG BOX COMPONENT DATA.

Click here

General settings
for the project

Select how to
show the ref.
designations
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In the dialog box Reference designations you can create and edit the Function and 
Location aspects for the reference designations.

The first time you enter the dialog box, no Function or Location aspects will be 
specified.

Displaying reference designations in the dialog box Reference designations
In the upper-left corner of the dialog box Reference designations you can specify 
how to display the reference designations in the dialog box:

Display reference designations as hierarchy / Tree
When you click the Show as tree button, the reference designations are displayed 
as a hierarchical structure — see below.

The reference designations are hereby displayed as a folder structure, just like a 
folder structure you would find in the Windows Explorer, with similar possibilities 
for copying, deleting structure parts etc.

Display reference designations as a list
When you click the Show as list button, the reference designations are displayed as 
a list, with all of the reference designations displayed at the same level — see 
below.

OPTIONS IN THE DIALOG BOX REFERENCE DESIGNATIONS

— DISPLAYING REFERENCE DESIGNATIONS IN THE DIALOG BOX............................(P. 343)

— SPECIFYING FUNCTION/LOCATION ASPECTS.......................................................(P. 344)

— SEE USED FUNCTION/LOCATION ASPECTS ..........................................................(P. 345)

— SORTING FUNCTION/LOCATION ASPECTS BY COLUMN .......................................(P. 346)

— EDITING FUNCTION/LOCATION ASPECTS ............................................................(P. 346)

— DELETING FUNCTION/LOCATION ASPECTS .........................................................(P. 347)

Hierarchial display of
reference designations

List display of
reference designations
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Specifying function/location reference designations
When you want to add a function aspect, click on the New button next to the Func-
tion window — or press the [Insert] key, if you have already selected a function 
aspect in the dialog box.

You then enter the dialog box New:

The character = will be suggested as the first sign in the reference designation, but 
you can also use a character of your own choice.

If the dialog box displays reference designations in list form, and a function refer-
ence designation is selected in the dialog box, the dialog box New will be filled out 
with this reference designation — as for instance =G1 in the dialog box above. This 
is a help for when you type in many reference designations starting with the same 
text.

Type in the name of the new function aspect and click OK.

Then type in the description for the reference designation.

Click OK.

If you are displaying the reference designations as a list — see “Displaying refer-
ence designations in the dialog box Reference designations” on page 343 — the 
function aspect is placed below the selected function aspect in the dialog box.

Click on New again — or press the [Insert] key — to add more function reference 
designations.

Location reference designations are specified correspondingly.

IEC / EN STANDARD

THE CHARACTERS = AND + ARE IEC / EN STANDARD FOR REFERENCE DESIG-
NATIONS.
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See used reference designations
When you wish to see which refer-
ence designations are currently used 
in the project, click on Marked used. 
This inserts a + in front of the used 
reference designations.

This + remains visible until the dia-
log box is closed. The next time the 
dialog box is opened, the + characters 
are removed.

See on which page the reference designations are used
If you wish to see on which page a reference designation is used, you can right-
click on the reference designation and choose Show pages — or click on the refer-
ence designation and press the <spacebar> —, and the pages are displayed in the 
right-hand side of the dialog box:

If you see the reference designations in list form, you can also double-click on the 
reference designation, to see on which pages the reference designation is used.

If you then right-click on a page, and choose Go to page, the selected page is dis-
played in the project:

If you right-click on a page, and choose Show list of objects, a list is displayed, 
containing all the objects on the page with the selected reference designation:

In the left-hand side of the list, you can see the type of the objects. The list can be 
printed, or saved as a file.
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Sorting reference designations by columns
Please note: This only applies for displaying reference designations as a list — see 
“Display reference designations as a list” on page 343.

In the dialog box Reference designations you can sort the reference designations 
alphabetically based on the columns Function aspect, Location aspect and 
Description for function and location aspects.

This is done as described in “The sorting order of the data in the Object Lister” on 
page 316.

Dragging a reference designation to a new position in the dialog box Reference designations
When you wish to move a reference designation to another position in the list of 
reference designations, do this by clicking on the reference designation, and then 
drag it to the desired position:

The function/location aspect is placed just below the function/location aspect, that 
you point on when you release the mouse button. If you drag a function/location 
aspect beyond the top or the bottom of the list, the list starts scrolling. The last used 
function/location aspect will be memorized for the next time the dialog box is 
opened.

— See “The mouse” on page 35 for further details about drag and drop.

Editing reference designations
If you wish to change a function/location aspect, right-click on it and choose Edit 
— or press the [F2] key.

If you change a reference designation, and there exists other reference designations 
starting with this reference designation, you will be asked whether these should be 
changed also. If you change the reference designation =G1 to =G2, you can for 
instance have the reference designation =G1A2 changed to =G2A2 automatically.

Changing reference designations for more than one page
To change reference designations for more than one page at a time, see “Edit refer-
ence designations for more than one page” on page 363.

Changing reference designations for Chapters
Changing reference designations for a full chapter, see “Editing reference designa-
tions for chapters” on page 363.

Click here

Drag the line to the
desired position

Release the mouse
button
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Deleting reference designations
To delete a reference designation, click on it and click Delete — or press the 
[Delete] key. You can also right-click, and select Delete unused, to delete the 
unused reference designations.

Reference designations with line breaks
If you want each section of the reference designation to be on a separate line, select 
Reference designation with line break. If this option is not selected, the reference 
designation will be written in one single line.

— See also “Individual control of reference designations with line breaks from 
Component data” on page 355 and “The tab Ref.design.” on page 181.

Closing the dialog box Reference designations
Click Close and then OK under Project data, to return to your project.

THE MEANING OF REFERENCE DESIGNATIONS WITH LINE BREAKS

IF YOU APPLY REFERENCE DESIGNATIONS WITH LINE BREAKS, THIS MEANS — 
ACCORDING TO THE STANDARDS — THAT EACH SEPARATE LINE IN THE REFER-
ENCE DESIGNATION UNIQUELY IDENTIFIES THE COMPONENT.
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USE FULL EXCLUDE OF CONCATENATION

In the lower-left corner of the dialog box Reference designations, you can select/
deselect Use full exclude of concatenation.

What is concatenation?
Concatenation means "joining two character strings end to end", and is used in this 
context to describe how you understand the reference designations displayed on the 
project pages.

In order to make the reference designations take up less space on the project pages, 
it is implied that the reference designation for the page (or reference frame) is also a 
part of the symbol name — even though the page reference designation does not 
appear in front of the symbol name on the page. If the page has the reference desig-
nation =G1+A1, and the symbol name -P1 is displayed on the page, you will inter-
pret this as the symbol has the reference designation =G1+A1-P1. The page 
reference designation and the symbol name has hereby been concatenated.

The way that PCschematic ELautomation 9.0 — and previous versions — have 
handled displaying the reference designations on the schematic pages, corresponds 
to not activating Use full exclude of concatenation.

If you do activate Use full exclude of concatenation, there will not exist any possi-
bilities for misunderstandings in how to interpret reference designations on project 
pages, which is elaborated in the examples below:

Example without Use full exclude of concatenation
Example on four symbols, where the page reference is =G1+A1, and where Use 
full exclude of concatenation is not activated:

CHARACTER FOR "EXCLUDE CONCATENATION"
WHEN THE CHARACTER > IS THE FIRST CHARACTER IN THE REFERENCE DESIG-
NATION, THIS MEANS THAT THE REFERENCE DESIGNATION IS THE FULL REFER-
ENCE DESIGNATION FOR THE SYMBOL. THE DISPLAYED REFERENCE 
DESIGNATION SHALL THEREFORE NOT BE CONCATENATED WITH THE PAGE REF-
ERENCE DESIGNATION.
IF IT THEREFORE SAYS >+A1-P1 FOR A SYMBOL, THEN +A1-P1 IS THE FULL 
REFERENCE DESIGNATION FOR THE SYMBOL.

-P1 +A1-P1 =G1+W1-P1
Symbol ref.
designation:

(The Page ref. designation is =G1+A1)

=G1+A1-P1



PCschematic ELautomation 10.0 PAGE 349

REFERENCE DESIGNATIONS

Explanation:

1) The name >-P1 is displayed: This means that the full reference designation is 
displayed, which is correct.

2) The name -P1 is displayed: Because the displayed reference designation does 
not start with the > character, this is interpreted as that the page reference des-
ignation must be concatenated with the displayed symbol name. The symbol 
reference designation will therefore be interpreted as =G1+A1-P1, which is 
not correct, because =G1 is not part of the symbol reference designation.

3) The name +W1-P1 is displayed: Because it does not start with the > charac-
ter, we must concatenate with the page refernce designation. Because the 
location aspect is included in the name, we will only concatenate with the 
function aspect. Therefore the reference designation will be interpreted as 
=G1+W1-P1, which is correct.

4) The name -P1 is displayed: Because it does not start with the > character, we 
must concatenate with the page reference designation. You will therefore 
understand the reference designation as =G1+A1-P1, which is correct.

Example with Use full exclude of concatenation
Example on four symbols, where the page reference is =G1+A1, and where Use 
full exclude of concatenation is activated. (This means that everywhere possible, 
PCschematic ELautomation will use full exclusion of concatenation):

1) The name >-P1 is displayed: This means that the full reference designation is 
displayed, which is correct.

2) The name >+A1-P1 is displayed: This again means that the full reference des-
ignation is displayed, which is correct.

3) The name +W1-P1 is displayed: Because it does not start with the > charac-
ter, we must concatenate with the page refernce designation. Because the 
location aspect is included in the name, we will only concatenate with the 
function aspect. Therefore the reference designation will be interpreted as 
=G1+W1-P1, which is correct.

-P1 +A1-P1 =G1+W1-P1
Symbol ref.
designation:

(The Page ref. designation is =G1+A1)

=G1+A1-P1
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4) The name -P1 is displayed: Because it does not start with the > character, we 
must concatenate with the page reference designation. You will therefore 
understand the reference designation as =G1+A1-P1, which is correct.

Close the dialog box Reference Designations
Click on Close, and then on OK under Project data, to return to your project.
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IMPORT AND EXPORT OF REFERENCE DESIGNATIONS

Reference designations can be exported/imported to/from Excel (*.xls files) and to/
from commaseparated files (*.csv files).

If you right-click in the Function or Location win-
dow in the dialog box Reference designations, you 
get the option of exporting or importing reference 
desinations, by choosing Export or Import respec-
tively.

If you have right-clicked in the Functions window, 
you can also choose Export Functions, as you can 
choose Export Locations if you right-clicked in the 
Locations window.

If no reference designations have been defined in the 
project yet, an Import button will also appear in the right-hand side of the dialog 
box.

When you choose to export reference designations, you enter a dialog box, where 
you specify where to save the reference designations file, and specify whether to 
save the file as an Excel file or as a CSV file.

Format for Reference designations files
The applied format for reference designations files, is displayed in the figure 
below:

Format in
Excel files

Format in
CSV files
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Importing reference designations
When you import reference designations, you enter the following dialog box:

To the left in the dialog box, you can see the status for the different reference desig-
nations:

If you do not wish to import some of the reference designations, select the 
unwanted reference designations in the dialog box, and click the Remove button in 
the right-hand side of the dialog box:

Then import the remaining reference designations by clicking OK.

+ NEW REFERENCE DESIGNATION, WHICH IS ADDED TO THE PROJECT.

GREEN SQUARE REFERENCE DESIGNATION, WHICH ALREADY EXISTS IN THE PROJECT.

YELLOW SQUARE THE REFERENCE DESIGNATION ALREADY EXISTS IN THE PROJECT, BUT 
HAS ANOTHER DESCRIPTION. AFTER IMPORTING, THE IMPORTED 
DESCRIPTION FOR THE REFERENCE DESIGNATION WILL BE USED IN THE 
PROJECT.

STATUS IN THE DIALOG BOX LOAD REFERENCE DESIGNATIONS
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REFERENCE DESIGNATIONS FOR SYMBOLS

Selecting Reference designations when placing symbols
When you have activated the reference designations in the Project data dialog box, 
you can apply reference designations when you place symbols in the project.

THIS CHAPTER DESCRIBES

— REFERENCE DESIGNATIONS WHEN PLACING SYMBOLS .......................................(P. 353)

— EDITING REF. DES. FOR ALREADY PLACED SYMBOLS .........................................(P. 356)

— EDITING REF. DES. USING THE SELECT NAME FUNCTION....................................(P. 356)

— PRECEEDING "-" IN SYMBOL NAMES ...................................................................(P. 356)

— INSERTING REFERENCE DESIGNATIONS FOR SIGNAL SYMBOLS...........................(P. 356)

IF THE TAB REF.DESIGN DOES NOT APPEAR

IF THE REFERENCE DESIGNATION PART OF THE DIALOG BOX DOES NOT EXIST, 
THIS IS BECAUSE NO REFERENCE DESIGNATIONS HAVE BEEN DEFINED IN THE 
PROJECT DATA DIALOG BOX. — SEE HOW TO CREATE THESE IN “DEFINING 
REFERENCE DESIGNATIONS FOR THE PROJECT” ON PAGE 342.

Click here
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Choosing reference designations when placing symbols
When you click on on the tab Ref. design. and then Select, you enter this dialog 
box:

Here you select the desired reference designation, and click OK. If one of the 
aspects shall not be a part of the symbol name, you click on Top node = none under 
the aspect.

If you wish to create a new reference designation, click on New, and create the ref-
erence designation — see “Specifying function/location reference designations” on 
page 344.

When you return to the Component data dialog box, you can see the reference 
designation on the tab Ref. design. in the lower part of the dialog box.

ONLY CREATED ASPECT TYPES DISPLAYED

WHEN PLACING SYMBOLS, THE DIALOG BOX REFERENCE DESIGNATIONS 
ONLY DISPLAYS THE ASPECT TYPES, WHICH HAVE BEEN CREATED IN THE 
PROJECT.
IF FOR INSTANCE YOU HAVE NOT CREATED A LOCATION REFERENCE DESIGNA-
TION ’+’ THIS PART OF THE DIALOG BOX IS NOT DISPAYED, AND THE FUNCTION 
REFERENCE DESIGNATION WINDOW FILLS ALL OF THE DIALOG BOX.
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Displaying the page reference designation and the most recently applied reference designations
When you click on the down-arrow next to the Function field, the function refer-
ence designation for the page and the most recently applied function reference des-
ignations are displayed. You can then select a function reference designation in the 
list.

The function reference designation for the page and the most recently applied func-
tion reference designation are displayed in the top of the list.

You can do just the same for location reference designations.

SHORT-CUT KEYS

These functions has the short-cut keys <Ctrl+f> for function reference designations 
and <Ctrl+l> for location reference designations. The Ref.design. tab is automati-
cally displayed when the short-cut keys are pressed.

Show full Reference designation
Because the page can be assigned a reference designation, and because the symbol 
can be placed in an area on the page containing reference designations, only the 
part of the reference designations that are different from the page or the area is dis-
played.

If you wish to display the full reference designation, select Show full Reference 
designation.

— See “Character for specifying full reference designation (exclude concatena-
tion)” on page 341 also.

Individual control of reference designations with line breaks from Component data
Under Settings => Project data => Reference designations you can select Refer-
ence designation with line break: Project controlled as a general setting for the 
project. — See “The meaning of reference designations with line breaks” on 
page 347.

In the dialog box Component data on the tab Ref.design., you can — for the 
selected symbol — deselect this setting by removing the check mark in the check 
box Reference designation with line break: Project controlled.

When the check mark is removed, you get the following option:

Click here ... and select the aspect here
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You can then select/deselect Reference designation with line break for the selected 
symbol, independant of the general project settings.

Type in the symbol name
Now type in the symbol name and click OK.

Editing reference designations for placed symbols
When you want to assign reference designations to a group of placed symbols, do 
the following:

1) Click the Symbols button and select the symbols

2) Right-click on the selected symbols, and choose Component data

3) In the dialog box Component data: Click on the tab Ref.design. and click on 
Select

4) In the dialog box Reference Designations: Choose reference designation and 
click OK

5) In the dialog box Component data: Click OK

6) Click somewhere on the page — to deselect the symbols

You have now assigned reference designations to the selected symbols.

Editing reference designations using the Select name function
— See “Changing the symbol reference designations using Select name” on 
page 250.

Preceding “-” in symbol names
The symbols in the EN60617 folder does not have a preceding “-” in their symbol 
names.

Therefore enter Settings => Pointer/Screen and 
select Insert - in front of symbol names. All symbols 
you place in the following, will have a preceding “-” in their symbol names.

Adding "-" in already placed symbols
If you have an old project without "-" in the symbol names, this prefix can be added 
automatically to all symbols in the project, by choosing Functions => Special 
Functions => Prefix all symbol names with -.

Inserting reference designations on signal symbols and symbol references
— See “Reference designations on symbol and signal references” on page 378.
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REFERENCE DESIGNATIONS FOR A FULL PAGE

It is also possible to specify reference designations for a full page.

To do this you enter Settings => Page data.

Here you click on Select under Reference designations, and enter the dialog box 
Reference designations:

Then click on the reference designations you wish to select for the page and click 
OK.

You now return to the dialog box Page data.

The page reference is not displayed on the page
Please note, that it is not displayed on the project page, that reference designations 
have been attached to it. — See “Inserting a drawing header displaying reference 
designations” on page 358.

Click OK.

ALREADY PLACED SYMBOLS ARE NOT ASSIGNED NEW REF. DESIGNATIONS

SYMBOLS ALREADY PLACED ON THE PAGE, WILL NOT AUTOMATICALLY GET 
THE NEW REFERENCE DESIGNATION FOR THE PAGE.
SYMBOLS PLACED AFTER ASSIGNING THE REFERENCE DESIGNATION WILL AUTO-
MATICALLY GET THE NEW REFERENCE DESIGNATIONS FOR THE PAGE.

Click here



PAGE 358 PCschematic ELautomation 10.0

REFERENCE DESIGNATIONS

Symbol names on pages with assigned reference designations
Every symbol you place on a page with reference designations, are assigned the ref-
erence designation of the page — unless you specify otherwise for the individual 
symbols in their respective Component data dialog boxes.

Because the symbols are conceived as belonging to the reference designation of the 
page, this reference designation is not displayed as a part of the symbol name on the 
page. Reference designations will only be displayed when they are different form 
the reference designation of the page.

Using the Show available function on pages with reference designations
When you via the Show available function place symbols for a component, which 
have already been assigned a reference designation, this symbol keeps the assigned 
reference designation.

The page reference designation displayed in the Status line
In the status line at the bottom of the 
screen you can see the reference desig-
nation of the page along with the page 
title. Click OK.

The page reference designation is displayed as popup information
When you let the mouse cursor rest over a page tab, 
the page reference designation is displayed in the 
popup information.

Inserting a drawing header displaying reference designations
If you do not take action yourself, the reference designation of the page is not dis-
played on the project page itself. Therefore it is a good idea to place a drawing 
header on the page, in which the reference designation of the page is displayed.

To do this, you must place the datafield Reference designation of the type Page 
data in the drawing header. — See “Datafield for reference designations in 
projects” on page 368.

Please refer to “Creating Drawing Headers” on page 715 for further details on cre-
ating drawing headers.

Inserting a datafield with reference designations
You can also place the datafield directly on the page.

To do this choose Functions => Insert datafield. Then click on Page Data, choose 
the datafield Reference designation, and click OK.

The datafields Next used page and Previous used page can also display the refer-
ence designation of the pages they refer to.

The page reference designation
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REFERENCE DESIGNATIONS FOR AREAS ON PAGES

It is also possible to specify that areas on pages shall 
have an attached reference designation.

To do this choose Functions => Insert Reference 
Frame.

You then get a pencil in the cross hairs, and draw a frame 
for the area with the reference designation.

When you have drawn the frame, you enter this dialog box:

Here you select the relevant reference designation as described in “Selecting Refer-
ence designations when placing symbols” on page 353, and click OK.

You now return to the above dialog box, where the selected reference designation is 
displayed.

Because the page also can have assigned a reference designation, the only the part 
of the reference designation which is displayed is the part which is different from 
the reference designation of the page.

Show full Reference designation
When you want the full reference designation to be displayed, select Show full Ref-
erence designation.

THE PROGRAM MEMORIZES THE LINES SETTINGS

THE PROGRAM AUTOMATICALLY USES THE LAST APPLIED LINES SETTINGS FOR 
INSERT REFERENCE FRAME.
AFTER DRAWING THE REFERENCE FRAME, THE PROGRAM AUTOMATICALLY 
CHANGES TO THE LINES SETTINGS, WHICH YOU WERE USING BEFORE INSERT-
ING THE REFERENCE FRAME.
— READ MORE ABOUT LINES SETTINGS IN “THE LINES TOOLBAR” ON 
PAGE 94.
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Show Function description and Show Location description
If you select Show Function 
description and/or Show Location 
description, the function descrip-
tion and/or the location description 
for the reference frame will be dis-
played. Here the description for the 
function aspect will be placed start-
ing in the upper-left corner of the 
frame, while the location will be 
placed starting in the lower-left 
corner of the frame.

Both texts can be moved freely, and 
their text data can be edited, as for 
other texts in the program. — See “Moving symbol texts on a Diagram page” on 
page 133 and “Specifying text properties / Appearance of text” on page 145.

If the frame is moved, the texts are moved relative to the frame, which is also the 
case for the reference designation text.

Individual control of reference designations with line break
— See “Individual control of reference designations with line breaks from Compo-
nent data” on page 355 and “The meaning of reference designations with line 
breaks” on page 347.

Click OK
When the dialog box is filled out, click OK.

Editing reference designations for areas
If you want to change the reference designation for the 
area, click the Lines button, right-click on the frame, 
and choose Reference Frame data.

You then enter the dialog box Reference Frame data, 
as described in “Reference designations for Areas on 
pages” on page 359. Here you type in the new refer-
ence designations for the area / reference frame.

DRAW THE REFERENCE FRAME BEFORE PLACING THE SYMBOLS

WHEN YOU CREATE REFERENCE DESIGNATIONS FOR AREAS YOU FIRST DRAW 
THE FRAME, AND THEN PLACE THE SYMBOLS IN THE FRAME. THIS WAY THE 
SYMBOLS ARE ASSIGNED THE REFERENCE DESIGNATIONS FOR THE AREA.
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When you change the reference designation on a reference frame, you are asked 
whether/how to change the reference designations for symbols placed inside the 
reference frame with the previous reference designation for the frame.

Specifying which symbols inside the frame to assign new reference designations to
In this dialog box you specify how/whether to update the symbols:

- Do NOT change Reference Designations on symbols: The reference designa-
tions remains unchanged for the symbols inside the reference frame

- Change symbols with Ref. "=G1+A1" to "=G2+A2": Symbols with the same 
full reference designation as the reference frame, are updated

- Change symbols with Ref. "=G1" or "+A1": You get the option to further spec-
ify whether the function and/or location aspect to change for symbols with 
matching function/location aspect inside the frame

Change symbols outside the frame with same names
If you choose Change symbols outside the frame with same names, all symbols 
outside the frame are changed, if they have the same symbol name and reference 
designation, as any of the symbols inside the frame.

If the reference frame is placed on a page, which you have just copied into the 
project, you will typically not select this option — so that you do not change names 
on other project pages by accident.

When there are symbols inside the reference frame, which are part of a component, 
for which there also are placed symbols outside the reference frame, it can be 
important that Change symbols outside the frame with same names is selected. 
This ensures you that all symbols for the same component still have the same refer-
ence designations. — If this is not the case, the program will no longer understand 
these symbols as being parts of the same component.
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Show/Edit list of symbols being placed
If you choose Show/Edit list of symbols being placed, you subsequently enter a 
dialog box where you can see which symbols PCschematic ELautomation will 
change reference designations for. Here you can also specify not to assign new ref-
erence designations to some of the symbols in the list, by removing the check mark 
for these symbols in the list. — See also “Show/Edit list of symbols being changed” 
on page 367.

Click OK
Make the desired changes in the dialog box Change Reference designations, and 
click OK.

See all reference frames in the project
To see all areas with reference designations in the project, you can enter the Object 
Lister and choose Reference Frames.

— See “The Object Lister” on page 314.
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EDITING REFERENCE DESIGNATIONS FOR CHAPTERS

To assign the same reference designation to a full chapter, enter the Page menu — 
as described in “Edit reference designations for more than one page” on page 363 
—, select all pages in the project, and change the reference designations for the 
pages.

— Please refer to “Change reference designations via chapter Divider pages” on 
page 366 also.

EDIT REFERENCE DESIGNATIONS FOR MORE THAN ONE PAGE

To edit reference designations for one or more pages in one operation, do this:

1) Click the Pagemenu button, or select View => Select page.

2) In the Page menu: Select the pages for which you wish to change reference 
designations — eg. by pressing down the <Ctrl> key, and clicking on the 
pages one by one.

3) Click on Article data.

YOU MUST ASSIGN REF.DES. MANUALLY TO NEW PAGES IN CHAPTERS

WHEN YOU INSERT A NEW PAGE IN A CHAPTER, THE PAGE IS NOT ASSIGNED 
REFERENCE DESIGNATIONS AUTOMATICALLY.
YOU MUST DO THIS MANUALLY, AS DESCRIBED IN “REFERENCE DESIGNATIONS 
FOR A FULL PAGE” ON PAGE 357.

IF THE PAGES DO NOT HAVE IDENTICAL REFERENCE DESIGNATIONS

IN THE DIALOG BOX PAGE ARTICLE DATA: IF THE TEXTS FUNCTION AND/OR 
LOCATION ARE DIMMED, THIS MEANS THAT THE SELECTED PAGES DO NOT 
HAVE IDENTICAL REFERENCE DESIGNATIONS.

IF THIS IS THE CASE, IT IS ONLY POSSIBLE TO EDIT THE REFERENCE DESIGNATI-
ONS FOR THE PAGES. THE REFERENCE DESIGNATIONS FOR THE SYMBOLS WILL 
NOT BE CHANGED.

NOTE: If dimmed,
only the ref.des. of the
pages can be changed
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4) In the dialog box Page article data: Click on Select under Reference desig-
nations:

5) In the dialog box Reference designations: Select the new reference designa-
tions, and click OK. What to do next depends on whether the selected pages 
had identical reference designations:

If the pages did NOT have identical reference designations
6a) If the selected pages did not have 

identical reference designations, do the 
following in the dialog box Page arti-
cle data: Click on one — or both — of 
the reference designations, to confirm 
that you wish to select this reference 
designation. This causes Function 
and/or Location to be written in black, and the selected pages are assigned the 
reference designation — which is displayed in the title bar of the dialog box 
Page article data. (Please note, that only the pages, and not the symbols on 
the pages, will have their reference designations changed — as described in 
the box “If the pages do not have identical reference designations” on 
page 363).
Klik OK.

If the pages did have identical reference designations
6b) If the selected pages had identical reference designations, you enter the dia-

log box Change Reference Designations. Here you get the option of chang-

2) Select the pages
3) Click on Article data

4) Click on Select, and
select reference designations

Click here to confirm the
selected reference designation
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ing reference designations for the implicated symbols:

— Read about the options in this dialog box in “Options in the dialog box 
Change Reference Designations” on page 366.
Choose how to change reference designations for the involved symbols, and 
click OK. If you have chosen Show/Edit list of symbols being changed, 
please also see “Show/Edit list of symbols being changed” on page 367.

Click OK in the Page menu
7) You now return to the Page menu: Click OK.
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CHANGE REFERENCE DESIGNATIONS VIA CHAPTER DIVIDER PAGES

To change reference designations via a chapter tab, do this:

1) Click on the page tab for the divider 
page for the chapter (The chapter 
front page).

2) Select Settings => Page data, and click on Select below Reference designa-
tions.

3) In the dialog box Reference designations: Choose reference designations, 
and click OK.

Options in the dialog box Change Reference Designations
4) You now enter the dialog box Reference designations:

Here you are asked whether to change reference designations on the pages in 
the chapter having the same reference designations as the divider page, and 
which directions to apply for changing the symbols. You have the following 
options:

OPTION EFFECT

CHANGE REFERENCE DESIG-
NATIONS ON CHAPTER PAGES

SELECT THIS OPTION IN ORDER TO CHANGE REFERENCE 
DESIGNATIONS FOR THE CHAPTER PAGES HAVING THE 
SAME REFERENCE DESIGNATIONS AS THE DIVIDER PAGE.
YOU WILL NOT BE ABLE TO SELECT THE OPTIONS 
BELOW, BEFORE YOU HAVE SELECTED THIS OPTION.

DO NOT CHANGE REFER-
ENCE DESIGNATIONS ON SYM-
BOLS

CLICK HERE IN ORDER NOT TO CHANGE REFERENCE 
DESIGNATIONS ON ANY SYMBOLS.

CHANGE SYMBOLS WITH REF. 
"X" TO "Y"

CLICK HERE TO CHANGE BOTH THE FUNCTION AND THE 
LOCATION REFERENCE DESIGNATION.

OPTIONS IN CHANGE REFERENCE DESIGNATIONS
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Show/Edit list of symbols being changed
5) If you have chosen Show/Edit list of symbols being changed, you now enter 

the following dialog box:

Remove the check mark in front of the symbols, that shall not have their ref-
erence designations changed, and click OK.

6) In the dialog box Settings: Click OK

You have now changed reference designations for the desired pages and symbols.

CHANGE SYMBOLS WITH REF. 
"X" OR "Y"

CLICK HERE TO CHANGE EITHER THE FUNCTION OR THE 
LOCATION REFERENCE DESIGNATION.

CHANGE SYMBOLS WITH 
FUNCTION REFERENCE DES-
IGNATION "X" TO "Y"

FIRST CHOOSE CHANGE SYMBOLS WITH REF. "X" OR 
"Y": THEN CLICK HERE ONLY TO CHANGE FUNCTION 
REFERENCE DESIGNAITON.

CHANGE SYMBOLS WITH 
LOCATION REFERENCE DES-
IGNATION "X" TO "Y"

FIRST CHOOSE CHANGE SYMBOLS WITH REF. "X" OR 
"Y": THEN CLICK HERE ONLY TO CHANGE LOCATION 
REFERENCE DESIGNATION.

CHANGE SYMBOLS ON OTHER 
PAGES WITH SAME NAME AS 
ON THIS PAGE

CLICK HERE, SO THAT YOU ALSO CHANGE REFERENCE 
DESIGNATIONS FOR SYMBOLS OUTSIDE THE CHAPTER, 
WHICH ARE A PART OF THOSE OF THE COMPONENTS IN 
THE CHAPTER, WHICH WILL HAVE THEIR REFERENCE 
DESIGNATIONS CHANGED.

SHOW/EDIT LIST OF SYMBOLS 
BEING CHANGED

CLICK HERE TO GET A LIST OF WHICH SYMBOLS THAT 
ARE GOING TO BE CHANGED. IN THIS LIST YOU CAN 
DESELECT SYMBOLS, FOR WHICH YOU DO NOT WISH TO 
CHANGE REFERENCE DESIGNATIONS.

OPTION EFFECT

OPTIONS IN CHANGE REFERENCE DESIGNATIONS

Click here for different views

Click here to select/deselect symbols
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DATAFIELD FOR REFERENCE DESIGNATIONS IN PROJECTS

When you wish to place a 
datafield containing reference des-
ignations in a list or on a diagram 
page, do the following:

1) Choose Functions => Insert 
Datafield.

2) In the dialog box Datafield: 
Click on Project Data, and 
choose the datafield Refer-
ence designation.

3) Choose the relevant part of 
the reference designation — 
as displayed in the figure to 
the right.

4) Click OK.

Specify which reference designations to display
When you have selected the datafield Reference designa-
tion in the Project data group, you can choose only to 
display a limited part of the reference designations.

This is done in the field First,last, where you type in the number of the first and the 
last reference designation you wish to display.

When for instance you type in 1,20 the first 20 reference designations are dis-
played, if you type in 21,40 the subsequent 20 reference designations are displayed. 
This way it is possible to list the reference designations over several pages or and/or 
columns, when a project contains many reference designations.

REFERENCE DESIGNATIONS IN ALPHABETICAL ORDER

WHEN REFERENCE DESIGNATIONS ARE BEING PRINTED VIA THIS DATAFIELD, 
THEY ALWAYS APPEAR IN ALPHABETHICAL ORDER.

The full ref. designation is shown
Only the Function aspect

Only the Location aspect

The Reference designation itself is shown
The attached description is shown
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 LISTS FOR EACH FUNCTION OR LOCATION

When you apply reference designations, it is possible to create separate lists for 
each Function or Location in the project.

This is done by clicking on the list in the project you want divided following these 
criteria. Here you choose Lists => List setup, and enter the dialog box List setup, 
where you click on the Criteria tab.

If you want a list of every symbol having the Function aspect =P1 — which for 
instance could be a pump — you fill out the Criteria tab like this:

Or fill out the Criteria tab like this to get a list of the assembly +A1:

— Please refer to “Specifying Criteria for the components to include” on page 541 
for further details on criteria on lists.
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This section describes the use of references in 

PCschematic ELautomation:

- Automatically updated references .......(p. 373)

- Contact mirrors and Reference crosses(p. 380)

- Reference system settings....................(p. 385)

R
eferences
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AUTOMATICALLY UPDATED REFERENCES

When you place more than one symbol for the same component in a project, the 
program can automatically create references between these symbols on the project 
pages.

Next to each symbol you can therefore see references to the other symbols for the 
same component. The appearance of these references you can determine yourself.

— Please also refer to “Contact mirrors and Reference crosses” on page 380.

INSERTING A REFERENCE SYSTEM

In order to let the program create appropriate references, you must first create/adapt 
the reference system for the diagram pages, so that it meets your demands. Read 
more about this in “Setting up the current paths” on page 385.

THIS CHAPTER DESCRIBES

— INSERTING A REFERENCE SYSTEM ......................................................................(P. 373)

— AUTOMATIC JUMP BETWEEN REFERENCES ON DOUBLE-CLICK ...........................(P. 374)

— REFERENCES ON SYMBOLS .................................................................................(P. 375)

— APPEARANCE OF REFERENCES ............................................................................(P. 377)

— REFERENCE DESIGNATIONS ON SYMBOL AND SIGNAL REFERENCES...................(P. 378)

— REFERENCES FOR PLCS......................................................................................(P. 379)

http://www.dps.dk/english/Video/Product_videos.htm
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AUTOMATIC JUMP BETWEEN REFERENCES ON DOUBLE-CLICK

To jump to a symbol which is referred to, do the following:

1) Double-click on the reference.

2) The program now automatically jumps to the project page, where the referred 
to symbol is placed. The referred symbol is selected by the cross hairs.

Automatic jump to reference from reference cross
Correspondingly you can double-click on the reference in a reference cross or in a 
contact mirror:

When you double-click on the reference for a symbol in the reference cross/contact 
mirror, you return to the symbol with the symbol having the symbol type Relay.

SYMBOL REFERENCES ARE ACTIVE IN ALL COMMANDS

WHEN YOU DOUBLE-CLICK ON A REFERENCE FOR A SYMBOL, PCschematic 
ELautomation JUMPS TO THE REFERRED SYMBOL — NO MATTER IF YOU 
WORK WITH LINES, TEXTS, CIRCLES, SYMBOLS OR AREAS.

Double-click on the reference, and the referred symbol is selected

Double-click on the reference in the reference cross
and the referred symbol is selected

Double-click here to return
to the relay coil symbol

http://www.dps.dk/english/Video/Product_videos.htm
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REFERENCES ON SYMBOLS

In PCschematic ELautomation you can apply references on all types of symbols.

How the reference appears for a symbol, primarily depends on the symbol type of 
the symbol. However, some symbols are created without symbol type, and there-
fore has no references.

Inserting references on symbols without reference
To insert references on symbols without references — or to change the selected ref-
erence for a symbol — do the following:

1) Click on the Symbols button, right-click on the symbol, and choose Compo-
nent data — or double-click on the symbol.

2) In the dialog box Component data: Click on the Reference tab, choose With 
reference and then either Master reference or With reference, and click OK.

Choosing the reference type Master reference
If you select the reference type Master reference, a list is created next to the sym-
bol, containing references to the other symbols having the same symbol name — if 
these are set to With reference.

It is possible to set more than one symbol with the same symbol name to Master 
reference. However, from the symbols set to With reference, there are only a refer-
ence to the first symbol with Master reference in the documentation.

References can be placed in columns. How many references to place in each col-
umn, is specified in the field Max. Number of references pr. column.

When you choose Master reference for PLC symbols, a PLC I/O reference cross is 
placed next to the symbol.

Choosing the reference type With reference
When you choose the reference type With reference, there will be placed a refer-
ence next to the symbol, which refers to the symbol(s) that has the same symbol 
name and are set to Master reference.
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When there are no symbols with the same symbol name which are set to Master 
reference, a reference is placed to the preceding and the succeeding symbol in the 
project. Hereby a chain of references between symbols with the same symbol name 
is created. This makes it easy to run through the project and find all symbols having 
the same symbol name. All you need to do is to double-click on the references, and 
you jump to the next — or previous — symbol in the chain.

Symbol type and References
The symbol type is specified in the symbol definition — see “Creating Symbols” 
on page 670; see "Symbol types" in particular.

However, you can change the symbol type for a symbol like this:

1) Click on the Symbols button — to work with symbols.

2) Right-click on the symbol and choose Component data.

3) Click on the General tab, and click on the down-arrow in the Symbol type 
field:

4) You can now choose between the following symbol types:

SYMBOL TYPE STANDARD REFERENCES FOR THE SYMBOL TYPE

NORMAL THE SYMBOL IS NOT ASSIGNED REFERENCES — UNLESS SPECIAL ACTION 
IS TAKEN.

RELAY A REFERENCE CROSS/CONTACT MIRROR IS CREATED FOR THE SYMBOL, 
WHEN PLACED ON A DIAGRAM.

OPEN THE SYMBOL WILL BE CONCEIVED AS AN OPEN CONTACT, AND THERE 
WILL BE PLACED A REFERENCE TO THE SYMBOL IN THE REFERENCE CROSS/
CONTACT MIRROR BELOW THE RELAY COIL SYMBOL FOR THE COMPO-
NENT. THE SYMBOL WILL ALSO GET A REFERENCE TO THE RELAY COIL 
SYMBOL, WHEN THE SYMBOL IS PLACED IN THE PROJECT.

CLOSE THE SYMBOL WILL BE CONCEIVED AS A CLOSE CONTACT, AND THERE 
WILL BE PLACED A REFERENCE TO THE SYMBOL IN THE REFERENCE CROSS/
CONTACT MIRROR BELOW THE RELAY COIL SYMBOL FOR THE COMPO-
NENT. THE SYMBOL WILL ALSO GET A REFERENCE TO THE RELAY COIL 
SYMBOL, WHEN THE SYMBOL IS PLACED IN THE PROJECT.

SYMBOL TYPES AND REFERENCES

Click here to choose
symbol type



PCschematic ELautomation 10.0 PAGE 377

AUTOMATICALLY UPDATED REFERENCES

5) Choose symbol type and click OK.

APPEARANCE OF REFERENCES

To specify the appearance of the reference, do the following:

1) Choose Settings => Text/Symbol defaults.

2) Click on References.

3) Then click on Symbol reference to specify the appearance of the symbol ref-
erences.

SWITCH THE SYMBOL WILL BE CONCEIVED AS A SWITCH, AND THERE WILL BE 
PLACED A REFERENCE TO THE SYMBOL IN THE REFERENCE CROSS/CON-
TACT MIRROR BELOW THE RELAY COIL SYMBOL FOR THE COMPONENT. IN 
REFERENCE CROSSES, THERE WILL BE A REFERENCE TO THE SYMBOL IN 
BOTH THE OPEN AND THE CLOSE CONTACT SIDE. THE SYMBOL WILL ALSO 
GET A REFERENCE TO THE RELAY COIL SYMBOL, WHEN THE SYMBOL IS 
PLACED IN THE PROJECT.

MASTER REF-
ERENCE

THE SYMBOL WILL HAVE REFERENCES TO ALL OTHER SYMBOLS OF THE 
SAME SYMBOL NAME. FOR INSTANCE HAND OPERATED CONTACTS

WITH

REFERENCE

REFERS EITHER TO A SYMBOL WITH MASTER REFERENCE, OR TO SYM-
BOLS IN THE CLOSEST PROCEEDING OR SUCCEEDING CURRENT PATH, 
WHICH ARE PART OF THE SAME COMPONENT.

TERMINAL THE SYMBOL IN NOT ASSIGNED REFERENCES — UNLESS SPECIAL ACTION 
IS TAKEN.

PLC THE SYMBOL IN NOT ASSIGNED REFERENCES — UNLESS SPECIAL ACTION 
IS TAKEN.

NON CON-
DUCTING

THE SYMBOL IN NOT ASSIGNED REFERENCES — UNLESS SPECIAL ACTION 
IS TAKEN.

SUPPORT THE SYMBOL IN NOT ASSIGNED REFERENCES — UNLESS SPECIAL ACTION 
IS TAKEN.

ALL SYMBOL TYPES CAN BE CREATED WITH ACTIVE WITH REFERENCE

ALL SYMBOL TYPES CAN BE CREATED WITH WITH REFERENCE ACTIVE VIA 
THEIR SYMBOL DEFINITION. — READ MORE ABOUT THIS IN “CREATING SYM-
BOLS” ON PAGE 670, “SYMBOL SETTINGS: REFERENCE” ON PAGE 683 IN PAR-
TICULAR.

SYMBOL TYPE STANDARD REFERENCES FOR THE SYMBOL TYPE

SYMBOL TYPES AND REFERENCES
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4) You now get the following options:

5) Now choose Reference format and Separator and brackets if necessary.

6) When you wish also to change the appearance of the text, click the Text prop-
erties button, as described in “Specifying text properties / Appearance of 
text” on page 145.

7) Click OK.

8) Choose Functions => Update references — and the changes are displayed in 
the project.

When you wish to change the appearance for references for signal symbols, just 
choose Signal reference in step 3 above.

REFERENCE DESIGNATIONS ON SYMBOL AND SIGNAL REFERENCES

To let references for symbols contain reference designations for the page that are 
referred to, do the following:

1) Choose Settings => Text/Symbol defaults.

2) Click on References.

3) Then click on Symbol reference to specify the appearance of the references 
for symbols.
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4) Now choose a reference format with reference designations, as displayed in 
the figure below:

5) Click OK.

Signal symbol references with reference designations
You can, correspondingly, activate reference designations for signal symbols by 
choosing Signal reference in stead of Symbol reference in the procedure above.

REFERENCES FOR PLCS

— See "Jumping between PLC ref. symbols and PLC I/O symbols" på side 455.
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CONTACT MIRRORS AND REFERENCE CROSSES

When displaying references for symbols with the type Relay — see “References on 
symbols” on page 375 — you can either use reference crosses or contact mirrors.

This chapter describes how to use reference crosses and contact mirrors in the pro-
gram.

— Please read “Setting up the current paths” on page 385 to see how to set the ref-
erence system on the project pages.

— Please also read “Automatically updated references” on page 373 for general 
information on references in PCschematic ELautomation.

THIS CHAPTER DESCRIBES

— ON CONTACT MIRRORS ......................................................................................(P. 381)

— ON REFERENCE CROSSES....................................................................................(P. 382)

— CHOOSING BETWEEN CONTACT MIRRORS AND REFERENCE CROSSES ............... (P. 383)

— CONTACT MIRRORS ARE CREATED AUTOMATICALLY BY THE PROGRAM ...........(P. 383)

CONTACT MIRRORS GIVES QUICK ACCESS TO AVAILABLE SYMBOLS

CONTACT MIRRORS ALSO GIVES YOU THE OPTION TO GET THE AVAILABLE 
SYMBOLS FOR A COMPONENT IN THE CROSS HAIRS RIGHT AWAY.

http://www.dps.dk/english/Video/Product_videos.htm
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ON CONTACT MIRRORS

If you have set the program to use contact mirrors — see 
“Choosing between contact mirrors and reference crosses” 
on page 383 — and place a symbol with an article number 
from the attached database, the other symbols for the com-
ponent are displayed at the bottom of the page.

Thus contact mirrors are a graphical representation of the 
other symbols for the component. The contact mirror is 
placed under the symbol for the component, which has the 
symbol type Relay.

When for instance you place a relay coil symbol via the 
database, the other symbols for the component are displayed 
below the relay coil symbol at the bottom of the page — as 
displayed on the figure to the right. In the contact mirror for 
the relay coil symbol you see a three-poled open contact, a 
close contact and an open contact.

Contact mirrors and changes in the article number
When you change the article number for a symbol, the con-
tact mirror will be changed, so that it matches the informa-
tion about the article number in the database.

Direct jump to the other symbols for the component
For the symbols, which are already placed in the project, a reference to their loca-
tion is displayed. When you double-click on one of these symbols, you jump 
directly to the symbol in the project. — See “Automatic jump between references 
on double-click” on page 374.

Get available symbols from the contact mirror directly into the cross hairs
When you double-click on one of the symbols in the con-
tact mirror, which is not placed in the project, you get the 
symbol in the cross hairs, and can then place it in the 
project.

When a symbol is deleted from the project, the reference 
to the symbol is removed from the contact mirror, and you 
can once again see that the symbol is available in the con-
tact mirror.

Symbol with the
type Relay

Contact mirror
for the symbol

Double-click on an
available symbol,
and you get it in the
cross hairs
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ON REFERENCE CROSSES

When you are using reference crosses, a reference 
cross is displayed under all symbols of the symbol 
type Relay.

Under the open contact in the reference cross, refer-
ences to all the open contacts for the component are 
displayed. Also, references to all the close contacts 
are displayed below the close contact in the reference 
cross.

When you double-click on one of these references, 
you jump directly to the symbol in the project, which 
the reference refers to. — See “Automatic jump 
between references on double-click” on page 374.

Available symbols are not displayed in reference crosses
Available symbols for the component are not displayed in the reference cross.

When you are using reference crosses, you therefore do not have the option to get 
available symbols directly in the cross hairs, as when you use contact mirrors — 
see “Get available symbols from the contact mirror directly into the cross hairs” on 
page 381.

Reference crosses for symbols with sub names
For components containing symbols with sub names, independent reference crosses 
are created for each of the relay coil symbols for the component, which has inde-
pendent sub names.

Hereby components with several functions can be separated functionally on the 
project pages, and still appear as one component in the project lists.

— See "Sub names on symbols" på side 185, especially "Functionally understood 
as different components" på side 185.

Click here, and you

symbol, which is
jump directly to the

referred to
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CHOOSING BETWEEN CONTACT MIRRORS AND REFERENCE CROSSES

To choose whether to use contact mirrors or reference crosses in PCschematic 
ELautomation, you must click the Project data button, and click on either Refer-
ence cross or Contact mirror in the lower-left corner of the dialog box, and click 
OK.

You can, at any time, choose whether you wish to use contact mirrors or reference 
crosses.

If Contact mirror is activated without an attached database, the contact mirrors 
only contains the symbols, which are used in the project.

CONTACT MIRRORS ARE CREATED AUTOMATICALLY

In PCschematic ELautomation the program creates the contact mirrors for you 
automatically, so that they contains all the relevant symbols. When for instance you 
place a relay coil symbol from a component from the database, the program auto-
matically creates a contact mirror containing the other symbols for the component 
under the relay coil symbol in the project.

If you later place other symbols with the same symbol name in the project, where 
these symbols does not have an article number — or has an unknown article 
number — the symbols are added to the bottom of the contact mirror. When these 
symbols are deleted in the project, they are removed from the contact mirror.

SWITCHING BETWEEN CONTACT MIRRORS AND REF. CROSSES

YOU CAN CHOOSE TO USE CONTACT MIRRORS WHILE WORKING WITH THE 
PROJECT, AND THEN SWITCH TO REFERENCE CROSSES WHEN DELIVERING THE 
PROJECT. — OR VICE VERSA.
HOWEVER, THE DATABASE MUST BE ATTACHED WHEN CHOOSING TO WORK 
WITH CONTACT MIRRORS, BECAUSE THE PROGRAM THEN RUNS THROUGH THE 
PROJECT, IN ORDER TO CREATE CONTACT MIRRORS. IF THE DATABASE IS NOT 
ATTACHED AT THIS TIME, AVAILABLE CONTACTS ARE NOT DISPLAYED.
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Creating contact mirrors without using the database
When you are working without an attached database, and place a symbol with the 
symbol type Relay, no contact mirror is created for the symbol.

The contact mirror is not created until you place another symbol with the same 
symbol name in the project. After this, symbols will be added to the contact mirror 
as you place more symbols with the same symbol name. The symbols will therefore 
appear in the order in which they are placed in the project.

When a symbol is placed using an attached database, the contact mirror for the 
symbol is memorized, also when the database is no longer attached. This applies as 
long as the article number for the symbol remains unchanged.

Contact mirrors for symbols without article numbers
What is mentioned above, only applies when you are working with an attached 
database, and place a symbol without an article number — or a symbol with an 
unknown article number.

When you assign an article number to a symbol, the contact mirror for the symbol 
is created/re-organized according to the order of the symbols for the component in 
the database (In the PCSTYPE field in the database — see “Database settings” on 
page 591).
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CURRENT PATH NUMBERS / REFERENCE SYSTEM

The reference system / current path numbers is a coordinate system you can use on 
your diagrams. It will be used when you refer to the position of the individual com-
ponents, for instance in a reference cross. The current path numbers / reference sys-
tems can be located along the horizontal or vertical axis, or along both axis 
simultaneously.

You can determine to let the number of the current path, and/or page a symbol is 
located on, be part of the name of the symbol. This is called current path naming.

SETTING UP THE CURRENT PATHS

To determine where and how to locate the current path numbers, you choose Set-
tings => Page data => References.

You then enter the Reference system setup dialog box:

THIS CHAPTER DESCRIBES

— SETTING UP THE CURRENT PATHS......................................................................(P. 385)

— THE HORIZONTAL REFERENCE SYSTEM ..............................................................(P. 386)

— THE VERTICAL REFERENCE SYSTEM ...................................................................(P. 386)

— COPYING THE REFERENCE SETTINGS ..................................................................(P. 387)

— CHANGING THE REFERENCE CROSSES.................................................................(P. 387)

— NAMING SYMBOLS ACCORDING TO CURRENT PATH NUMBERS ...........................(P. 388)

— SYMBOL NAMES WHEN MOVING OR COPYING ...................................................(P. 390)

— CURRENT PATH NUMBERS AND AUTOMATIC PROJECT GENERATION..................(P. 391)

— NAMING DUE TO CHANGES IN THE PAGE MENU .................................................(P. 391)
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HORIZONTAL REFERENCE SYSTEM

In the field Active on the tab Horizontal you determine whether you want to use 
references along the x-axis on your diagram or not.

In the Main reference check box you determine whether these current path num-
bers are to be used when referring between symbols.

If Main reference is selected a reference cross will be placed on the diagram for 
each individual symbol having a relay status (See “Symbol types” on page 680). 
These will be filled out with references to the contacts of the same component. If 
Main reference is deselected, no reference crosses will be placed on the diagram.

In the fields X position (mm) and Y position (mm), you determine where to place 
the first current path; in the Distance (mm) field you determine the distance 
between the current paths; and in Number you choose how many current path num-
bers you want on the chosen page.

In the Start value field, you determine the start value of the first current path on the 
diagram, and in Counting direction you choose whether to count from left to right, 
or from right to left.

If you want the current paths on the different pages in the project to be numbered in 
succession, select the Continuous check box. If the page you are working on has no 
preceding diagram, the field will be dimmed and can not be selected.

If you have selected Continuous on a page and then change the initial value, you 
automatically change the initial value on the first of the coherent pages.

In the Reference symbol position field you determine the position of the reference 
crosses.

By clicking on the Text properties button, you determine the size of the characters/
figures in the numbering of the current paths.

Default settings
If you want to see the present default settings for the tab Horizontal, you click the 
Show defaults button. The default settings are displayed as long as the button is 
pressed down.

To load the defaults for the tab Horizontal, you click the Load defaults button.

VERTICAL REFERENCE SYSTEM

By clicking on the tab Vertical you will be able to determine corresponding set-
tings for the current path numbers along the vertical axis. If you wish, you can use 
letters instead of numbers.
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COPYING THE REFERENCE SETTINGS

If you want these settings for the current path numbers to 
be used on the diagrams you create from now on, you 
click on the tab Default, and then click on the Save as 
default button. Hereby you save all settings made on the 
tabs Horizontal and Vertical.

Please note, that clicking on the Save as standard button 
will not effect any pages in the project.

If you want to update the other pages in the project with 
the chosen settings, you click on Update.

Hereby you update all pages having the Page function 
Normal, the Page type Diagram, and also the same Page 
size as the page you are working on at present.

Check marks in the check boxes Active, Main reference and Continuous are not 
updated/changed.

— Read more about Page type and Page function in “Pages and Chapters” on 
page 487.

CHANGING THE REFERENCE CROSSES

The reference crosses are defined as symbols, so in order to change these, you have 
to change their symbol definitions. — See “Creating Symbols” on page 670.

You choose which reference cross to use in the project by first choosing Settings 
=> Text/Symbol defaults, then click on Others, on Reference cross, and on Add. 
You then enter the Symbol menu, where you select the symbol for the reference 
cross you wish to use.

The reference crosses are defined as symbols, so when you wish to change these, 
you must edit their symbol definitions. — See “Creating Symbols” on page 670.

If you enter Settings => Text/Symbol defaults, click on Reference and then on 
Reference cross, you can edit the appearance of the text in the reference crosses by 
clicking on the Text properties button. Please note, that the appearance will only 
be changed for the reference crosses that are placed in the project after you made 
the changes.

You can also choose which separator to use in the reference crosses:

Then choose Functions => Update references and the entire project is updated 
with the new references.
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NAMING SYMBOLS DUE TO PAGE AND CURRENT PATH NUMBER

If you want the page and the number of the current path, in which the symbols are 
located, to be part of the symbol names, you can let PCschematic ELautomation 
handle this automatically.

To arrange this, you choose Settings => Text/Symbol standards, and click on 
Symbols, and then on Name.

In the field Name format you can choose between different formats for the symbol 
names.

Name formats
You can here choose between the following name formats:

THE NAME FORMAT FREE

If you choose Free, the symbol names become exactly as you type them.

THE NAME FORMAT K1/5
If you choose K1/5, the location of the symbol will automatically be included as the 
last part of the symbol name.

After the letter (K) follows the page number (1) a separator (/) and the number of 
the current path (5) in which the symbol is placed.

If you have chosen this type, you can specify which separator should be used 
between the page number and the current path number. You do this in the Separator 
field.

THE NAME FORMAT 1K5
If you choose 1K5, the page number will be located before, and the current path 
number after the code letter.

THE NAME FORMAT K5
If you choose K5, only the current path number is included in the symbol name. 
This only makes sense if you are using Continuous current path numbers.

TERMINALS AND CONTACTS FOR RELAYS ARE NOT ASSIGNED CURRENT PATH 
NUMBERS.
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THE NAME FORMAT K15
If you choose K15, the last digit specifies the current path number. Other digits after 
the code letter specifies the page number. If for instance it says -P146 on the dia-
gram page, this refers to page 14, current path 6. This format can only be used if the 
current path numbers does not exceed one character — e.g. 0 to 9.

THE NAME FORMAT K105
If you choose K105, the last two digits specifies the current path number. Other 
characters after the code letter specifies the page number. If for instance it says
-P1406 this refers to page 14, current path 6. This format can only be used if the 
current path numbers does not exceed two characters — e.g. 0 to 99.

Changing symbol names to current path names
When you in this dialog box specifies that current path numbers shall be included in 
the symbol names, this only has an effect for the symbols you place succeedingly.

If you want to include current path numbers in the placed symbols, choose Func-
tions => Special Functions => Create CurrentPath Numbers on all Symbols.

You are then asked whether to rename all symbols. Click OK.

The option Create CurrentPath Numbers on all Symbols is only displayed when 
you have specified that current path numbers shall be included in the symbol names 
in the project.

Generation names
If you place more symbols of the same type in the same current path, the symbols 
will still be assigned unique names.

If for instance you place a lamp in current path sixteen on page three, it gets the 
name H3.16. If you then place more lamps in the same current path, they’ll be 
assigned the names H3.16.1 and H3.16.2 — and so on. In this context the additions 
are called generation names, and are added to be able to distinguish between the 
symbols.

The generation names are assigned according to the order in which you place the 
symbols, and has nothing to do with their position in the current path.

In the Second separator field, you determine which sign will be used to separate 
the generation name from the current path number.

NAMING FORMATS WITH CURRENT PATH NUMBERS AND THE

IEC/EN 61346 STANDARD

THE STANDARD IEC/EN 61346 DOES NOT MENTION CURRENT PATH NUMBER-
ING.
IF YOU USE THE FORMAT K1/5 OR 1K5, THIS WILL BE IN CONTRADICTION TO 
THE NAMING RULES IN THE STANDARD.
BUT IF YOU CHOOSE THE FORMAT K5, K15 OR K105, AND EXPLAINS THE SIG-
NIFICANCE OF THE APPLIED FORMAT IN THE DOCUMENTATION, YOU CAN FOL-
LOW THE STANDARDS IN THIS CONTEXT.
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Save as default
If you want the chosen settings to be in effect for any new project you create, you 
click on the Save as default button.

If you want to load the present default settings for symbol names, you click the 
Load defaults button.

If you just want to see the defaults, you click the Show defaults button, which only 
displays the defaults as long as you keep the mouse button pressed down.

Symbol names in previously created projects will not be affected.

— Read more about default settings and about this dialog box in “Texts displayed 
in the project (general setting)” on page 150.

Changing between name format types
If you change from using the name format Free to a name format with included 
current path numbers, this will not have any effect on symbols already placed in 
your project. The change only concern the symbols you place after having made the 
changes.

If you want to change symbol names for symbols, that have been named using the 
name format Free, in order to make them follow page and current path numbers, 
you must do as described in “Make a symbol regain its adaptability” on page 391.

If you change from one current path name format to another, the changes will affect 
all symbol names, which contains the correct page and current path number for the 
symbol.

During moving or copying, symbols having these name formats, furthermore have 
the capability to have their names corrected, corresponding to page and current path 
numbers of their new location.

SYMBOL NAMES WHEN MOVING OR COPYING

If you copy a symbol with a current path name, the copy of the symbol automati-
cally receives a name corresponding to which page/current path you place it on.

If you, on the other hand, move a symbol, you 
will be asked whether or not to rename the 
symbol.

If you answer Yes, the symbol is assigned a 
name corresponding to the new location of 
the symbol.

If your answer is No, the symbol keeps its old name, but at the same time it loses 
the ability automatically to be assigned a current path name during moving/copy-
ing.

Copying or moving more objects at the same time, follows the same directions as 
mentioned above.
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Make a symbol regain its adaptability
If you have a symbol that has lost its adaptability, you can manually change its 
name to what it should be called, according to its present location.

This makes the symbol name regain its adaptability.

NAMING DUE TO CHANGES IN THE PAGE MENU

When you make changes on project pages in the Page menu, this may have conse-
quences for pages containing symbols with current path names. (You can read more 
about this in “The Page menu and current path numbers” on page 491).

If this is the case, you will get a warning:

If you answer Yes to rename the symbols, their names are changed according to the 
new page and current path numbers. If you copy/move the symbols later on, they 
will still be able to be assigned new current path names.

If your answer is No, the symbol names loose their adaptability. Thus, a symbol 
having the name K3.5 will remain the name K3.5 on its new location. But the pro-
gram will no longer recognize this as a current path name. In this case the symbol 
will from then on be regarded as a symbol having the name format type Free.

— Se how to let the symbol regain its adaptability in "Make a symbol regain its 
adaptability" above.

CURRENT PATH NUMBERS AND AUTOMATIC PROJECT GENERATION

When applying the automatic project generation facilities in PCschematic ELauto-
mation, all symbols in the generated project can automatically be assigned current 
path numbers.

— Read more about this in the Project Generator manual.
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This section describes functions for automatic 

and manual wire numbering:

- Automatic wire numbering ..................(p. 395)

- Manual wire numbering.......................(p. 404)

- Wire number files ................................(p. 407)
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AUTOMATIC WIRE NUMBERING

PCschematic ELautomation can assign wire numbers to your drawings automati-
cally. You can also assign wire numbers manually, and combine these two ways of 
working.

— Please refer to “Manual placing of wire numbers” on page 404 to see how to 
place wire numbers manually.

STARTING THE AUTOMATIC WIRE NUMBERING

If you want to insert wire numbers automatically on your diagrams, you choose 
Functions => Wire numbers. This makes you enter the dialog box Wire num-
bers, which contains various tabs. Here you determine how the automatic wire 
numbering is to be carried out.

If you need to place wire numbers manually, this is described in “Manual placing of 
wire numbers” on page 404.

When the settings are appropriate, you click either All Pages, This 
page or Select pages to carry out the automatic wire numbering, fol-
lowing the directions you have set up.

When you click on All Pages, the wire numbering is made for all 
pages in the project.

When you click on This Page, the wire numbering is only made for 
the current page.

THIS CHAPTER DESCRIBES

— STARTING THE AUTOMATIC WIRE NUMBERING................................................. (P. 395)

— LOCKING THE AUTOMATIC WIRE NUMBERING................................................... (P. 396)

— FUNCTIONS......................................................................................................... (P. 397)

— POTENTIAL NUMBERING..................................................................................... (P. 397)

— WIRE NUMBERING.............................................................................................. (P. 398)

— FORMAT ............................................................................................................. (P. 401)

— NUMBER SYMBOL .............................................................................................. (P. 402)

— EXCLUDE SIGNALS............................................................................................. (P. 403)

NO UNDO FOR WIRE NUMBERING

BEFORE ASSIGNING WIRE NUMBERS AUTOMATICALLY, IT SHOULD STRESSED 
THAT IT IS NOT POSSIBLE TO UNDO THIS FUNCTION. THEREFORE, IT IS A GOOD 
IDEA TO SAVE THE PROJECT BEFORE ACTIVATING THE AUTOMATIC WIRE NUM-
BERING.
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When you click on Select pages, you enter a special version of the Page menu:

The pages where it is possible to perform wire numbering, are indicated by a green 
page icon. Select the pages where you wish to assign wire numbers, and click OK.

If you wish to keep the settings in the dialog box Wire Numbers, but not carry out 
the wire numbering right now, click on Close. If you do not wish to keep the new 
settings, click Cancel.

Wire numbering settings in the project file
The directions for the wire numbering you set up here, are remembered in the 
project file. Thus you can perform automatic wire numbering following different 
guidelines in different projects, if you want.

When you start up a new project, the wire number settings used in the last active 
project will be suggested.

Wire numbers in the Object lister
To locate wire numbers in the project, you can use the Object lister, as described in 
“The Object Lister” on page 314.

When you use the Show net function, you get access to the same function, as 
described in “Show net” on page 217.

LOCKING THE AUTOMATIC WIRE NUMBERING

At the top of the dialog box Wire numbers you can lock the project against wire 
numbering/renumbering by selecting Lock the project against wire numbering/
renumbering.

This makes it possible to avoid renumbering a project by mistake.

These pages can
be selected
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FUNCTIONS

On the wire number tab Functions, you determine the principles for the automatic 
wire numbering.

Basically, there are two different principles for performing the wire numbering, 
namely potential numbering and wire numbering.

Potential numbering
To select potential numbering, you click on Potential numbering in the upper-left 
corner of the dialog box.

Hereby each electrical potential is assigned its own wire number. If the same elec-
trical potential is separated by signal symbols (see “Signal symbols” on page 218) 
— for instance because it is used on more pages — the same wire number will be 
applied each place this potential exists.

The wire number is placed in the middle of the longest line-segment in the poten-
tial, but may be moved succeedingly if you wish.

If you want the same wire number on each side of a terminal, you click on Same 
number through terminals.

Due to the fact that cables are components of their own right, cable wires will not 
be numbered unless you check off Include cable wires.

If you wish to interpret signal variants as unique potentials, select Separate Signal 
Variants.

Please observe the warning
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Wire numbering
If you want to assign a unique number to each wire in the entire project, you check 
off Wire Numbering in the upper-left corner of the dialog box.

Therefore, if you want to perform automatic wire numbering, you receive this 
warning:

Unambiguous drawing
To make it perfectly clear how the wires should be installed, you can make the 
drawing unambiguous:

On the ambiguously drawn figure above, it is not clear whether the horizontal wire 
connects K1 to S1, or from K1 to S2.

On the other hand, the unambiguously drawn figure clearly states that the wire con-
nects K1 to S2.

THE WIRE NUMBERING IS A QUALIFIED GUESS

IF YOU CANNOT TELL FROM THE DRAWING HOW THE WIRE NUMBERS SHOULD 
BE PLACED, YOU CANNOT ASSUME THAT THE PROGRAM CAN GUESS WHERE 
THE WIRE NUMBERS SHOULD BE LOCATED!
THE PROGRAM WILL PLACE THE CORRECT AMOUNT OF WIRE NUMBERS WITHIN 
THE INDIVIDUAL POTENTIALS, AND YOU WILL THEREFORE RECEIVE THE COR-
RECT AMOUNT OF WIRE NUMBERS IN YOUR WIRE NUMBERS FILE. — BUT 
THERE IS NO GUARANTEE THAT THE NUMBERS WILL BE LOCATED ON THE COR-
RECT WIRES, IF YOU DO NOT DRAW IN MOUNTING MODE.

Ambiguous Unambiguous

1

2
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It only makes sense to place a wire number on a drawn line, which only represents 
one wire. However, on the ambiguous drawing above, it is not clear whether the 
line from S1 to the connection dot (1), or the line from the connection dot to S2 rep-
resents both wires. On the ambiguous drawing, the symbols could be connected in 
two different ways:

In this case, the program must make a qualified guess.

The program guess
PCschematic ELautomation will 
make a guess which polyline repre-
sents more than one wire. These are 
not assigned a wire number.

— In this context a polyline is the 
line drawn from the connection 
point of a symbol to the connection 
dot in which the line meets another 
line. On the figure, one of the 
polyline is the line starting in the 
connection point 13, and ending in 
the connection dot.

In an electrical potential with for instance three connected symbols, two lines will 
be included. The program will then make a guess, that the shortest polyline repre-
sents both wires. Please bear this in mind when you draw diagrams.

Numbering order
To specify which corner of the page to start the wire 
numbering from, you select one of the four corners.

Also you specify whether the counting direction shall be 
Horizontal or Vertical.

Wire numbers here

Wire numbers here

Option 1 Option 2

Numbered

Not numbered
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Function
In the lower-left corner of the tab, you determine how to assign wire numbers, and 
where to place the wire numbers:

Please notice that the further down you go on the list, the larger is the extent of the 
actions. — Please remember that Undo is no option here!

FUNCTION ACTION

PLACE MISSING DOES NOT ALTER WIRE NUMBERS THAT HAVE ALREADY BEEN PLACED, 
BUT ASSIGNS WIRE NUMBERS TO WIRES WITHOUT NUMBERS.

PLACE MISSING AND 
RENUMBER

PLACES NEW WIRE NUMBERS ON WIRES WITHOUT WIRE NUMBERS, AND 
ALLOWS ALREADY PLACED WIRE NUMBERS TO KEEP THEIR POSITION ON 
THE DIAGRAMS, BUT ALL WIRE NUMBERS ARE RENUMBERED.

RENUMBER EXIST-
ING

THIS FUNCTION IS USED WHEN YOU HAVE PLACED ALL THE WIRE NUM-
BERS, AND DO NOT WISH TO PLACE MORE NUMBERS. THEREFORE IT ONLY 
RENUMBERS ALREADY PLACED WIRE NUMBERS - WITHOUT EXAMINING 
WHETHER OTHER WIRES LACKS WIRE NUMBERS.

REMOVE EXISTING 
AND REPLACE

ALL EXISTING WIRE NUMBERS ARE REMOVED COMPLETELY, AND NEW 
WIRE NUMBERS ARE PLACED. THE EARLIER POSITION OF THE WIRE NUM-
BERS ARE NOT REMEMBERED.

REMOVE EXISTING REMOVES ALL WIRE NUMBERS FROM THE PROJECT.

NUMBERS AND LOCATION OF WIRE NUMBERS
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FORMAT FOR AUTOMATIC WIRE NUMBERS

Here you determine the numbering principles for the wire numbers.

Please note, that in the right-hand side of the tab, you can see an example on how 
the wire numbers would appear in a (fictional) project.

FORMAT ACTION

PREFIX HERE YOU CAN PLACE A PREFIX, WHICH IS PLACED IN THE BEGIN-
NING OF THE WIRE NUMBERS.

START NUMBER HERE YOU CAN SPECIFY A START NUMBER FOR THE WIRE NUMBERS.

FIXED DIGITS HERE YOU STATE WHETHER THE WIRE NUMBERS SHALL CONTAIN A 
FIXED NUMBER OF DIGITS — FROM TWO TO NINE.

PRECEDE PAGE 
NUMBER

PLACES THE PAGE NUMBER IN THE FIRST PART OF THE WIRE 
NUMBER. — CAN ONLY BE CHOSEN IF FIXED DIGITS HAVE BEEN 
CHECKED OFF. INSERTION OF A NEW PAGE BETWEEN PAGES, WHICH 
USES THIS TYPE OF WIRE NUMBERS, WILL NOT CHANGE WIRE NUM-
BERS AUTOMATICALLY.

PAGE SEPARATOR INSERTS A USER DEFINED SEPARATOR BETWEEN THE PAGE NUMBER 
AND THE WIRE NUMBER.

RESTART ON PAGE SHIFT MAKES THE WIRE NUMBERS START ALL OVER ON EACH PAGE.
— CAN ONLY BE SELECTED IF PRECEDE PAGE NUMBER IS 
SELECTED.

SPARES PR. PAGE RESERVES AN EXTRA POOL OF AVAILABLE WIRE NUMBERS FOR 
EACH DIAGRAM PAGE. THUS YOU MAKE ROOM FOR WIRE NUMBERS 
THAT ARE APPLIED LATER ON, WITHOUT THIS CAUSING ANY 
CHANGES TO THE OTHER WIRE NUMBERS IN THE PROJECT.
— DOES NOT MAKE MUCH SENSE IF YOU HAVE CHECKED OFF 
RESTART ON PAGE SHIFT.

THE WIRE NUMBER FORMAT
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NUMBER SYMBOL FOR AUTOMATIC WIRE NUMBERING

When you assign a wire number to a wire, this is done by placing a wire number 
symbol, having the wire number as its symbol name.

When you click on the tab Number symbol, you state which symbol will be used 
as the wire number symbol.

If you want to change which symbol is being used, you click on Browse, whereby 
you enter the Symbol menu. Here you click on the desired wire number symbol, 
and click OK.

You can only apply symbols of the type Wire number.

Position of wire number symbol
In the lower-left corner, you specify whether the wire number symbols are placed 
on the Left side or on the Right side of vertical lines.

Design your own wire number symbol
If you want to design your own wire number symbols, you can see how to design 
symbols in “Creating Symbols” on page 670.
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EXCLUDE SIGNALS FROM AUTOMATIC WIRE NUMBERING

Because some users do not wish to number certain signals, it is possible to deter-
mine which signals should be excluded from the automatic wire numbering.

Select the signals you want to transfer and click on the Transfer button, or click on 
the Transfer all button to exclude all signals from the automatic wire numbering.

Correspondingly you can select excluded signals in the right hand side of the tab, 
and revert them by clicking on the Revert button, or click on the Revert all button 
to get all excluded signals back on the included list of signals to be numbered.
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MANUAL PLACING OF WIRE NUMBERS

If you want to make sure that certain wires in the project are assigned specific wire 
numbers, you can apply the wire numbers manually.

It is a good strategy to place the wire numbers you want to place first, and then 
apply the automatic wire numbering function, as described in “Automatic wire 
numbering” on page 395.

FETCHING A WIRE NUMBER SYMBOL

The wire numbers are placed by a wire number symbol, which you place on the line 
that shall have the wire number.

To fetch a wire number symbol you click on the Symbols and the Symbol menu 
button, to enter the Symbol menu. Or press [F8] to enter the menu directly.

Here you choose a wire number symbol — for instance the symbol WIRENO in the 
MISC folder — and click OK.

Please note, that this wire number must be of the symbol type Wire number.

Place the wire number symbol in the pickmenu
Also, you can place the wire number symbol in the pickmenu, as described in 
“Placing symbols in the pickmenu” on page 196.

This speeds up the manual placing of the symbol.

Please refer to “Fetching symbols” on page 160 for further details about fetching 
symbols.

THIS CHAPTER DESCRIBES

— FETCHING A WIRE NUMBER SYMBOL .................................................................(P. 404)

— PLACING A WIRE NUMBER SYMBOL ...................................................................(P. 405)

— AUTOMATICALLY INCREMENTING OF WIRE NUMBER NAMES.............................(P. 406)
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PLACING A WIRE NUMBER SYMBOL

You now have the wire number symbol in the cross hairs, and click on the wire you 
want to place the symbol on.

If the wire already has a wire number, you will get this message:

If you want to place another wire number, click No, and you enter the dialog box 
Wire number data.

If Enter Wire Numbers Manually is not selected, the program automatically sug-
gest the next available wire number — according to the wire numbering principle 
specified in Functions => Wire Numbers.

If Enter Wire Numbers Manually is selected, you can specify the wire number 
names independent of these settings. This way the program supports, that you can 
apply a specific numbering principle for the naming of your manually placed wire 
numbers.

If you select Protected, the wire number will not be renamed or moved automati-
cally when you change the wire numbers automatically in Functions => Wire 
numbers.
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AUTOMATIC INCREMENTING OF MANUALLY PLACED WIRE NUMBERS

Having selected Enter Wire Numbers Manually, you can for instance type in L1/1, 
press down <Ctrl>, and click on Plus. Hereby you activate the automatic incre-
menting of the manually placed wire number names. Click OK.

When you place the wire number in a potential already having a wire number, you 
can select Change all in Potential to L1/1. This way you rename all wire numbers 
in the potential. This function is particularly useful when you have copied diagrams 
from other projects.

Now click on another wire, and notice that the name of the new wire number now 
have been incremented to L1/2. Click OK.

OTHER FUNCTIONS IN THE DIALOG BOX

By selecting Visible in the dialog box, you specify that the wire number should be 
visible on the diagrams.

The buttons +, -, ? and Σ function as described in “Placing and Naming symbols” 
on page 176.
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WIRE NUMBER FILES

In PCschematic ELautomation you can create wire number files for a wire num-
bering tool. This chapter describes how to create wire number files.

CREATING A WIRE NUMBER FILE

When you want have your wire numbers saved in a file, you choose Lists => Wire 
number file.

You then enter this dialog box:

Here you have the following options:

New or All wire numbers
The program keeps track of which wire numbers have been saved in a file. There-
fore clicking on Not yet written (new) only gives you a file with wire numbers, 
which have not been written to a wire number file earlier.

If you want all wire numbers in the project included in the file, you click on All.

How many numbers pr. wire
If you only want a single wire number pr. wire, click on 1 number pr. wire, if you 
want two wire numbers for each wire, you click on 2 numbers pr. wire.

WIRE NUMBERS PR. CONNECTION

If you choose 1 number pr. connection, one wire number pr. connection is created. 
This function only has relevance for potential numbering, where two wires under 
the same terminal has the same number, and therefore can use the same wire 
number label.

THIS CHAPTER DESCRIBES

— CREATING A WIRE NUMBER FILE ....................................................................... (P. 407)

— CREATING A CONNECTIONS LIST FILE FOR WIRE NUMBERING........................... (P. 409)
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Wire numbers to file according to Line color and Line width
It is furthermore possible to create wire number files, which is sorted according to 
line color and/or line width for the line on which the wire number is placed.

This makes it possible succeedingly to handle the wire numbers differently in the 
wire numbering tool, in which the file is loaded.

To sort the wire numbers, select Sort on Line Color and/or Sort on Line Width.

Specify name and file format for the wire number file
In the field Wire Numbers File you type in the name of the wire number file, as 
well as the path that leads to the file. The extension of the file specifies the file for-
mat — see the options in the figure below.

By clicking on Browse, you enter the dialog box Save as. Here you can find the 
folder and/or the file name you want to use for the file, and specify the file format 
for the wirenumber file:

OPENING THE WIRE NUMBER FILE

If you select Open list file in the dialog box Wire Numbers File, the wire number 
file is subsequently opened in a program according to the file format. If for instance 
you selected Microsoft Excel (*.xls), the file is opened in Excel, if you have this 
program installed on your PC.

Creating the wire number file
When you click OK, a wire number file is created, which can be loaded in a wire 
numbering tool, from which you can print the wire numbers to place on the actual 
wires.
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CONNECTIONS LIST FOR WIRE NUMBERING

In PCschematic ELautomation you can create a connections list file, which con-
tains component names with connections for all electrically connected components. 
Hereby a complete connections list is displayed, where name and connection is dis-
played for each individual connection.

This list can succeedingly be sent to a wire numbering tool, from which you can 
have all the necessary wire numbers printed.

It is also possible to create connection lists with wire numbers, so that the list can 
be used for mounting.

Creating a connections list for wire numbering
Choose Lists => Connectionslist for file, and you enter this dialog box:

If you create a connections list 
file, which only contains com-
ponent names with connec-
tions for all of the electrically 
connected components, just 
choose the datafield Name 
twice.

When you then select With 
Connection Name for both of 
these datafields, and set the 
one to From and the other to 
To.
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— Read more about the options in this dialog box in “Specifying the contents of the 
file” on page 630, and see “The buttons in the right-hand side of the dialog box” on 
page 629 also.

Settings for Connections lists for file
If you click on Setup, you enter the following dialog box:

Here you have the following options for specifying how to sort the list:

WIRE NUMBERS

The file is sorted by wire numbers, so that the lowest wire numbers are placed first.

COMPONENT NAMES

The file is sorted alphabetically by component names. Thus for instance all wires 
attached to the component -K1 comes first, then wires attached to -K2 etc.

COMPONENT DRAWING LOCATION

The file is sorted according to the pages in the project. First comes everything from 
page 1, then everything from page 2 etc.

STARTING POINT OF WIRES

The file is sorted by the starting 
points, as displayed in the figure to 
the right.

WRITE COMPLETE NETS

If you select Write complete nets, the connections in the same nets are listed in suc-
cession.

IF YOU NEED TO CREATE 
CONNECTION LIST FILES 
ACCORDING TO OTHER 
DIRECTIONS, PLEASE CON-
TACT DPS CAD-CENTER 
APS.

1
2
3
4
5
6
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INCLUDE CABLES IN LISTS

Select Include cables in lists, in order to include cables in the list.

CLICK OK
Select the desired setting, and click OK.

— Read more about lists to files in “Exporting List Files” on page 625.
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create from Symbols command  . . . . . . . 154
create from Texts command  . . . . . . . . . 154
delete . . . . . . . . . . . . . . . . . . . . . . . . 157
edit  . . . . . . . . . . . . . . . . . . . . . . . . . 156
in PLC I/O lists  . . . . . . . . . . . . . . . . . 157
indication of linked texts  . . . . . . . . . . . 153
what is a text link  . . . . . . . . . . . . . . . . 153

toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . 128
type in  . . . . . . . . . . . . . . . . . . . . . . . . . . 128
underline . . . . . . . . . . . . . . . . . . . . . . . . . 140
visible text . . . . . . . . . . . . . . . . . . . . . . . . 147
width  . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Texts button . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Tile horizontal  . . . . . . . . . . . . . . . . . . . . . . . . 510
Tile vertical . . . . . . . . . . . . . . . . . . . . . . . . . . 510
Time-out . . . . . . . . . . . . . . . . . . . . . . . . . . . . 830
Title bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Toolbars

arcs/circles  . . . . . . . . . . . . . . . . . . . . . . . 125
dock/move . . . . . . . . . . . . . . . . . . . . . . . . . 50
lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
symbols  . . . . . . . . . . . . . . . . . . . . . . . . . 194
texts . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Tools => . . . . . . . . . . . . . . . . . . . . . . . . . . . . 825
Create variable list  . . . . . . . . . . . . . . 290, 292
Database . . . . . . . . . . . . . . . . . . . . . . . . . 591
Mouse Chasing System  . . . . . . . . . . . . . . . 779
Rename symbols  . . . . . . . . . . . . . . . . . . . 299
Show textfile . . . . . . . . . . . . . . . . . . . . . . 654

Tools menu
open files from . . . . . . . . . . . . . . . . . . . . . 654

Top to bottom  . . . . . . . . . . . . . . . . . . . . . . . . 466
Transfer Group Number button  . . . . . . . . . . . . . 552
Transfer information

from database . . . . . . . . . . . . . . . . . . . . . . 561
Translate

database fields  . . . . . . . . . . . . . . . . . . . . . 591
Trim line . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Type in texts  . . . . . . . . . . . . . . . . . . . . . . . . . 128
Type of file  . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Types

line types  . . . . . . . . . . . . . . . . . . . . . . . . . 96
symbol types  . . . . . . . . . . . . . . . . . . . . . . 680

U
Unambiguous drawing . . . . . . . . . . . . . . . . . . . 398
Underline  . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Underline text  . . . . . . . . . . . . . . . . . . . . . . . . 140
Undo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Undo button . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Uninstall modules . . . . . . . . . . . . . . . . . . . . . . 760
Unit Drawing, page function . . . . . . . . . . . . . . . 492

Unit drawings
attach to symbol  . . . . . . . . . . . . . . . . . . . .555
correct . . . . . . . . . . . . . . . . . . . . . . . . . . .747
create  . . . . . . . . . . . . . . . . . . . . . . . . . . .744
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insert  . . . . . . . . . . . . . . . . . . . . . . . . . . .555
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correct . . . . . . . . . . . . . . . . . . . . . . . . . . .747
without unit drawings . . . . . . . . . . . . . . . . .747

Unregister command  . . . . . . . . . . . . . . . . . . . .803
Update  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

automatic information  . . . . . . . . . . . . . . . .762
modules . . . . . . . . . . . . . . . . . . . . . . . . . .760

Update lists  . . . . . . . . . . . . . . . . . . . . . . . . . .532
Update, button  . . . . . . . . . . . . . . . . . . . . . . . .387
USB keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . .32
User defined short-cut keys . . . . . . . . . . . . . . . .768
User Home view

set  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65
User name  . . . . . . . . . . . . . . . . . . . . . . . . . . .829
USERLIB, symbol folder  . . . . . . . . . . . . . . . . .240

V
Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . .848

create variablelist  . . . . . . . . . . . . . . . . . . .292
indexed variables  . . . . . . . . . . . . . . . . . . .849
insert  . . . . . . . . . . . . . . . . . . . . . . . . . . .290
insertion with default value . . . . . . . . . . . . .848
normal variable . . . . . . . . . . . . . . . . . . . . .848
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with default value  . . . . . . . . . . . . . . . . . . .848
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Vertical reference  . . . . . . . . . . . . . . . . . . . . . .151
Vertical, tab . . . . . . . . . . . . . . . . . . . . . . . . . .386
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Activate Pickmenu  . . . . . . . . . . . . . . . . . . .53
Clean screen . . . . . . . . . . . . . . . . . . . . . . . .66
Go to page . . . . . . . . . . . . . . . . . . . . . . . .487
Goto symbol . . . . . . . . . . . . . . . . . . . . . . .188
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Select page . . . . . . . . . . . . . . . . .52, 363, 489
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Show object below cursor . . . . . . . . . . . . . . .81
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Visible text . . . . . . . . . . . . . . . . . . . . . . . . . . 147

W
Warnings  . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
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maximize . . . . . . . . . . . . . . . . . . . . . . . . . 37
minimize  . . . . . . . . . . . . . . . . . . . . . . . . . 37
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Tile . . . . . . . . . . . . . . . . . . . . . . . . . . . . 511
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Wire
add to cable  . . . . . . . . . . . . . . . . . . . . . . 236
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connection lists  . . . . . . . . . . . . . . . . . . . . 410
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Work area . . . . . . . . . . . . . . . . . . . . . 59, 61, 855
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x,y position . . . . . . . . . . . . . . . . . . . . . . . . . . 616
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